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About this Guide
This guide explains how to configure and use Media Manager software on a UNIX Server. 
Media Manager is the component of VERITAS NetBackup BusinesServer that manages 
the devices and media that are used to store your backup data.

See the NetBackup release notes for information on the supported UNIX server platforms.

This guide describes using the NetBackup Administration Console (Java administrative 
interface) to manage Media Manager software and its components. You can use other 
administrative interfaces. See “Introduction to Media Manager” on page 1 for a 
description of the other Media Manager administrative interfaces that are available.

In this guide, NetBackup refers to the VERITAS NetBackup BusinesServer product.

Audience
This guide is intended primarily for the system administrator, who most likely will want 
to read every chapter.

An operator should read the chapter “Monitoring Storage Devices” on page 137.

A tape user, who has no responsibility for administration, may have an interest in reading 
the chapter “Tape I/O Commands” on page 165, which describes the user command 
interface and possibly the Media Manager overview in “Introduction to Media Manager” 
on page 1.

In this manual, various roles are defined as follows:

� A system administrator is a person with typical UNIX administrator privileges and 
responsibilities.

� An operator may be any user of the system; by default, root user privileges are 
required to use the operator interface.

� A user is anyone with access to the commands of the system; root user privileges are 
required to use tapes.

This guide assumes you are familiar with the operating system of the platform on which 
Media Manager is being used and UNIX systems in general.
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Organization
Organization
This guide contains the following chapters:

� “Introduction to Media Manager” on page 1 provides an overview of Media Manager 
and the administrative interfaces that are available.

� “Configuring Storage Devices” on page 9 explains how to configure Media Manager 
to manage the drives and robots at your site.

� “Managing Media” on page 45 provides topics on configuring Media Manager to use 
the media (volumes and volume pools) that Media Manager requires to store 
backups.

� “Managing Media in Robots” on page 93 explains how to configure Media Manager 
to use and manage media in robots (using robot inventory).

� “Monitoring Storage Devices” on page 137 discusses tasks, such as how to assign a 
drive to a tape request.

� “Managing Daemons” on page 159 explains how to start and stop the media 
management daemons and how these daemons relate to each other.

� “Tape I/O Commands” on page 165 describes the commands for requesting tape 
mounts, writing files, and other user-related operations.

In addition to these chapters, there are the following appendixes, a glossary of NetBackup 
terms and an index. 

� “Media Manager Man Pages” on page 169 contains the man pages for the commands 
that relate to media management. You can use the UNIX man command to view these 
commands online.

� “Media Manager Reference Topics” on page 229 provides background information on 
important Media Manager features and concepts.

� “Using tpconfig” on page 265 explains how to use the tpconfig utility for 
configuring robots and devices. tpconfig is a character-based menu utility.

� “Using vmadm” on page 275 explains how to use vmadm to define media in the 
volume database. vmadm is a character-based menu utility.

� “Robot Drive and Slot Layouts” on page 335 contains diagrams showing the slot 
layout and drive locations in many of the robots supported by Media Manager.

Related Documents
NetBackup documents that may be useful are listed below. For a complete list of related 
documents, see the NetBackup release notes. Depending on your configuration, other 
documents may also be required.
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Related Documents
� NetBackup BusinesServer Getting Started Guide for UNIX

Gives you the information you need to quickly get NetBackup BusinesServer server 
software installed and running. This is the first document that you should read after 
opening the NetBackup BusinesServer package.

� NetBackup BusinesServer System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup BusinesServer on a UNIX system. 

� NetBackup Global Data Manager System Administrator’s Guide for UNIX and Windows

Explains how to install, configure, and use Global Data Manager (GDM) for 
NetBackup DataCenter and BusinesServer products on UNIX and Windows-based 
operating systems.

� NetBackup Media Manager Device Configuration Guide for UNIX

Explains how to add device drivers and perform other system-level configurations for 
storage devices that are supported by NetBackup DataCenter and NetBackup 
BusinesServer Media Manager on UNIX hosts.

� NetBackup for NDMP System Administrator’s Guide

Explains how to install, configure, and use NetBackup for NDMP to control backups 
on an NDMP host.

� NetBackup Release Notes for UNIX and Windows

Provides important information about NetBackup DataCenter and BusinesServer 
products on UNIX- and Windows-based servers, such as the platforms and operating 
systems that are supported and operating notes that may not be in the NetBackup 
manuals or the online help.

� NetBackup Troubleshooting Guide for UNIX

Provides troubleshooting information for UNIX-based NetBackup DataCenter and 
BusinesServer products.

� NetBackup Vault 4.5 System Administrator's Guide for UNIX and Windows

Describes how to configure and use logical vaults and profiles to duplicate backups, 
perform catalog backups, eject media, and generate reports.

If your configuration includes Windows servers, you may also need the following 
manuals:

� NetBackup BusinesServer Getting Started Guide for Windows

Gives you the information you need to quickly get NetBackup BusinesServer server 
software installed and running. This is the first document that you should read after 
opening the NetBackup BusinesServer package.

� NetBackup BusinesServer System Administrator’s Guide for Windows
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Accessibility
Explains how to configure and manage NetBackup BusinesServer on a Windows 
server.

� NetBackup Troubleshooting Guide for Windows

Provides troubleshooting information for Windows-based NetBackup DataCenter 
and BusinesServer products.

Accessibility
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include:

� Support for assistive technologies such as screen readers and voice input (Windows 
servers only)

� Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys

For more information, see the NetBackup system administrator’s guide.

Conventions
The following explains typographical and other conventions used in this guide.

Type Style

Typographic Conventions

Typeface Usage

Bold fixed width Input. For example, type cd to change directories.

Fixed width Paths, commands, filenames, or output. For example: The default installation 
directory is /opt/VRTSxx.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your 
file.
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Conventions
Notes and Cautions

Note This is a Note. Notes are used to call attention to information that makes using the 
product easier or helps in avoiding problems.

Caution This is a Caution. Cautions are used to warn about situations that could cause 
data loss.

Key Combinations
Some keyboard command sequences use two or more keys at the same time. For example, 
holding down the Ctrl key while pressing another key. Keyboard command sequences are 
indicated by connecting the keys with a plus sign. For example:

Press Ctrl+t

Command Usage
The following conventions are frequently used in the synopsis of command usage.

brackets [ ]

The enclosed command line component is optional.

Vertical bar or pipe (|)

Separates optional arguments from which the user can choose. For example, when a 
command has the following format:

command arg1|arg2

the user can use either the arg1 or arg2 variable.

Serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.

Typographic Conventions (continued)

Typeface Usage
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Getting Help
Terms
The terms listed in the table below are used in the VERITAS NetBackup documentation to 
increase readability while maintaining technical accuracy. 

Getting Help
For updated information about this product, including system requirements, supported 
platforms, supported peripherals, and a list of current patches available from Technical 
Support, visit our web site:

http://www.support.veritas.com/

VERITAS Customer Support has an extensive technical support structure that enables you 
to contact technical support teams that are trained to answer questions to specific 
products. You can contact Customer Support by sending an e-mail to 
support@veritas.com, or by finding a product-specific phone number from the VERITAS 
support web site. The following steps describe how to locate the proper phone number.

Term Definition

Microsoft Windows, 
Windows

Terms used as nouns to describe a line of operating systems 
developed by Microsoft, Inc. 

A term used as an adjective to describe a specific product or 
noun. Some examples are: Windows 95, Windows 98, 
Windows NT, Windows 2000, Windows servers, Windows 
clients, Windows platforms, Windows hosts, and Windows GUI.

Where a specific Windows product is identified, then only that 
particular product is valid with regards to the instance in which 
it is being used. 
For more information on the Windows operating systems that 
NetBackup supports, refer to the VERITAS support web site at 
http://www.support.veritas.com.

Windows servers A term that defines the Windows server platforms that 
NetBackup supports; those platforms are: Windows NT and 
Windows 2000.

Windows clients A term that defines the Windows client platforms that 
NetBackup supports; those platforms are: Windows 95, 98, ME, 
NT, 2000, XP (for 32- and 64-bit versions), and LE.
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Getting Help
1. Open http://www.support.veritas.com/ in your web browser.

2. Click Contact Support. The Contacting Support Product List page appears.

3. Select a product line and then a product from the lists that appear. The page will 
refresh with a list of technical support phone numbers that are specific to the product 
you just selected.
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Introduction to Media Manager
 1

Media Manager is used by NetBackup to provide media and device management 
capabilities for tape drives. These capabilities include the following:

� Media and device management interfaces that allow configuration of storage devices.

� Device monitor interfaces that display the current status of all defined tape devices 
and pending requests for volumes, allowing the operator to assign tapes to the 
appropriate drives and respond to problems.

� Automatic scanning of devices for loaded media with automatic volume recognition 
of recorded volume labels.

Note Automatic volume recognition is the only aspect of ANSI labeled tapes that Media 
Manager supports. Once a tape is assigned to a request, all volumes are treated as 
unlabeled, and the user or application is responsible for reading or writing labels if 
applicable.

� Support of numerous robotic tape library devices that can automatically retrieve, 
mount, assign, unmount, and store removable volumes.

� A volume database containing location and other information about volumes that can 
be used to identify and retrieve volumes in the robotic devices.

� Allow any user to request and unmount a specific volume. See “Allowing Nonroot 
Users to Administer NetBackup” in the UNIX NetBackup system administrator’s 
guide.

� Ability to obtain a media inventory of a robotic device and update the associated 
volume database to provide efficient media tracking.

� The capacity to record media statistics. For example, the first and last time the volume 
was mounted, the date it was created, an expiration date, and the number of times the 
volume was mounted. 

� Grouping volumes into volume pools for convenience and protection.

� Capability to perform automated drive cleaning, based on the TapeAlert feature or a 
frequency-based cleaning schedule.
1



Administrator and User Interfaces
Visit the VERITAS support web site for a list of the platforms and peripherals that Media 
Manager supports.

Caution Note: If you want to use devices with some other application and these devices 
are currently being controlled by Media Manger, you must do one of the 
following to avoid potential loss of data:

A. Use the Media Manager commands, tpreq to mount a drive and 
tpunmount to unmount the drive. These commands will safely get control of 
the device when Media Manager is finished with the device.

B. Down the drive, if the drive is in the Media Manager up state.

Administrator and User Interfaces

Note As of release 4.5, NetBackup does not include or support the xvmadm and xdevadm 
Motif interfaces. Attempting to configure NetBackup by using copies of these Motif 
interfaces from an earlier NetBackup release will corrupt your NetBackup 
configuration.

The following table shows the Media Manager administrative interface choices that are 
available. The terminology, general concepts, and results in the databases are the same, 
regardless of which interface you use.

See the following sections for more information on these administrative interfaces:

� “Java Administrative GUI” on page 3.

� “Menu-Based Administrative Interfaces” on page 5.

� “Command Line Administrative Interfaces (CLI)” on page 5.

Media Manager Administrative Interfaces

Java GUI Menus CLI Wizards

Task jnbSA tpconfig vmadm

Configure Devices X X X X

Configure Media X X X X

Manage Devices X X
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Administrator and User Interfaces
� “The Device Configuration Wizard” on page 6.

� “The Volume Configuration Wizard” on page 6.

Note For ease of use, the wizards are recommended for device and media configuration.

Java Administrative GUI
The NetBackup Administration Console allows you to configure and manage media and 
devices from one main interface. This interface is supported on certain UNIX platforms.

See the NetBackup release notes for information on platform support, and configuring 
and using the NetBackup Administration Console on UNIX and the UNIX NetBackup 
system administrator’s guide for an overview of the interface.

Starting the Administration Interface

To start the NetBackup Administration Console (the Java administrative interface) enter 
the following:

/usr/openv/netbackup/bin/jnbSA

The NetBackup Administration Console is the starting point for administering 
NetBackup. The left pane of the console window has a node for each major area of 
NetBackup administration (including nodes for optional VERITAS products).

The right pane initially contains the NetBackup wizards that apply to each node. The 
figure shows the available wizards for Media Manager (the Media and Device 
Management node).
Chapter 1, Introduction to Media Manager 3



Administrator and User Interfaces
The Media and Device Management node contains the Media Manager utilities. Expand 
Media and Device Management to view these utilities.

Clicking a node displays information related to that node in the right pane. The menus 
contain commands relevant to the selected node.

� Click Device Monitor. The device monitor has commands for monitoring the 
operation of storage devices.

“Monitoring Storage Devices” on page 135 explains how to use the Device Monitor.

� Click Media. This node has commands for managing media.

“Managing Media” on page 43 and “Managing Media in Robots” on page 91 explain 
how to manage your media. 

� Click Devices. This node has commands for configuring and managing hosts, robots, 
and drives.

“Configuring Storage Devices” on page 9 explains how to configure robots and 
drives.

The Media and Device Management node
 Media and Device Management wizards
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Administrator and User Interfaces
Note See the NetBackup system administrator’s guide for UNIX servers for details on the 
other NetBackup administration utilities and menu commands available.

Shortcut Menus

Pressing the right-mouse button while the pointer is over sections of the NetBackup 
Administration Console, displays shortcut menus. Different menus appear depending on 
where your pointer is positioned.

Menu-Based Administrative Interfaces
Media Manager has the following utilities that you can use from terminals that do not 
support Java capabilities. These utilities have character-based interfaces that let you 
choose operations from menus and prompt you for necessary information.

tpconfig

Used for device configuration. See “Using tpconfig” on page 265 for more 
information.

vmadm

Used for media configuration. See “Using vmadm” on page 275 for more information.

Command Line Administrative Interfaces (CLI)
Media Manager has the following commands that you can use from terminals that do not 
support Java capabilities:

vmoprcmd

Used for device management and to perform operator functions on drives.

Users and administrators that are not using NetBackup can use the following commands 
to request Media Manager to mount and unmount specific volumes. “Tape I/O 
Commands” on page 165 explains these commands.

tpreq

Used to request and mount volumes.

tpunmount

Used to unmount volumes.

For more information about these and other commands, see “Media Manager Man Pages” 
on page 169.
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Device and Media Configuration - Overview
The Device Configuration Wizard
You can use the Device Configuration wizard to configure robots and drives.

This wizard is available from the right pane of the NetBackup Administration Console 
(click Configure Storage Devices).

The Volume Configuration Wizard
You can use the Volume Configuration wizard to configure media (volumes). This wizard 
is available from the right pane of the NetBackup Administration Console (click 
Configure Volumes).

This wizard configures volumes for all supported standalone drives and robotic libraries.

Device and Media Configuration - Overview
The following summarizes the steps for configuring storage devices and media. Complete 
your NetBackup configuration, as explained in the NetBackup system administrator’s 
guide for UNIX servers.

1. Physically attach the storage devices to the Media Manager server and perform any 
configuration steps specified by the device or operating system vendor. Also, see the 
NetBackup Media Manager device configuration guide.

2. Create the system device files for the drives and robotic control.

This is usually done during installation. Device files are created automatically on 
some UNIX servers. Explicit configuration of device files is required on some UNIX 
servers to make full use of NetBackup features. See the NetBackup Media Manager 
device configuration guide for information.

3. Use the Device Configuration Wizard to configure your robots and drives. For more 
information, see “Using the Device Configuration Wizard to Configure Devices” on 
page 24.

To configure unsupported devices, you must use the menus of the Devices node. See 
“Configuring Storage Devices” on page 9

4. Use the Volume Configuration Wizard to add the media that you will be using in your 
storage devices. This wizard configures volumes for all supported standalone drives 
and robots.
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Using Media Manager - Overview
When you logically add a new volume (or move volumes) in a robot that supports 
barcodes, a scan occurs and the Media Manager volume database is updated to reflect 
the contents of the robotic library.

To configure volumes for unsupported devices, use the menus of the Media node. See 
“Managing Media” on page 45 and “Managing Media in Robots” on page 93 for 
advanced robot inventory options.

Using Media Manager - Overview
When configuration is complete, you enable device management by starting the Media 
Manager device daemon (ltid). This starts the following daemons:

� Media Manager device daemon (ltid). This daemon allows Media Manager to 
mount volumes on the tape devices in response to user requests.

� Media Manager volume daemon (vmd). This daemon allows Media Manager to track 
the location of on-line and off-line volumes and remotely manage devices.

� Automatic volume recognition daemon (avrd). If a tape volume is labeled and 
mounted in a drive, avrd automatically reads the label. If the label matches 
information contained in a pending request, Media Manager assigns the drive to that 
request.

� Robotic daemons. If you defined any robots, ltid starts the corresponding robotic 
daemons.

Once these daemons are started, applications and users can request volumes.

Requesting Volumes
NetBackup  requests specify the volume’s media ID and device density. A request must 
have a file name to use as a link to the device that is assigned and the external media ID 
should correspond to the Media Manager media ID. When Media Manager receives a 
request for a volume, it searches its volume database(s) for the media ID.

If the volume is in a robot, the volume database information includes the specific robot 
that has the volume and the location of the volume within the robot (if applicable). Media 
Manager then issues a mount command to the robotic daemon controlling the robot and 
the volume is mounted. Control is returned to NetBackup and the media read or write 
operation proceeds.

Note For standalone drives, NetBackup attempts to use the media in the drive, if the 
media meets the selection criteria in the request. For more information, see the 
standalone drive extensions in the UNIX NetBackup system administrator’s guides.
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Security Issues
Checking Barcodes
Media Manager checks barcodes to ensure that the robot loads the correct tape, in the 
event that the volume database is incorrect. If the barcode on the tape does not match the 
barcode in the mount request, Media Manager logs an error and stops the operation. In 
the case of a backup or restore, NetBackup also logs an error.

If a requested volume is not in a robot, a pending request message appears in the Device 
Monitor. The operator must then find the volume and do one of the following:

� Check the Device Monitor to find a suitable drive, and mount the requested volume in 
that drive.

� Move the volume into the robot and update the volume configuration to reflect the 
correct location for the media, and resubmit the request.

If the volume is a labeled tape, avrd reads the label and the drive is assigned to the 
request. If the volume is unlabeled, the operator manually assigns the drive to the request.

Volume Pools
Media Manager also uses a concept called volume pools. A volume pool is a set of media 
that can be used only by the users that you designate when you configure the pool. You 
specify volume pools and assign media to them when you configure Media Manager. The 
Media Manager device daemon validates access to volume pools.

Whenever a new volume is required for a robotic or standalone drive, Media Manager 
allocates it from the volume pool requested by the application. If there are no volumes 
available in the requested volume pool and a scratch pool has been configured, Media 
Manager allocates a volume from the scratch pool.

A pool named NetBackup is created by default and, unless you specify otherwise in the 
policy or schedule, all NetBackup images go to media in the NetBackup pool. You can 
create other volume pools as desired. Other volume pools that are created by default are 
named None and DataStore.

See “Volume Pools and Volume Groups” on page 242 for more information.

Security Issues
See “vmd Security” on page 251 for important information about security.
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Configuring Storage Devices
 2

The device management window provides the tools required to add, configure, and 
manage the devices that Media Manager uses. 

This chapter explains how to attach drives and robotic libraries and configure Media 
Manager to use them. The topics in this chapter are listed below. If this is the first time you 
have configured devices, read the topics in the order they are presented.

� Starting Device Management

� Using the Device Management Window

� Performing Initial Device Configuration

� Making Device Configuration Changes

� Using the Device Configuration Wizard to Configure Devices

� Managing Partially-Configured Devices

� Adding Robots

� Adding Drives

� Managing Robots and Drives

� Robot and Drive Configuration Example

Starting Device Management
In NetBackup Administration Console, click Media and Device Management > Devices.

The device management window appears.
9



Using the Device Management Window
Device Management Window

In addition to the tree pane on the left, two panes are displayed on the right when you 
start device management:

� A pane showing global topology.

� A pane showing devices.

Using the Device Management Window
The following topics provide an overview of the window’s contents:

� Menus and Commands

� Toolbars

� Tree Pane

� Global Topology Pane

� Devices Pane

� Shortcut Menus and Commands

� Customizing the Window

� Allowable Media Manager Characters
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Using the Device Management Window
Menus and Commands
The device management window has available the menus and commands shown in the 
following table.

The menu items are enabled based on the items that are currently selected in the tree pane 
or topology pane, or which tab is selected in the devices pane. For example, if the robot 
tab is selected in the devices pane and a robotic library is selected in the list, Inventory 
Robot is enabled on the Actions menu.

Device Management Menus and Commands

Menu Commands

File Change Server - Displays a dialog box that allows you to change to a different host that 
is running NetBackup.

New Window from Here - Starts another instance of the NetBackup Administration 
Console node that was active.

Adjust Application Timezone - Displays a dialog that allows you to manage the 
timezone. NetBackup Console can execute in a different timezone than the timezone of 
the server on which it was initiated. See the NetBackup System Administrator’s guide 
for UNIX for more information.

Close Window - Closes the current window.

Exit - Closes all open windows.

Edit New - Displays a dialog box to add an item of the type that is currently selected.

Change - Displays a dialog box for changing the configuration of the selected items.

Delete - Deletes selected items from the configuration.

View Contains commands for specifying your viewing preferences for the device 
management window, including showing and hiding the toolbar or tree, showing and 
hiding robots, and refreshing the display. See “Customizing the Window” on page 20.

Actions New - Displays choices for adding robots or drives to a configuration.

Inventory Robot - Displays a dialog box with choices for performing an inventory of 
the selected robot or updating the volume configuration to match the contents of the 
robot.

Drive Cleaning - Displays a dialog box with choices for performing drive cleaning 
functions.

Stop/Restart Media Manager Device Daemon - Controls the Media Manager device 
daemon.

Analyze Device Configuration - Displays a dialog box for starting the configuration 
analyzer. This analyzer verifies that the settings in your device configuration are 
consistent and checks for potential problems.
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Using the Device Management Window
Toolbars
The toolbar buttons of the device management window provide shortcuts for commands 
that are on the menus.

To show or hide the toolbar buttons:

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Click View > Show ToolBar.

Also see “Customizing the Window” on page 20.

Tree Pane
The tree pane for Devices contains nodes for Hosts, Robots, and Standalone Drives. You 
can select items in the tree pane or the Topology pane in conjunction with the tabs of the 
Devices pane to filter the lists that are shown in the Devices pane.

The following figure shows just the tree pane and contains an expanded view of the 
Devices node:

Help Help Topics - Provides online help information about the NetBackup Console.

License Keys - Provides information about your active and registered license keys.

About NetBackup Administration Console - Displays program information, version 
number, and copyright information.

Device Management Menus and Commands (continued)

Menu Commands
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Using the Device Management Window
Note Selecting an item in the Tree pane (for example, a specific robot) does not enable the 
Robots tab in the Devices pane.

Global Topology Pane
A description bar is displayed at the top of the topology pane. 

The topology view shows how devices are configured to the server being administrated, 
by showing images of servers and devices. The topology information is taken from the 
Media Manager global device database and is displayed in this pane.

Topology Images

The following images may appear in the topology pane. Shared drives are a NetBackup 
DataCenter option.

If you select a device host, robot, or Standalone 
Drives, the Topology pane shows the pertinent 
connections highlighted and the Devices pane shows 
information filtered for that specific selection.

Description Topology Image

NetBackup media server

Robot 
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Using the Device Management Window
Topology Connections

Connections in the topology indicate physical and logical connections of the devices, as 
follows:

� Media server to robotic library and drive relationships are indicated. A line attaches a 
robot arm to the media server that has robot control.

� Drives that are physically located in a robotic library are shown directly below the 
robotic library. Standalone drives are represented as individual drive objects.

� Drive to device host connections are shown only if the drive is being used for a 
request and the drive is in use by NetBackup. A line attaches a drive to the servers 
that are configured to use it. Robot to server connections and robot to volume 
database connections are always shown.

� Media is represented as in a robotic library. A line attaches the media to the server 
doing media management. 

� The topology also indicates robotic library to volume database host connections.

Selecting Topology Objects

Selecting an object will highlight the connecting lines from the object to all other objects to 
which it is connected, as follows:

� Clicking on a drive will highlight the connection to the server it is attached. 

Robot that is partially configured

Robot media

Drive

Drive that is partially configured

Drive that is shared
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Using the Device Management Window
� Clicking on a shared drive will highlight connections to all servers that are configured 
to use the drive. 

� Clicking on a server will high light connections to all robots, media, and drives that 
are connected or configured to the server.

Selecting objects in the topology pane is also one of the methods to filter the contents of 
the lists shown in the Devices pane. 

Multiple objects of the same type can be selected by pressing the Ctrl key and selecting 
another object. If the Ctrl key is used and an object of a different type is selected, the 
selection is not allowed. If the Ctrl key is not used and an object is selected, the previous 
selection will be unselected.

Devices Pane
The lower right pane contains tabs for Drives, Robots, and Hosts. These tabs allow you to 
select different views of your devices. Information in the devices pane is taken from the 
Media Manager global device database and the local device databases.

You can use the tree pane or the topology pane in conjunction with the tabs to filter the 
lists shown in this pane. Selecting an item in the tree (for example, a specific robot) does not 
enable the Robots tab in the devices pane.

Using the Drives Tab

The drives list allows you to view detailed information about drives configured with 
NetBackup. 

To update the drives list with more detailed information, a drive must be selected in the 
topology pane. You can select a drive in the topology explicitly or implicitly by selecting a 
robotic library. The drives list will then be updated with the objects selected in the 
topology.

The following table describes the columns in the drives list:

Drives List

Column Description

Drive Name Contains the configured name of the drive.

Device Host Contains the name of the device host where this drive is attached.
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Using the Device Management Window
Drive Type Contains the type of drive. For example, 4MM.

If the drive is partially configured, PCD is shown. See “Managing 
Partially-Configured Devices” on page 25 for details.

Robot Type Specifies the type of robot that contains this drive. For example, TL4.

NONE in this column means that the drive is a standalone drive.

If the robot is partially configured, PCR is shown. See “Managing 
Partially-Configured Devices” on page 25 for details.

Robot Number Contains the number of the robot. If the robot type is NONE, this column is 
blank.

Robot Drive 
Number

Specifies the number of the drive in the robot. This number is only present for 
robot types that are not ACS, TLH, and TLM.

Vendor Drive 
Name

For TLH robots, this column contains the DAS drive name. 

For TLH robots, this contains the IBM device name.

This column is not applicable for NetBackup BusinesServer.

ACS Contains the index (in ACS library software terms) that identifies the robot that 
has this drive.

This column is not applicable for NetBackup BusinesServer.

LSM Contains the ACS Library Storage Module that has this drive.

This column is not applicable for NetBackup BusinesServer.

Panel Contains the ACS robot panel where this drive is located.

This column is not applicable for NetBackup BusinesServer.

Drive Contains the physical number of the drive (in ACS library software terms).

This column is not applicable for NetBackup BusinesServer.

Drive Path Contains the path for the drive, for example, Tape5.

Serial Number Contains the drive serial number, if the drive reports one.

World Wide ID Contains a unique identifier that is assigned to each device. Some drives may not 
report this identifier.

Drives List (continued)

Column Description
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Using the Device Management Window
Using the Robots Tab

The robots list allows you to view detailed information about robots configured with 
NetBackup. Initially, all robots in the global device database are listed in the robot list. 
However, only information found in the global device database will be displayed in the 
list.

Shared This column is used for the shared storage option (SSO) feature. Yes, means this 
drive is configured as a shared drive. No, means the drive is not a shared drive.

For NetBackup BusinesServer this column contains No, since this feature is not 
supported.

Drive Status Contains the current status of the drive.

Port Contains the SCSI port number (if the robot is connected to a Windows server).

Bus Contains the SCSI bus number (if the robot is connected to a Windows server).

Target Contains the SCSI target number (or SCSI ID) (if the robot is connected to a 
Windows server).

Lun Contains the SCSI logical unit number of the robot (if the robot is connected to a 
Windows server).

Cleaning 
Frequency

Contains the cleaning frequency for the drive, in hours.

Volume Header This column applies only to optical disk drives on certain UNIX hosts and 
specifies the volume header device path for the drive.

This column is not applicable for NetBackup BusinesServer.

Drive 
Comments

Contains any user comments added for the drive.

Inquiry 
Information

Contains device information returned from the device. This information is used 
to identify the device. For example, vendor ID, product ID, and product revision.

NDMP Host Contains the name of the NDMP control host.

Drive Index Drive index assigned to the drive during configuration.

Drives List (continued)

Column Description
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Using the Device Management Window
To update the robot list with more detailed information, a robot must be selected in the 
topology pane or in the tree pane. You can select a robot in the topology explicitly or 
implicitly by selecting a drive in the robot or the device host that the robot is connected to. 
The list will then be updated with the objects selected in the topology.

The following table describes the columns in the robots list:

Robots List

Column Description

Robot Name Contains the type and number of the robot, for example TLM(3). 

If the robot is partially configured, PCR is shown. For example, PCR(3). See 
“Managing Partially-Configured Devices” on page 25 for details.

Device Host Contains the name of the device host where this robot is attached.

Robot Type Contains the type of robot. If the robot is partially-configured, PCR is shown. 
See “Media Manager Robot Types” on page 229 for a list of supported robot 
types.

Robot Number Number of the robot.

Volume 
Database Host

Contains the name of the volume database host that is used to track the volumes 
in this robot 

Serial Number Contains the robot serial number.

Robotic Path Contains the path for the robot, for example, changer0.

Robot Control 
Host

Contains the name of the host that is providing the robotic control.

Port Contains the SCSI port number (if the robot is connected to a Windows server). 

Bus Contains the SCSI bus number (if the robot is connected to a Windows server).

Target Contains the SCSI target number (or SCSI ID) (if the robot is connected to a 
Windows server).

Lun Contains the logical unit number of the robot (if the robot is connected to a 
Windows server).

Inquiry 
Information

Contains device information returned from the device. This information is used 
to identify the device. For example, vendor ID, product ID, and product revision.
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Using the Hosts Tab

The hosts list allows you to view detailed information about the hosts that are referenced 
in your Media Manager configuration.

To update the hosts list with more detailed information, a host must be selected in the 
topology pane or in the tree pane. You can select a host in the topology explicitly or 
implicitly by selecting a robot. The hosts list will then be updated with the objects selected 
in the topology.

The following table describes the columns in the hosts list:

Shortcut Menus and Commands
Clicking the right mouse button while the pointer is over a pane or a selection of a pane, 
displays a shortcut menu with commands that apply to that context. These shortcut 
commands are also available on the menus or toolbars.

These shortcut menus work in the context of what device is currently selected in the tree 
pane or topology pane, or which tab is selected in the devices pane.

Hosts List

Column Description

Host Name Contains the name of the device host.

Connection 
Status

Contains the current NetBackup connection status for this host. This status field 
contains Connected, Not Connected, or the text of a possible connection error 
message.

Standalone 
Volume 
Database Host

Contains the name of the volume database host for all of the standalone drives 
controlled by this device host.

Version Contains the NetBackup software version.
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Using the Device Management Window
Short Cut Menu

Customizing the Window

Changing the View of the Topology Pane

You can manage the view of the robot diagrams by right-clicking in the topology pane and 
selecting Expand All Robots or Collapse All Robots.

Allowable Media Manager Characters
The following set of characters can be used in user-defined names, such as drive 
comments and drive names that you enter when creating these entities. These characters 
must be used even when specifying these items in foreign languages.

Do not use a minus as the first character or leave any spaces between characters.

� Alphabetic (A-Z a-z)

� Numeric (0-9)

� Period (.)

� Plus (+)
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Performing Initial Device Configuration
� Minus (-)

� Underscore (_)

Performing Initial Device Configuration

1. Physically attach the storage devices to the device host and perform any configuration 
steps specified by the device or operating system vendor. 

Explicit configuration of device files is required on some UNIX servers to make full 
use of NetBackup features. See the appropriate chapter of the NetBackup Media 
Manager device configuration guide for your UNIX platform.

2. Create any required system device files for the drives and robotic control. This is 
usually done during installation. Device files are created automatically on some UNIX 
platforms.

See the appropriate chapter of the NetBackup Media Manager device configuration 
guide for your UNIX platform.

3. Add the storage devices to the Media Manager configuration. If this is the first time 
you have configured devices:

a. See “Making Device Configuration Changes” on page 21.

b. Depending on the type of device you are adding, proceed to one of the following 
topics:

- “Using the Device Configuration Wizard to Configure Devices” on page 24.

- “Adding Robots” on page 26.

- “Adding Drives” on page 32.

Making Device Configuration Changes
The following procedure explains how to make device configuration changes:

1. Make your device configuration changes.

If you use the Device Configuration wizard, the following step is done by the wizard.

2. Stop and restart the Media Manager device daemon (ltid) using Actions > 
Stop/Restart Media Manager Device Daemon.
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Making Device Configuration Changes
Stopping and restarting ltid also stops and restarts the robot daemons.

Remote Administration of Other UNIX Hosts
The name of the UNIX host that you specify in the Login box, when starting the 
NetBackup Administration Console, must be in the NetBackup bp.conf file on the 
remote UNIX host where you want to monitor devices.

Remote Administration Example

For example, you could start the administration interface from the NetBackup UNIX host 
(named bear) and specify the UNIX host (named shark) in the Login box.

In this example, you

� Started the interface from the host named bear.

� Are managing NetBackup, through Java application server software running on the 
host named shark.

� Want to manage devices on a third host, named tiger.

The bp.conf file on host tiger must include the name of the server that you logged into 
(shark), not the host where you first started the administration interface (bear).

If you cannot connect to host tiger, add host shark to the bp.conf file on host tiger.

Adding SERVER Entries in the bp.conf File

1. Add a SERVER = host entry below any existing server entries in the 
/usr/openv/netbackup/bp.conf file.

2. Stop and restart the NetBackup database manager (bpdbm) and NetBackup request 
daemon (bprd).

See the NetBackup system administrator’s guide for UNIX for more information.

Also, the Media Manager volume daemon must be running on host tiger or Media 
Manager will not be able to update its configuration. This daemon is normally started 
when you start the Media Manager device daemon.

If you suspect that the volume daemon is not running, you should start vmd using 
/usr/openv/volmgr/vmd.

If you are unable to access the devices, you may need to add a SERVER entry to the 
vm.conf file on tiger. See “Media Manager Security” on page 23.
22 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Making Device Configuration Changes
Media Manager Security
For Media Manager to access devices on another host, it may be necessary to add a 
SERVER entry to the vm.conf file on the remote host (or you can use the Host properties 
node in the NetBackup Administration Console to add an entry).

SERVER entries are used for security. Without any SERVER entries and authentication not 
enabled, any host can manage the devices on the host. You can add entries allowing only 
specific hosts to remotely access the devices.

vmd is the Media Manager volume daemon. Device configuration changes, even those 
made local to a server, may require vmd to be running. It is recommended that vmd be 
running at all times, including when changes are being made to the Media Manager 
device configuration.

vmd Considerations

Media Manager authentication/authorization may affect systems where NetBackup 
authentication/authorization has been enabled.

Connections to vmd will fail if authentication/authorization are enabled, an 
AUTHORIZATION_REQUIRED entry is present in vm.conf, and the caller of vmd does not 
have the required permission to use vmd functions.

If authentication/authorization is needed in NetBackup but not in Media Manager, you 
can do one of the following:

� Add SERVER entries in vm.conf.

� Have no SERVER and no AUTHORIZATION_REQUIRED entries in vm.conf.

See “vmd Security” on page 251 for more information.

Example SERVER Entries

Assume that we have three hosts, named eel, yak, and shark; and that NetBackup 
authentication is not enabled. 

If the vm.conf file on a 
remote host contains Then

No SERVER entries and 
authentication is not enabled

Any host can manage the devices on this host. It is not necessary to 
make any additions to vm.conf.

SERVER entries You must add a SERVER entry for the host where you are running 
the NetBackup Administration Console (if it is not present).
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We want to centralize device management on host shark and also permit each host to 
manage its own devices.

� The vm.conf file on shark contains

SERVER = shark

The vm.conf file on shark does not require any additional SERVER entries, because 
all device management for shark will be performed from shark.

� The vm.conf file on eel contains

SERVER = eel

SERVER = shark

This allows eel to manage its own devices and also permits shark to access them.

� The vm.conf file on yak contains

SERVER = yak

SERVER = shark

This allows yak to manage its own devices and also permits shark to access them.

Using the Device Configuration Wizard to Configure 
Devices

Using the Device Configuration wizard is the recommended method of configuring 
robots and drives. This wizard performs better if the robotic libraries and drives that you 
are configuring support complete device serialization. This wizard does not support 
robots and drives for use with NetBackup for NDMP.

To configure these unsupported devices, see “Adding Robots” on page 26 and “Adding 
Drives” on page 32.

All information required for full auto-configuration may not be available on some 
systems. In this case, the wizard will do as much as possible with the limited device 
information. Later you need to manually configure the remaining devices.

If tape drives are in use or offline, they cannot be discovered.

Starting the Wizard
The Device Configuration wizard is available from the list of wizards displayed in the 
right pane of the Media and Device Management window. 

Click Media and Device Management > Configure Storage Devices.
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In some cases the wizard may leave some devices partially configured. See “Managing 
Partially-Configured Devices” on page 25 for more information.

Rerunning the Wizard
Rerunning the Device Configuration wizard updates the Media Manager configuration. 
For example, adding a new SCSI adapter may change the path to a robotic library. A 
similar change to the configuration may occur if you add a new drive.

The Device Configuration wizard updates the Media Manager configuration to match the 
new configuration.

External Device Mapping Files
These text files are used by the Device Configuration wizard to automatically discover 
and configure new devices. External mapping files exist for robots and drives.

This means that in some cases, device discovery support for your new or upgraded 
devices may be accomplished without waiting for a patch from VERITAS. Support for 
some new devices only requires that you download an updated external mapping file 
when any device changes are made to your configuration.

Note These files do not indicate support for any of the devices, only the ability to 
recognize and automatically configure them.

Obtaining External Device Mapping Files

Visit the VERITAS support web site (http://support.veritas.com) to download 
the latest external device mapping files for your devices.

Refer to the supplied README file for instructions. The files that you download will be 
named similar to the following files: MAPPINGS_4.5_nnnnnn.TAR and 
MAPPINGS_4.5_nnnnnn.ZIP

Managing Partially-Configured Devices
Under certain conditions, for example an unsupported robotic library or drive, the Device 
Configuration wizard may leave some devices as partially configured.

Also if you unselect a discovered device from the tree view of the wizard, will cause the 
device to be configured as partially configured.
Chapter 2, Configuring Storage Devices 25



Adding Robots
Partially-configured drives are designated by PCD and partially-configured robots by 
PCR in the Devices window pane. 

See “Using the Drives Tab” on page 15 and “Using the Robots Tab” on page 17.

If this happens it is best to ensure that you have downloaded the most recent external 
mapping files from the VERITAS support web site (see “External Device Mapping Files” 
on page 25).

Adding Robots

Note Using the Device Configuration wizard is the recommended method of configuring 
robots. See “Using the Device Configuration Wizard to Configure Devices” on 
page 24 for wizard restrictions and more information.

When adding a robotic library and drives, the best method is to add the robotic library 
first, as explained in this procedure and then add the drives (see “Adding Drives” on 
page 32).

Note For NetBackup BusinesServer, only one robot per server is allowed.

1. Perform the steps explained in “Performing Initial Device Configuration” on page 21.

2. In the NetBackup Administration Console, click Media and Device Management > 
Devices.

3. Select Actions > New > Robot.

A dialog box for adding a robotic library appears. The properties that appear in this 
dialog box vary depending on the host platform type and robot type.
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4. Specify the properties for the robotic library as explained in “Dialog Box Entries for 
Adding and Changing Robots” on page 27.

5. Click OK.

Dialog Box Entries for Adding and Changing Robots
The following topics describe the properties that you specify when you add a robotic 
library or change a robot configuration. Note that some of these properties apply only to 
specific robots or host platforms.

Device Host

Note This property does not apply to NetBackup BusinesServer.

Specifies the host to which you are adding the robotic library. To specify a host, click the 
arrow and select a host from the list.

To choose a device host that is not in the list, click the browse button (...). In the dialog box 
that then appears, specify the name of the host you want. 
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Robot Type

Specifies the type of robot that you are adding. Click the arrow and select from the list of 
types that Media Manager supports.

Visit the VERITAS support web site (http://www.support.veritas.com) to locate 
the robot type to use for specific vendors and models.

Microsoft Windows 2000 Removable Storage Manager (RSM)

If you want to use the RSM robot type, review the following important points:

� Your device host must be running Windows 2000.

� You want the Microsoft Removable Storage Manager to control the robot, rather than 
Media Manager.

� A robotic library configured as an RSM robot, cannot also be used as a Media 
Manager direct-controlled (SCSI) robot (for example, TLD).

� Shared drives cannot be configured in an RSM robot.

� For more information on configuring and using RSM robots, see the RSM appendix of 
the NetBackup Media Manager system administrator’s guide for Windows.

Robot Number

Specifies a unique, logical identification number for the robotic library. This number 
identifies the robotic library in displays (for example, TLD (21)) and also is used when 
adding media for the robot to the Media Manager configuration.

Volume Database Host

Note This property does not apply to NetBackup BusinesServer.

Specifies the name of the host where Media Manager keeps the volume configuration 
information about the media in the robotic library.

You can specify any host that has Media Manager installed as the volume database host, 
even if the host does not have any drives or robots attached. Click the arrow and select 
from the list of hosts listed.

Robot Control

In the Robot control section, you specify the control for the robot. Depending on the robot 
type you are adding and the type of device host, various combinations of the robot control 
buttons are available in the dialog.
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The following table provides an overview of configuring robot control, based on robot 
type and the device host platform type. The third column in the table indicates the robot 
control button that is valid for that particular robot type and platform, as follows:

� Robot is controlled locally by this device host (Local)

� Robot control is handled by a remote host (Remote) 

� Robot control is attached to an NDMP host (NDMP)

For NetBackup BusinesServer, Robot control is handled by a remote host is not 
supported and is not available. See the NetBackup release notes or visit the VERITAS 
support web site for more detailed information on supported platforms and other 
NetBackup product limitations.

Robot Control Configuration Overview

Robot Type Valid Device Host Platform Robot Control
Information Required 
for Configuration

ACS Any (except UNIX Auspex 
and Linux)

Remote ACSLS host

LMF UNIX Solaris Local Library name

LMF UNIX Solaris Remote Robot control host

ODL UNIX (except Linux) Local Robotic device file

RSM Windows 2000 Local Robot device

TL4, TL8, TLD
TS8, TSD, TSH

UNIX Local Robotic device file

TL4, TL8, TLD
TS8, TSD

Windows Local Robot device

TL8 Any (except UNIX NCR) Remote Robot control host

TLD Any Remote Robot control host

TL8, TLD, TSD Windows
UNIX AIX
UNIX Solaris
UNIX HP/UX

NDMP NDMP host name

Robot device

TLH UNIX AIX Local LMCP device file
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Robot is controlled locally by this device host

For this type of robot control, you have the following possibilities based on the robot type 
and device host platform that you selected.

Robotic Device File

When adding a robot to UNIX device hosts, specify the robotic device file path as follows. 
This file is used for a SCSI connection and is located in the /dev directory tree on the 
device host.

1. Click ... to browse and then select a robotic device file from the list that appears in the 
Devices dialog box. When you click OK, your selection will be entered in the Robotic 
device file box.

2. If the browse operation fails to find and display all of the attached robots, click More 
to enter the path of the device file. Your entry will be entered in the Robotic device 
box.

If the device file entry does not exist, create the entry as explained in the NetBackup 
Media Manager device configuration guide for UNIX.

Robot Device

When adding a robot to Windows device hosts, specify the robot as follows. 

For information on adding RSM robots, see the RSM appendix in the NetBackup Media 
Manager system administrator’s guide for Windows.

TLH UNIX (except AIX and Linux) Local Library name

TLH Windows (Intel only) Local Library name

TLH Any (except Linux) Remote Robot control host

TLM Any Remote DAS server

Robot Control Configuration Overview (continued)

Robot Type Valid Device Host Platform Robot Control
Information Required 
for Configuration
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1. Click ... to browse and then select a device from the list that appears in the Devices 
dialog box.

Selecting a robot in the Devices dialog and clicking OK will set different values in the 
Robot Control text box depending on the type of Windows device host. The following 
table shows the settings in the first column for the type of device host listed in the 
second column:

2. If the browse operation fails to find and display all of the attached robots, click More 
to display a dialog box that allows you to specify the Port, Bus, Target, and LUN 
numbers, or the device name. Your entry will be set in the Robot device box.

If the browse operation fails, a dialog box appears allowing you to enter the Port, Bus, 
Target, and LUN numbers, or the device name. Your entry will be set in the Robot 
device box.

Note You can find Port, Bus, Target, and LUN numbers in the appropriate Windows 
applet.

Robot control is attached to an NDMP host

For this type of robot control, you specify the following:

Robot Device

Specify the robot device that is attached to the NDMP host.

Click ... to enter a robot device file in the Devices dialog.

NDMP Host Name

Enter the name of the NDMP host where the robot is attached.

Robot Control text box Setting Type of Windows Device Host

SCSI Port, Bus, Target, and LUN numbers Windows NT hosts

SCSI Port, Bus, Target, and LUN numbers Windows 2000 hosts where a changer driver is 
not in control of the robot

Device name (for example, Changer1) Windows 2000 hosts where a changer driver is in 
control of the robot
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Adding Drives

Note Using the Device Configuration wizard is the recommended method of configuring 
drives. See “Using the Device Configuration Wizard to Configure Devices” on 
page 24 for wizard restrictions and more information.

The following procedure explains how to add drives using device management menus:

Note For NetBackup BusinesServer, a maximum of two drives per server is allowed.

1. Perform the steps necessary for the host to recognize the attached drives (see 
“Performing Initial Device Configuration” on page 21).

2. In NetBackup Administration Console, click Media and Device Management > 
Devices.

3. Select Actions > New > Drive.

The properties that appear in this dialog box vary slightly, depending on the type of 
host platform and robot type.
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4. Specify the properties of the drive as explained in “Dialog Box Entries for Adding or 
Changing Drives” on page 33.

5. Click OK.

The display now shows the new drive information.

Dialog Box Entries for Adding or Changing Drives
The following are the properties that you can specify when adding a drive or changing the 
properties of a drive. Some of these properties apply only to specific types of drives or 
host platforms.

Device Host Section

Note This property does not apply to NetBackup BusinesServer.

Specifies the host to which you are adding the drive. The host that is shown initially in the 
box is the device host you selected earlier in the tree pane.

Drive Information Section

Drive Type

Specifies the type of drive that you are adding. Click the arrow and select from the list of 
the drive types that Media Manager supports.

See “Media Manager Media Types” on page 230 for more information.

Drive Name

Enter a name that will be used by Media Manager to identify the drive. Descriptive names 
are recommended and the name must be unique.

Device Name

Note Applies only to Windows servers.

Enter the name of the drive as it is recognized by the Windows server. Enter the name in 
the box. You can find the name in the registry.

For example, if the registry shows the following display, the device name for the tape is 
Tape1:
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Logical Unit Id 1- TapePeripheral (Tape1)

You can also get the device name for the drive from the appropriate Windows applet.

No Rewind Device

Note Applies only to UNIX servers.

Enter the no rewind device file path for the drive.

Although both no rewind and rewind device files are usually available, Media Manager 
requires only the no rewind on close device file.

Device files are located in the /dev directory on the UNIX host. If the device files do not 
exist, create them as explained in the NetBackup Media Manager device configuration 
guide for UNIX.

A no rewind device remains at its current position on a close operation. Usually the device 
file name is preceded or followed by the letter n.

If you are using NDMP drives, see the NetBackup for NDMP system administrator’s 
guide for configuration information.

Character Device

Note Applies only to optical disk drives on NetBackup DataCenter UNIX servers, and 
does not apply to NetBackup DataCenter Windows servers or NetBackup 
BusinesServer.

Enter the Character Device file path for the drive.

Character device files are in the /dev directory on the UNIX host. If the entries do not 
exist, you can create them as explained in the NetBackup Media Manager device 
configuration guide for UNIX. Media Manager uses character mode device files.

Volume Header Device

Note Applies only to optical disk drives on NetBackup DataCenter UNIX servers, and 
does not apply to NetBackup DataCenter Windows servers or NetBackup 
BusinesServer.

Enter the Volume Header Device path for the drive. This file is in the /dev directory on 
the UNIX host. If the entry does not exist, create it as explained in the NetBackup Media 
Manager device configuration guide for UNIX.
34 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Adding Drives
Cleaning Frequency

If you want to setup a frequency-based cleaning schedule for the drive you are adding, set 
the desired number of hours between drive cleanings. When you add a drive, Media 
Manager starts recording the amount of time that volumes have been mounted in that 
drive.

If you do not specify a cleaning frequency, you can still utilize automated drive cleaning 
with the TapeAlert feature, provided the following conditions have been met:

� A cleaning volume has been defined in Media Manager.

� The host platform, robot type, and drive support drive cleaning.

If the drive is in a robotic library that supports drive cleaning and a cleaning cartridge is 
defined in that robotic library, cleaning occurs when the accumulated mount time exceeds 
the time you specify for cleaning frequency. The mount time is reset when the drive is 
cleaned.

See “Drive Cleaning” on page 239 for information on manual cleaning and cleaning tapes.

Drive Status

The default drive status is Up, meaning the drive is available. You can change the drive 
status using commands found on the Actions menu in Device Monitor.

When the drive status is up, the default mode is AVR (Automatic Volume Recognition) for 
all drives.

Drive Is In A Robotic Library

Select Drive is in a robotic library to specify that the drive is under robotic control and 
then enter information in the Robotic drive information section of the dialog.

Clear Drive is in a robotic library for standalone (nonrobotic) drives.

Robotic Drive Information Section

Robotic Library

This box specifies the robotic library that will control the drive.

Robot Drive Number

Specifies the physical location within the robotic library of the drive. 
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Set this to the number that correlates to the location of the drive that you are adding. 
When adding more than one drive to a robot, you can add the physical drives in any 
order. For example, in a TS8 robot you can add drive 2 before drive 1.

If you assign the wrong number Media Manager does not detect it, but an error occurs 
when the robotic control attempts to mount media on the wrong drive. To determine the 
correct number, you must know which physical drive in the robot is identified by the 
logical device name (Windows) or device file (UNIX) that you specify in this dialog box.

See “Correlating Device Files to Physical Drives When Adding Drives” on page 236 for 
more information.

Managing Robots and Drives
The following topics explain how to manage your robots and drives:

� Changing a Robot Configuration

� Changing the Configuration of a Drive

� Deleting Robots

� Deleting Drives

� Cleaning Tape Drives

Rerunning the Device Configuration wizard updates the Media Manager configuration. 
For example, adding a new SCSI adapter may change the path to a robotic library. A 
similar change to the configuration may occur if you add a new drive or robotic library.

The Device Configuration wizard updates the Media Manager configuration to match the 
new configuration. See “Using the Device Configuration Wizard to Configure Devices” on 
page 24.

Changing a Robot Configuration

Caution If you install more than two drives in a robot, the robot will not function. This is 
true even if you do not configure the additional drives in Media Manager. Two 
drives in a robot is the maximum for NetBackup BusinesServer.

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Select the Robots tab in the Devices pane.

3. Select the robotic library you want to change.
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4. Select Edit > Change.

A dialog box appears, showing the current information for the selected robotic library.

5. Make the desired changes (see “Dialog Box Entries for Adding and Changing Robots” 
on page 27).

6. Click OK.

Changing the Configuration of a Drive
To change information for a drive, use the following procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Select the Drives tab in the Devices pane.

3. Select the drive you want to change.

4. Select Edit > Change.

a. A dialog box appears showing the current information for the selected drive. 
Make the desired changes (see “Dialog Box Entries for Adding or Changing 
Drives” on page 33).

b. Click OK.

Deleting Robots
Any drives that were configured as residing in the deleted robot are changed to 
standalone drives.

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Select the Robots tab in the Devices pane.

3. Select the robotic library you want to delete.

4. Select Edit > Delete.

5. Answer the delete confirmation dialog.
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Deleting Drives

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Select the Drives tab in the Devices pane.

3. Select the drive you want to delete.

4. Select Edit > Delete.

5. Answer the delete confirmation dialog.

Cleaning Tape Drives
For drives in libraries that are under RSM robotic control, the Windows 2000 RSM 
software controls drive cleaning. Use the Windows 2000 administrative interfaces to 
manage drive cleaning.

See “Drive Cleaning” on page 239 for background information.

To add a cleaning tape, perform “Adding New Volumes” on page 65 and specify a 
cleaning tape as the media type.

To perform a drive cleaning use the following procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Devices.

2. Select the Drives tab in the Devices pane.

3. Select the drive you want to clean.

4. Select Actions > Drive Cleaning.
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The dialog allows you to perform the following functions:

5. If you click Apply, the selected action is done and the dialog remains open.

Updated Drive Cleaning Information is then presented.

Note The clean drive command is queued internally and may take several minutes to 
complete, so the Last Cleaned column may not be updated immediately with the 
current time.

6. If you click OK, the selected action is done and the dialog is closed. 

Select To 

Clean Drive Start cleaning the selected drive, regardless of the cleaning 
frequency or accumulated mount time. The drive must contain a 
cleaning tape.

Change Cleaning 
Frequency

Change the frequency at which the selected drive will be cleaned. 
Select the number of hours for the new cleaning frequency.

Reset Mount Time Reset the mount time for the selected drive to zero. Use this option 
to reset the time after manually cleaning a drive.
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To view the updated Drive Cleaning Information, you must reopen the dialog.
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Robot and Drive Configuration Example

This is a configuration with a tape stacker containing two 8mm tape drives. The robot and 
drives are connected to a host running Windows.

After installing Media Manager software and attaching the drives, run the Device 
Configuration wizard or complete the Add Robot and Add Drive dialog box entries as 
shown in the following tables.

Add Robot Dialog Entries

Robot Type TS8 - Tape Stacker 8MM

Robot Number 0

Robot Device Selecting a robot device sets the SCSI Port, 
Bus, Target, and LUN numbers in the dialog 
for Windows NT hosts and for Windows 
2000 hosts where a changer driver is not in 
control of the robot.

On Windows 2000 hosts where a changer 
driver is in control of the robot, selecting a 
robot device sets the changer name in the 
dialog.

Add Drive Dialog Entries (Tape0)

Drive Type 8mm Cartridge (8mm)

Drive Name eel_dr_1

eel  
Windows Server

Robotic Control 
Information

Volume 
Database

Robotic Drive 
Information for 
Drives 1 and 2

Robotic 
Drive 2 
(8mm)

Robotic 
Drive 1 
(8mm)

Robot Number 0

Device 
Name

Drive 
Name

Tape0

Tape1

eel_dr_1

eel_dr_2

TS8
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If eel was a UNIX host, you would complete the following dialog box entries. Your actual 
entries needed may vary from these examples.

Device Name Tape0

Drive is in a Robotic Library Yes

Robotic Library TS8(0) - eel

Robot Drive Number 1

Add Drive Dialog Entries (Tape1)

Drive Type 8mm Cartridge (8mm)

Drive Name eel_dr_2

Device Name Tape1

Drive is in a Robotic Library Yes

Robotic Library TS8(0) - eel

Robot Drive Number 2

(UNIX): Add Robot Dialog Entries

Robot Type TS8 - Tape Stacker 8MM

Robot Number 0

Robotic Device File /dev/sg/c0t4l0

(UNIX): Add Drive Dialog Entries (Tape0)

Drive Name eel_dr_1

Drive Type 8mm Cartridge (8mm)

Add Drive Dialog Entries (Tape0) (continued)
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No Rewind Device /dev/rmt/5cbn

Cleaning Frequency 25

Drive Status UP

Drive is in a Robotic Library Yes

Robotic Library TS8(0) - eel

Robot Drive Number 1

(UNIX): Add Drive Dialog Entries (Tape1)

Drive Name eel_dr_2

Drive Type 8mm Cartridge (8mm)

No Rewind Device /dev/rmt/6cbn

Cleaning Frequency 25

Drive Status UP

Drive is in a Robotic Library Yes

Robotic Library TS8(0) - eel

Robot Drive Number 2

(UNIX): Add Drive Dialog Entries (Tape0) (continued)
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Managing Media
 3

The media management window provides the tools required to add and manage the 
removable media that Media Manager controls. These media are referred to as volumes.

This chapter explains how to add and manage the removable media that Media Manager 
controls. These media are referred to as volumes, and are assigned media IDs and other 
attributes that are required to track and manage them.

The chapter “Managing Media in Robots” on page 93 explains how to manage media in 
robots.

If you have Backup Exec volumes to manage, see the Backup Exec tape reader option 
appendix of the NetBackup system administrator’s guide for Windows for more 
information.

Starting Media Management
In NetBackup Administration Console, click Media and Device Management > Media.

The media management window appears.
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Media Management Window

In addition to the tree pane displayed on the left, a volume pane is displayed on the right 
when you start media management.

Using the Media Management Window
The following topics describe the media management window:

� Menus and Commands

� Toolbars

� Tree Pane

� Volumes Pane

� Shortcut Menus and Commands

� Customizing the Window

� Allowable Media Manager Characters

Menus and Commands
The media management window has available the menus and commands shown in the 
following table.

The menu items are enabled based on the items that are currently selected in the tree pane 
or volumes pane. For example, if a volume group is selected in the tree pane, Delete is 
enabled on the Edit menu.
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Media Management Menus and Commands

Menu Commands

File Change Server - Displays a dialog box that allows you to change to a different host that 
is running NetBackup.

New Window from Here - Starts another instance of the NetBackup Administration 
Console node that was active.

Adjust Application Timezone - Displays a dialog that allows you to manage the 
timezone. NetBackup Console can execute in a different timezone than the timezone of 
the server on which it was initiated. See the NetBackup System Administrator’s guide 
for UNIX for more information.

Close Window - Closes the current window.

Exit - Closes all open windows.

Edit New - Displays a dialog box to add an item of the type that is currently selected.

Change - Displays a dialog box for changing the configuration of the selected items. 

Delete - Deletes selected items from the configuration. 

View Contains commands for specifying your viewing preferences for the media 
management window, including showing and hiding the toolbar or tree, and refreshing 
the display. See “Customizing the Window” on page 55.

Actions New - Displays a dialog box for adding volumes or volume pools to a configuration.

Change Volume Group - Displays a dialog box for changing the volume group for 
selected volumes.

Move - Displays a dialog box for moving volumes.

Rescan/Update Barcodes - Rescans the barcodes in the selected robotic library and 
updates the barcodes for the selected volumes, as necessary.

Eject Volume(s) From Robot - Ejects selected single or multiple volumes to the robot’s 
media access port.

Start/Restart Media Manager Device Daemon - Controls the Media Manager device 
daemon.

Inventory Robot - Displays a dialog box with choices for performing an inventory of 
the selected robot or updating the volume configuration to match the contents of the 
robot.

Help Help Topics - Provides online help information about the NetBackup Console.

License Keys - Provides information about your active and registered license keys.

About NetBackup Administration Console - Displays program information, version 
number, and copyright information.
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Toolbars
The toolbar buttons of the Media window provide shortcuts for commands that are on the 
menus. 

To show or hide the toolbar buttons:

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Click View > Show ToolBar.

Also see “Customizing the Window” on page 55.

Tree Pane
The tree pane for Media contains nodes for Volume Pools, Volume Groups, Robots, and 
Standalone.

The display in the Volumes pane (on the right) shows the volumes that are in the volume 
database on this server. If you add any volumes, they are added to this volume database. 

If there are no volumes configured in the volume database, the Volumes pane will be 
blank. Selecting different items in the tree pane filters the lists that are shown in the 
Volumes pane. 

To view or configure volumes on another server, change your connection to that host by 
using File > Change Server. See “Administering Media on Other Hosts” on page 56 for 
more information.

The following figure shows an expanded view of the Media tree pane:
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Volumes Pane
This pane lists the volumes in the volume database. The following tables describe the 
columns in the various volume lists that can be displayed.

Managing the Volumes Pane

You can view any hidden columns in the volumes pane by right-clicking in the pane and 
selecting Show All Columns.

All the volume groups in the volume database on the current 
server. If you select Volume Groups, the Volumes pane 
contains information for all the volumes in all groups. 
Selecting an individual group, displays only the volumes in 
that group.

All the volume pools in the volume database on the current 
server. If you select Volume Pools, the Volumes pane 
contains information for all the volumes in all pools. Selecting 
an individual pool, displays only the volumes in that pool.

If you select Robots, the Volumes pane contains information 
for all the volumes that are in all robots and in the volume 
database on this server. Selecting an individual robot, 
displays only the volumes in that robot.

If you select Standalone, the Volumes 
pane contains information for all the 
volumes that are in standalone drives 
(or in standalone status) and in the 
volume database on this server.

The current Media Manager server. You 
are currently connected to this host. 
Volumes that appear in the Volumes 
pane are in the volume database on 
this server.
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Volume Pools List

If you select Media > Volume Pools in the tree pane, the following list is displayed in the 
Volumes Pane showing information for all of the volume pools.

Volume Pools List

Column Description

Volume Pool Name of the volume pool. A volume pool defines the usage for the volume. 
Volumes in a pool are grouped together for use by a single application and are 
protected from access by other applications and users.

None is the default pool for users of applications, other than NetBackup.

NetBackup is the default pool name for NetBackup.

DataStore is the default pool name for DataStore.

Number Number assigned to the volume pool. This number is assigned by NetBackup. 
The following numbers are reserved:

0 is the None (default) pool.

1 is the NetBackup pool.

The DataStore pool is assigned the next available number.

User Contains the value ANY or the user ID (for example, root(0)).

Host Name of the host that is allowed to request and use the volumes in this volume 
pool or the value ANYHOST.

Group Identifies the UNIX user group for this volume pool or contains NONE.

Description Description for the volume pool. You create the description when you configure 
a volume pool.
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Volume Groups List

If you select Media > Volume Groups in the tree pane, the following list is displayed in 
the Volumes Pane showing information for all of the volume groups.

Robots List

If you select Media > Robots in the tree pane, the following list is displayed in the 
Volumes Pane showing information for all of the robots.

Volume Groups List

Column Description

Volume Group Name of the volume group. A volume group defines the volume by location and 
is a logical group of volumes that are at the same physical location.

Volume groups are a convenience for administrating multiple volumes. By using 
a volume group, you can logically move a set of volumes between a robotic 
library and a standalone location, or delete them by specifying the group name 
rather than each individual media ID.

More than one volume group can share the same location. For example, a robotic 
library can contain volumes from more than one volume group and there can be 
more than one standalone volume group. All volumes in a volume group must 
have a compatible media type.

Media Type Media Manager media type of the volume group.

Robot Number Number of the robot that contains this volume group. If the robot type is NONE, 
this column is blank.

Robot Type Type of robot that contains this volume group. NONE in this column means a 
standalone volume group.

Robot Control 
Host

This is the robot control host for the volumes in this volume group. If the robot 
type is NONE, this column is blank.

Volume Count Number of volumes in this volume group.

Robots List

Column Description

Robot Name Contains the name of the robot (comprised of the robot type and robot number), 
for example TLM(3).
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Device Host Contains the name of the device host where this robot is defined.

Robot Type Type of robot. See the Reference Topics appendix of this guide for a list of 
supported robot types.

Robot Number Number of the robot.

Volume 
Database Host

Contains the name of the volume database host for the volumes in this robot.

Serial Number Contains the robot serial number.

Robotic Path Contains the path of the robot or is blank for remote robots.

Robot Control 
Host

Name of the host that is providing the robotic control. This column contains a 
host name only for robots where the robot control is handled by a different host 
than the host where the robot is attached.

This column is not applicable for NetBackup BusinesServer and is blank.

Port Contains the SCSI port number (if the robot is connected to a Windows server). 

Bus Contains the SCSI bus number (if the robot is connected to a Windows server).

Target Contains the SCSI target number (or SCSI ID) (if the robot is connected to a 
Windows server).

Lun Contains the logical unit number of the robot (if the robot is connected to a 
Windows server).

Inquiry 
Information

Contains device information returned from the device. This information is used 
to identify the device. For example, vendor ID, product ID, and product revision.

Robots List (continued)

Column Description
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Volumes List

If you select an item under Volume Pools, Volume Groups, Robots, or Standalone in the 
tree pane, the volumes list is filtered based on the selected item and that information is 
displayed in the Volumes pane.

Volumes List

Column Description

Media ID Identifies the volume in six or less alphanumeric characters. This value is usually 
assumed to be the same as the external media ID and should be the same as the 
recorded media ID for non-scratch, labeled media.

You specify the media ID when you add volumes to Media Manager.

Barcode Uniquely identifies the barcode of a volume in 13 alphanumeric characters or 
less.

Media Type Media type of the volume. See “Media Manager Media Types” on page 230 for a 
list of the supported media types.

Robot Type Type of robot that contains this volume. See “Media Manager Robot Types” on 
page 229 for a list of supported robot types.

NONE in this column means a standalone volume.

Robot Number Number of the robot that contains this volume. If the volume is for a standalone 
drive or the volume is part of a group that was moved out of a robot (with the 
intent of being moved back into a robot), this column is blank.

Robot Control 
Host

Name of the host that controls the robot that contains this volume. This host is 
providing the robotic control. 

If this column is blank, the volume is for a standalone drive.

Slot Slot in the robot that contains the volume.

This column is blank for RSM robots, since Media Manager does not track slot 
information for these robots. For RSM robots, the operating system software 
tracks the slot information.

Volume Group Name of the volume group for this volume. 
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Volume Pool The volume pool defines the usage for the volume. Volumes in a pool are 
grouped together for use by a single application and are protected from access by 
other applications and users.

None is the default pool name for users of applications, other than NetBackup, 
DataStore, and Storage Migrator.

NetBackup is the default pool name for NetBackup.

DataStore is the default pool name for DataStore.

HSM is the default pool name for Storage Migrator.

Mounts Number of times that the volume has been mounted (does not apply to cleaning 
media types).

Time Assigned Shows the date when the volume was assigned for use. You cannot delete a 
volume or change its volume pool while it is assigned to an application.

Status Applies only to volumes that are assigned to NetBackup or Storage Migrator for 
Microsoft Exchange.

There is also a date in the Time Assigned column for assigned volumes.

- 0 - NetBackup

The volume is assigned to NetBackup regular backups.

- 1 - Catalog

The volume is assigned to NetBackup catalog (database) backups.

- 3 - Storage Migrator

The volume is assigned to Storage Migrator for Microsoft Exchange or 
Storage Migrator for Windows 2000.

Side/Face Location of the volume.

If the media type is an 8mm tape and the robot type is TL8, this column shows 
the xy coordinates for the slot number.

For any other media type, this column is blank.

Partner For optical disks, this column shows the media ID of the volume on the other 
side of the optical platter. For all other media types, the column is blank. You 
define this value as Partner ID when you add the volume.

For NetBackup BusinesServer, this column is blank, since optical media is not 
supported

Max Mounts Number of times the volume can be mounted. If maximum mounts is reached, a 
message is logged to the system application log and Media Manager allows no 
further mounts in write mode. Further mounts in read mode are allowed.

Volumes List (continued)

Column Description
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Shortcut Menus and Commands
Clicking the right mouse button while the pointer is over either pane or a selection of a 
pane, displays a shortcut menu with commands that apply to that context. These 
commands are also usually available on the menus or toolbars.

Customizing the Window

Showing or Hiding Columns

You can view all of the columns in the volumes pane by right-clicking in the pane and 
enabling Show All Columns.

Allowable Media Manager Characters
The following set of characters can be used in user-defined names, such as volume 
groups, volume pool names, and media IDs that you enter when creating these entities. 
These characters must be used even when specifying these items in foreign languages.

First Mount Date and time that the volume was first mounted through Media Manager.

Last Mount Date and time that the volume was last mounted.

Expiration Date Refers to the age of the volume. If the expiration date is reached, the volume is 
considered too old to be reliable and Media Manager allows no further mounts in 
write mode. Further mounts in read mode are allowed, but a message is logged 
to the system application log indicating that the expiration date has been 
reached. If the column is blank, the volume has no expiration date.

Cleanings 
Remaining

For a cleaning tape, this column shows how many more times the tape can be 
used. To use a cleaning tape, the value in this column must be greater than zero. 
You can change this count by selecting the volume and using Change on the Edit 
menu.

Created Date and time that the volume was added. 

Description Describes the media in 25 or less alphanumeric characters. You create the 
description when you add volumes.

Volumes List (continued)

Column Description
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Do not use a minus as the first character or leave any spaces between characters.

� Alphabetic (A-Z a-z)

� Numeric (0-9)

� Period (.)

� Plus (+)

� Minus (-)

� Underscore (_)

Administering Media on Other Hosts
Initially, you can manage media on the server where you are running NetBackup. The 
name of this server is shown in the line directly above the volumes pane, for example 
Volumes in Media Manager spain4.

If you change from a NetBackup DataCenter server to a NetBackup BusinesServer server, 
the functionality available on the new server is limited to the functionality supported by 
NetBackup BusinesServer.

You cannot change from a NetBackup BusinesServer server to a NetBackup DataCenter 
server.

To change to a different server, use the following procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Click File > Change Server.

3. In the dialog box that appears, do one of the following to specify the host:

- Enter the name of the host.

- Click the arrow and select a host. The hosts in the list have a master server and 
media server relationship in the global device database.

Click OK.

4. The name of the new host appears above the volumes pane and the volumes pane 
shows the volume information for the new server.

The name of the UNIX host that you specify in the Login box, when starting the 
NetBackup Administration interface, must be in the bp.conf file on the remote UNIX 
host where you want to manage media or monitor devices.
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If you encounter problems or for more information on remote administration, see the 
following topics:

� “Remote Administration of Other UNIX Hosts” on page 22.

� “Media Manager Security” on page 23.

Configuring Volume Pools
A volume pool identifies a logical set of volumes by usage. Associating volumes with a 
volume pool protects them from access by unauthorized users, groups, or applications.

With the exception of the volume pools automatically created by NetBackup, you must 
create a volume pool before you can add volumes to a volume pool. The following 
volume pools are automatically created (see “Volume Pools List” on page 50):

� Media Manager creates a pool, named NetBackup, for NetBackup use.

� NetBackup creates a pool, named DataStore, for DataStore use.

During initial configuration, it is easiest to create all of your volume pools first. Then as 
you add volumes, you can assign them to volume pools.

It is also possible to configure a scratch pool from which Media Manager can transfer 
volumes, when another volume pool has no volumes available.

For background information, see “Volume Pools” on page 242 and “Scratch Volume 
Pools” on page 244

The following topics explain volume pool configuration:

� Adding a New Volume Pool or Scratch Volume Pool

� Changing the Attributes of a Volume Pool

� Changing the Volume Pool Assignment for a Volume

� Deleting a Volume Pool

Adding a New Volume Pool or Scratch Volume Pool

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Click Actions > New > Volume Pool.

To add a scratch volume pool, see “Adding a Scratch Volume Pool” on page 58.
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3. In the Pool name text box, enter a name for the new volume pool.

The name can be 20 characters or less, and cannot contain any spaces or special 
characters. See “Allowable Media Manager Characters” on page 55.

4. In the Description text box, enter a brief description for the pool.

Adding a Scratch Volume Pool

A scratch pool is a special volume pool that you can optionally configure. If a scratch pool 
is configured, Media Manager moves volumes from the scratch pool to any other pools 
that do not have volumes available.

If you want this pool to be a scratch volume pool, do the following:
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1. Specify attributes for the scratch pool as shown in the following table:

2. Add volumes to the scratch volume pool for each robotic or standalone device that 
may require them.

Follow the steps for adding other volumes to pools (see “Adding New Volumes” on 
page 65). In this case, select the pool name of the scratch pool you created as the 
volume pool.

Changing the Attributes of a Volume Pool

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Select the desired pool from the pools shown under Volume Pools in the tree pane.

3. Click Edit > Change.

For Enter

Pool Name Any name, except NetBackup or None. It is recommended to use 
scratchpool as the pool name.

Description It is recommended to use scratch pool in the description.

Scratch Pool Select this check box.
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4. In the Description text box, enter a new description for the pool.

To change this pool to a scratch volume pool, see “Changing a Volume Pool To a 
Scratch Volume Pool” on page 60.

Changing a Volume Pool To a Scratch Volume Pool

A scratch pool is a special volume pool that you can optionally configure. If a scratch pool 
is configured, Media Manager moves volumes from the scratch pool to any other pools 
that do not have volumes available. 

If you want to change this pool to be a scratch volume pool:

1. Specify attributes for the scratch pool as follows.

2. Add volumes to the scratch volume pool for each robotic or standalone device that 
may require them.

Follow the steps for adding other volumes to pools (see “Adding New Volumes” on 
page 65). In this case, select the name of the scratch pool as the volume pool.

Changing the Volume Pool Assignment for a Volume
Volumes are grouped in a specific volume pool. The Volume Pool column in the Volumes 
list shows the name of the volume pool to which the volumes belong. Change the volume 
pool assignment as follows:

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Select a volume or volumes from the volumes pane.

Note You are unable to change the volume pool for any assigned volumes until the 
application deassigns them (see “Deassigning Volumes” on page 83).

3. Click Edit > Change.

For Action 

Description It is recommended to enter scratch pool as the description.

Scratch Pool Select this check box.
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In the dialog box that appears, the volumes you selected are listed in the top section of 
the dialog.

4. In the Volume Pool section, click New Pool and click the arrow to view a list of the 
available volume pools.

Select a volume pool from the list.

5. Click OK.

Deleting a Volume Pool
Note that you cannot delete any of the following pools:

� A volume pool that contains volumes

� Scratch pools

� The NetBackup volume pool
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� The None volume pool

� The HSM volume pool (for VSM)

� The DataStore volume pool

Delete a volume pool as follows:

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. Choose the volume pool and ensure that the volume pool is empty.

If necessary, change the volume pool name for any volumes in the pool. Or if the 
volumes are not needed, delete them.

3. Click Edit > Delete.

Methods Available for Injecting and Ejecting Volumes
Some robotic libraries implement different functionality for their media access ports. For 
example, some libraries have front-panel inject and eject features that conflict with the use 
of the media access port in NetBackup. Other robotic libraries require front-panel 
interaction when using the media access port.

Read the operator manual for your robotic library to understand the media access port 
functionality. Libraries such as the ones noted may not be fully compatible with the inject 
and eject features of NetBackup if not properly handled. Other libraries may not be 
compatible at all.

Methods for Injecting Volumes into a Robot
The following methods are available to inject a single volume into a robotic library.

When Adding New Volumes

When specifying dialog box entries for adding new volumes, select Inject volume into 
robot via the media access port to inject a volume into a robotic library.

Inject volume into robot via the media access port is available only for the robot types 
listed in the matrix shown in “Inject and Eject Functions Available by Robot Type” on 
page 64.

Inject volume into robot via the media access port may be enabled for some robots that 
do not have media access ports, since the robot type for the robotic library only indicates 
that media access ports are possible.
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See “Adding Volumes - Using the Actions Menu” on page 68 for complete instructions.

When Moving Volumes

When specifying dialog box entries for moving volumes, select Inject volume into robot 
via the media access port to inject this volume into a robotic library.

Inject volume into robot via the media access port is available only if the following are 
true:

� You are moving a single volume from standalone to a robotic library.

� Media Manager supports inject for the robot type involved (see “Inject and Eject 
Functions Available by Robot Type” on page 64).

Inject volume into robot via the media access port may be enabled for some robots that 
do not have media access ports, since the robot type for the robot only indicates that 
media access ports are possible.

See “Moving Volumes” on page 75 for complete instructions.

When Performing a Volume Configuration Update Using Robot 
Inventory

When performing a volume configuration update for a robot, select Empty media access 
port prior to update to inject a volume into a robot. 

Any volumes to be injected must be in the media access port before the operation begins. 
If Empty media access port prior to update is selected and there are no volumes in the 
port, you are not prompted to place volumes in the media access port and the update 
operation continues.

Each volume located in the media access port is moved into the robotic library. If the 
robotic library has a port that can hold multiple volumes, volumes are moved to empty 
slots in the robotic library until the media access port is empty or all the slots are full. 

After the volume or volumes have been moved, the configuration update proceeds as 
usual.

Empty media access port prior to update is available only for the robot types listed in the 
matrix shown in “Inject and Eject Functions Available by Robot Type” on page 64.

Empty media access port prior to update may be available for some robots that do not 
have media access ports, since these robot types only indicate that media access ports are 
possible.

See “Updating the Volume Configuration for a Robot” on page 99 for complete 
instructions.
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Methods for Ejecting Volumes From a Robot
The following methods are available to eject single or multiple volumes.

When Moving Volumes

When specifying dialog box entries for moving volumes, select Eject volume from robot 
via the media access port to eject a single selected volume using the robot’s media access 
port.

Eject volume from robot via the media access port is available only if the following are 
true:

� You are moving a volume from a robotic library to standalone.

� Media Manager supports eject for the robot type involved (see “Inject and Eject 
Functions Available by Robot Type” on page 64).

Eject volume from robot via the media access port may be enabled for some robots that 
do not have media access ports, since the robot type for the robotic library only indicates 
that media access ports are possible.

See “Moving Volumes” on page 75 for complete instructions.

Using the Eject Volumes From Robot Command

Select Actions > Eject Volume(s) From Robot to eject one or more selected volumes from 
a robotic library.

Eject Volume(s) From Robot is only available for the robot types shown in the matrix in 
“Inject and Eject Functions Available by Robot Type” on page 64.

You cannot eject volumes that reside in multiple robots.

For the robot types shown in the 4th column of the following table, operator intervention 
is only required if the robotic library does not have a media access port large enough to 
eject all of the selected volumes. For these robot types, you are prompted to remove the 
media from the media access port so the eject can continue with the remaining volumes.

See “Ejecting Volumes From Robots (Actions Menu Command)” on page 81 for complete 
instructions.

Inject and Eject Functions Available by Robot Type
The following matrix shows the availability of inject and eject functions provided with the 
Media Manager functions listed in the 1st column. The availability of the inject and eject 
functions listed in the column headings depends on the robot type being used. NA in a 
cell means not applicable.
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Note For RSM robot types, the robot must be attached to a Windows 2000 server running 
NetBackup.

Adding New Volumes
Media Manager volumes are logical units of data storage or cleaning capability on media 
that have been assigned media IDs and other attributes, which are recorded in the Media 
Manager volume database. The attributes in the volume database include information to 
show the robotic location, and includes the robot host, robot type, robot number, and slot 
location. This type of information for the volume is referred to as residence information or 
residence. 

When you add a new volume, there is no default expiration date.

Methods Available for Adding Volumes
The methods available to add volumes depend on how the volume will be used, as 
follows.

If your devices are supported by the Volume Configuration wizard, using this wizard is 
an easy method for adding volumes. See “Using the Volume Configuration Wizard” on 
page 74 for more details.

Robotic Volumes (Volumes Located in a Robot)

� The easiest way to add robotic volumes is to use the Volume Configuration wizard. 
See “Using the Volume Configuration Wizard” on page 74 for more details.

Inject / Eject Functions Available by Robot Type

Media Manager
Function 

Inject Single
Volume

Eject Single
Volume

Eject Single or
Multiple Volumes

New Volumes RSM, TL8, TLD NA NA

Move Volumes  TL8, TLD  TL8, TLD NA

Robot Inventory TL8, TLD NA NA

Eject Volumes NA NA TL8, TLD
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� To use robot inventory to add robotic volumes, perform the Update Volume 
Configuration procedure. During the update, Media Manager assigns the media IDs 
and other attributes.

See “Adding Volumes - Using the Robot Inventory Update Option” on page 67.

� To add volumes using the menu, see “Adding Volumes - Using the Actions Menu” on 
page 68.

Standalone Volumes (Volumes To Be Used in Standalone Drives)

� The easiest way to add standalone volumes is to use the Volume Configuration 
wizard. See “Using the Volume Configuration Wizard” on page 74 for more details.

� You can also configure volumes automatically by inserting the media into a 
standalone drive. For an unused volume, NetBackup assigns a media ID, labels the 
volume, and uses it (if it needs a volume of that type for a backup). Media Manager 
adds the media ID (designated by NetBackup) and other attributes for the volume.

The DISABLE_STANDALONE_DRIVE_EXTENSIONS NetBackup configuration option 
turns off NetBackup’s automatic use of standalone volumes. See the NetBackup 
system administrator’s guide for UNIX for more information.

� To manually choose the media IDs, label the volume with the NetBackup bplabel 
command and follow the instructions in “Adding Volumes - Using the Actions Menu” 
on page 68.

Even if you normally use NetBackup’s assignment capabilities for standalone 
volumes, manually adding extra standalone volumes prevents "out of media" errors 
in some situations.

For example, if a volume in a standalone drive is full or unusable because of errors, 
NetBackup requests that Media Manager eject the volume. NetBackup then searches 
for another unused volume. If another appropriate volume is not defined, NetBackup 
exits with an error.

Labeling a volume (using the NetBackup bplabel command) and adding it prevents 
this problem, because Media Manager displays a mount request for that volume 
rather than returning an error to NetBackup.

NetBackup Catalog Backup Volumes

� Prior to using volumes for NetBackup catalog backups, you must add them. You can 
also use the NetBackup bplabel command to label the volume.

See “Adding Volumes - Using the Actions Menu” on page 68.
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Notes on Labeling NetBackup Volumes

Labeling volumes is controlled by the application. For more information, refer to the 
NetBackup BusinesServer system administrator’s guide for UNIX.

NetBackup controls the labeling of its volumes and in most cases performs this operation 
automatically.

� If a volume in a robotic library has not been labeled, NetBackup labels it with the 
media ID assigned by Media Manager the first time that it uses the volumes for a 
backup. This is done unless those volumes

- Were last used for NetBackup catalog backups. You do not want to label the 
volumes unless they are no longer being used for catalog backups.

- Contain data from a recognized non-NetBackup application. The NetBackup 
configuration option, ALLOW_MEDIA_OVERWRITE can be set to allow the volume 
to be overwritten.

� If you prefer to assign specific media IDs to NetBackup volumes, label them with the 
NetBackup bplabel command and add them using the manual update procedure.

� NetBackup uses a default prefix of A when assigning media IDs (for example, 
A00001). To change this default, use the NetBackup MEDIA_ID_PREFIX 
configuration option.

� If the robotic library supports barcodes, by default NetBackup generates media IDs 
for new volumes based on the last six characters of the barcode. To change this 
default, you can specify and select specific characters using Media ID generation rules 
(see “Configuring Media ID Generation Rules” on page 130).

Adding Volumes - Using the Robot Inventory Update Option
To update the volume database to match the contents of the robotic library, use the 
following procedure:

1. Insert the volume into the robotic library.

2. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

3. Select the robotic library where you inserted the volume.

4. Click Actions > Inventory Robot.

5. On the Robot Inventory tab, select Perform volume configuration update.

The update includes the generation of media IDs for new volumes as follows. 
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If the robot

� Supports barcodes and the volumes have readable barcode labels, the update part of 
the operation generates media IDs for new volumes based on the last six characters of 
the barcodes as the default or the specific characters that you specify if you are using 
Media ID generation rules.

� Does not support barcodes or the volumes do not have readable barcodes, the new 
media IDs are based on a media ID prefix that you specify.

See “Updating the Volume Configuration for a Robot” on page 99 for more 
information on robot inventory and media ID generation rules.

When you use barcode rules, new volumes that are added through a barcode rule are 
assigned a media type, volume pool, maximum number of mounts (or maximum 
cleanings), and description.

Adding Volumes - Using the Actions Menu

1. If you are adding new volumes to a robotic library, insert them into the proper slots.

2. In NetBackup Administration Console, click Media and Device Management > 
Media.

3. Click Actions > New > Volumes.
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4. Specify the properties for the volumes as explained in “Dialog Box Entries for New 
Volumes” on page 70. 

Caution Be careful when specifying properties, since you cannot later change properties 
such as the media ID or media type. To change these properties you need to 
delete the volumes and add them again.

5. Click OK to execute the add. If you selected Inject volume into robot via the media 
access port, an inject prompt appears.

The volumes pane now shows the new volume information. If the robot has a barcode 
reader, Media Manager does the following:

- Adds an entry in the volume database, using the specified media ID.

- Reads the barcode of each new volume.

- Adds the barcodes as attributes in the volume database.

Note If you are making multiple additions, clicking Apply updates the configuration 
without closing the dialog box or refreshing the display. This allows you to add 
another volume by modifying the dialog box contents and then clicking Apply or 
OK.
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Dialog Box Entries for New Volumes

Media Type

Specifies the media type for the volume that you are going to add. Click the arrow to open 
a list of the available media types and select from the list.

If you are adding a cleaning tape, choose one of the cleaning tape media types.

Volume Is In a Robotic Library

When you select Volume is in a Robotic Library, the Select Robot section (containing 
Device Host and Robot) of the dialog box is available.

Device Host

Specifies the name of the device host where the robot is defined.

Robot

Specifies the robotic library to which you are adding the volumes.

Number of Volumes

Specify the number of volumes. For a robotic library, this refers to the number of slots that 
must be reserved for the new volumes. Depending on the number of volumes you are 
adding, you must also specify additional information as shown in the following table:

Media ID Naming Style

If you are adding more than one volume, click the arrow in the Media ID Naming Style 
box to open a list of possible combinations of alphanumeric characters and digits. Then 
select a style to use in creating the media IDs for this range of new volumes.

If you are adding You must also specify

One volume Media ID.

More than one volume First Media ID and Media ID naming style.
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Media IDs for an RSM robot must always match the barcodes. This means that you must 
get a list of the barcodes prior to adding the volumes. You can obtain this information 
through a robotic inventory or from the robot vendor’s software. For RSM robots, Media 
Manager supports barcodes with six or less characters.

Media ID or First Media ID

In the text box, enter a 1 to 6-character ID for the new volume.

If you are adding one volume, Media ID is the ID for the volume.

If you are adding more than one volume, First Media ID is the ID for the first volume in 
the range of volumes. Use the same pattern that you chose in the Media ID Naming Style 
box. Media Manager names the remaining volumes by incrementing the digits.

Media IDs for an RSM robot must always match the barcodes. This means that you must 
get a list of the barcodes prior to adding the volumes. You can obtain this information 
through a robotic inventory or from the robot vendor’s software. For RSM robots, Media 
Manager supports barcodes with six or less characters.

Partner ID

Note This property does not apply to NetBackup BusinesServer.

If you are adding one optical volume, you can specify a 1 to 6-character ID for the partner 
ID. This ID is the media ID of the volume on the other side of the optical platter. 

Description

Enter a 1 to 25 ASCII character description of the media that you are adding.

First Slot Number

Note You cannot enter slot information for volumes in a RSM robot. Windows 2000 tracks 
the slot locations for RSM robot types.

For volumes in a robot, specify the first slot number to be used by the range of volumes 
that you are adding. Media Manager assigns the remainder of the slot numbers 
sequentially.

The appendix “Robot Drive and Slot Layouts” on page 335 shows the slot layout for many 
of the robots that Media Manager supports.
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Maximum Mounts

For volumes intended for backups, specify the maximum number of times that Media 
Manager is able to mount the volumes. When a volume reaches this mount limit, the 
volume can be read, but not written.

To help determine the maximum mount limit to use, consult your vendor documentation 
for information on the expected life of the volume.

Note Specify the number 0 to permit an unlimited number of mounts.

Maximum Cleanings

For a cleaning tape, specify the number of cleanings that can be performed. The number 
must be greater than zero.

See “Drive Cleaning” on page 239 for information on manual cleaning and cleaning tapes.

Volume Group

Enter the name of the volume group for the volumes you are adding, or click the arrow to 
select from a list of previously configured volume groups. The following table shows the 
results if you leave the volume group blank:

Note Do not confuse volume groups with volume pools. Refer to “Volume Pools and 
Volume Groups” on page 242 for an explanation of the differences.

Rules for Assigning Volume Groups

� All volumes in a group must be the same media type.

However, a media type and its corresponding cleaning media type are allowed in the 
same volume group (for example, DLT and DLT_CLN).

If you leave the Volume 
group blank for Media Manager 

Standalone volumes Does not assign a volume group.

Robotic volumes Generates a name using the robot number and type.
For example, if the robot is a TS8 and has a robot number of 50, the group 
name will be 00_050_TS8.
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� All volumes in a robotic library must belong to a volume group. You cannot add 
volumes to a robotic library without specifying a group or having Media Manager 
generate a name.

� The only way to clear a volume group name is to move the volume to standalone and 
not specify a volume group.

� More than one volume group can share the same location. For example, a robotic 
library can contain volumes from more than one volume group and you can have 
more than one standalone volume group.

� All members of a group must be in the same robotic library or be standalone. 

Volume Pool

Click the arrow and select from the list of volume pools as follows.

Label Optical Media

Note This property does not apply to NetBackup BusinesServer.

Before using optical volumes, they must be formatted and labeled. Click the arrow to 
select from the list of choices. The default choice does not overwrite any old labels.

Inject Volume Into Robot via the Media Access Port

Select Inject volume into robot via the media access port to insert a single volume into 
the media access port, so it can be injected into the correct slot in the robot. When you 
select Inject volume into robot via the media access port, insert the volume in the robotic 
library and Media Manager will add it to its volume configuration.

Select To Make

None The volume available to any user or application (cleaning tapes must be in 
the None pool).

NetBackup The volume available only to NetBackup.

DataStore The volume available only to DataStore.

One of the other 
volume pools in the 
list

The volume available to a specific volume pool. Other volume pools appear 
only if you created them earlier as explained in “Configuring Volume Pools” 
on page 57.
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See “Methods for Injecting Volumes into a Robot” on page 62 for a list of the robot types 
that determine when Inject volume into robot via the media access port is available and 
more information on using this function.

Using the Volume Configuration Wizard
Use the Volume Configuration wizard to do the following:

� Inventory your robots.

� Identify cleaning media in your robots.

� Add volumes for standalone drives.

� Update the Media Manager volume database.

After running this wizard to configure media, each media will have a unique media ID in 
the volume database that is used in NetBackup and Media Manager to track the media.

Wizard Limitations
The Volume Configuration wizard is only available in NetBackup releases 3.4 or later.

This wizard configures volumes for all standalone drives and robots that are supported in 
NetBackup BusinesServer.

To configure volumes for unsupported devices, see “Adding Volumes - Using the Robot 
Inventory Update Option” on page 67 or “Adding Volumes - Using the Actions Menu” on 
page 68.

What To Expect In This Wizard
The following table shows the screens of the wizard and what to expect in each:

Wizard Screen What to Expect

Welcome With this wizard you can

- Inventory the volumes in a robotic library.

- Create new volumes for use in standalone drives.
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Before You Start This Wizard
Make sure that you have all media that you want to use in the robotic library before 
starting the wizard.

To Start This Wizard
This wizard is available from the list of wizards displayed in the right pane of the Media 
and Device Management window of the NetBackup Administration Console. 

Click Media and Device Management > Configure Volumes.

Moving Volumes
When you move volumes in or out of a robotic library, you must physically and logically 
move the volume.

Select Device You select one of the following:

- The robotic library that you want to inventory.

- The type of standalone drive where you want to configure 
volumes.

Robots that have more than one type of drive are not supported.

Robot Inventory
(Only if a robot was selected)

You start the inventory which updates the Media Manager 
volume database.

Robot Inventory
(Only if a robot was selected)

You can view the results of the inventory.

Identify Cleaning Media
(Only if a robot was selected)

To avoid any potential problems in the Media Manager volume 
database, you select the slots in the robotic library that are known 
to contain cleaning media.

Volumes for Standalone Drives
(Only if a standalone drive was 
selected)

You specify the number of volumes to configure for the selected 
drive type. The Media Manager volume database is updated 
when you click Next.

Completion You can choose to go back and configure more volumes if 
necessary, or exit the wizard.

Wizard Screen What to Expect
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For important background information, see “Moving Volumes” on page 246.

You can move volumes using one of the following methods:

� Moving Volumes - Using the Robot Inventory Update Option

� Moving Volumes - Using the Actions Menu

Moving Volumes - Using the Robot Inventory Update Option
The robot must have a barcode reader and the volumes must have readable barcodes to 
use the following procedure. But you can also use this procedure to just move volumes out 
of a robot, even if the volumes do not have barcodes or if the robot does not have a reader.

1. Physically move the volumes to their new location.

2. Click Actions > Inventory Robot to update the volume database to agree with the 
contents of the robot.

See “Updating the Volume Configuration for a Robot” on page 99 for more 
information.

Moving Volumes - Using the Actions Menu
If you move a volume to a robotic library that has a barcode reader, Media Manager 
updates the media database to show the correct barcode for the volume.

1. Physically move the volumes to their new location.

2. In NetBackup Administration Console, click Media and Device Management > 
Media.

3. In the volumes pane, select the volumes you want to move. 

4. Click Actions > Move.
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5. Specify the properties for the move as explained in “Dialog Box Entries for Move 
Volumes” on page 77.

Note If you are moving a single volume, the dialog box entries are set to show the current 
location of the volume.

6. Click OK to execute the move.

If you selected Eject volume from robot via the media access port, an eject dialog 
appears. See “Ejecting Volumes From Robots (Actions Menu Command)” on page 81 
for more information on the eject dialogs.

Dialog Box Entries for Move Volumes

Volumes to Move

Shows the Media IDs of the volumes that you selected to move.
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Volume Is In a Robotic Library

Select Volume is in a robotic library to indicate the robotic library where you are moving 
the volumes. When you select Volume is in a robotic library, the Device Host and Robot 
boxes are available.

Note If you are moving a single volume, the Select Robot section initially shows the 
current location of the volume.

Select Volume is in a robotic library in either of the following cases and specify the 
robotic library and the slot number for the volume.

� You are injecting a volume into a robotic library.

� The volume has already been injected into the robotic library and you are updating 
the volume database for this volume.

Clear Volume is in a robotic library, in either of the following cases:

� You are ejecting a volume from a robot.

� The volume has already been ejected from the robot and you are updating the volume 
database for this volume.

Device Host

Click the arrow and select from the list to specify the name of the device host where the 
robot is defined.

Robot

Click the arrow and select from the list to specify the robot to which you are moving the 
volumes.

Volume Group

Enter the name of the volume group for the volumes that you are moving, or click the 
arrow to select from a list of previously configured volume groups. The following table 
shows the results if you leave the volume group blank:

If you leave Volume 
group blank for Media Manager 

Standalone volumes Does not assign a volume group.
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Rules for Moving Volumes Between Groups

� You must move volumes to a new volume group or to an existing volume group that 
has the same type of volumes as you are moving.

� All volumes in a robotic library must belong to a volume group. You cannot move 
volumes into a robotic library without specifying a group or having Media Manager 
generate a name.

� More than one volume group can share the same location. For example, a robotic 
library can contain volumes from more than one volume group and you can have 
more than one standalone volume group.

� All members of a group must be in the same robotic library or be standalone. 

First Slot Number

Note You cannot enter slot information for volumes in a RSM robot. Windows 2000 tracks 
the slot locations for RSM robot types.

For volumes in a robotic library, specify the first slot number to be used in the destination 
robotic library.

By default, this box shows the slot number that the volume is coming from. Media 
Manager assigns the remainder of the slot numbers sequentially.

The appendix, “Robot Drive and Slot Layouts” on page 335 shows the slot layout for 
many of the robots that Media Manager supports.

Eject Volume From Robot via the Media Access Port

Select Eject volume from robot via the media access port to eject a single selected volume 
using the robot’s media access port.

See “Methods for Ejecting Volumes From a Robot” on page 64 for a list of the robot types 
and cases that determine when Eject volume from robot via the media access port is 
available and more information on using this function.

Robotic volumes Generates a name by using the robot number and type. For example, if the 
robot is a TS8 and has a robot number of 50, the group name will be 
00_050_TS8.

If you leave Volume 
group blank for Media Manager 
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Inject Volume Into Robot via the Media Access Port

Select Inject volume into robot via the media access port to insert a single selected 
volume in the robot’s media access port. The robotic library will then move the volume to 
the correct slot.

See “Methods for Injecting Volumes into a Robot” on page 62 for a list of the robot types 
and cases that determine when Inject volume into robot via the media access port is 
available and more information on using this function.

When to Delete Volumes
There may be times when you want to delete volumes. For example, if any of the 
following situations apply. The volume is

� No longer used and you want to recycle it by relabeling it with a different media ID.

� Unusable because of repeated media errors.

� Past its expiration date or has too many mounts, and you want to replace it with a 
new volume.

� Lost and you want to clean up the volume database.

Once a volume is deleted, you can discard it or add it back under the same or a different 
media ID.

 See “Deassigning Volumes” on page 83.

Before deleting and reusing or discarding a volume, ensure that it does not have any 
important data. NetBackup volumes have an extra safeguard against accidental deletion. 
Volumes assigned to NetBackup cannot be deleted while they are still assigned. See 
“Deassigning Volumes” on page 83.

Deleting Volumes

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the volumes pane, select the volumes that you want to delete.

Note You cannot delete any assigned volumes until any application using them deassigns 
them (see “Deassigning Volumes” on page 83).

3. Click Edit > Delete.
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A dialog box appears asking you to confirm the action.

4. Remove the deleted volumes from the storage device.

Deleting a Volume Group

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the volumes list, look at the Time Assigned column to check if any of the volumes 
in the group you want to delete are currently assigned.

The Time Assigned column is hidden by default. To display this column, see 
“Customizing the Window” on page 55.

If any of the volumes are assigned, you cannot delete the group until these volumes 
are deassigned by the application (see “Deassigning Volumes” on page 83). Use the 
“Deleting Volumes” procedure to delete individual volumes that are unassigned.

3. Select a volume group in the tree pane.

4. Click Edit > Delete.

A dialog box appears asking you to confirm the deletion.

5. Remove the deleted volumes from the storage device.

Ejecting Volumes From Robots (Actions Menu Command)
You can eject single or multiple volumes. See “Methods for Ejecting Volumes From a 
Robot” on page 64 for a list of robot types that determine when this command is available 
and more information on using this command.

To eject volumes, use the following procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the volumes pane, select one or more volumes that you want to eject.

3. Click Actions > Eject Volume(s) From Robot.
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4. In normal cases, the Tapes tab shows the volumes that you selected to eject and the 
Errors tab is empty.

The eject may not be possible because of an error. If an error occurs, the Errors tab is 
opened. The following two classes of errors can occur: 

- For more serious errors, Eject will not be available and the error situation must be 
corrected (see the sample dialog that follows).

- For other errors, the Errors tab shows an explanation of the error. You may 
continue the eject action (select Eject) or cancel (select Cancel) depending on the 
type of error.
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5. Click Eject to execute the eject.

The robotic library may not have a media access port large enough to eject all of the 
selected volumes. For most robot types, you are prompted to remove the media from 
the media access port so the eject can continue with the remaining volumes.

Deassigning Volumes
An assigned volume is currently assigned for exclusive use by NetBackup. A volume is 
set to the assigned state when NetBackup first starts using it to store data. The time of the 
assignment appears in the Time Assigned column for the volume in the volumes pane. 
When a volume is assigned, you cannot delete it or change its volume pool.

A volume remains assigned until NetBackup deassigns it. NetBackup deassigns a volume 
only when it no longer needs the data.

In the case of a NetBackup volume:

� A regular backup volume is deassigned when the retention period has expired for all 
the backups on the volume. 

� A catalog backup volume is deassigned when you stop using it for catalog backups.

Determining Which Application is Using a Volume
To determine which application is using the volume, look at the Status column of the 
Volumes list (see “Volumes Pane” on page 49).
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Deassigning NetBackup Volumes

Caution It is recommended that you do not manually deassign NetBackup volumes. If 
you do, be certain that the volumes do not have any important data. If you are 
uncertain, duplicate the images to another volume.

The procedure is different depending on whether the volume is currently being used for 
regular backups or for backing up the NetBackup catalogs. See the following two topics 
for instructions.

Deassigning NetBackup Regular Backup Volumes

NetBackup deassigns a regular backup volume when the retention periods have expired 
for all backups on the volume. If you do not need the data and do not want to wait for 
normal expiration to occur, you can expire the backup by using the bpexpdate command 
on the master server.

This command is located in the /usr/openv/netbackup/bin/admincmd directory 
and has the following format:

bpexpdate -d 0 -m media id

Where:

media id is the media ID to be expired.

The following example assumes there is only one NetBackup server and expires all the 
backups on media ID ABC001:

/usr/openv/netbackup/bin/admincmd/bpexpdate -d 0 -m ABC001

If you use this command to expire the volume, NetBackup stops tracking the backups that 
are on it and deassigns it. This makes the volume available to be reused, deleted, or its 
volume pool to be changed. You can manually expire the backups regardless of the 
volume’s prior state (frozen, suspended, and so on).

Expiring the volume does not change anything on the volume itself. When a media is 
expired, however, you must use the NetBackup import feature before restoring the 
backups it contains (a restore is possible only if the volume has not been overwritten).

Deassigning NetBackup Catalog Backup Volumes

Volumes used for backing up the NetBackup catalogs are tracked separately from regular 
backup volumes. To deassign these volumes (assuming they do not contain any important 
data), specify None or a different media ID for catalog backups (see the NetBackup system 
administrator’s guide for UNIX). Then the media is available to be reassigned or deleted; 
or its volume pool can be changed.
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Changing the Attributes for a Volume

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the volumes pane, select a volume or volumes.

3. Click Edit > Change.

A dialog box appears and shows the media ID and other attributes for each selected 
volume. 

4. In the dialog box, change the attributes as explained in “Dialog Box Entries for 
Change Volumes” on page 86.

5. Click OK to apply the changes to the selected volumes.
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Dialog Box Entries for Change Volumes

Maximum Mounts

Note Does not apply to cleaning tapes.

Controls the number of times that the selected volumes can be mounted. The choices for 
this entry are as follows.

To help determine the maximum mount limit to use, consult your vendor documentation 
for information on the expected life of the volume.

Expiration Date

Note Expiration date does not apply to cleaning tapes. When you add a new volume, 
there is no default expiration date.

Changes the expiration date for the selected volumes. This date refers to the age of the 
volume and is the time at which the volume is considered too old to be reliable. When the 
expiration date has passed, a volume can still be read but will not be mounted for a write.

Do not confuse the expiration date with the retention period for the backup data on the 
volume. The expiration date that you can set in this dialog box refers only to the physical 
expiration of the volume and is independent of the backup data written on the volume.

Select Result 

Do Not Change No changes will be made to Maximum Mounts.

Unlimited Allows an unlimited number of mounts. Unlimited is the default.

Number Sets a specific limit for the number of mounts. When the limit is passed the 
volume can still be read, but it will not be mounted for a write. Entering 0 (the 
default) is the same as selecting Unlimited.
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The backup data expiration date is separately managed by the application that is using the 
volume. In the case of NetBackup, the expiration date for the data is set as the retention 
level during schedule configuration. The choices for this entry are as follows.

Description

Specifies the media description for the selected volumes. The choices for this entry are as 
follows.

Volume Pool

Note Does not apply to cleaning tapes.

Specifies the desired volume pool. The choices for this entry are as follows.

Select Result 

Do Not Change No changes will be made to Expiration Date.

Never Sets the expiration date to infinity.

Number Sets a specific date and time when you want Media Manager to stop using the 
volumes.

Select Result 

Do Not Change No changes will be made to the media description.

New Description Allows you to enter a short description of how the volumes are being used.

Select Result

Do Not Change No changes will be made to Volume Pool.

New Pool Specify a volume pool. Click the arrow for a list of all previously configured 
volume pools.
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Number of Cleanings Remaining

Note Applies to cleaning tapes only.

Specifies the number of cleanings that are allowed for the cleaning tape. This number is 
decremented with each cleaning and when it is zero, Media Manager stops using the tape. 
At this point, you can change the cleaning tape or increase the number of cleanings 
allowed. The choices for this entry are as follows.

Changing the Volume Group of a Volume

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the volume list, select the volumes that you want to change the volume group.

3. Click Actions > Change Volume Group.

4. Enter a name in the New volume group name box or click the arrow to select a name 
from the list of volume groups.

5. Click OK.

Select Result

Do Not Change No changes will be made to Number of Cleanings Remaining.

New Count Allows you to change the number of cleanings.
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The name change is reflected in the volume list entry for the selected volumes. If you 
specified a new volume group, the group appears under Volume Groups in the tree 
pane.

Moving A Volume Group
In addition to moving individual volumes, you can move an entire volume group. This 
move can be one of the following:

� From a robotic library to standalone

� From standalone to a robotic library

1. In NetBackup Administration Console, click Media and Device Management > 
Media.

2. In the tree pane, select the volume group that you want to move.

3. Click Actions > Move.

In the dialog box that appears, the current attributes of the volume group you selected 
are displayed. These fields cannot be changed.

4. If you are moving the volume group from a robotic library to standalone, Standalone 
is selected as the destination. For this type of move, fields that are not used cannot be 
selected.

5. If you are moving the volume group from standalone to a robotic library, Robot is 
selected as the destination.
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Select the destination robotic library, by clicking the arrow and selecting from the list.

6. Click OK.

7. Move the volumes physically to their new location.

Moving a volume group in Media Manager changes only their residence information 
in the volume database. They must also be moved physically.

Replacing Volumes
In general, you should replace volumes that are any of the following:

� Full

� Past their maximum allowable number of mounts

� Too old (past their expiration date)

� Unusable, for example, because of repeated media errors

The following are two possible procedures for replacing volumes, depending on whether 
you want to reuse the old media ID.

Replacing a Volume Without Reusing the Media ID
Use this procedure when the volume you are replacing has unexpired images. For 
example, the volume may be full.
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1. Move the volume to another location (see “Moving Volumes” on page 75). 

If the volume is in a robotic library, you may want to take it out of the robotic library 
and move it to a standalone group. 

2. Add a new volume or move an existing volume in as a replacement.

If you are adding a new volume, specify the same attributes as the old volume, except 
for media ID. See “Adding New Volumes” on page 65. 

3. Physically replace the old volume, but do not delete the volume entry for that Media 
ID.

Replacing a Volume and Reusing the Media ID
This procedure lets you reuse the same set of media IDs, which may be convenient in 
some instances.

Caution Reuse a media ID only if all data on the old volume is no longer needed and 
you are going to recycle it later, or if the volume is damaged and you are going 
to discard it. Otherwise, you may encounter serious operational problems and 
possible loss of data.

1. Delete the volume entry and physically remove the old volume from the storage 
device. See “When to Delete Volumes” on page 80.

2. Physically add the new volume to the storage device.

3. Logically add the new volume to the configuration and specify the same attributes, 
including the media ID. See “Adding New Volumes” on page 65. 

4. Set a new Expiration Date for this volume. See “Changing the Attributes for a 
Volume” on page 85.

5. Reset the number of mounts. Otherwise, the number continues to be incremented 
from the value accumulated for the old volume. You can reset the number of mounts 
using the following command:

/usr/openv/volmgr/bin/vmchange -m media_id -n number_of_mounts

Where:

- media_id is the media ID for which you are changing the number of mounts.

- number_of_mounts is the new number that you want for this media ID.
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Recycling Volumes

Caution Recycle a volume only if all data on the volume is no longer needed, or if the 
volume is damaged and unusable. Otherwise, you may encounter serious 
operational problems and possible loss of data.

Recycling Volumes Under the Same Media ID
Reusing a NetBackup volume without changing its media ID is usually done when the 
last image expires. If the volume has unexpired NetBackup images, see “Deassigning 
Volumes” on page 83.

Recycling Volumes Under a New Media ID
Before changing the media ID and reusing a volume, be certain that it does not have any 
required data.

1. Physically remove the volume from the storage device.

2. If the volume is in a robotic library, move it to standalone. See “Moving Volumes” on 
page 75.

3. Record the number of mounts and expiration date for the volume.

4. Delete the volume entry. See “When to Delete Volumes” on page 80.

5. Add the new volume entry, and physically add the volume to the storage device. See 
“Adding New Volumes” on page 65.

6. Set the number of mounts to the value you recorded in step 3 by using the following 
command:

/usr/openv/volmgr/bin/vmchange -m media_id -n number_of_mounts

Where:

- media_id is the media ID for which you are changing the number of mounts.

- number_of_mounts is the new number that you want in the volume database for 
this media ID.

7. Set the expiration date to the value you recorded in step 3.
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Managing Media in Robots
 4

See “Starting Media Management” on page 45 for explanation of the Media window that 
you use in the procedures of this chapter.

If you have Backup Exec volumes to manage, see the Backup Exec tape reader option 
appendix of the NetBackup system administrator’s guide for Windows for more 
information.

Robot Management Overview
The following topics explain the available Media Manager features for managing volumes 
in a robotic library.

� “Robot Inventory Operations (Inventory Robot Dialog)”

� “Checking Barcodes (Rescan/Update Barcodes Dialog)”

Robot Inventory Operations (Inventory Robot Dialog)
To access the Media Manager robot inventory operations, use the following initial 
procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robot you want to inventory.

3. Click Actions > Inventory Robot.

The following inventory operations are performed using the following tabs of the Robot 
Inventory dialog:

� Robot Inventory tab

This tab contains the following choices:

- Show contents of robot
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Robot Management Overview
Inventories the selected robotic library and generates a report showing which 
volume (media ID) is in each slot. This operation does not check or change the 
volume database, but is useful for determining the contents of a robot.

For detailed instructions, see “Showing the Contents of a Robot” on page 95.

- Compare robot contents with the volume configuration

Compares the contents of a robotic library with the contents of the Media 
Manager volume database. Regardless of the result the volume database is not 
changed. This is useful for determining if volumes have been physically moved 
within a robot.

For detailed instructions, see “Comparing Robot Contents with the Volume 
Configuration” on page 97.

- Preview volume configuration update

Inventories the selected robotic library and compares the results with the contents 
of the volume database. If there are differences, the results section shows a list of 
recommended changes. For example, a preview allows you to ensure that all new 
media have barcodes before they are added to the Media Manager volume 
database.

You can also specify Empty media access port prior to update to inject volumes 
into the robot.

After checking the results of a preview, you can perform a volume configuration 
update operation to update the volume database to agree with the contents of the 
robot.

For detailed instructions on performing a preview, see “To Update the Volume 
Configuration for a Robot” on page 101.

- Perform volume configuration update

Inventories the selected robotic library and compares the results with the contents 
of the Media Manager volume database. If there are differences, Media Manager 
updates the volume database to match the contents of the robot.

You can also specify Empty media access port prior to update to inject volumes 
into the robot.

For detailed instructions, see “Updating the Volume Configuration for a Robot” 
on page 99.

� Update Options tab

If you select Preview volume configuration update or Perform volume 
configuration update, you can specify options for the update.

For detailed instructions, see “Changing the Update Options” on page 103.
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� Barcode Rules tab

A barcode rule specifies criteria for assigning attributes to new robotic volumes. The 
attributes are assigned according to the actual barcode that is detected by the robot. 

For detailed instructions, see “Configuring Barcode Rules” on page 124.

� Media Type Mappings tab

If you select Preview volume configuration update or Perform volume 
configuration update, you can assign media-type mappings if the robot type 
supports these mappings.

For detailed instructions, see “Changing the Update Options” on page 103.

� Media ID Generation tab

Using media ID generation rules allows you to manage your barcodes when you do 
not want to use the default rule for media ID generation. You control how Media 
Manager media IDs are created by defining rules that specify which characters of a 
barcode on tape will be used in the media ID.

For detailed instructions, see “Configuring Media ID Generation Rules” on page 130.

Checking Barcodes (Rescan/Update Barcodes Dialog)
In addition to the functions available in the Robot Inventory dialog, you can check the 
barcodes of volumes in certain robot types and update the volume database to agree with 
the contents of the robotic library.

For detailed instructions, see “Rescaning and Updating Barcodes for a Robot” on 
page 134.

Showing the Contents of a Robot

1. In the dialog box, the Device host box contains the name of the host that controls the 
robot and the Robot box contains the robot you selected.

To select a different robotic library on the host, click the arrow and select from the list 
of robots shown.

2. On the Robot Inventory tab, select Show contents of robot.

To clear any previous display in the Results section, click Clear.

3. Click Start to start the inventory.

The inventory report appears in the Results section.
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Showing the Contents of a Robot
Note For NetBackup BusinesServer the dialog box is similar, but you cannot change the 
device host.

Show Contents Report

Note If a volume happens to be in a drive, the inventory report shows it in the slot that it 
came from.

For robots (other than RSM robots) that have a barcode reader, Media Manager 
obtains the barcode and includes it in the report.

See “Robot Attributes” on page 231 for information on the robots that support 
barcode readers. These robots can have up to eight characters in the barcodes.
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For RSM robots, Media Manager reports what it receives from the Windows 2000 
Removable Storage service. The resulting report shows a list of volumes obtained 
from the service along with their RSM and Media Manager media types.

Comparing Robot Contents with the Volume Configuration

1. In the dialog box, the Device host box contains the name of the host that controls the 
robot and the Robot box contains the robot you selected.

To select a different robot on the host, click the arrow and select from the list of robots 
shown.

2. On the Robot Inventory tab, select Compare robot contents with volume 
configuration.

To clear any previous display in the Results section, click Clear.

3. Click Start to start the compare.

Media Manager requests an inventory from the selected robotic library and compares 
the results with the contents of the volume database. 

Note For NetBackup BusinesServer the dialog box is similar, but you cannot change the 
device host.

The Results section of the dialog box shows any discrepancies as follows:

- If the robot can read barcodes (see “Robot Attributes” on page 231), the report 
includes barcode information. Media Manager determines if the barcodes in the 
robot match those in the volume database.

The following figure shows an example report. For NetBackup BusinesServer the 
dialog box is similar, but you cannot change the device host.
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Compare Contents Report (Non-RSM Robot That Can Read Barcodes)

- For RSM robots, Media Manager determines whether the media ID and media 
type in the Media Manager volume database matches what it receives from the 
Windows 2000 Removable Storage service.

- If the robotic library cannot read barcodes, Media Manager verifies only whether 
the volume database correctly shows whether a slot contains a volume.

4. If the report shows that the volume database does not match the contents of the 
robotic library, do one of the following:

- Physically move the volume.

- Correct the condition by using Actions > Move or by updating the volume 
configuration as explained in “Updating the Volume Configuration for a Robot” 
on page 99.
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Updating the Volume Configuration for a Robot
The following topics explain how to use the Update Volume Configuration feature:

� When to Use Update Volume Configuration

� When Not to Use Update Volume Configuration

� To Update the Volume Configuration for a Robot

� Changing the Update Options

� Update Options

� Examples of Updating a Volume Configuration

These topics explain how to inventory a robotic library, and optionally update the volume 
database to match the contents of the robotic library. In these topics, insert means the 
volume is placed physically in the robot without using an add or move option to update 
the volume database, and remove means to take a volume out of a robot without using a 
move or eject command.

If you have inserted new volumes, the configuration update includes creation of media 
IDs (based on barcodes or a prefix that you specify).

When you use barcode rules, a new volume that is added by using a barcode rule is also 
assigned a media type, volume pool, maximum number of mounts (or maximum number 
of cleanings), and description. For instructions on setting up barcode rules see 
“Configuring Barcode Rules” on page 124.

When to Use Update Volume Configuration
You can use this operation on robots that Media Manager supports, regardless of whether 
they can read barcodes or not. The Update Volume Configuration operation is useful for 
updating the volume’s configuration information that is stored in the Media Manager 
volume database, after performing one of the following tasks:

� Removing existing volumes from a robotic library.

The operation updates the residence information in the volume database, to show the 
new standalone location. You specify the volume group to use.

� Inserting new volumes into a robotic library.

If the robotic library supports barcodes and the volume has readable barcode labels, 
the operation creates new volume entries in the volume database with media IDs that 
are based on the last six characters of the barcodes as the default or the specific 
characters that you specify, if you are using media ID generation rules (see 
“Configuring Media ID Generation Rules” on page 130).
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If the robotic library does not support barcodes or the volumes do not have readable 
barcodes, the new media IDs are based on a media ID prefix that you specify.

For more information, see “Adding New Volumes” on page 65.

If the robotic library supports barcodes and the volume has a readable barcode, you can 
use this operation in the following cases. If you are

� Inserting existing volumes into a robotic library.

The operation updates the residence information in the volume database, to show the 
new robotic location. This includes the robot host, robot type, robot number, and slot 
location. You specify the volume group to use.

� Physically moving existing volumes within a robotic library.

The operation updates the residence information in the volume database, to show the 
new slot location.

� Physically moving volumes between robotic and standalone.

The operation updates the residence information in the volume database, to show the 
new robotic or standalone location.

When Not to Use Update Volume Configuration
The following situations require a move operation, rather than using Update Volume 
Configuration:

� After inserting existing volumes into a robotic library, and the volume does not have 
readable barcodes or the robotic library does not support barcodes.

Without barcodes, Media Manager cannot identify the volume and assigns a new 
media ID that uses the media ID prefix you select for the update. A volume entry for 
the old media ID remains in the volume database. An error may occur later, if an 
application attempts to use the new or old volume.

� After physically moving existing volumes that do not have readable barcodes or if the 
volumes are in a robot that does not support barcodes.

If you swap volumes between two different locations, Media Manager is unable to 
detect the change and cannot update the volume database.

If you remove a volume from a slot and place it in an empty slot, Media Manager 
assumes it is a new volume. Media Manager then adds a new logical volume entry 
with a generated media ID at its new robotic location. The volume entry for the old 
media ID is moved to standalone. An error may occur if an application attempts to 
use the volume entry with the new or old media ID.
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To Update the Volume Configuration for a Robot

1. In the dialog box, the Device host box contains the name of the host that controls the 
robot and the Robot box contains the robot you selected.

To select a different robot on the host, click the arrow and select from the list of robots.

2. Check the barcode capabilities of the robotic library and the volume by performing 
the procedure “Comparing Robot Contents with the Volume Configuration” on 
page 97.

Determine if the following are true:

- The robotic library supports barcodes.

- Any new volume that was inserted has readable barcodes.

3. If the robotic library does not support barcodes or the volume does not have readable 
barcodes, consider the following important points:

- Save the results of the verify, as it may be useful in deciding on a media ID prefix 
if you use Update Options to assign a prefix later in this procedure.

- For RSM robot types, assign media-type mappings. If you do not, default media 
types are used.

See “Media Type Mappings (for RSM robots)” on page 112 for instructions.

4. Create barcode rules (optional).

Barcode rules are used for updating the volume database for a volume that has been 
inserted into the robotic library.

See “Configuring Barcode Rules” on page 124 for more information.

5. Create media ID generation rules (optional).

Media ID generation rules allow you to manage your barcodes when you do not want 
to use the default rules for media ID generation. You control how Media Manager 
media IDs are created by defining rules that specify which characters of a barcode on 
tape will be used in the media ID.

See “Configuring Media ID Generation Rules” on page 130 for more information.

6. On the Robot Inventory tab, select Perform volume configuration update.

Note To preview the update without making any changes, select Preview volume 
configuration update.

To clear any previous display in the Results section, click Clear.
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7. Select Empty media access port prior to update to move (inject) one or more volumes 
in the robot’s media access port into the robotic library before initiating the update.

Any volumes to be injected must be in the media access port before the operation 
begins. If Empty media access port prior to update is selected and there are no 
volumes in the port, you are not prompted to place volumes in the media access port 
and the update operation continues.

Check “Methods for Injecting Volumes into a Robot” on page 62 for a list of robot 
types that determine when Empty media access port prior to update is available and 
more information on using this function.

Note If you have recently ejected volumes from the robot with the eject or move volume 
Media Manager commands, remove the volumes from the media access ports 
before performing an inject with Empty media access port prior to update selected. 
Otherwise, if the entry and exit ports are the same, the volumes that you ejected 
could be injected back into the robotic library.

8. To view or change the settings for the update (or preview), click the Update Options 
tab. See “Changing the Update Options” on page 103 for instructions.

9. Click Start to start the update (or the preview).

The following figure shows example results.

Note For NetBackup BusinesServer the dialog is similar, but you cannot change the 
device host.
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Update Volume Configuration Report

Changing the Update Options
For most configurations, the default update options work well. You should only change 
the defaults if your configuration has special hardware or usage requirements.

1. In the Robot Inventory dialog box, click Perform volume configuration update or 
Preview volume configuration update to enable the Update Options tab.

2. Click the Update Options tab.

See “To Update the Volume Configuration for a Robot” on page 101 for the complete 
procedure.
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3. Specify update options properties, as explained in “Update Options” on page 105.

To reset all settings on this tab to their defaults, click Reset to Default.

4. When you are satisfied with your settings on this tab, click the Robot Inventory tab to 
return.

5. Click Start to initiate the update.
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Update Options

Media which have been removed from the robot should be assigned 
to the volume group

If you leave the volume group at DEFAULT and there is an existing group with a 
compatible residence for the volume, the volume is added to that group. A compatible 
residence means the same robot type, robot number, robot host, and media type (DLT and 
DLT_CLN are considered equivalent in this regard). If a suitable volume group does not 
currently exist, Media Manager generates a new volume group name.

To change from DEFAULT, do one of the following:

� Enter a volume group name in the box.

� Click the arrow and select from the list of choices for the volume group. This opens a 
list of choices for the volume group that Media Manager can assign to volumes that 
you have removed from the robotic library. The list always has the following choices.

The other available volume group choices in the list depend on the Media Type 
selection (see “Media Type (for robots that are not RSM robots)” on page 108).

Select To 

DEFAULT Let Media Manager choose the volume group.

AUTO-GENERATE Automatically generate a new volume group.

NO VOLUME GROUP Not assign a volume group.

If Media Type is The list shows existing volume groups that are valid for 

DEFAULT The robot’s default media type (see “Media Type When Not 
Using Barcode Rules” on page 109).

Not DEFAULT The specified media type.
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Media which have been moved into or within the robot should be 
assigned to the volume group

If you leave the volume group at DEFAULT and there is an existing group with a 
compatible residence for the volume, the volume is added to that group. A compatible 
residence means the same robot type, robot number, robot host, and media type (DLT and 
DLT_CLN are considered equivalent in this regard). If a suitable volume group does not 
currently exist, Media Manager generates a new volume group name.

To change from DEFAULT, do one of the following:

� Enter a group name in the box.

� Click the arrow and select from the list of choices for the volume group. This opens a 
list of choices for the volume group that Media Manager can assign to volumes that 
you have moved into the robotic library. The list always has the following choices.

The other available volume group choices depend on the Media Type selection (see 
“Media Type (for robots that are not RSM robots)” on page 108).

Media ID Prefix

Specify a Media ID prefix, if either of the following conditions exist:

� The robotic library does not support barcodes.

� The volume that was inserted does not have readable barcodes.

If the robotic library supports barcodes and the volume has readable barcodes, a prefix is 
not required because Media Manager creates the media ID in one of the following ways. 
This is true whether or not a barcode rule is used.

Select To 

DEFAULT Let Media Manager choose the volume group.

AUTO-GENERATE Automatically generate a new volume group.

If Media Type is The list shows existing volume groups that are valid for 

DEFAULT The robot’s default media type (see “Media Type When Not 
Using Barcode Rules” on page 109).

Not DEFAULT The specified media type.
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� As the default, Media Manager assigns the last six characters of the barcode as the 
media ID.

� You specify specific characters for the media ID using Media ID generation rules. See 
“Configuring Media ID Generation Rules” on page 130.

Click ... if you want media IDs for media generated based on a specific prefix. You can 
then specify a media ID prefix by entering a prefix or by choosing a prefix from a list as 
follows.

Click Specify the media ID prefix for the current session only.

The prefix is used only for the current operation. It is not added to the vm.conf file.

Enter a new value for the prefix in the text box. You can specify a prefix having from one 
to five alpha-numeric characters. Media Manager assigns the remaining numeric 
characters. For example, if the prefix is NETB, the media IDs are: NETB00, NETB01, and 
so on.

Click Choose from the media ID prefix list (stored in vm.conf file).

The list will be similar to the following example list. The first two items in this example 
list are configured media ID prefixes. These prefixes are based on MEDIA_ID_PREFIX 
entries that were added to the vm.conf file on the host where you are running 
NetBackup administration.

NV

NETB

DEFAULT

See “Media Manager Configuration File (vm.conf)” on page 258 for an overview of the 
vm.conf file.

DEFAULT always appears in the selection list. If you select DEFAULT, Media Manager 
checks the vm.conf file for MEDIA_ID_PREFIX entries, as shown in the following table:

You can also add or remove media ID prefixes. Add a prefix by entering it in the text box.

If vm.conf Media Manager 

Contains prefix entries Assigns the last one as the default prefix.

Does not contain prefix entries Uses the letter A, as the default prefix.
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Use Barcode Rules

This check box specifies whether you are using barcode rules or not. The resulting actions 
are shown in the following table:

Media Type (for robots that are not RSM robots)

Note See “Media Type Mappings (for RSM robots)” on page 112 for instructions for 
specifying Media Type for RSM robot types.

Specifies the media type for the volume that is being added. Click the arrow to select from 
the list of media types that are valid for this robotic library. 

The following is an sample list for a TLD robotic library:

DEFAULT
1/2” cartridge tape
8MM cartridge tape
DLT cartridge tape
1/2” cleaning tape
8MM cleaning tape
DLT cleaning tape

The procedure you follow to select a media type depends on whether you are using 
barcode rules, as follows:

Note Media Type Mappings applies to RSM robot types, but does not apply to any other 
robot types that are supported on NetBackup BusinesServer hosts.

If you Media Manager 

Select Use barcode rules Searches existing barcode rules and applies the rules to new volumes that 
have been inserted into a robot.

Clear Use barcode rules Ignores barcode rules.

If you are See the instructions in 

Not using barcode rules “Media Type When Not Using Barcode Rules” on page 109.

Using barcode rules “Media Type When Using Barcode Rules” on page 109.
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Media Type When Not Using Barcode Rules

If you are not using barcode rules and you want to use the media type shown in first 
column of the following table, select the type as shown in the second column.

The following table shows the default media types for robots when drives are not 
configured on the robot control host:

Media Type When Using Barcode Rules

If you are using barcode rules and you want to

� Let the barcode rule determine the media type that is assigned, select DEFAULT as the 
media type.

Media Type Select 

The default media type DEFAULT.

If all of the drives in the robotic library (configured on this 
robot host) are

- The same type and at least one drive is configured on the 
robot control host, then Media Manager uses the media 
type for the drives.

- Not the same type, then Media Manager uses the default 
media type for the robotic library.

A media type other than the default 
media type

A media type from the list.

Default Media Types for Robots

Robot Type Default Media Type

Tape Library 4MM (TL4) 4MM cartridge tape

Tape Library 8MM (TL8) 8MM cartridge tape

Tape Library DLT (TLD) DLT cartridge tape

Tape Stacker 8MM (TS8) 8MM cartridge tape

Tape Stacker DLT (TSD) DLT cartridge tape

Tape Stacker Half-inch (TSH) 1/2-inch cartridge
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Note If you choose DEFAULT here and in the barcode rule, Media Manager assigns the 
default media type for the robotic library. 

� Use a media type other than the default, select a media type from the list.

The update media type always overrides the rule. If you specify any value other than 
DEFAULT in Update Options, the media type for the rule must be the same type or be 
DEFAULT in order to obtain a match (except for cleaning media).

The following table shows the results for various combinations of update and barcode 
rule media types:

The fourth barcode rule in the table shows Media Manager’s ability to add cleaning 
cartridges with regular volumes when you execute an update for a robotic library.

If the volumes that you insert include a cleaning tape, Media Manager adds the 
volumes correctly, if the following are true:

- The update options media type is for the regular media (DLT in this example).

Update Options
Media Type

Barcode Rule
Media Type Rule Used

Media Type in
Volume Configuration

DLT DEFAULT Yes DLT

HCART DEFAULT Yes HCART

DLT DLT Yes DLT

DLT DLT_CLN Yes DLT_CLN

DLT_CLN DLT No DLT_CLN

DLT_CLN DLT_CLN Yes DLT_CLN

DLT_CLN DEFAULT Yes DLT_CLN

DLT 8MM, 4MM, and so on No DLT

DEFAULT DEFAULT Yes DLT

DEFAULT DLT Yes DLT

DEFAULT DLT_CLN Yes DLT_CLN

DEFAULT 8MM, 4MM, and so on No Depends on robot type.
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- The barcode on the volume matches a barcode tag and the barcode rule media 
type is the cleaning media (DLT_CLN in this example).

Also see “Example 5: Add cleaning tapes to a robot” on page 121.

The sixth and seventh rules in the table illustrate how to add only a cleaning tape. In 
the sixth rule, you specify the cleaning media type in Update Options and in the 
barcode rule. In the seventh rule, you specify the cleaning media in Update Options 
and choose default when you configure the barcode rule.

Volume Pool

Specifies the volume pool. Click the arrow and select from the list of volume pools to 
which you can assign new volumes. 

The list will be similar to the following example:

DEFAULT
None
NetBackup
DataStore
a_pool
b_pool

If you are using barcode rules and you want to Select 

Let the barcode rule determine the volume pool that is 
assigned to new volumes.

DEFAULT.

Use a volume pool other than the default. That pool name in the list. The 
Update Options volume pool 
always overrides the rule.

If you are not using barcode rules and you want to use Select

The NetBackup volume pool for data volumes and no 
volume pool for cleaning tapes.

DEFAULT.

A volume pool other than the default. That pool name in the list.
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Label Media (local host only)

Note This option does not apply to NetBackup BusinesServer.

This option is enabled if you selected an optical robot. The media labeling will only be 
done if the optical robot is attached to the local host specified during the NetBackup Java 
login.

Note The media is labeled and is not formatted.

Media Type Mappings (for RSM robots)

For RSM robot types, the Media type setting is always DEFAULT. Media Manager uses the 
mappings on the Media Type Mappings tab to set the media type for new volumes. This 
tab is available only for this robot type.

In Media Type Mappings, map the media type specified by the robot vendor or operating 
system software to a corresponding Media Manager type as follows. Your mappings 
apply only to the current update.

1. Find the appropriate robot vendor media type in the dialog.

2. Click the arrow and select a Media Manager type from the list.

You can set the defaults that appear in Media Type Mappings by adding media mappings 
to the Media Manager configuration file, vm.conf.

For information on adding RSM media mapping entries to the vm.conf file, see the 
Windows NetBackup Media Manager system administrator’s guides.

If either of the following are true, Media Manager uses the default media type mappings 
shown in the following table:

� The vm.conf file does not exist.

� The vm.conf file does not contain media mapping entries for that robot type.

Default Media Types for RSM Robots

RSM Media Type Default Media Manager Media Type

DDS_4MM 4mm cartridge (4MM)

MINI_QIC 1/4-inch cartridge (QCART)
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Examples of Updating a Volume Configuration

Note The following examples show only the relevant dialog box and volume attributes.

Example 1: Remove a volume from a robot

The following is an example of removing a volume from a robotic library. It does not 
matter whether the robot supports barcodes.

TRAVAN 1/4-inch cartridge (QCART)

QIC 1/4-inch cartridge (QCART)

MP_8MM 8mm cartridge (8MM)

AME_8MM 8mm cartridge (8MM)

AIT1_8MM 8mm cartridge (8MM)

DLT Digital Linear Tape (DLT)

IBM_MAGSTAR_3590 1/2-inch cartridge (HCART)

IBM_MAGSTAR_MP 1/2-inch cartridge (HCART)

STK_DATA_D3 1/2-inch cartridge (HCART)

MP2_8MM 8mm cartridge (8MM)

CLEANER_CARTRIDGE 1/2-inch cartridge (HC_CLN)

STK_EAGLE 1/2-inch cartridge (HCART)

LTO_ULTRIUM 1/2-inch cartridge (HCART)

LTO_ACCELIS 1/2-inch cartridge (HCART)

UNKNOWN 1/2-inch cartridge tape 3 (HCART3)

Default Media Types for RSM Robots (continued)

RSM Media Type Default Media Manager Media Type
Chapter 4, Managing Media in Robots 113



Updating the Volume Configuration for a Robot
1. The following are the attributes for media ID 800001. 

2. Assume that you remove the volume from the robotic library, specify the following in 
the Update Options dialog box, and then execute the update.

3. The resulting volume attributes for media ID 800001 are as follows:

media ID 800001

media type 8MM cartridge tape

barcode TL800001

media description tl8 backup volume

volume pool NetBackup

robot type TL8 - Tape Library 8MM

volume group EXB220

max mounts allowed 0 (unlimited)

media type DEFAULT

volume group NONROB_8MM

volume pool DEFAULT

media ID 800001

media type 8MM cartridge tape

barcode TL800001

media description tl8 backup volume

volume pool NetBackup

robot type NONE - Not Robotic

volume group NONROB_8MM
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The new residence information in the volume database shows a standalone location in 
the volume group, specified by the volume group on the Update Options dialog. The 
media type and volume pool remain unchanged.

The results are the same for a volume that does not have a barcode.

Example 2: Add existing standalone volumes to a robot

The following is an example of adding a standalone volume, that has a barcode, to a 
robotic library that supports barcodes (TL8).

1. The following are the volume attributes for media ID 800021, which has a readable 
barcode and already exists as a standalone volume. 

2. Assume that you insert the volume into a TL8 robot, specify the following in the 
Update Options dialog box, and then execute the update.

max mounts allowed 0 (unlimited)

media ID 800021

media type 8MM cartridge tape

barcode TL800021

media description 8MM standalone

volume pool None

robot type None (Standalone)

volume group NONROB_8MM

max mounts allowed 0 (unlimited)

media type DEFAULT

volume group EXB220

use barcode rules YES

volume pool NetBackup
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The barcode rules shown in the following table exist:

3. Media Manager recognizes that the media ID exists and changes the volume database 
to reflect the new robotic location, rather than creating a new media ID. The resulting 
volume attributes for media ID 800021 are as follows:

Barcode Tag Media Type Volume Pool Max Mounts/ 
Cleanings

Description

CLND DLT_CLN None 30 dlt cleaning

CLN8 8MM_CLN None 20 8mm cleaning

TL8 8MM NetBackup 0 tl8 backup

DLT DLT d_pool 200 dlt backup

TS 8MM None 0 8mm no pool

<NONE> DEFAULT None 0 no barcode

<DEFAULT> DEFAULT NetBackup 0 other barcodes

media ID 800021

media type 8MM cartridge tape

barcode TL800021

media description 8MM standalone

volume pool NONE

robot type TL8 - Tape Library 8MM

robot number 0

robot slot 1

robot host shark

volume group EXB220

max mounts allowed 0 (unlimited)
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Because the last six characters of the barcode match the media ID of an existing 
standalone volume in the configuration, the residence information in the volume 
database is updated to reflect the new robotic location. Since the volume is not new, 
barcode rules are ignored. 

The only option used in the Update Options dialog box is the volume group for added 
or moved volumes. The media type option was not used because this example was for 
a single existing volume that already had a media type.

Example 3: Move existing volumes within a robot

The following is an example of moving a volume from one slot to another within the same 
robot. The robot supports barcodes and the volume has a readable barcode.

Caution For volumes moved within a robotic library, use Update Volume Configuration 
only if the robotic library supports barcodes and the volumes have readable 
barcodes. Otherwise, Media Manager is unable to properly recognize the move 
(see “When Not to Use Update Volume Configuration” on page 100).
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1. The following are the attributes for media ID 800002, which currently resides in slot 1 
of the robotic library.

2. Assume that you move the volume to empty slot 10, specify the following in the 
Update Options dialog box, and then execute the update.

3. The resulting volume attributes are:

media ID 800002

media type 8MM cartridge tape

barcode TL800002

media description tl8 backup

volume pool NetBackup

robot type TL8 - Tape Library 8MM

robot number 0

robot slot 1

robot host shark

volume group EXB220

max mounts allowed 0 (unlimited)

media type DEFAULT

volume group EXB220

use barcode rules NO

volume pool DEFAULT

media ID 800002

media type 8MM cartridge tape
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The updated volume attributes show the new slot number, but all other information is 
unchanged.

Example 4: Add new volumes to a robot

The following is an example of adding new volumes with barcodes to a robot that 
supports barcodes. Assume the following:

� The new volume is an 8MM tape with a readable barcode of TL800002.

� There are no media generation rules defined.

� The drives in the robot all have a drive type of 8MM or there are no drives configured 
on the robot control host.

barcode TL800002

media description tl8 backup

volume pool NetBackup

robot type TL8 - Tape Library 8MM

robot number 0

robot slot 10

robot host shark

volume group EXB220

max mounts allowed 0 (unlimited)
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1. You specify the following in the Update Options dialog box and execute the update.

The barcode rules shown in the following table exist:

2. The barcode on the media matches the barcode rule named TL8 and the resulting 
volume attributes for the new volume are as follows:

media type DEFAULT

volume group EXB2220

use barcode rules YES

volume pool DEFAULT

Barcode Tag Media Type Volume Pool Max Mounts/ 
Cleanings

Description

CLND DLT_CLN None 30 dlt cleaning

CLN8 8MM_CLN None 20 8mm cleaning

TL8 8MM NetBackup 0 tl8 backup

DLT DLT d_pool 200 dlt backup

TS 8MM None 0 8mm no pool

<NONE> DEFAULT None 0 no barcode

media ID 800002

media type 8MM cartridge tape

barcode TL800002

media description tl8 backup

volume pool NetBackup

robot type TL8 - Tape Library 8MM
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The media ID is from the last six characters of the barcode since there are no media ID 
generation rules. The new residence information in the volume database, shows the 
robot host, robot type, robot number, slot, and host. The volume group is from the 
Update Options dialog. The volume pool and max mounts allowed are from the 
barcode rule.

If barcode rules (or barcodes) had not been used, the media description, volume pool, 
and max mounts allowed would be set to the following defaults:

- Media description: added by Media Manager

- Volume pool: NetBackup for data tapes or None for cleaning tapes

- Max mounts: 0 (unlimited)

Note If the robot does not support barcodes or the barcode is unreadable, you must 
specify a Media ID prefix (or DEFAULT) in the Update Options dialog box or Media 
Manager will not add new media IDs.

Example 5: Add cleaning tapes to a robot

A special case exists when adding cleaning tapes. For example, assume you are doing an 
update for a TLD robot.

1. The tapes you inserted include regular tapes with barcodes ranging from DLT00000 to 
DLT00010 and a cleaning tape with a barcode of CLN001.

The barcode rules shown in the following table exist:

robot number 0

robot slot 1

robot host shark

volume group EXB220

max mounts allowed 0 (unlimited)

Barcode Tag Media Type Volume Pool Max Mounts/ 
Cleanings

Description

CLN DLT_CLN None 30 dlt cleaning

DL DLT d_pool 200 dlt backup
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2. You specify the following in the Update Options dialog box and then execute the 
update.

3. The barcodes on the regular tapes match the DL barcode rule and the media type of 
the DL barcode rule matches the Media type in the Update Options dialog box. These 
tapes are added as DLT.

The cleaning tape matches the CLN barcode rule and Media Manager recognizes that 
DLT_CLN is the cleaning tape for DLT. The cleaning tape CLN001 is added as 
DLT_CLN type media along with the regular volumes.

This illustrates Media Manager’s ability to add cleaning cartridges along with regular 
volumes when you use Update Volume Configuration.

If the volumes you insert include a cleaning tape, Media Manager adds the volumes 
correctly if the following are true:

- The Media type in the Update Options dialog box is the regular media (DLT in 
this example).

- The barcode on the volume matches a barcode tag (CLN in this example) and the 
media type for the barcode rule is the correct cleaning media (DLT_CLN in this 
example).

To add only cleaning media, specify the cleaning media type in the Update Options 
dialog box and in the barcode rule (DLT_CLN in this example).

Example 7: Adding existing volumes when barcodes are not used

Caution This example is NOT recommended and is shown only to illustrate the results.

The following is an example of adding an existing standalone volume to a TL4 robot. A 
TL4 robot supports inventory (detects media presence), but not barcodes.

<NONE> DEFAULT None 0 no barcode

media type DLT

volume group STK7430

use barcode rules YES

Barcode Tag Media Type Volume Pool Max Mounts/ 
Cleanings

Description
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1. The following are the attributes for media ID 400021, which already exists as a 
standalone volume.

2. Assume that you insert the volume into the robot, specify the following in the Update 
Options dialog box, and then execute the update.

3. The resulting volume attributes are:

media ID 400021

media type 4MM cartridge tape

barcode -----------

media description 4MM standalone

volume pool None

robot type NONE - Not Robotic

volume group NONROB_4MM

max mounts allowed 0 (unlimited)

media type DEFAULT

volume group 00_000_TL4

media ID prefix C4

volume pool DEFAULT

media ID C40000

media type 4MM cartridge tape

barcode -----------

media description Added by Media Manager

volume pool NetBackup
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It is important to note that Media Manager assigned a new media ID to the volume 
(C40000). This undesired result occurs if you use Update Volume Configuration to 
add volumes that do not have readable barcodes or if the robot does not support 
barcodes. Without a barcode, Media Manager cannot identify the volume and 
assumes it is new. The media ID C40000 is generated from the media ID prefix on the 
Update Options dialog.

The old media ID (400021) remains in the configuration unchanged. The information 
for the new media ID (C40000) shows the robotic location, including the robot host, 
robot type, number, slot, and host. The volume group and volume pool are according 
to the Update Options dialog box selections. The max mounts allowed is set to the 
default (0).

Configuring Barcode Rules
A barcode rule specifies criteria for assigning attributes to new robotic volumes. The 
attributes are assigned according to the barcode that is detected by the robotic library. You 
choose whether to use barcode rules when you set up the update operation.

For background information, see “Barcode Rules” on page 248.

The following topics explain how to use barcode rules:

� Adding a New Barcode Rule

� Dialog Box Entries for Adding and Changing Barcode Rules

� Changing a Barcode Rule

� Deleting a Barcode Rule

robot type TL4 - Tape Library 4MM

robot number 0

robot slot 1

robot host shark

volume group 00_000_TL4

max mounts allowed 0 (unlimited)
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Adding a New Barcode Rule

1. In the Robot Inventory dialog box, click the Barcode Rules tab.

2. Click New.... A dialog box appears.
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3. Specify the properties for the new barcode rule and click OK.

See “Dialog Box Entries for Adding and Changing Barcode Rules” for help on 
specifying these properties.

Dialog Box Entries for Adding and Changing Barcode Rules

Barcode Tag

Enter a barcode tag for the rule. The tag can have from 1 to 16 characters, but cannot 
contain any spaces (or special characters that appear as spaces). 

In the barcode rule database and in the volume database a barcode tag can have a 
maximum of 16 characters, but Media Manager only supports the following maximum 
barcode lengths (in the volume database not all 16 characters are used for all robot types).

� Eight characters in robots that are not API robots (and the robot also supports 
barcodes). 

� Six characters in RSM robots.

The following rules can have special characters in the barcode tags:

� <NONE > - Matches when rules are used and the volume has an unreadable barcode 
or the robotic library does not support barcodes.

� <DEFAULT> - For volumes with barcodes, this tag matches when none of the other 
barcode tags match, providing the media type in the <DEFAULT> rule and the media 
type on the Update Options tab are compatible.
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Use Update Options to set up the criteria for a robot update (see “Updating the Volume 
Configuration for a Robot” on page 99).

Media Type

Click the arrow to select the media type for which this rule will be used, as shown in the 
following table:

Note Always select DEFAULT for RSM robots.

The following table shows various combinations of update selections and barcode rule 
media types for a TLD robot.

If you want the rule match Select 

Any media type that you select in Update Options DEFAULT.

If you also select DEFAULT in Update 
Options, Media Manager uses the default 
media type for the robotic library (see “Media 
Type (for robots that are not RSM robots)” on 
page 108).

Only when you select that specific media type or 
DEFAULT in Update Options

A specific media type from the list.

If you select DEFAULT for the update, Media 
Manager assigns the rule’s media type.

Update
Media Type 

Barcode Rule
Media Type Rule Used

Media Type Added To
Volume Configuration

DLT DEFAULT Yes DLT

HCART DEFAULT Yes HCART

DLT DLT Yes DLT

DLT DLT_CLN Yes DLT_CLN

DLT_CLN DLT No DLT_CLN

DLT_CLN DLT_CLN Yes DLT_CLN

DLT_CLN DEFAULT Yes DLT_CLN
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When setting up the update operation, a rule is not used if the media type in the rule is not 
compatible with the media type you select in Update Options. See “Updating the Volume 
Configuration for a Robot” on page 99.

For an RSM robot, Media Manager determines whether the media type is compatible by 
mapping it according to the setting in the media mappings dialog box. See “Media Type 
Mappings (for RSM robots)” on page 112 for more information.

Volume Pool

Click the arrow to select a volume pool for the volume. This is the pool that the volume 
will be added to, when a barcode matches the rule.

Whenever the barcode rule is used and the Update Options dialog shows

� DEFAULT for the volume pool, then the volume is assigned to the pool you specified 
in the barcode rule.

� A specific volume pool, then that selection overrides the pool you specified in the 
barcode rule.

DLT ,4MM No DLT

DEFAULT DEFAULT Yes DLT

DEFAULT DLT Yes DLT

DEFAULT DLT_CLN Yes DLT_CLN

DEFAULT  4MM No DLT (unless drives in the 
robot are configured on the 
robot control host with a 
different type)

Update
Media Type 

Barcode Rule
Media Type Rule Used

Media Type Added To
Volume Configuration
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Maximum Mounts

Specify the maximum number of mounts or cleanings that are allowed for this volume, as 
follows:

When a barcode rule is used, Media Manager adds the number you specify to the volume 
database for the media ID. 

Note When you specify 0 (unlimited), a cleaning tape whose barcode happens to match 
the rule will be assigned a 0 for Cleanings. This means it will not be used unless you 
subsequently change Cleanings to another value. You can avoid this situation by 
carefully selecting the barcodes for your cleaning media.

Description

Enter description. This can be a description of how the barcode rule will be used or any 
useful description determined by your site. You can enter from 1 to 25 characters.

Changing a Barcode Rule

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volume database where you want to change 
barcode rules.

3. Click Actions > Inventory Robot.

4. In the dialog box, click the Barcode Rules tab.

5. In the dialog box, select a rule that you want to change from the rules listed.

6. Click Change.

A dialog box appears.

For Select 

Media other than cleaning tapes The maximum number of mounts to allow.

Cleaning tapes The number of cleanings to allow.
Chapter 4, Managing Media in Robots 129



Configuring Media ID Generation Rules
7. Specify your changes.

See “Dialog Box Entries for Adding and Changing Barcode Rules” on page 126 for 
help in changing the properties of the rule.

Note You cannot change the barcode tag. To change a barcode tag, you must delete the 
rule and then add a rule with a new tag.

Deleting a Barcode Rule

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volume database where you want to change 
barcode rules.

3. Click Actions > Inventory Robot.

4. In the dialog box, click the Barcode Rules tab.

5. In the dialog box, select the rule you want to delete from the list of rules.

6. Click Delete.

In the confirmation dialog box, confirm or cancel the delete.

Configuring Media ID Generation Rules

Note To use media ID generation rules, the robotic library must support barcodes and the 
robot type cannot be RSM.

For background information see “Media ID Generation Rules” on page 250.

The following topics explain how to use media ID generation rules:

� Adding a New Media ID Generation Rule

� Changing a Media ID Generation Rule

� Deleting a Media ID Generation Rule

� Dialog Box Entries for Adding and Changing Media ID Generation Rules
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Adding a New Media ID Generation Rule

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volume database where you want to change a 
media ID generation rule.

3. Click Actions > Inventory Robot.

4. In the Robot Inventory dialog box, click the Media ID Generation tab.

5. Click New.
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Configuring Media ID Generation Rules
6. Specify the properties for the new media ID generation rule and click OK.

See “Dialog Box Entries for Adding and Changing Media ID Generation Rules” on 
page 133 for help on specifying the rule.

Changing a Media ID Generation Rule

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volume database where you want to change a 
media ID generation rule.

3. Click Actions > Inventory Robot.

4. In the dialog box, click the Media ID Generation tab.

Select a rule or rules from the list of rules.

5. Click Change.

6. In the dialog box, specify your changes for the rule. You cannot change the Robot 
Number or Barcode Length fields.
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Configuring Media ID Generation Rules
See “Dialog Box Entries for Adding and Changing Media ID Generation Rules” on 
page 133 for help in changing the rule.

Deleting a Media ID Generation Rule

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volume database where you want to delete 
media ID generation rules.

3. Click Actions > Inventory Robot.

4. In the dialog box, click the Media ID Generation tab.

Select a rule or rules from the list of rules.

5. Click Delete.

6. In the dialog box, confirm or cancel the delete action.

Dialog Box Entries for Adding and Changing Media ID 
Generation Rules

Robot Number

Specify a robot number where this rule will apply.

Barcode Length

Specify the length of the barcode for tapes in this robotic library and for this rule.

Media ID Generation Rule

A rule consists of a maximum of six fields that must be delimited by colons. Numbers in 
the fields of the rule define the positions of the characters in the barcode that are to be 
extracted. For example, 2 in a field extracts the second character from the barcode 
(numbering is from the left). The numbers can be specified in any order.
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Rescaning and Updating Barcodes for a Robot
Characters prefixed by # in a field result in that character being inserted in that position in 
the generated ID. Any alphanumeric characters that are specified must be valid for a 
media ID.

The following table shows some examples of rules and the resulting media IDs. You can 
use rules to create media IDs of many varied formats, but keep in mind that the difference 
in the label on the media and the generated media ID may make it difficult to keep track 
of your media.

Rescaning and Updating Barcodes for a Robot
Use the Rescan/Update Barcodes command to check the barcodes of volumes in a robotic 
library and update the volume database to agree with the contents of the robotic library.

Note The Rescan/Update Barcodes command does not apply to volumes in RSM robot 
types.

“Robot Attributes” on page 231 lists the robots that support barcodes.

When to Use Rescan/Update
Use Rescan/Update Barcodes only to fill in barcodes that are missing from the volume 
database.

For example, if you added a new volume to your configuration but did not physically 
insert the volume into the robotic library when the logical volume entry was added, the 
Media Manager volume database will not include the barcode. In this case, you can use 
this command to fill in the missing barcode, provided that the media has since been 
physically inserted in the robotic library.

Eight-character 
Tape Barcode Media ID Generation Rule

Generated
 Media Manager Media ID

032945L1 1:2:3:4:5:6 032945

032945L1 3:4:5:6:7 2945L

032945L1 #N:2:3:4:5:6 N32945

543106L1 #9:2:3:4 9431

543106L1 1:2:3:4:#P 5431P
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When Not to Use Rescan/Update
Do not use this command to correct reports that show a media ID in the wrong slot. In this 
case, you must do one of the following:

� Logically move the volume using Actions > Move.

� Logically move the volume using Inventory Robot. See “Updating the Volume 
Configuration for a Robot” on page 99.

� Physically move the volume into the correct slot to agree with the volume database.

To obtain an inventory of the robotic library without updating the barcode information in 
the volume database, select Show Contents in the Robot Inventory dialog box. 

See “Comparing Robot Contents with the Volume Configuration” on page 97 for more 
information.

To Rescan/Update Barcodes
To check barcodes and update the volume database:

1. In NetBackup Administration Console, click Media and Device Management > 
Media > Robots.

2. Select the robotic library that has the volumes that you want to check and update.

3. In the volume pane, select the volumes.

4. Click Actions > Rescan/Update Barcodes.

A dialog box appears listing the volumes you selected for the rescan operation. Select 
OK to continue or Cancel. If you select OK, the results of the update are displayed in 
the output section of the dialog.
Chapter 4, Managing Media in Robots 135



Rescaning and Updating Barcodes for a Robot
136 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Monitoring Storage Devices
 5

The Device Monitor provides the tools needed to manage drives and operator service 
requests.

This chapter explains the Device Monitor and contains the following topics:

� Starting Device Monitor

� Using the Device Monitor Window

� Controlling the Media Manager Device Daemon

� Administering Devices on Other Hosts

� Changing the Operating Mode of a Drive

� Resetting a Drive

� Adding or Changing a Drive Comment

� Handling Pending Requests and Pending Actions

� Assigning a Drive to a Pending Request

� Resolving Pending Actions

� Resubmitting Requests

� Denying Requests

Starting Device Monitor
In the NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

The Device Monitor window appears.
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Using the Device Monitor Window
Device Monitor Window

In addition to the tree pane on the left, a pane showing drive information is displayed on 
the right when you start the Device Monitor:

In addition, a pane for pending requests (or pending actions) is displayed on the right if 
there is a pending request or pending action active.

Using the Device Monitor Window
The following topics describe various portions of the Device Monitor window:

� Menus and Commands

� Toolbars

� Drives Status Pane

� Pending Requests Pane

� Status Bar

� Shortcut Menus and Commands

� Customizing the Window

� Allowable Media Manager Characters

Menus and Commands
The Device Monitor window has available the menus and commands shown in the 
following table.
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Using the Device Monitor Window
The menu items are enabled based on what items are currently selected in the drive status 
or pending requests panes. For example if a drive is selected in the drive status pane, Up 
Drive is enabled on the Actions menu.

Device Monitor Menus and Commands

Menu Commands

File Change Server - Displays a dialog box that allows you to change to a different 
NetBackup media server.

New Window from Here - Starts another instance of the NetBackup Administration 
Console node that was active.

Adjust Application Timezone - Displays a dialog that allows you to manage the 
timezone. NetBackup Console can execute in a different timezone than the timezone of 
the server on which it was initiated. See the NetBackup System Administrator’s guide 
for UNIX for more information.

Close Window - Closes the current window.

Exit - Closes all open windows.

View Contains commands for specifying your viewing preferences for the Device Monitor, 
including showing and hiding the toolbar or tree, and refreshing the display. See 
“Customizing the Window” on page 146.
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Actions Note For NetBackup Datacenter SSO configurations, also see “Changing the Operating 
Mode of a Drive” on page 149.

Up Drive - Sets the drive to up in automatic volume recognition (AVR) mode. This is the 
normal and default mode for drives. In AVR mode, a robotic library automatically 
retrieves, mounts, unmounts, and stores volumes. Manual intervention is necessary 
only when a request causes an error.

For standalone drives using labeled volumes, when the volume is mounted and the tape 
drive is ready, Media Manager automatically reads the recorded media ID and assigns 
the tape drive.

For standalone drives using unlabeled volumes, you assign tape drives to requests 
using Actions > Assign Request.

Up Drive, Operator Control - Sets the drive to up in operator control mode (OPR). This 
mode is normally used only for security reasons. Do not use this mode for drives that 
are being used by NetBackup.

By default, all operations are similar as if in AVR mode. If standalone drive extensions 
have been disabled by using the DISABLE_STANDALONE_ DRIVE_EXTENSIONS 
entry in the NetBackup bp.conf file, all operations are similar as if in AVR mode 
except that labeled volumes are not automatically assigned to standalone drives. You 
must assign a standalone drive to a request using Actions > Assign Request.

Down Drive - Sets the selected drive to the DOWN mode, so it is not available to Media 
Manager. In this mode, drives are not under control of Media Manager and cannot be 
assigned to requests.

Reset Drive - Resets the specified drive, terminating the drive assignment and taking 
control away from the assigned user. For NetBackup Datacenter SSO configurations, the 
drive is only reset on the device host being managed. For more information, see 
“Resetting a Drive” on page 150.

Device Monitor Menus and Commands (continued)

Menu Commands
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Toolbars
The toolbar buttons of the Device Monitor window provide shortcuts for commands that 
are on the menus. 

To show or hide the toolbar buttons:

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. Click View > Show ToolBar.

Actions Change Drive Comment - Displays a dialog box for changing the comment for the 
selected drive. For NetBackup Datacenter SSO configurations, the drive comment is 
changed only on the device host being managed.

Drive Details - Displays a dialog with information about the selected drive, including 
drive properties, drive status, and robotic library information.

Up the Drive on Every Host - For NetBackup Datacenter SSO configurations only. 
Displays a dialog that allows you to up the drive on all hosts that share this drive.

Down the Drive on Every Host - For NetBackup Datacenter SSO configurations only. 
Displays a dialog that allows you to down the drive on all hosts that share this drive.

Assign Request - Assigns a drive to a pending request.

Deny Request - Denies a pending request.

Resubmit Request - Resubmits a pending request.

This command is not applicable for NetBackup BusinesServer.

Display Pending Action - Displays information about the pending action.

Stop/Restart Media Manager Device Daemon - Controls the Media Manager device 
daemon.

Analyze Device Configuration - Starts the configuration analyzer wizard. The analyzer 
verifies that the settings in your device configuration are consistent and checks for 
potential problems.

View Status of Shared Drives - Displays a dialog box that allows you to display device 
allocation information about NetBackup Datacenter SSO configurations.

Help Help Topics - Provides online help information about the NetBackup Console.

License Keys - Provides information about your active and registered license keys.

About NetBackup Administration Console - Displays program information, version 
number, and copyright information.

Device Monitor Menus and Commands (continued)

Menu Commands
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Using the Device Monitor Window
Also see “Customizing the Window” on page 146.

Drives Status Pane
This pane shows the status of the drives that Media Manager controls on this server. The 
following table describes the columns displayed in this pane. 

Drives Status Pane

Column Description

Drive Name Drive name assigned to the drive during configuration.

Drive Index Drive index assigned to the drive during configuration.

Host Name The name of the device host that has the drive.

Type Drive type. Use this column to find a drive that supports the density required by 
the request. The drive type to use for each density is as follows:

4mm: 4mm cartridge

8mm: 8mm cartridge

dlt: DLT cartridge

hcart: 1/2-inch cartridge

qscsi: 1/4-inch cartridge
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Control Control mode for the drive. Control mode can be any of the following:

- robot_designation. For drives in a robot. For example, TLD.

- DOWN-robot_designation. For drives in a robot. For example, DOWN-TLD.

- DOWN. For standalone drives only. In this mode, the drive is not available to 
Media Manager. 

A drive can be in a DOWN mode because of problems or because it was set to 
that mode using Actions > Down Drive.

- PEND-robot_designation. For drives in a robot. For example, PEND-TLD.

- PEND. For standalone drives only. 

If the drive reports a SCSI RESERVATION CONFLICT status, this column will 
show PEND. This status means that the drive is reserved when it should not 
be.

Several operating systems (Windows, Tru64, and HP-UX) also may report 
PEND if the drive reports Busy when opened. This reporting is likely caused 
by errors in the configuration. See the SCSI Reserve/Release section of the 
NetBackup Shared Storage Option guide for details.

- AVR (up in Automatic Volume Recognition mode). For standalone drives only. 
This is the normal operating mode.

- OPR (up in operator control mode). For standalone drives only.

If the drive is a shared drive (NetBackup DataCenter SSO option only), click 
Actions > Drive Details to view the drive control mode for each host that is 
sharing this drive.

 Shared This column is used for the NetBackup Datacenter SSO feature. Yes, means this 
drive is configured as a shared drive. No, means the drive is not a shared drive.

For NetBackup BusinesServer this column contains the value No, since this 
feature is not supported.

Assigned Host This column shows the device host that currently has the drive assigned. If the 
selected drive is not assigned, this column is blank.

User User ID of the person or application whose request is currently assigned to this 
drive. If the selected drive is not assigned, this column is blank.

Media Label Shows whether a labeled or unlabeled volume is mounted on this drive. Yes, 
means labeled. No, means unlabeled. Labeled volumes can also be Backup Exec 
volumes. A dash means there is no volume mounted on the drive.

Drives Status Pane

Column Description
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Pending Requests Pane
This pane shows pending requests (or pending actions) for volumes. These usually 
originate from NetBackup, but can come from a user.

This pane is not displayed until a pending request or pending action appears. After all 
requests have been resolved by Media Manager (automatically) or by operator 
intervention, the Pending Requests pane is again hidden. See “Handling Pending 
Requests and Pending Actions” on page 151 for more information.

The following table describes the columns that are displayed in this pane for a pending 
request or action.

Recorded 
Media ID

ID recorded on the volume mounted on this drive. This identifier is the same as 
the media ID and should match the external media ID. If no volume or a Backup 
Exec volume is mounted, this column is blank.

External
Media ID

External ID of the volume mounted on this drive. This identifier should match the 
recorded media ID. If no volume is mounted, this column is blank.

Ready Status of the drive, indicating if it is ready to perform an operation on the loaded 
volume. Yes, means ready. No, means not ready. 

See the vendor’s manual for the drive for instructions to make it ready, if it does 
not become ready automatically.

Writable Shows whether the volume currently mounted on this drive is write-enabled. Yes, 
in this column means the volume is write-enabled. No, means the volume is 
write-protected. A - in this column means there is no volume in the drive.

Request ID If this drive is assigned to a request, this column contains the ID of the request.

Last Cleaned The date that the drive was last cleaned. If the selected drive has not been cleaned, 
this column is blank.

Comment Comments that the administrator has added about this drive. See “Adding or 
Changing a Drive Comment” on page 151.

Drives Status Pane

Column Description
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Pending Requests Pane

Column Description

Host Name The name of the device host that has the pending request.

Request ID Identification number for the request or action. This is a system-assigned number 
that identifies the request.

NOTE: A pending action is indicated by a media icon with a hand, located to the 
left of the Request ID.

Recorded 
Media ID

Media ID of the volume requested by the user. It is the same media ID that is 
recorded in the volume database. The ID consists of up to six alphanumeric 
characters that are recorded at the beginning of the volume to identify the 
volume.

A volume with a recorded media ID is termed a labeled volume (that is, the volume 
was labeled by NetBackup or Backup Exec). Unlabeled volumes do not have 
recorded media IDs.

When a user requests an unlabeled volume and does not specify a recorded 
media ID, the external media ID appears in this column by default. This occurs 
because Media Manager assumes that the recorded and external media IDs are 
the same.

External
Media ID

External media ID of the volume requested by the user. The ID consists of up to 
six alphanumeric characters and is usually written on an external label attached 
to the volume. The external media ID is not recorded on the volume and is used to 
identify the volume before it is inserted in a robotic library.

User User ID of the person or application making the request.

Density Density of the volume required by the user. You must mount the volume on a 
drive that supports the required density. 

Densities correspond to the following drive types (to find a drive of the correct 
type, check the drive status list.):

4mm: 4mm cartridge tape

8mm: 8mm cartridge tape

dlt: DLT cartridge tape

hcart: 1/2-inch cartridge tape

qscsi: 1/4-inch cartridge tape
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Status Bar
The status bar appears at the bottom of the Device Monitor window. The status bar 
contains any error messages.

Shortcut Menus and Commands
Clicking the right mouse button while the pointer is over a pane or a selection in a pane, 
displays a shortcut menu with commands that apply to that context. These shortcut 
commands are also available on the menus or toolbars.

Customizing the Window

Changing the Screen Display Refresh Rate

The refresh rate specifies how often the Device Monitor will query the device host for new 
display data. Initially, screen refresh is enabled and the default rate is 60 seconds. 

To change the refresh rate:

Mode Specifies whether the volume should be write-enabled. Write in this column 
means you must write-enable the volume. Read means you do not have to 
write-enable the volume, unless specified by site policy. To write-enable a 
cartridge volume, move the tab off the safe position.

Time Time of day the user made the request for access.

Media 
Description

Describes the media in 25 or less alphanumeric characters. You create the 
description when you configure volumes.

Barcode Alphanumeric representation of the barcode label on the volume that was 
requested by the user. The barcode can contain up to 13 characters.

Volume Group Volume group to which this volume belongs. A volume group defines the volume 
by location and is a logical group of volumes that are at the same physical 
location.

Pending Requests Pane

Column Description
146 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Controlling the Media Manager Device Daemon
1. Click View > Options.

2. Select Refresh display every.

3. Set the desired refresh rate.

To disable screen refresh, unselect Refresh display every.

It may be necessary to scroll the Device Monitor window to see any newly arrived jobs 
after a refresh.

The Device Monitor saves the setting of Refresh display every when you exit.

Allowable Media Manager Characters
The following set of characters can be used in user-defined names, such as drive 
comments and drive names that you enter when creating these entities. These characters 
must be used even when specifying these items in foreign languages.

Do not use a minus as the first character or leave any spaces between characters.

� Alphabetic (A-Z a-z)

� Numeric (0-9)

� Period (.)

� Plus (+)

� Minus (-)

� Underscore (_)

Controlling the Media Manager Device Daemon
The Media Manager device daemon must be running on the host being monitored or the 
displays in the Device Monitor panes will be blank. 

If the daemon is not running when you start the Device Monitor, NetBackup prompts you 
so you can start it at that time. The device daemon can be managed as described in the 
following procedure.

Note If the device host you want to monitor is a Windows host, this procedure also 
controls the NetBackup Device Manager service on that Windows host.
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Administering Devices on Other Hosts
1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. Click Action > Stop/Restart Media Manager Device Daemon.

3. Select the action you want to perform.

4. Click OK or Apply when done.

Note You may find it useful to select Stop and click Apply, and then select Start and click 
Apply.

Administering Devices on Other Hosts
Initially, you can monitor devices on the server where you are running the Device 
Monitor. The name of this server is shown in the line directly above the drive status pane, 
for example Device host: spain

If you change from a NetBackup DataCenter server to a NetBackup BusinesServer server, 
the functionality available on the new server is limited to the functionality supported by 
NetBackup BusinesServer.

You cannot change from a NetBackup BusinesServer server to a NetBackup DataCenter 
server.

To change to a different server, use the following procedure:

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. Click the Device host: icon shown directly above the drive status pane.

You can also click File > Change Server, but if the media server you want to monitor 
is a Backup Exec server (and not operating in the Backup Exec tape reader mode) 
most NetBackup commands are not valid. In this case, using the icon is 
recommended.

3. In the dialog box that appears, do one of the following to specify the host to monitor:

- Enter the name of the host.

- Click the arrow and select a host. The hosts in the list have a master server and 
media server relationship in the global device database.

Click OK.
148 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Changing the Operating Mode of a Drive
4. The name of the new host appears in the Device host: line and the lists in the panes 
show device information for the new device host.

The Media Manager device daemon must be running on the host that you are going to 
monitor, or the lists in the detail panes will be blank. If it is not running when you 
attempt to connect, a message box prompts you to start the daemon. Click Yes in this 
box.

If you encounter problems, see “Remote Administration of UNIX Hosts” on page 149.

Remote Administration of UNIX Hosts
The name of the UNIX host that you specify in the Login box, when starting the 
NetBackup Administration interface, must be in the NetBackup bp.conf file on the 
remote UNIX host where you want to monitor devices.

For more information on remote administration, see the following topics:

� “Remote Administration of Other UNIX Hosts” on page 22

� “Media Manager Security” on page 23

Changing the Operating Mode of a Drive
It is usually not necessary to change the operating mode of a drive. Drives are set to the 
UP in AVR mode (the default mode) when you add drives to your configuration, and 
usually can be left at that setting. Other operating mode settings are used for special 
purposes. 

To change the mode of a drive, do the following:

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Drives status pane, select a drive or drives.

3. From the Actions menu, choose the command for the new operating mode you want 
(for example, Down Drive).

See the Actions menu in “Menus and Commands” on page 138 for an explanation of 
the operating mode commands.
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Resetting a Drive
Changing Mode Example
The following example shows the results of changing the operating mode of Drive2 from 
AVR to DOWN.

Note Some columns of the drive status list are not shown in this example.

The following example display shows the Drives status pane before changing the drive 
mode. Notice that the Control column shows AVR and the Ready column shows Yes.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drive1 qscsi OPR   chg  No    TST401  TST401  Yes   No         0
Drive2 4mm   AVR                              Yes

The following display shows the Drives status pane after using Actions > Down Drive to 
change the operating mode of Drive2 to DOWN. Notice that the Control column shows 
DOWN and the Ready column now shows No.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drive1 qscsi OPR   chg  No    TST401  TST401  Yes   No         0
Drive2 4mm   DOWN                             No

Resetting a Drive

Caution Do not reset an assigned drive unless directed by site policy or the system 
administrator. Terminating an active job can destroy user data.

The actions that result from resetting a drive, depend on the state of the drive as follows:

Drive State Reset Action

DOWN Media Manager attempts to unload the drive. This occurs for 
standalone drives, as well as drives in a robot.

UP state, not assigned to a user 
or application and in a ready 
state

Media Manager attempts to unload the drive. If the drive is not 
ready, no action occurs.

UP state and assigned to a user 
or application

Removes the tape. This takes control away from the user.
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Use the reset capability with caution. A situation where resetting a drive might be 
necessary is if a system problem causes the drive to remain assigned after a job is 
complete. In this case, the drive cannot be used for another request and the only way to 
regain control of the drive is to reset it.

Note Resetting a drive does not perform any SCSI bus or SCSI device resets.

To reset a drive:

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Drives status pane, select a drive or drives.

3. Click Actions > Reset Drive.

4. Verify that the assignment was terminated by checking that the User and Request ID 
columns are empty for the drive number.

Adding or Changing a Drive Comment

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Drives status pane, select the drive.

3. Click Actions > Change Drive Comment.

The dialog box shows the current comment (if any).

4. Enter a comment or change the comment and click OK.

Handling Pending Requests and Pending Actions
In the following topics, the operator is the person responsible for performing the manual 
intervention. A user is a person or application (for example, NetBackup) that initiates 
requests.

When NetBackup needs a volume to complete a tape mount, it displays a request in the 
Pending Requests pane. The following is an example request:

Note Some columns of the pending requests pane are not shown in this example.
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              Recorded External
RequestID User MediaID MediaID Density Mode  Time Barcode Volume Group
0         ldr  LDR001  LDR001  4mm     Write 7:22 LDR001  rack_1

See the table in “Pending Requests Pane” on page 144 for an explanation of the columns in 
a pending request display.

Media Manager is able to resolve most requests automatically. For example, if the required 
volume is labeled and in a robotic library, Media Manager assigns the request as soon as 
the volume and a drive are available, and then removes the request and also the Pending 
Requests pane.

Pending Requests
Media Manager sometimes needs operator assistance to complete a tape mount request. 
In the following cases, Media Manager is unable to automatically assign the request and 
the request remains in the Pending Requests pane. In any of these cases, proceed as 
explained in “Assigning a Drive to a Pending Request” on page 153.

� The required drive is in the Up Under Operator Control mode (OPR mode) and 
standalone drive extensions were disabled by using the 
DISABLE_STANDALONE_DRIVE_EXTENSIONS entry in the NetBackup bp.conf 
file.

� The volume in a drive is unlabeled (and the volume being mounted is not a known 
Backup Exec tape).

� NetBackup issues a write request for an unlabeled volume in a standalone drive and 
the standalone drive extensions were disabled.

A request for a volume that is displayed in the Pending Requests pane is sometimes called 
a mount request. This term means to make the volume available for reading or writing by 
placing it in an appropriate drive and then assigning the associated request to that drive.

Pending Actions
Media Manager also needs operator assistance to complete a tape mount request when the 
request causes an error. These special requests are called pending actions.

A pending action is indicated by a media icon (the icon has hand on it depicting a manual 
action is required), located to the left of the Request ID column.

In these cases, the problem must be resolved before proceeding. See “Resolving Pending 
Actions” on page 156.
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Assigning a Drive to a Pending Request
Use the following procedure to assign a drive to a pending request.

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Pending Requests pane, select the request. Also, note the contents of the 
following columns of the request:

3. In the Drives status pane:

a. Find a drive type that matches the density for the request. 

See the table in “Drives Status Pane” on page 142 for a list of the densities that 
each drive type supports.

b. Ensure that the drive is in the Up mode and not assigned to another request.

c. Select the drive.

4. If necessary, get the media, write-enable it, and insert it into the drive.

5. Wait for the drive to become ready, as explained in the drive equipment manual.

6. Click Actions > Assign Request.

Verify that the request disappears from the Pending Requests pane.

7. In the Drives status pane, verify that

- The assigned request ID appears in the Request ID column for the drive.

- The User column is filled in.

See Column To Determine 

Density The recording density that is required.

External Media ID The ID of the media that is required.

Mode Whether the volume should be write-enabled.
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Assigning a Drive Example 1

Note Some columns of the drive status and pending requests panes are not shown in this 
example.

In this example, a pending request is assigned to a drive using Actions > Assign Request. 
The following sample display shows the Pending Requests pane before assigning the 
request.

              Recorded External
RequestID User MediaID MediaID Density Mode  Time Barcode Volume Group
2         cas  CAS135  CAS135  4mm     Read  7:30 CAS135  offsite

The following display shows the Drives status pane before assigning the request. Notice 
that Drv2 is available (the User and Request ID columns are empty) and is in OPR mode.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drv1  qscsi OPR    rhs  No    TST401  TST401  Yes   No         0
Drv2  4mm   OPR                               Yes

The following display shows the Drives status pane after the request is assigned to Drv2. 
Notice that for Drv2, the Request ID column now shows request 2 and the User column 
shows cas as the user.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drv1  qscsi OPR    rhs  No    TST401  TST401  Yes   No         0
Drv2  4mm   OPR    cas        CAS135  CAS135  Yes   Yes        2

The Pending Requests pane shows that the request has been cleared.

              Recorded External
RequestID User MediaID MediaID Density Mode  Time Barcode Volume Group

Assigning a Drive Example 2
This example shows how to satisfy a typical request where drives are up under Automatic 
Volume Recognition control (AVR mode).

Note Some columns of the drive status and pending requests panes are not shown in this 
example.

1. Assume that you have the following pending request. The contents of the pending 
request line determine how to proceed.

              Recorded External
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RequestId User MediaID MediaID Density Mode  Time Barcode Volume Group
4         NBU  TV101   TV101   4mm     Write 1:35 TV101  nonrob

The first step is to find an available tape drive. The request specifies a recording 
density of 4mm. This means you need a 4mm cartridge tape drive. The volume is 
labeled so you do not have to assign the drive using Actions > Assign Request.

2. Check the Drives status pane to see if an appropriate tape drive is available.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drive1 dlt AVR                                No
Drive2 4mm AVR                                No

Drive2 is a 4mm cartridge tape drive and is available, since it is not down and there is 
not a request number in the Request ID column. See the table in “Drives Status Pane” 
on page 142 for an explanation of each column in the drives status list.

3. Get the volume with the external media ID of TV101 and barcode of TV101. 
Depending on your site’s use of the Volume Group column, the volume group may 
give an indication of where the media ID is located.

4. Insert the volume into the drive. Assume that the tape drive is powered on and ready 
to receive the volume. Also, assume that when you insert the volume, the tape drive 
loads and positions it to the beginning.

5. Check the Drives status pane to verify that the drive is automatically assigned to 
request ID 4.

The following display shows that the assignment was successful. Drive2 is assigned 
to request 4, which is a request to write information on labeled volume TV101.

                             Recorded External
Drive Type Control User Label MediaID MediaID Ready Writable RequestID
Drive1 dlt AVR                                No
Drive2 4mm AVR     NBU  Yes   TV101   TV101   Yes Yes        4

In this example, the drive is up in AVR mode as indicated by AVR in the Control 
column. This means Media Manager assigned it automatically (which it does in AVR 
mode, providing the recorded media ID on the volume header matches the media ID 
for the request).

The write operation proceeds. When complete, NetBackup or the tpunmount 
command requests Media Manager to release the drive and Drive2 is available for 
other requests.
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Resolving Pending Actions
A pending action is indicated by a media icon (the icon has hand on it depicting a manual 
action is required), located to the left of the Request ID column.

The procedure for resolving a pending action follows:

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Pending Requests pane, select the pending action.

3. Click Actions > Display Pending Action (or double-click on the pending action).

This opens a message box with a description of the problem and a list of possible 
actions to correct it. The message box also shows other information, such as user 
name, recorded media ID, external media IDs, and drive number.

4. Click OK after viewing the information.

5. In most cases, you can do one of the following to resolve the action:

- Correct the error condition and resubmit the request.

See “Resubmitting Requests” on page 156

- Click Actions > Deny Request to deny the request.

See “Denying Requests” on page 157.

Resubmitting Requests
The procedure to resubmit a request follows:

1. Correct the problem identified by the pending action message.

2. In the Pending Requests pane, select the request.

3. Click Actions > Resubmit Request.

The pending action message disappears from the Pending Requests pane and the 
operation proceeds.

If a pending action message involves a robotic library, after correcting the problem you 
may need to resubmit the request that caused the message before the operation can 
proceed. For example, if a volume is requested after being removed from a robotic library, 
do the following:
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1. Insert the volume in the robotic library.

2. Perform an Update Volume Configuration.

See “Updating the Volume Configuration for a Robot” on page 99 for complete 
instructions.

3. Resubmit the request.

Denying Requests
Some situations may require you to deny requests for service (for example, when drives 
are not available, you cannot find the volume, or the user is not authorized to use it). 
Denying a request returns an error message to the user.

1. In NetBackup Administration Console, click Media and Device Management > 
Device Monitor.

2. In the Pending Requests pane, select the request.

3. Click Actions > Deny Request.

The request is removed from the Pending Requests pane.
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Managing Daemons
 6

This chapter includes the following Media Manager daemon topics:

� Overview of Media Manager Daemons

� Media Manager Device Daemon (ltid)

� Automatic Volume Recognition Daemon (avrd)

� Media Manager Volume Daemon (vmd)

� Robotic Daemons

� Displaying Process Status using the vmps Script

� Logging

Overview of Media Manager Daemons
The following daemons manage the assignment and scanning of devices:

� ltid - The Media Manager device daemon.

� avrd - The automatic volume recognition daemon.

� vmd - The Media Manager volume daemon enables remote device management and 
controls the volume database. This daemon informs ltid of the location of 
requested volumes, and tracks the number of mounts and last mount time for each 
volume.

Robotic Daemons and Robotic Control Daemons
A Media Manager robotic daemon (and possibly a robotic control daemon) exists for each 
robot that you configure on a host where Media Manager is installed.

Every host that has a drive in a robot, has a robotic daemon for that robot. The robotic 
daemon receives requests from the Media Manager device daemon and sends necessary 
information directly to the robotics or to a robotic control daemon.
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Media Manager Device Daemon (ltid)
Robotic control daemons also exist for robot types where drives can optionally attach to 
hosts other than the host with direct robotic control. These types of robots are not 
supported in NetBackup BusinesServer. 

Media Manager Device Daemon (ltid)
ltid is the interface between Media Manager commands and device control. ltid 
controls the reservation and assignment of volumes. When a tape request is issued, ltid 
requests vmd to find the volume and then requests the appropriate robot to mount the 
volume. If necessary, ltid notifies the operator that the volume must be mounted 
manually.

Starting the Device Daemon
Starting ltid also starts avrd, vmd, and the daemons for any robots with defined drives.

From a Command Line

Enter the following command.

/usr/openv/volmgr/bin/ltid

To start ltid and the robotic daemons in verbose mode and log debug information 
through syslogd, use the -v option. This option should only be used when needed for 
debugging, since it can use large amounts of disk space to save extra information.

From the Java Administrative Interface

1. Use Actions > Stop/Restart Media Manager Device Daemon.

2. Select the Start action and OK. This also starts the daemons for any robot that is 
configured.

Stopping the Device Daemon
Stopping ltid stops robotic daemons. vmd continues to run.

From the Java administrative interface, stop the device daemon before making any 
changes to the device configuration as follows:
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1. Notify users and operators that the system will be unavailable.

2. Check the Pending Requests list to ensure that no tapes are currently assigned. If any 
tapes are assigned, you cannot stop the daemons.

3. Use Actions > Stop/Restart Media Manager Device Daemon.

4. Select the Stop action and OK.

Automatic Volume Recognition Daemon (avrd)
This daemon handles automatic volume recognition and label scanning. This allows 
Media Manager to read labeled tape volumes and assign the associated removable media 
requests to drives.

avrd is started when you start ltid and stops when you stop ltid. You do not have to 
start and stop it at any other times.

Media Manager Volume Daemon (vmd)
When vmd receives information from ltid about a requested volume, it searches the 
volume database and returns the robotic location of the volume to ltid. Because vmd 
may be running on or servicing requests from another system, and because it is used for 
remote device configuration and device management, vmd continues to run even after 
ltid and the other daemons have been stopped.

vmd must be active to change the volume configuration.

You can do either of the following when starting this daemon:

� Start ltid. This also starts vmd.

� Start only vmd, by using the following command:

/usr/openv/volmgr/bin/vmd

To stop this daemon use the following command:

/usr/openv/volmgr/bin/vmctrldbm -t
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Robotic Daemons
The following table lists the robotic daemons and robotic control daemons (if applicable) 
for each robot type. For more information about these daemons, see the appendix, “Media 
Manager Man Pages” on page 169.

Robotic and Robotic Control Daemons

Robot Daemon Description

Tape Library 
DLT (TLD)

tldd

tldcd

The robotic daemon (tldd) runs on each Media Manager server 
that has a drive in a Tape Library DLT. This daemon receives 
requests to mount and unmount volumes and sends these requests 
to the robotic control daemon (tldcd).

tldcd runs on the Media Manager server that has the robotic 
control, accepts mount, dismount, and robot inventory requests and 
communicates with the Tape Library DLT robotics through a SCSI 
interface.

Tape Library 
4MM (TL4)

tl4d This daemon runs on a host that has a Tape Library 4MM. tl4d 
receives requests to mount and unmount volumes, or for robot 
inventory, and communicates these requests to the robotics through 
a SCSI interface.

Tape Library 
8MM (TL8)

tl8d

tl8cd

The robotic daemon (tl8d) runs on each Media Manager server 
that has a drive in a Tape Library 8MM. This daemon receives 
requests to mount and unmount volumes and sends these requests 
to the robotic control daemon (tl8cd).

tl8cd runs on the Media Manager server that has the robotic 
control, accepts mount, dismount, and robot inventory requests and 
communicates with the Tape Library 8MM robotics through a SCSI 
interface.

Tape Stacker 
8MM (TS8)

ts8d This daemon runs on a Media Manager server that has a Tape 
Stacker 8MM. ts8d receives requests to mount and unmount 
volumes, or for robot inventory, and communicates these requests to 
the robotics through a SCSI interface.

Tape Stacker 
DLT (TSD)

tsdd This daemon runs on a Media Manager server that has a Tape 
Stacker DLT. This daemon receives requests to mount and unmount 
volumes, or for robot inventory, and communicates these requests to 
the robotics through a SCSI interface.
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Starting and Stopping Robotic Daemons
Starting ltid also starts the robotic daemons for all configured robots. Stopping ltid 
also stops robotic daemons.

Once started, a robotic daemon can be in an UP or DOWN state. When a connection is 
made to the appropriate robot, the corresponding daemon is in the UP state and can 
mount or unmount tapes. If the connection cannot be made or if errors exist, the daemon 
moves to the DOWN state. Even in the DOWN state, the daemon is still running and 
automatically returns to the UP state when the connection is made or problems no longer 
exist.

Displaying Process Status using the vmps Script
The vmps script shows the Media Manager daemon processes that are active. You can 
execute this script using the following command:

/usr/openv/volmgr/bin/vmps

In the following sample display, the second column contains the process IDs for the 
processes.

root       303  0.0  0.2  136  264 ?  S    Feb 11  4:32 ltid -v
root       305  0.0  0.0  156    0 ?  IW   Feb 11  0:54 vmd -v
root       306  0.0  0.0  104    0 ?  IW   Feb 11  0:15 tl8d -v
root       307  0.0  0.0   68   56 ?  S    Feb 11 12:16 avrd
root       310  0.0  0.0  116    0 ?  IW   Feb 11  0:07 tl8cd -v

Logging
Robotic errors and network errors are logged using syslogd. See the NetBackup 
troubleshooting guide for UNIX for more information.
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Tape I/O Commands
 7

If you are not using NetBackup, or want to troubleshoot or test Media Manager; you can 
manually request Media Manager to mount and unmount specific volumes by using the 
commands found in this chapter.

Requesting Tapes
The tpreq command allows you to request a tape of a particular density and specify 
various options, such as the access mode. This command implicitly reserves a single drive 
and creates a file in the current working directory (unless a full path is specified). The file 
acts as a symbolic link to the tape and all subsequent access to the tape is through this file 
name. Users do not have to be concerned with the full path to a specific device file.

The information you supply on the tpreq command is registered for use by the Media 
Manager device daemon and used to validate all access requests to the tape file.

For all types of tapes, the tape is actually mounted and assigned when you enter the 
tpreq command.

By default, the drive assigned is one which supports DLT cartridge tapes, using the 
density dlt. You can use the density option on tpreq to request a drive that supports 
another density. See the Density field in the table in “Pending Requests Pane” on page 144 
for a list of supported densities and drive types.

The density for the physical write is not selected automatically on drives. It is requested, 
so an operator can satisfy the correct drive. Density is determined by the /dev device 
name that was used when the drive was added to the Media Manager configuration or by 
the buttons selected on the drive itself.

A tpreq command must include a media ID and a file name. If the tape volume is 
associated with a volume pool (configured using Media Manager), the name of the 
volume pool must also be specified using the -p parameter. 

The following example tpreq command reserves a tape drive and creates a symbolic tape 
file:

/usr/openv/volmgr/bin/tpreq -f tape1 -m jlr01 -a w -d qscsi
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Reading and Writing Tape Files
This example creates a file named tape1 in the user’s current working directory and links 
the file to the drive containing the tape volume having the media ID of JLR01. The access 
mode for the tape file is set to write and a 1/4-inch cartridge drive is assigned.

See the tpreq(1) man page in the appendix for more information.

Note When a tpreq command is executed, a call is made to the script 
drive_mount_notify immediately after the media has been successfully placed 
in a pre-selected drive. This script is located in the /volmgr/bin directory and 
usage information is documented within the script. This script is only called from 
the tpreq command for drives that are in robots and is not valid for standalone 
drives.

Reading and Writing Tape Files
Reading or writing tape files involves copying the file from tape to disk or from disk to 
tape. To perform read or write operations, use one of the UNIX commands that performs 
input/output operations, for example tar or mt.

Positioning Tape Files
The mt command positions tape files by skipping forward or backward according to tape 
marks. The following table shows the operations available on the mt command for 
positioning tapes and how they affect tape files.

The following example uses mt to skip forward three files on a tape:

mt -f tape1 fsf 3

mt Command Operations

Command Description

eof, weof Writes end-of-file tapemarks at the current position on the tape according to 
the count option on mt.

fsf, bsf Spaces forward or backward the number of tapemarks on the count option.

fsr, bsr Spaces forward and backward the number of records according to the count 
option on mt. bsr is only supported for the undefined record type.
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Rewinding Tape Files
When a file is rewound, it is positioned to the beginning of information. To rewind a tape 
file, you can use the mt command. 

The following command causes rewinding of tape file tape1. tape1 is positioned to the 
beginning of the tape volume associated with the file.

mt -f tape1 rewind

The count option is not used for the rewind operation. If a count is specified, it is ignored.

Removing Tape Files
When you have completed reading or writing tape files, use the 
/usr/openv/volmgr/bin/tpunmount command to end the assignment of the tape 
file. This command removes from the directory the tape file you created using tpreq and 
causes the tape volume to be removed from the tape drive. tpunmount is required for 
each file created by a tpreq command. 

See the tpunmount(1) man page for more information.

Note When a tpunmount command is executed, call is made to the script 
drive_mount_notify. This script is located in the /volmgr/bin directory and 
usage information is documented within the script.

External Access to Media Manager Controlled Devices
The device daemon (ltid) restricts access to Media Manager controlled drives that are in 
an UP state by changing the permissions of the device files for those drives. The 
permissions are changed to 0600 when ltid starts and back to their original settings 
when ltid is terminated (or when a drive’s state is changed to DOWN).

Do not modify the permissions of these device files when ltid is active. To ensure 
reliable operation, only users that use the tpreq and tpunmount commands explained in 
this chapter can have access to an UP drive under ltid control.

The following example uses tpreq:

tpreq tape -m xxx -d 4mm -f /tmp/tape

/bin/tar -cvf /tmp/tape files

tpunmount /tmp/tape
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User Messages
Users that do not use tpreq and tpunmount to access drives that are in the UP state may 
encounter both access and data reliability problems. These problems occur because the 
Media Manager avrd daemon periodically attempts to rewind and read data from media 
in UP drives that are not currently assigned.

A user that is unable to use tpreq and tpunmount must do one of the following before 
attempting to access the drive:

� Down the drive prior to accessing it.

� Terminate ltid by executing stopltid and then restart ltid after accessing the 
drive. 

User Messages
See the Device Management Status Codes section of the NetBackup troubleshooting guide 
for errors returned from user tape commands.
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Media Manager Man Pages
 A

This appendix describes Media Manager commands and Media Manager processes. These 
commands can be executed from the command line.

The remaining commands in this appendix are for device management and are started or 
stopped by the Media Manager device daemon (ltid) as needed.

� tpreq and tpunmount are user commands for requesting tape mounts and 
unmounts for configured drives. 

� tpautoconf (for NetBackup DataCenter only), tpclean, tpconfig, tpformat 
(NetBackup DataCenter only), and vmoprcmd are administrative commands for 
device management.

� vmadd, vmadm, vmchange, vmcheckxxx, vmdelete, vmpool, vmquery, vmrule, 
and vmupdate are administrative commands for media management.

The following conventions are used in the command descriptions:

� Brackets [ ] indicate that the enclosed component of the command line is optional.

� A vertical bar (or the pipe symbol) | separates optional arguments.

For example, if a command has the following format, you can choose arg1 or arg2 
(but not both):

command [arg1 | arg2]

� Italics indicate that the information is user supplied.
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ltid(1M)

NAME

ltid, stopltid - start and stop the Media Manager device daemon

SYNOPSIS

/usr/openv/volmgr/bin/ltid [-v] [-nsu] [-logmounts [minutes]] 
[-noverify]

/usr/openv/volmgr/bin/stopltid

DESCRIPTION

The ltid command starts the Media Manager device daemon (ltid) and Automatic 
Volume Recognition daemon (avrd). These daemons manage Media Manager devices. 
With both daemons started, an operator can initiate the operator display, observe the 
drive status, and control the assignment of requests to standalone drives. ltid can be 
placed in a system initialization script.

The Media Manager volume daemon, vmd, is also started by the ltid command. ltid 
also starts the appropriate robotic daemons, if robotic devices were defined in Media 
Manager.

The stopltid command stops ltid, avrd, and the robotic daemons.

OPTIONS

-v
Logs debug information using syslogd. This is most informative when 
robotic devices are in use. This option starts robotic daemons and vmd 
in verbose mode.

-nsu
If this option is specified, tapes in standalone drives are not ejected 
when tpunmount is issued (though they are ejected if end of media is 
reached during a NetBackup backup or archive). You can override this 
option by specifying the -force option on tpunmount.
This option can be used in a NetBackup environment where it is 
desirable to keep the standalone drives ready after successful backups 
are performed.
Specifying this option is equivalent to specifying 
DO_NOT_EJECT_STANDALONE in the vm.conf file.
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-logmounts minutes
If this option is specified, ltid logs mount requests using syslogd. 
The mount requests are still posted to Media Manager displays. The 
mount requests are only logged after a delay of the specified number of 
minutes. 
If -logmounts is specified, the default number of minutes is 3. If 
-logmounts 0 is specified, ltid logs the mount request through 
syslogd immediately. If minutes is not zero and the mount request is 
satisfied before the number of minutes are up, the request is not logged 
through syslogd.

-noverify
If this option is specified, ltid does not verify drive names. Normally, 
ltid verifies that the no rewind on close drive name has the correct 
minor number bits relating to no rewind, variable, berkeley-style, and 
so on. This option is normally not required, but may be helpful if using 
non-standard platform device files. If this option is specified, caution 
should be taken in making sure the device files are correct.

ERRORS

stopltid does not stop the daemons if any drives are assigned to users. Ensure that all 
users have unmounted assigned tapes before attempting to stop the daemons.

Error messages are logged using syslogd.

SEE ALSO

rc(8), syslogd(8), tpconfig(1M), vmadm(1M), tpunmount(1)
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tl4d(1M)

NAME

tl4d - Tape Library 4MM (TL4) daemon

SYNOPSIS

/usr/openv/volmgr/bin/tl4d [-v]

DESCRIPTION

tl4d interfaces with Media Manager to mount and unmount tapes in a Tape Library 
4MM (TL4) robot. It is started by ltid (the Media Manager device daemon), if the Media 
Manager device configuration shows drives in the robot.

Stopping ltid stops tl4d. You can stop tl4d independently of ltid using 
/usr/openv/volmgr/bin/vmps or your server’s ps command to identify the tl4d 
process ID and entering the following commands:

kill tl4d_pid

/usr/openv/volmgr/bin/tl4d [-v] &

tl4d communicates with the robotics through a SCSI interface. When the connection is 
established (the path for robotics can be opened), tl4d puts the TL4 robot in the UP state 
and can mount and unmount tapes. If the robotics are inaccessible, tl4d changes the 
robot to the DOWN state. In this state, tl4d is still running and returns the robot to the 
UP state if it is able to make a connection.

The media ID and slot number information for 4 mm tapes in a robot must be defined in 
the Media Manager volume database before any tapes can be accessed through ltid and 
tl4d.

If a cleaning volume is used, it must be defined in the volume configuration. See 
tpclean(1M) for information on setting the frequency for automatic drive cleaning.

The Internet service number for tl4d must be in /etc/services. If you are using NIS 
(Network Information Service), you should place the entry in this host’s /etc/services 
file in the master NIS server database for services. To override the services file, create the 
file /usr/openv/volmgr/database/ports/tl4d with a single line containing the 
service number for tl4d. The default service number is 13713.

OPTION

-v Logs debug information using syslogd. If you start ltid with -v, tl4d 
also starts with -v.
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ERRORS

tl4d returns an error message if there is a copy of tl4d running.

Media Manager logs any Tape Library 4MM and robotic errors to syslogd. Log entries 
are also made when the state changes between UP and DOWN.

SEE ALSO

ltid(1M), syslogd(8), tpclean(1M), tpconfig(1M), vmadm(1M)
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NAME

tl8d, tl8cd - Tape Library 8MM (TL8) daemon and control daemon

SYNOPSIS

/usr/openv/volmgr/bin/tl8d [-v]

/usr/openv/volmgr/bin/tl8cd [-v] [-t] [-n]

DESCRIPTION

tl8d and tl8cd interface with Media Manager to mount and unmount volumes in a 
Tape Library 8MM robot.

tl8d directly interfaces with the Media Manager device daemon (ltid). A tl8d daemon 
runs on each host with a drive connection and sends mount and unmount requests to the 
control daemon (tl8cd). tl8cd communicates with the robotics through a SCSI 
interface.

For NetBackup DataCenter, Tape Library 8MM robotic control software permits drives in 
the same robot to be configured on different hosts. tl8cd may be running on a different 
host than tl8d, depending on where the SCSI connection resides (see EXAMPLES). When 
the connection is established (that is, the path for robotics can be opened), tl8d puts the 
TL8 robot in the UP state and can mount and unmount volumes. If the robotics are 
inaccessible, tl8d changes the robot to the DOWN state. In this state, tl8d is still 
running and returns the robot to the UP state if tl8cd is able to make a connection.

Note If drives are on different NetBackup DataCenter hosts, the robotic information must 
be entered in the Media Manager configuration on all machines and the robot 
number must be the same on all machines.

tl8d and tl8cd are automatically started when ltid is started and stopped when ltid 
is stopped. You can stop or start tl8d independently of ltid using 
/usr/openv/volmgr/bin/vmps or your server’s ps command to identify the tl8d 
process id and then entering the following commands:

kill tl8d_pid

/usr/openv/volmgr/bin/tl8d [-v] &

The control daemon, tl8cd, is on the host that has the robotic control and is started by 
tl8d on that host (see EXAMPLES).

The media ID and slot number information for volumes in a robot must be defined in the 
volume database before any volumes can be accessed through ltid, tl8d, and tl8cd.
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If a cleaning volume is used, it must be defined in the volume configuration. See 
tpclean(1M) for information on setting the frequency for automatic drive cleaning.

If the vm.conf configuration option PREVENT_MEDIA_REMOVAL is enabled when tl8cd 
is active, tl8cd disables access to the volumes and media access port by issuing a 
command to the TL8 robot. If it is necessary to open the door of the cabinet, you must 
terminate tl8cd first. By default, access to the library is allowed.

The drives are logically numbered 1 through n, where n is the number of drives in the 
robotic library. Use one or more of the following to determine the correct robot drive 
numbers:

� The Device Configuration wizard (if the robotic library and drives support 
serialization).

� The Robot Drive and Slot Layout appendix in the NetBackup Media Manager system 
administrator’s guide.

� The robotic library vendor’s documentation on drive indexing.

� The robotic test utility, or experiment by mounting media and watching the operator 
display.

The Internet service number for tl8cd must be in /etc/services. If you are using NIS 
(Network Information Service), the entry found in this host’s /etc/services file should 
be placed in the master NIS server database for services. To override the services file, 
create the file /usr/openv/volmgr/database/ports/tl8cd file with a single line 
containing the service number for tl8cd. The default service number is 13705. 

OPTIONS

-v Logs debug information using syslogd. If you start ltid with -v, tl8d 
and tl8cd are also started with -v.

-t Terminates tl8cd.

-n Causes tl8cd to run with barcode checking disabled. This option is 
useful, if all or most of the volumes in the library do not contain barcodes, 
because it takes the robot a lot less time to scan volumes.
Note that if the volumes contain barcodes and the -n option is selected, 
the barcodes are ignored.

ERRORS

tl8d and tl8cd log error messages if there is a copy of the daemon running.

Media Manager logs any Tape Library 8MM and robotic errors to syslogd. Log entries 
are also made when the state changes between UP and DOWN.
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EXAMPLES

In the following diagram, the drives and the robotics are connected to a single host. ltid 
initiates tl8d, which in turn initiates tl8cd.

        host A                 TL8 Robot

     ------------            ------------- 

     |          |            |           | 

     |  ltid    |            |           | 

     |  tl8d    |            |           | 

     |  tl8cd   |            |-----------| 

     |          |         |--| Robotics  | 

     |          |         |  |-----------| 

     |          |         |--|  drive 1  | 

     |----------|         |  |-----------| 

     |   SCSI   |------------|  drive 2  | 

     ------------            ------------- 

Note The following diagram applies only to NetBackup DataCenter.

In the following diagram, each host is connected to one drive in the robot and the robotics 
are connected to host A. ltid on each host initiates tl8d. The tl8d on host A also 
initiates tl8cd, since that is where the robotic control is defined. Requests to mount tapes 
from host B go to tl8d on host B, which sends the robotic command to tl8cd on host A.

    host A            TL8 Robot               host B 

------------        -------------         ------------ 

|          |        |           |         |          | 

|  ltid    |        |           |         |  ltid    | 

|  tl8d    |        |           |         |  tl8d    | 

|  tl8cd   |        |-----------|         |          | 

|          |   |----| Robotics  |         |          | 

|          |   |    |-----------|         |----------| 

|          |   |    |  drive 1  |---------|   SCSI   | 

|----------|   |    |-----------|         |----------| 

|   SCSI   |--------|  drive 2  |         |          | 

------------        -------------         ------------
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SEE ALSO

ltid(1M), syslogd(8), tpclean(1M), tpconfig(1M), vmadm(1M)
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NAME

tldd, tldcd - Tape Library DLT (TLD) daemon and control daemon

SYNOPSIS

/usr/openv/volmgr/bin/tldd [-v]

/usr/openv/volmgr/bin/tldcd [-v] [-t]

DESCRIPTION

tldd and tldcd interface with Media Manager to mount and unmount volumes in a 
Tape Library DLT (TLD) robot.

tldd directly interfaces with ltid (the Media Manager device daemon). tldd runs on 
each host with a drive connection and sends mount and unmount requests to the control 
daemon (tldcd). tldcd communicates directly with the robotics through a SCSI 
interface.

For NetBackup DataCenter, TLD robotic control software permits drives in the same robot 
to be configured on different hosts. tldcd may be running on a different host than tldd, 
depending on where the interface connection resides (see EXAMPLES). When the 
connection is established (that is, the path for robotics can be opened), tldd puts the TLD 
robot in the UP state and can mount and unmount volumes. If the robotics are 
inaccessible, tldd changes the robot to the DOWN state. In this state, tldd is still 
running and returns the robot to the UP state if tldcd is able to make a connection.

Note If drives are on different NetBackup DataCenter hosts, the robotic information must 
be entered in the Media Manager device configuration on all machines and the 
robot number must be the same on all machines.

tldd and tldcd are started when ltid is started and stopped when ltid is stopped. 
You can stop or start tldd independently of ltid using 
/usr/openv/volmgr/bin/vmps or your server’s ps command to identify the tldd 
process ID and then entering the following commands:

kill tldd_pid

/usr/openv/volmgr/bin/tldd [-v] &

tldcd is on the host that has the robotic control and is automatically started by tldd on 
that host (see EXAMPLES).

The media ID and slot number information for volumes in the robot must be defined in 
the volume database before any volumes can be accessed through ltid, tldd, and 
tldcd.
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If a cleaning volume is used, it must be defined in the volume configuration. See 
tpclean(1M) for information on setting the frequency for automatic drive cleaning.

The drives are logically numbered 1 through n, where n is the number of drives in the 
robotic library. Use one or more of the following to determine the correct robot drive 
numbers:

� The Device Configuration wizard (if the robotic library and drives support 
serialization).

� The Robot Drive and Slot Layout appendix in the NetBackup Media Manager system 
administrator’s guide.

� The robotic library vendor’s documentation on drive indexing.

� The robotic test utility, or experiment by mounting media and watching the operator 
display.

The Internet service number for tldcd must be in /etc/services. If you are using NIS 
(Network Information Service), the entry found in this host’s /etc/services file should 
be placed in the master NIS server database for services. To override the services file, 
create the /usr/openv/volmgr/database/ports/tldcd file with a single line 
containing the service number for tldcd. The default service number is 13711. 

OPTIONS

-v Logs debug information using syslogd. If you start ltid with -v, tldd 
and tldcd are also started with -v.

-t Terminates tldcd.

ERRORS

tldd and tldcd log an error message if there is another copy of the daemon running.

Media Manager logs any Tape Library DLT and robotic errors to syslogd. Log entries are 
also made when the state changes between UP and DOWN.

EXAMPLES

In the following diagram, the two drives and the robotics connect to Host A. ltid 
initiates tldd, which in turn initiates tldcd.

        Host A              TLD Robot

      __________          ___________

     |          |        |           |

     |  ltid    |        |           |

     |  tldd    |        |           |

     |  tldcd   |        |-----------|
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     |          |     |--| Robotics  |

     |          |     |  |-----------|

     |          |     |  |           |

     |----------|     |  |-----------|

     |   SCSI   |-----|--|  drive 2  |

     |__________|     |  |-----------|

                      |--|  drive 1  |

                         |___________|

Note The following diagram applies only to NetBackup DataCenter.

In the following diagram, each host connects to one drive and the robotics connect to host 
A. ltid on each machine initiates tldd. The tldd on host A also initiates tldcd, since 
that is where the robotic control is defined. Requests to mount tapes from host B go to 
tldd on host B, which sends the robotic command to tldcd on host A.

        host A             TLD Robot             host B

      __________          ___________           __________

     |  ltid    |        |           |         |  ltid    |

     |  tldd    |        |           |         |  tldd    |

     |  tldcd   |        |-----------|         |          |

     |          |   |----| Robotics  |         |          |

     |          |   |    |-----------|         |----------|

     |          |   |    |  drive 3  |---------|   SCSI   |

     |----------|   |    |-----------|         |----------|

     |   SCSI   |---|----|  drive 2  |         |          |

     |__________|   |    |-----------|         |__________|

                    |----|  drive 1  |

                         |___________|

SEE ALSO

ltid(1M), syslog(8), tpclean(1M), tpconfig(1M), vmadm(1M)
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NAME

tpclean - manages tape drive cleaning

SYNOPSIS

/usr/openv/volmgr/bin/tpclean -L

/usr/openv/volmgr/bin/tpclean -C drive_name

/usr/openv/volmgr/bin/tpclean -M drive_name

/usr/openv/volmgr/bin/tpclean -F drive_name cleaning_frequency

DESCRIPTION

tpclean allows you to monitor Media Manager tape drive usage and optionally 
configure tape drives to be automatically cleaned (except drives in ACS, LMF, ODL, RSM, 
or TLH robots; or shared (SSO) drives).

Media Manager tracks the total amount of time that volumes have been mounted in the 
drives. You can use tpclean to specify a cleaning frequency (in hours) for a drive.

Drive cleaning occurs, if the following are true:

� The mount time exceeds the cleaning frequency.

� The drive is in a robot.

� The Media Manager volume configuration shows a cleaning tape in the robot.

The Comment field in the tpclean -L output will contain the message, NEEDS 
CLEANING, if the following are true. You can then manually clean the drive and reset the 
mount time using the -M option.

� The mount time exceeds the cleaning frequency.

� The drive is a standalone drive or does not have a cleaning tape defined.

For the -C, -M, and -F options, ltid must be running. You must also have root privileges 
to execute this command.

See the reference topics appendix of the Media Manager system administrator’s guide for 
information about the TapeAlert feature that is available with most tape drives, and other 
related drive cleaning topics.
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OPTIONS

-C drive_name
Initiates the cleaning of a drive in a robot. The drive must be defined in a 
robot and a cleaning tape defined in the Media Manager volume 
configuration. The mount time is reset to zero. The drive name is the 
name that was assigned to the drive, when it was added.

-L
Prints cleaning statistics to stdout.

-M drive_name
Use this option to indicate that the drive has been manually cleaned. The 
mount time is reset to zero. The drive name is the name that was assigned 
to the drive, when it was added to the device configuration.

-F drive_name cleaning_frequency
Sets cleaning frequency for the specified drive to cleaning_frequency 
hours. The drive name is the name that was assigned to the drive when it 
was added. The value of cleaning_frequency must be between 0 and 
10,000 hours.
For NetBackup DataCenter, frequency-based cleaning is not supported 
for shared drives.

EXAMPLES

The following example displays cleaning statistics. An asterisk next to the drive type 
means the device is defined as robotic.

#tpclean -L

Drive Name   Type   Mount Time  Frequency   Last Cleaned   Comment

**********   ****   **********  **********  ************   *******

qsci_drv0    qscsi      0.0         0           N/A

rob_A_drv1   8mm*      11.4        30       14:33 05/29/92

4mm_drv5     4mm        5.6        10       13:01 06/02/92

dlt_drv6     dlt        3.0         0           N/A

The following example sets the cleaning frequency for the drive named qsci_drv0 to 25 
hours. The drive will be flagged as needing cleaning after 25 hours of mount time has 
occurred.

tpclean -F qsci_drv0 25

The following example resets the mount time for the drive named rob_A_drv1 to zero. 
You would normally use this command after you had manually cleaned the drive.

tpclean -M rob_A_drv1
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The following example initiates the cleaning of drive rob_A_drv1. This example 
assumes the drive is a robotic drive, with a cleaning tape defined. The mount time is reset 
to zero.

You can use the -C option to force the cleaning of a drive prior to reaching 
cleaning_frequency. Normally, robotic drives are cleaned automatically when their mount 
time exceeds the cleaning frequency.

tpclean -C rob_A_drv1

Note To use a cleaning tape, the Cleanings Remaining for that tape (as shown in the 
volume list of the Media node in the NetBackup Administration Console or from 
the vmquery command) must be greater than zero. This cleaning count refers to 
how many more times the cleaning tape can be used. You can change this count 
using the Media node or the vmchange command.

SEE ALSO

ltid(1M), tpconfig(1M), vmadm(1M)
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NAME

tpconfig - tape configuration utility

SYNOPSIS

/usr/openv/volmgr/bin/tpconfig [-noverify]

/usr/openv/volmgr/bin/tpconfig -d

/usr/openv/volmgr/bin/tpconfig -dl

/usr/openv/volmgr/bin/tpconfig -l

/usr/openv/volmgr/bin/tpconfig -lsavdbhost

/usr/openv/volmgr/bin/tpconfig -add -drive -type drvtype -path 
drivepath [-vhname opticalvolhdrdrvname] [-asciiname 
asciidrivename] [-index drvindex] [-shared [yes|no]] 
[-cleanfreq hours] [-comment comment] [-drstatus 
[UP|DOWN]] [-robot robnum -robtype robtype] [-noverify] 
[-robdrnum robdrvnum | -VendorDrvName venddrvname | -ACS 
acsnum -LSM lsmnum -PANEL panelnum -DRIVE drivenum]

/usr/openv/volmgr/bin/tpconfig -update -drive drvindex [-type 
drvtype] [-path drivepath] [-vhname opticalvolhdrdrvname] 
[-newasciiname asciidrivename] [-shared [yes|no]] 
[-cleanfreq hours] [-comment comment] [-drstatus 
[UP|DOWN]] [-robot robnum -robtype robtype] [-noverify] 
[-robdrnum robdrvnum | -VendorDrvName venddrvname | -ACS 
acsnum -LSM lsmnum -PANEL panelnum -DRIVE drivenum]

/usr/openv/volmgr/bin/tpconfig -delete -drive drvindex

/usr/openv/volmgr/bin/tpconfig -multiple_delete -drive 
drvindex1:drvindex2: ... drvindexN

/usr/openv/volmgr/bin/tpconfig -add -robot robnum -robtype 
robtype -robpath robpath [-vdbhost volume_database_host]

/usr/openv/volmgr/bin/tpconfig -add -robot robnum -robtype 
robtype -cntlhost cntlhost [-vdbhost volume_database_host]

/usr/openv/volmgr/bin/tpconfig -update -robot robnum [-robtype 
robtype] [-robpath robpath] [-cntlhost cntlhost] [-vdbhost 
volume_database_host]

/usr/openv/volmgr/bin/tpconfig -delete -robot robnum
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/usr/openv/volmgr/bin/tpconfig -multiple_delete -robot 
robnum1:robnum2: ... robnumN

/usr/openv/volmgr/bin/tpconfig -savdbhost 
standalone_volume_database_host

DESCRIPTION

tpconfig can be used as a command line interface or menu interface to configure robots 
and drives for use with NetBackup.

/usr/openv/volmgr/bin/tpconfig [-noverify] starts the Media Manager 
Device Configuration Utility. This menu-based utility creates and modifies databases in 
the /usr/openv/volmgr/database directory. These databases identify the robotics 
and drives that are under control of ltid (the Media Manager device daemon). ltid 
uses these files to correlate drives in the operator’s drive status display to the device files 
in the /dev directory.

For example, assume that you want to configure a drive recognized by the system as an 
8-mm type drive. Look in the /dev directory and locate the no rewind on close device 
path for an 8-mm type drive and then specify this device path for the drive. tpconfig 
then records the device path in the appropriate device database.

After using tpconfig to change your device configuration, use the stopltid 
command to stop the ltid and avrd (automatic volume recognition) daemons (if they 
are running). Then use the ltid command to start the daemons again. See ltid(1M) for 
more information.

You must be the root user to execute this utility.

OPTIONS

-l
Lists the current device configuration (to stdout), without volume 
database host names.

-d
Lists the current configuration information (to stdout), including 
volume database host names.

Note The following option is only applicable for NetBackup DataCenter.

-lsavdbhost
Lists the volume database host for standalone drives. This is the host 
where the Media Manager volume daemon maintains the volume 
configuration for standalone drives.
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-noverify
If this option is specified, drive paths are not verified. Normally, 
tpconfig verifies that the no rewind on close drive path has the correct 
minor number bits that relate to no rewind, variable, Berkeley-style, and 
so on. This option is normally not required, but may be helpful if using 
non-standard platform device files. If this option is specified, caution 
should be taken in making sure the device files are correct.

-add
Adds a drive or a robot, depending on the accompanying options.

-update
Changes the configuration information for a drive or robot. For example, 
you can add a drive to a robot.

-delete
Deletes a drive or robot, depending on the accompanying options.

-multiple_delete
Deletes multiple drives or robots, depending on the accompanying 
options.

Note The following option is only applicable for NetBackup DataCenter.

-savdbhost standalone_volume_database_host
Sets the volume database host for standalone drives that attach to this 
specified host.

-drive
Use this option with the -add option to specify that the action is for a 
drive.

-drive drvindex
Use this option with the -update, -delete,or -multiple_delete 
options to specify the drive index and that the action is for a drive.

-type drvtype
Specifies the type of drive that you are configuring.
Drive type can be any of the following for NetBackup DataCenter:
4mm for 4mm tape drive, 8mm for 8mm tape drive, 8mm2 for 8mm tape 
drive 2, 8mm3 for 8mm tape drive 3, dlt for DLT tape drive, dlt2 for 
DLT tape drive 2, dlt3 for DLT tape drive 3, dtf for DTF tape drive, 
qscsi for QIC tape drive, hcart for Half-inch cartridge drive, hcart2 
for Half-inch cartridge drive 2, hcart3 for Half-inch cartridge drive 3, 
odiskwm for optical disk-write many drive, odiskwo for optical 
disk-write once drive.
Drive type can be any of the following for NetBackup BusinesServer:
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4mm for 4mm tape drive, 8mm for 8mm tape drive, dlt for DLT tape drive, 
hcart for Half-inch cartridge drive, qscsi for QIC tape drive.

-path drivepath
Specifies the system name for the drive. For example, /dev/rmt/0cbn.

-comment comment
Adds a comment about the drive. This field is useful for storing SCSI 
inquiry data so you can easily check the drive type and firmware level.

-index drvindex
A drive index is a unique number that is used to identify the drive. When 
you add a drive you are not required to supply a drive index, since the 
next available drive index is used by Media Manager. Each drive on a 
particular host must have a unique index number.

-drstatus UP|DOWN
Sets the initial status of the drive to the UP or DOWN state. You can also 
perform this action with options in the Device Management window.

-cleanfreq hours

Note Not used with shared drives.

Specifies the number of hours between drive cleanings. When you add a 
drive, NetBackup starts recording the amount of time that volumes are 
mounted in that drive.
If the drive is in a robot and a cleaning volume is defined in the robot, 
cleaning occurs when the accumulated mount time exceeds the time that 
you specify for cleaning frequency. NetBackup resets the mount time 
when the drive is cleaned.
If the drive is standalone or if a cleaning tape is not defined, the message 
NEEDS CLEANING appears in the comment field of the tpclean -L 
output. To clean the drive, use the tpclean command.
Frequency-based cleaning is not needed if TapeAlert is used.

-robot robnum
A unique number that identifies the robot to NetBackup. You assign the 
robot number when you add the robot using the add option.
Robot numbers must be unique for all robots, regardless of the robot type 
or the host that controls them.

-robtype robtype
Specifies the type of robot that you are configuring and can be any of the  
types supported by NetBackup. Check the VERITAS support web site to 
determine the robot type to specify for a particular model of robotic 
library.
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Robot type can be any of the following for NetBackup DataCenter:
acs for Automated Cartridge System, lmf for Library Management 
Facility, tl4 for Tape Library 4mm, tl8 for Tape Library 8mm, tld for 
Tape Library DLT, tlh for Tape Library Half-inch, tlm for Tape Library 
Multimedia, ts8 for Tape Stacker 8mm, tsd for Tape Stacker DLT, tsh 
for Tape Stacker Half-inch, odl for Optical Disk Library.
Robot type can be any of the following for NetBackup BusinesServer:
tl4 for Tape Library 4mm, tl8 for Tape Library 8mm, tld for Tape 
Library DLT, ts8 for Tape Stacker 8mm, tsd for Tape Stacker DLT.

-robdrnum robdrvnum
Specifies the physical location (within the robot) of the drive. If you 
assign the wrong number, NetBackup does not detect it, but an error 
eventually occurs because the robotic control attempts to mount media on 
the wrong drive.
You can usually determine the physical location by checking the 
connectors to the drives or the vendor documentation.
The Robot Slot and Layout appendix of the Media Manager system 
administrator’s guide shows drive layouts for many of the robots that 
NetBackup supports.

Note The following four ACS options are not supported in NetBackup BusinesServer.

-ACS acsnum

-LSM lsmnum

-PANEL panelnum

-DRIVE drivenum
These options specify the configuration for ACS (Automated Cartridge 
System) robots.
acsnum specifies the number for the robotic library as configured on the 
ACS library software host.
lsmnum specifies the Library Storage Module that has this drive.
panelnum specifies the robot panel where this drive is located.
drivenum specifies the number of this drive.

-VendorDrvName venddrvname
Specifies the IBM device name for a TLH robotic drive or the DAS drive 
name for a TLM robotic drive.

-vhname opticalvolhdrdrvname
Specifies the volume header path for an optical drive.
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Note The following option is not supported in NetBackup BusinesServer.

-shared yes|no
Specify yes, if the drive you are adding or updating will be shared 
among hosts.

-asciiname asciidrivename
Specifies a name for the drive. This name identifies the drive to Media 
Manager. If you do not specify a drive name, Media Manager generates a 
name.

If you are adding or updating shared drives (SSO option) on NetBackup 
DataCenter, make this name as descriptive as possible.

-newasciiname asciidrivename
Specifies a new name for the drive.

Note The following option is only applicable for NetBackup DataCenter.

-cntlhost cntlhost
For a robot whose robotic control is on another host, this option specifies 
the host that controls the robotic library. 
This option applies only for LMF, TL8, TLD, and TLH, robots that can 
have the robotic control on another host, and for ACS and TLM robots.
For an ACS robot, specify the host name where the ACS library software 
is installed.
For a TLM robot, specify the host name where the DAS software is 
installed.

-robpath robpath
If the robot that you are adding or updating is a UNIX host or Windows 
2000 host with the robotic control, use this option.

Note The following option is only applicable for NetBackup DataCenter.

-vdbhost volume_database_host
For a robot, this specifies the volume database host. This is the host that 
will have the information about the media in the robot.

FILES

/usr/openv/volmgr/database/ltidevs

/usr/openv/volmgr/database/robotic_def

/usr/openv/volmgr/help/tpconfig* (Help files)
Appendix A, Media Manager Man Pages 189



tpconfig(1M)
SEE ALSO

ltid(1M)
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NAME

tpreq - request a tape volume for mounting and associate a file name with the assigned 
drive

SYNOPSIS

/usr/openv/volmgr/bin/tpreq -m media_id [-a accessmode] [-d 
density] [-p poolname] [-f] filename [-x 
symmetrix_serial_number]

DESCRIPTION

This command initiates a mount request for a tape volume on a removable media device. 
The information that you specify with this command identifies and registers the specified 
file as a logical identifier for the mount request with Media Manager and manages access 
to the volume.

Media Manager automatically mounts the media if it is in a robotic drive. Otherwise, an 
operator mount request appears in the Device Monitor window. tpreq will not complete 
normally in the case of a mount request for a robotic drive, if operator intervention is 
required. These requests also appear in the Device Monitor window.

When the operation is complete, use tpunmount to unmount the volume and remove the 
file name from the directory in which the file was created.

When a tpreq command is executed, a call is made to the script drive_mount_notify 
immediately after the media has been successfully placed in a pre-selected drive. This 
script is located in the /volmgr/bin directory and usage information is documented 
within the script. This script is only called from the tpreq command for drives that are in 
robots and is not valid for standalone drives.

For NetBackup DataCenter if you request optical disk densities (odiskwm or odiskwo), 
tpreq acts differently than with sequential tape devices. The logical file name is a link to 
the data partition of the disk device. By default, it is the character device. Optical platters 
are labeled by tpformat with the volume-header partition being the label and the data 
partition being the rest of the disk.

OPTIONS

-m media_id
Specifies the media ID of the volume to be mounted. You can enter the ID 
in upper or lowercase; Media Manager converts it to uppercase.
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-a accessmode
Specifies the access mode of the volume. Valid access modes are w and r. 
If the access mode is w (write), the media must be mounted with write 
enabled. The default is r (read), which means the media may be write 
protected.

-d density
Specifies the density of the drive. This option determines the type of drive 
on which the tape volume is mounted. The default density is dlt.

Valid densities for NetBackup DataCenter follow:
4mm for 4-mm cartridge, 8mm for 8-mm cartridge, 8mm2 for 8-mm 
cartridge 2, 8mm3 for 8-mm cartridge 3, dlt for DLT cartridge, dlt2 for 
DLT cartridge 2, dlt3 for DLT cartridge 3, dtf for DTF cartridge, hcart for 
1/2 Inch cartridge, hcart2 for 1/2 Inch cartridge 2, hcart3 for 1/2 Inch 
cartridge 3, odiskwm for Optical disk-write many, odiskwo for Optical 
disk-write once, qscsi for 1/4-inch cartridge.
For NetBackup DataCenter, the half-inch cartridge densities (hcart, 
hcart2, and hcart3) can be used to distinguish between any supported 
half-inch drive types. However, tape requests can only be assigned to 
drives of the associated media type. For example, a tape request with 
density hcart2 specifying a media ID with media type HCART2 will be 
assigned to an hcart2 drive. Likewise, a tape request with density hcart 
specifying an media ID with media type HCART will be assigned to an 
hcart drive. The same rules apply to the DLT densities (dlt, dlt2, and dlt3) 
and the 8MM densities (8mm, 8mm2, and 8mm3).
Valid densities for NetBackup BusinesServer follow:
4mm for 4-mm cartridge, 8mm for 8-mm cartridge, dlt for DLT cartridge, 
hcart for 1/2 Inch cartridge, qscsi for 1/4-inch cartridge.
The mount request must be performed on a drive type that satisfies the 
density.

-p poolname
Specifies the volume pool where the volume resides. poolname is case 
sensitive. The default is None.

-f filename
Specifies the file to be associated with the volume. The file name 
represents a symbolic link to the drive where the volume is mounted.
The file name can be a single name or a complete path. If you specify only 
a file name, the file is created in the current working directory. If you 
specify a path, the file is created in the directory named in the path. 
filename cannot be an existing file.
Specifying -f before filename is optional.
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-x symmetrix_serial_number
This option is valid only for Sun Solaris systems. Specifies the 12-digit 
serial number of an EMC Symmetrix storage system. This option allows 
the mounting of a Fastrax tape volume in a NetBackup for EMC Fastrax 
configuration.

SEE ALSO

tpformat(1M), tpunmount(1), vmadm(1M)
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NAME

tpunmount - removes a tape volume from a drive and tape file from the directory

SYNOPSIS

/usr/openv/volmgr/bin/tpunmount [-f] filename [-force]

DESCRIPTION

tpunmount removes a tape file from the directory and removes the tape volume from the 
drive (if the media was mounted). 

Standalone drives are not unloaded (if the -force option is not specified) in the following 
cases:

� The ltid option, -nsu (no standalone unload) was specified.

� The DO_NOT_EJECT_STANDALONE option was specified in the vm.conf file.

When a tpunmount command is executed for drives that are not NDMP or Fastrax 
drives, a call is made to the script drive_unmount_notify. This script is located in the 
/volmgr/bin directory and usage information is documented within the script.

The tape file and the device must be closed before you can use tpunmount.

OPTIONS

-f filename
Specifies the file associated with the media. You must specify a file name.
Specifying -f before filename is optional.

-force

Ejects the volume from a standalone drive, even if the -nsu option was 
specified for ltid or DO_NOT_EJECT_STANDALONE was specified in the 
vm.conf file, at the time ltid was started.

EXAMPLE

The following command unmounts the tape volume associated with file tape1 and 
removes the file from the current directory:

tpunmount tape1

SEE ALSO

tpreq(1), ltid(1M)
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NAME

ts8d - Tape Stacker 8MM (TS8) daemon 

SYNOPSIS

/usr/openv/volmgr/bin/ts8d [-v]

DESCRIPTION

ts8d interfaces with Media Manager to mount and unmount tapes in a Tape Stacker 
8MM robot. It is initiated by ltid (the Media Manager device daemon), if the Media 
Manager device configuration shows drives in a Tape Stacker 8MM.

Stopping ltid stops ts8d. You can stop or start ts8d independently of ltid using the 
/usr/openv/volmgr/bin/vmps command or your server’s ps command to identify 
the ts8d process id and then entering the following commands:

kill ts8d_pid

/usr/openv/volmgr/bin/ts8d [-v] &

ts8d communicates directly with the robotics through a SCSI interface. When the 
connection is established (the path for robotics can be opened), ts8d puts the TS8 robot in 
the UP state and can mount and unmount tapes. If the robotics are inaccessible, ts8d 
changes the robot to the DOWN state. In this state, ts8d is still running and returns the 
robot to the UP state if it is able to make a connection.

The media ID and slot number information for 8mm tapes in a robot must be defined in 
the volume database before any tapes can be accessed through ltid and ts8d.

If a cleaning volume is used, it must be defined in the volume configuration. See 
tpclean(1M) for information on setting the frequency for automatic drive cleaning.

The Internet service number for ts8d must be in /etc/services. If you are using NIS 
(Network Information Service), you should place the entry in this host’s /etc/services 
file in the master NIS server database for services. To override the services file, create the 
file /usr/openv/volmgr/database/ports/ts8d with a single line containing the 
service number for ts8d. The default service number is 13709.

OPTION

-v Logs debug information using syslogd. If you start ltid with -v, 
ts8d also starts with -v.

ERRORS

ts8d returns an error message if there is a copy of ts8d running.
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Media Manager logs any Tape Stacker 8MM and robotic errors to syslogd. Log entries 
are also made when the state changes between UP and DOWN.

SEE ALSO

ltid(1M), syslogd(8), tpclean(1M), tpconfig(1M), vmadm(1M)
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NAME

tsdd - Tape Stacker DLT (TSD) daemon

SYNOPSIS

/usr/openv/volmgr/bin/tsdd [-v]

DESCRIPTION

tsdd interfaces with Media Manager to mount and unmount tapes in Tape Stacker DLT 
(TSD) robots. It is initiated by ltid (the Media Manager device daemon), if the Media 
Manager device configuration shows drives in the Tape Stacker DLT (TSD).

Stopping ltid stops tsdd. You can stop or start tsdd independently of ltid using the 
/usr/openv/volmgr/bin/vmps command or your server’s ps command to identify 
the process id for tsdd, and then entering the following commands:

kill tsdd_pid

/usr/openv/volmgr/bin/tsdd [-v] &

tsdd communicates directly with the robotics using a SCSI interface. When the 
connection is established (the path for robotics can be opened), tsdd puts the TSD robot 
in the UP state and can mount and unmount tapes. If the robotics are inaccessible, tsdd 
changes the robot to the DOWN state. In this state, tsdd is still running and returns the 
robot to the UP state if it is able to make a connection.

The media ID and slot number information for DLT tapes in a robot must be defined in the 
volume database before any tapes can be accessed through the ltid and tsdd.

If a cleaning volume is used, it must be defined in the volume configuration. See 
tpclean(1M) for information on setting the frequency for automatic drive cleaning.

The Internet service number for tsdd must be in /etc/services. If you are using NIS 
(Network Information Service), you should place the entry in this host’s /etc/services 
file in the master NIS server database for services. To override the services file, create the 
file /usr/openv/volmgr/database/ports/tsdd with a single line containing the 
service number for tsdd. The default service number is 13714.

OPTION

-v Logs debug information using syslogd. If you start ltid with -v, 
tsdd also starts with -v.

ERRORS

tsdd returns an error message if there is a copy of tsdd running.
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Media Manager logs any Tape Stacker DLT robot and robotic errors to syslogd. Log 
entries are also made when the state changes between UP and DOWN.

SEE ALSO

ltid(1M), tpclean(1M), tpconfig(1M), vmadm(1M)
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NAME

vmadd - Add volumes to the volume database

SYNOPSIS 

/usr/openv/volmgr/bin/vmadd -m media_id -mt media_type [-h 
volume_database_host] [-verbose] [-b barcode] [-rt 
robot_type] [-rn robot_number] [-rh robot_host] [-rc1 
rob_slot] [-rc2 rob_side] [-p pool_number] [-mm max_mounts 
| -n cleanings] [-op optical_partner] [-d "media_description"]

DESCRIPTION

Add volumes to the Media Manager volume database.

OPTIONS

-m media_id
Specifies the media ID of the volume to add. The media ID can be a 
maximum of 6 ASCII characters. 
For NetBackup DataCenter if you are adding an optical disk, specify the 
media ID for the A side of the optical platter. Media IDs for an API robot 
type (ACS, TLH, TLM, LMF, or RSM) must always match the barcodes.
For NetBackup BusinesServer, media IDs for an RSM robot must always 
match the barcodes.

-mt media_type
Specifies the media type of the volume to add. 
Valid media types for NetBackup DataCenter are: 4mm, 8mm, 8mm2, 
8mm3, dlt, dlt2, dlt3, dtf, hcart, hcart2, hcart3, odiskwm, odiskwo, qcart, 
4mm_clean, 8mm_clean, 8mm2_clean, 8mm3_clean, dlt_clean, 
dlt2_clean, dlt3_clean, dtf_clean, hcart_clean, hcart2_clean, hcart3_clean.
Valid media types for NetBackup BusinesServer are: 4mm, 8mm, dlt, 
hcart, qcart, 4mm_clean, 8mm_clean, dlt_clean, hcart_clean.

Note The following option is only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host with the volume database where the volume will be 
added. You should ensure that the host specified matches the volume 
database host name associated with the robot or set of standalone drives, 
as indicated in the device configuration. If no host is specified, the host 
where you execute the command is assumed.
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-verbose
Selects verbose mode.

-b barcode
Specifies the barcode attached to the volume.

-rt robot_type
Specifies the robot type of the robot where the volume is located.
Valid robot types for NetBackup DataCenter are: none, acs, lmf, odl, rsm, 
tl4, tl8, tld, tlh, tlm, ts8, tsd, tsh.
Valid robot types for NetBackup BusinesServer are: none, rsm, tl4, tl8, tld, 
ts8, tsd.

-rn robot_number
Unique, logical identification number for the robot where the volume is 
located.

-rh robot_host
Name of the host which controls the robot, where the volume is located.

-rc1 rob_slot
Robot coordinate 1 is the slot number in the robot where the volume is 
located.
For NetBackup DataCenter, do not enter slot information for Media 
Manager API robot types. The robot software tracks the slot locations for 
these robots.
For NetBackup BusinesServer, do not enter slot information for Media 
Manager RSM robot types. The robot software tracks the slot locations for 
these robots.

Note The following option is only applicable for NetBackup DataCenter.

-rc2 rob_side
Robot coordinate 2 is the platter side for optical disks (A or B).

-p pool_number
Index of the volume pool which will contain this volume. You can use 
vmpool -listall to determine the index for a given pool name.

-mm max_mounts
Maximum number of mounts allowed for this volume. Only used for 
non-cleaning media. When this limit is exceeded, the volume can be 
mounted for read operations only.

-n cleanings
Number of cleanings remaining for this volume. Only used for cleaning 
media.
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Note The following option is only applicable for NetBackup DataCenter.

-op optical_partner
If this is an optical disk, specify the media ID of the opposite side of the 
optical platter.

-d "media_description"
Media description of the volume. The double quote marks are required if 
the description contains any spaces.

EXAMPLES

The following command adds volume AJU244 in the NetBackup volume pool to the 
volume database on the host named llama. For NetBackup BusinesServer there is only one 
host (the master), so the -h option is not needed.

The volume, with a barcode of AJU244, is in slot 2 of TLD robot 1. For write operations, 
the volume may be mounted a maximum of 1000 times.

Note This command is usually entered on one line.

vmadd -m AJU244 -mt dlt -h llama -b AJU244 -rt tld -rn 1 -rh llama 
-rc1 2 -p 1 -mm 1000 -d "vmadd example"

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmchange(1M), vmdelete(1M), vmpool(1M), vmquery(1M)
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NAME

vmadm - character-based media management utility

SYNOPSIS

/usr/openv/volmgr/bin/vmadm [-l] [-t]

DESCRIPTION

vmadm can be used to manage volumes and volume pools, manage barcode rules, and 
inventory robots controlled by the Media Manager volume daemon (vmd). Any actions 
performed using this utility are serviced by making requests to vmd. You must be the root 
user to use this utility.

This utility has a character-based user interface and can be used from any terminal. When 
this utility is initiated, the administrator is presented with a menu of operations that can 
be performed.

You can also start the tpconfig utility from vmadm.

OPTIONS

-l
Requests that the Media Manager volume daemon log the current status. 
If vmd can handle the request; no output is visible, but log messages are 
written to the debug log (if the log is enabled).

-t
Terminates the Media Manager volume daemon.

ERRORS

If vmd is not running, most vmadm operations fail and the following message appears:

unable to validate server: cannot connect to vmd (70)

See vmd(1M) to obtain additional debugging information should problems persist.

FILES

/usr/openv/volmgr/help/vmadm* (these are help files)

/usr/openv/volmgr/database/volDB

SEE ALSO

ltid(1M), tpconfig(1M), vmd(1M)
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NAME

vmchange - change media information in the Media Manager volume database

SYNOPSIS

Change volume group residence

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -vg_res 
-rt robot_type -rn robot_number -rh robot_host -v volume_group

Change volume residence

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -res -m 
media_id -mt media_type -rt robot_type -rn robot_number -rh 
robot_host -v volume_group -rc1 rob_slot [-rc2 rob_side]

Change volume expiration date

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -exp 
mm/dd/yy hh:mm:ss -m media_id

Change the barcode for a volume

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -barcode 
barcode -m media_id [-rt robot_type]

Change the media description for a volume

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -d 
"media_description" -m media_id

Associate this volume with a different pool

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -p 
pool_number -m media_id

Change a volume’s maximum mount count

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] 
-maxmounts max_mounts -m media_id

Change a volume’s number of mounts count or cleanings

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -n 
num_mounts/cleanings -m media_id

Change a volume’s media type

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -new_mt 
media_type -m media_id
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Change a volume’s robot type

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -new_rt 
robot_type -m media_id -rn robot_number

Change a volume’s group

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -new_v 
volume_group [-m media_id |-b barcode -mt media_type -rt 
robot_type]

Change a volume’s vault name 

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -vltname 
vault_name -m media_id

Change the date the volume was sent to the vault

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -vltsent 
mm/dd/yy hh:mm:ss -m media_id

Change the date when the volume returns from the vault

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] 
-vltreturn mm/dd/yy hh:mm:ss -m media_id

Change a volume’s vault slot number

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] -vltslot 
vault_slot -m media_id

Change the volume’s vault session id

/usr/openv/volmgr/bin/vmchange [-h volume_database_host] 
-vltsession vault_session_id -m media_id

Move (eject) volumes from an ACS, TLH, or TLM robot to standalone

/usr/openv/volmgr/bin/vmchange -api_eject -map map_id -w [-h 
volume_database_host] -res -ml media_id1:media_id2: ... 
media_idn -rt robot_type -rn robot_number -rh robot_host [-v 
volume_group]

Move (eject) multiple volumes from a TL8 or TLD robot to standalone

/usr/openv/volmgr/bin/vmchange -multi_eject -w [-h 
volume_database_host] -res -ml media_id1:media_id2: ... 
media_idn -rt robot_type -verbose -rn robot_number -rh 
robot_host

Move (inject) multiple volumes into a TL8 or TLD robot

/usr/openv/volmgr/bin/vmchange -multi_inject -w -res -rt 
robot_type -verbose -rn robot_number -rh robot_host
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Get robot information for a TL8 or TLD robot type

/usr/openv/volmgr/bin/vmchange -res -robot_info -verbose -rn 
robot_number -rt robot_type -rh robot_host

DESCRIPTION

Change volume information in the Media Manager volume database. 

OPTIONS

Note The following option is only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which keeps 
information about the media in robots and standalone drives. If no host 
is specified, the host where you execute the command is assumed.

-vg_res
Change volume group residence.

-rt robot_type
Specifies the robot type of the robot where the volume is located.
Valid robot types for NetBackup DataCenter are: none, acs, lmf, odl, rsm, 
tl4, tl8, tld, tlh, tlm, ts8, tsd, tsh.
Valid robot types for NetBackup BusinesServer are: none, rsm, tl4, tl8, tld, 
ts8, tsd.

-rn robot_number
Unique, logical identification number for the robot where the volume is 
located.

-rh robot_host
Name of the host which controls the robot, where the volume is located.

-v volume_group
A volume group is a logical grouping that identifies a set of volumes 
that reside at the same physical location.

-res
Change the volume’s residence.

-m media_id
Specifies the media ID of the volume to change.

-mt media_type
Specifies the media type of the volume to change. 
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Valid media types for NetBackup DataCenter are: 4mm, 8mm, 8mm2, 
8mm3, dlt, dlt2, dlt3, dtf, hcart, hcart2, hcart3, odiskwm, odiskwo, qcart, 
4mm_clean, 8mm_clean, 8mm2_clean, 8mm3_clean, dlt_clean, 
dlt2_clean, dlt3_clean, dtf_clean, hcart_clean, hcart2_clean, hcart3_clean.
Valid media types for NetBackup BusinesServer are: 4mm, 8mm, dlt, 
hcart, qcart, 4mm_clean, 8mm_clean, dlt_clean, hcart_clean.

-rc1 rob_slot
Robot coordinate 1 is the slot number in the robot where the volume is 
located.
For NetBackup DataCenter, do not enter slot information for API robot 
types. The robot software tracks the slot locations for these robots.
For NetBackup BusinesServer, do not enter slot information for RSM 
robot types. The robot software tracks the slot locations for these robots.

Note The following option is only applicable for NetBackup DataCenter.

-rc2 rob_side
Robot coordinate 2 is the platter side for optical disks (A or B).

-exp mm/dd/yy hh:mm:ss
Expiration date for this volume.

-barcode barcode
Specifies the barcode attached to the volume.

-d "media_description"
Media description for the volume. The double quote marks are required 
if the description contains any spaces.

-p pool_number
Index of the volume pool which will contain this volume. You can get 
the pool index using vmpool -listall.

-maxmounts max_mounts
Maximum number of mounts allowed for this volume. Only used for 
non-cleaning media.

-n num_mounts/cleanings
For non-cleaning media, num_mounts is the number of times this volume 
has been mounted.
For cleaning media, cleanings is the number of cleanings left for this 
cleaning tape.

-new_mt media_type
Specifies the media type of the volume to change. See the -mt option for 
a list of media types.
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-new_rt robot_type
Specifies the robot type. See the -rt option for a list of robot types.

-new_v volume_group
A volume group is a logical grouping that identifies a set of volumes 
that reside at the same physical location.

-b barcode
Specifies the barcode attached to the volume.

-vltname vault_name
Specifies the name of the logical vault configured for the robot that 
ejected the volume.

-vltsent mm/dd/yy hh:mm:ss
Specifies the date the volume was sent offsite.

-vltreturn mm/dd/yy hh:mm:ss
Specifies the date the volume was requested for return from the vault 
vendor.  For catalog backup volumes, this is the date that the volume will 
be requested for return from the vault vendor.

-vltslot vault_slot
Specifies the vault vendor’s slot number for the slot that this volume 
occupies.

-vltsession vault_session_id
Specifies the id of the vault session that ejected this media.

-api_eject
Eject ACS, TLH, or TLM volumes from the specified robot.

-map map_id
Specifies the media access port. For ACS robot types this is the CAP ID 
(which has the format: ACS, LSM, CAP).

-w
Wait flag. This flag must be used with the eject, multiple eject, and 
multiple inject commands.

-verbose
Selects verbose mode.

-ml media_id1:media_id2: ... media_idn
Specifies a list of media to be ejected from the robot.

-robot_info
Used to retrieve information about a robotic library. This option is valid 
only for TLD and TL8 robot types

-multi_eject
Use the robotic library’s media access port to eject multiple volumes.
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-multi_inject
Use the robotic library’s media access port to inject multiple volumes.

EXAMPLES

The following command changes the expiration date of volume AJS100:

vmchange -exp 12/31/99 23:59:59 -m AJS100

The following command changes the pool (which contains volume AJS999) to pool 1 
(which is the NetBackup pool):

vmchange -h dill -p 1 -m AJS999

The following command ejects volumes abc123 and abc124 from ACS robot number 
700. The residences for these two volumes are changed to standalone.

vmchange -res -api_eject -w -ml abc123:abc124 -rt acs -rn 700 -rh 
verbena -map 0,0,0

CAUTIONS

Only limited validation of the option parameters is done.

Some robotic libraries implement different functionality for their media access ports. For 
example, some libraries have front-panel inject and eject features that conflict with 
NetBackup’s use of the media access port (for example, Spectra Logic Bullfrog). Other 
libraries require front-panel interaction when using the media access port (for example, 
Spectra Logic Gator).

Make sure you read the operator manual for your robotic library to gain an understanding 
of its media access port functionality. Libraries such as the ones noted may not be fully 
compatible with NetBackup’s inject and eject features if not properly handled. Other 
libraries may not be compatible at all.

SEE ALSO

vmadd(1M), vmdelete(1M), vmpool (1M), vmquery(1M)
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NAME

vmcheckxxx - Report the media contents of a robotic library

SYNOPSIS

/usr/openv/volmgr/bin/vmcheckxxx -rt robot_type -rn robot_number 
[-rh robot_host] [-h volume_database_host] [[-if 
inventory_filter_value] [-if inventory_filter_value] ...] [-full] 
[-list]

DESCRIPTION

Report the media contents of a robotic library and optionally compare its contents with 
the volume configuration. 

If no options are specified, the media contents of the robot and the volume configuration 
are listed along with a list of any mismatches detected.

OPTIONS

-rt robot_type
Specifies the robot type of the robot to inventory.
Valid robot types for NetBackup DataCenter are: none, acs, lmf, odl, rsm, 
tl4, tl8, tld, tlh, tlm, ts8, tsd, tsh.
Valid robot types for NetBackup BusinesServer are: none, rsm, tl4, tl8, tld, 
ts8, tsd.

-rn robot_number
Unique, logical identification number of the robot to inventory.

-rh robot_host
Name of the host which controls the robot. If no host is specified, the host 
where you execute this command is assumed.

Note The following two options are only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which contains 
information about the volumes in a robot. If no host is specified, the host 
where you execute this command is assumed.

-if inventory_filter_value
Specifies inventory filter values. Multiple -if options may be specified. 
The inventory filter value is an ACS scratch pool ID, a TLH volume 
category, or an LMF barcode prefix.
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The -if and -full options cannot be specified together.

-full
Specifies full inventory. The -full and -if options cannot be specified 
together.

-list
Lists the robot contents.

EXAMPLES

The following command lists the media contents of TLD robot 1 and the volume 
configuration for that robot on the host named niagra, along with a list of any mismatches 
that are detected:

vmcheckxxx -rt tld -rn 1 -rh niagra -h niagra

The following command lists the contents of TLH robot 2 that is connected to the host 
where the vmcheckxxx command was executed:

vmcheckxxx -rt tlh -rn 2 -list

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmupdate(1M)
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NAME

vmd - Media Manager volume daemon

SYNOPSIS

/usr/openv/volmgr/bin/vmd [-v]

DESCRIPTION

vmd manages the volume database, responding to requests to add, change, list, or delete 
volumes. By maintaining the location of media, vmd allows volumes to be removed and 
recognized by Media Manager. vmd is used with the Media Manager device daemon 
(ltid) to determine the location of requested volumes and keep track of the number of 
mounts and last mount time. vmd is initiated by ltid, but remains running when ltid is 
terminated using stopltid.

ltid does not require volumes to be defined in the volume database before being used. 
Automatic mounting of volumes in robotic devices, however, does not take place until 
volumes are defined and their slot information (for non API robots on NetBackup 
DataCenter) is entered in the volume database.

A direct interface to the volume database is provided to easily facilitate volume database 
administrative activities. Graphical, menu-driven, and command line Media Manager 
utilities are provided.

vmd is also used for remote Media Manager device management and for managing the 
volume pool, barcode rules, and global device databases.

In addition, for NetBackup DataCenter, vmd is the device allocator (DA) for shared drives. 
vmd/DA maintains shared drive and host information, such as a list of hosts that are 
registered to share a drive and which host currently has the drive reserved. 

Shared drive information is modified only by requests from ltid. When ltid initializes 
on a device host, it calls vmd/DA with a list of shared drives. vmd/DA adds these drives 
and the host name to its configuration, if necessary. Since ltid passes a complete list of 
drives each time, vmd/DA deletes references to drives for that host when a change in 
configuration removes them from that host’s shared drive list. This deletion occurs when 
ltid shuts down gracefully or after it is restarted.

The Internet service number for vmd must be in /etc/services. If you are using NIS 
(Network Information Service), the entry found in this host’s /etc/services file should 
be placed in the master NIS server database for services. To override the services file, 
create the file /usr/openv/volmgr/database/ports/vmd with a single line 
containing the service number for vmd. The default service number is 13701.
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OPTION

-v Logs detailed debug information if you create the debug/daemon 
directory (see ERRORS). Specify this option only if problems occur or if 
requested by VERITAS support.

ERRORS

vmd logs an error message using syslogd, if there is a copy of vmd running.

vmd logs an error message using syslogd, if the port that it binds to is in use. If this 
occurs, it may be necessary to override the services file using the mechanism described 
under DESCRIPTION.

To run vmd in debug mode do the following:

1. Before starting vmd, create the following directory:

/usr/openv/volmgr/debug/daemon

If vmd is running, stop and restart it after creating the directory.

2. Start vmd in verbose mode as follows or put a VERBOSE entry in vm.conf.

/usr/openv/volmgr/bin/vmd -v

3. Check the log in /usr/openv/volmgr/debug/daemon.

If problems persist, you can obtain more debug information on the requestor by creating 
the following directory: /usr/openv/volmgr/debug/reqlib.

One log per day is created in each debug directory. These logs continue to build until the 
debug directory is moved or removed, unless you specify a DAYS_TO_KEEP_LOGS entry 
in vm.conf. Do not remove the debug directory while vmd is running. Running vmd in 
debug mode should be done only when necessary.

FILES

/usr/openv/volmgr/database/volDB

/usr/openv/volmgr/database/poolDB

/usr/openv/volmgr/database/ruleDB

/usr/openv/volmgr/database/globDB

/usr/openv/volmgr/debug/daemon/*

/usr/openv/volmgr/debug/reqlib/*

SEE ALSO

ltid(1M), vmadm(1M), vmadd (1M), vmchange (1M), vmdelete (1M), 
vmquery (1M)
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NAME

vmdelete - Delete volumes from the volume database

SYNOPSIS

/usr/openv/volmgr/bin/vmdelete [-h volume_database_host] [-m 
media_id | -v volume_group]

DESCRIPTION

Delete volumes from the volume database.

OPTIONS

Note The following option is applicable only for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which contains 
information about the volumes in a robot. If no host is specified, the host 
where you execute the command is assumed.

-m media_id
Specifies the media id of the volume to delete from the volume database.

-v volume_group
Specifies the volume group to delete. All volumes in this group are 
deleted from the volume database.

EXAMPLES

The following command deletes a single volume:

vmdelete -m AJS144

The following command deletes all volumes with the volume group name of 
DELETE_ME:

vmdelete -v DELETE_ME

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmadd(1M), vmchange(1M), vmquery(1M)
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NAME

vmoprcmd - perform operator functions on drives

SYNOPSIS

/usr/openv/volmgr/bin/vmoprcmd [-h device_host] -down | -up | 
-upopr | -reset drive_index | -downbyname | -upbyname | 
-upoprbyname | -resetbyname drive_name | 
-crawlreleasebyname drive_name | -comment drive_index 
["comment"] | -commentbyname drive_name ["comment"] | 
-assign drive_index mount_request_id | -assignbyname 
drive_name mount_request_id | -deny | -resubmit 
mount_request_id | -d [pr | ds | ad] | -help

DESCRIPTION

Perform operator functions on drives. The -h option is not required, but you must choose 
one and only one of the other options listed below.

OPTIONS

-h device_host
Name of the device host where the drives are attached and configured. 
If no host option is specified, the device host where you execute the 
command is assumed.
For NetBackup BusinesServer, the device host is the host where Media 
Manager is installed.

-down | -up | -upopr | -reset drive_index
-down Sets the drive to the DOWN state, if it is not assigned.
-up Sets the drive to UP in Automatic Volume Recognition (AVR) 
mode. This is the normal mode for all drives.
-upopr Sets the drive to UP in Operator (OPR) mode. This mode is 
normally used only for security reasons. For a drive in a robot, OPR and 
AVR are treated identically while the robot daemon is up.
-reset Resets the specified drive, terminating the drive assignment 
and taking control away from the assigned user.

Caution Do not reset an assigned drive unless directed by site policy or the system 
administrator. Terminating an active job can destroy user data.
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-downbyname | -upbyname | -upoprbyname | -resetbyname drive_name
These options are similar to -down, -up, -upopr, and -reset 
respectively, except the drive is specified by the drive name instead of 
drive index.

-comment drive_index ["comment"]
Add a comment for the drive. The quotes are required if your comment 
contains any spaces. If you do not specify comment, any existing 
comments for the drive are deleted.

-commentbyname drive_name ["comment"]
This option is similar to the -comment option, except the drive is 
specified by the drive name instead of drive index.

-assign drive_index mount_request_id
Assign a drive to a mount request.

-assignbyname drive_name mount_request_id
This option is similar to the -assign option, except the drive is 
specified by the drive name instead of drive index.

-deny | -resubmit mount_request_id
-deny Denying a mount request returns an error message to the user.
-resubmit Resubmit a mount request. If a pending action message 
involves a robot, you must correct the problem and resubmit the request 
that caused the message.

-d [pr | ds | ad]
If none of the following optional display parameters are specified, all 
information is displayed.
pr Display pending requests.
ds Display the status of drives under control of Media Manager.
ad Display additional status of drives under control of Media Manager.

-help
Display the usage statement for this command.

-crawlreleasebyname drive_name
This option forces all hosts (that are registered to use the drive) to issue a 
SCSI release command to the drive. Issue this option on the host that is 
the SSO device allocator (DA host) or use the -h option to specify the DA 
host.

Caution Use this option after a PEND status has been seen in Device Monitor. Do not use 
this option during backups.
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EXAMPLES

The following command sets the drive, with a drive index of 0, to UP mode:

vmoprcmd -up 0

The following command displays the drive status of all drives:

vmoprcmd -d ds

The following command displays pending requests and the drive status of all drives on 
the device host named crab:

vmoprcmd -h crab

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

tpconfig(1M)
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NAME

vmpool - Manage volume pools

SYNOPSIS

/usr/openv/volmgr/bin/vmpool [-h volume_database_host] -listall 
[-b] | -listscratch | -add pool_name "description" host uid 
gid | -change pool_name "description" host uid gid | -delete 
pool_name | -set_scratch pool_name | -unset_scratch 
pool_name

DESCRIPTION

Use this command to add, change, delete, or list volume pools. 

The -h option is not required, but you must choose one and only one of the other seven 
options (for example, -listscratch).

OPTIONS

Note The following option is only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which keeps 
information about the media in a robot. If no host is specified, the host 
where you execute the command is assumed.

-listall [-b]
List information about all volume pools. You can use the -b option to 
specify a brief format for volume pool information.

-listscratch
List all configured scratch pools.

-add pool_name "description" host uid gid
Add a new volume pool.

-change pool_name "description" host uid gid
Change an existing volume pool.

-delete pool_name
Delete a volume pool.

“description”
Description of the volume pool. The double quote marks are required if 
the description contains any spaces.
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host
Name of the host that will be permitted to request and use volumes in 
this volume pool.
For NetBackup DataCenter to permit only a specific host to access the 
volume pool, enter the name of that host. To permit any host to access 
the volume pool, enter ANYHOST. Using the value ANYHOST is 
recommended.
For NetBackup BusinesServer, you can only specify the value 
ANYHOST.

uid
Specifies the user id of the user that is permitted to request and use 
volumes in the volume pool. Enter a specific user id to permit only 
processes running at that user id, to access the volume pool.
Enter the default value, -1 (ANY), to permit any user id to access the 
pool.
For a NetBackup or Storage Migrator (NetBackup Datacenter only) 
volume pool, always enter the user id for root.
If you specify a specific user id and a different user id requests the pool, 
then Media Manager verifies the group id (see gid).

gid
Enter the group id of the group that is permitted to request and use 
volumes in this volume pool.
Enter a specific group id to permit only processes running as that group 
id, to access the volume pool.
Enter the default value, -2 (NONE), to permit only the user id specified 
by uid to request or access the volume pool.

-set_scratch pool_name
If pool_name is a previously defined volume pool, pool_name will 
become the scratch pool and its description will not be changed. The 
NetBackup, DataStore, and None volume pools cannot be changed to 
scratch pools.
If pool_name is a new volume pool, a new pool will be created with 
"Scratch Pool" as the description. 
Only one scratch pool at a time can be defined.

-unset_scratch pool_name
Undefines pool_name as the scratch pool and defines it as a regular 
volume pool. The pool can be deleted using vmpool -delete 
pool_name.
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EXAMPLES

The following command adds a new pool named MyPool on the host named llama with 
the default host, user id, and group id permissions:

vmpool -h llama -add MyPool "my description with spaces" ANYHOST -1 
-2

The following command lists all pools configured on the host where the command is 
executed:

vmpool -listall -b

NOTES

Only limited validation of the option parameters is done.

uid and gid should only be used for restricting access to volumes by user or by group on 
UNIX hosts.
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NAME

vmquery - Query the volume database, or assign and unassign volumes

SYNOPSIS

/usr/openv/volmgr/bin/vmquery [-h volume_database_host, ... -h 
volume_database_host] [-b | -w] -a | -m media_id | -v 
volume_group | -rn robot_number | -rt robot_type | -mt 
media_type | -p pool_number | -pn pool_name | -res 
robot_type robot_number robot_host rob_slot rob_side | 
-assignbyid media_id media_type pool_number stat asg_time | 
-deassignbyid media_id pool_number stat

DESCRIPTION

Query the volume database for volume information. The -h, -b, and -w options are not 
required, but you must choose only one of the other (eleven) options. 

The -b or -w option can be used in conjunction with any of the other eleven options, but 
the -b or -w options cannot be specified together.

OPTIONS

Note The following option is applicable only for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database maintaining information 
about the volumes in a robot. If no host is specified, the host where you 
execute the command is assumed. Up to 100 volume database hosts can 
be queried.

-b
Specifies the brief output format for volume information. This option 
can be used in conjunction with any of the other eleven options.

-w
Specifies the wide output format for volume information. This option 
includes additional information not shown by the -b option and can be 
used in conjunction with any of the other eleven options.

-a
Show all volumes.
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-m media_id
Query volumes by media id. The media id is a maximum of 6 ASCII 
characters.

-v volume_group
Query volumes by volume group. A volume group is a logical grouping 
that identifies a set of volumes that reside at the same physical location.

-rn robot_number
Query volumes by robot number. A robot number is a unique, logical 
identification number for the robot where the volume is located.

-rt robot_type
Query volumes by the type of the robot where the volume is located. 
Valid robot types for NetBackup DataCenter are: none, acs, lmf, odl, rsm, 
tl4, tl8, tld, tlh, tlm, ts8, tsd, tsh.
Valid robot types for NetBackup BusinesServer are: none, rsm, tl4, tl8, tld, 
ts8, tsd.

-mt media_type
Query volumes by media type. 
Valid media types for NetBackup DataCenter are: 4mm, 8mm, 8mm2, 
8mm3, dlt, dlt2, dlt3, dtf, hcart, hcart2, hcart3, odiskwm, odiskwo, qcart, 
4mm_clean, 8mm_clean, 8mm2_clean, 8mm3_clean, dlt_clean, 
dlt2_clean, dlt3_clean, dtf_clean, hcart_clean, hcart2_clean, hcart3_clean.
Valid media types for NetBackup BusinesServer are: 4mm, 8mm, dlt, 
hcart, qcart, 4mm_clean, 8mm_clean, dlt_clean, hcart_clean.

-p pool_number
Query volumes by pool number. Pool number is an index into the 
volume pool. You can use vmpool -listall to determine the index for 
a given pool name.

-pn pool_name
Query volumes by pool name.

-res robot_type robot_number robot_host rob_slot rob_side
Query volumes by residence.

robot_host
Name of the host which controls the robot, where the volume is located.

rob_slot
This is the slot number in the robot (robot coordinate 1) where the 
volume resides.

rob_side
This is the platter side (robot coordinate 2) for optical disks (A or B). If the 
volume is not an optical disk, specify zero for rob_side.
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-assignbyid media_id media_type pool_number stat asg_time
Assign volume by media id, pool, and status.

stat
Status applies only to volumes that are assigned to NetBackup or 
Storage Migrator.
A status of 0 means the volume is assigned to NetBackup regular 
backups.
A status of 1 means the volume is assigned to NetBackup catalog 
backups.
A status of 2 means the volume is assigned to Storage Migrator (valid 
with NetBackup DataCenter only).
A status of 3 means the volume is assigned to Storage Migrator for 
Microsoft Exchange or Storage Migrator for Windows 2000.

asg_time
Applies only to volumes assigned to NetBackup or Storage Migrator 
(NetBackup DataCenter only).
asg_time is the time when the volume was assigned and is the number of 
seconds since 00:00:00 UTC, January 1, 1970. asg_time was originally 
created using the time() call.

-deassignbyid media_id pool_number stat
Unassign volume by media id, pool, and status.

Caution Unassigning volumes may cause inconsistencies between the application media 
database and the volume database, leading to possible data loss. You must use a 
NetBackup application interface (for example, NetBackup Console) to expire 
the media after unassigning volumes.

EXAMPLES

The following command lists all volume information, in brief format from the volume 
database on the host named llama:

vmquery -h llama -b -a

The following command assigns volume A23456, which is in pool 1 (NetBackup), and sets 
the status to 0 and the assign time to 12/31/98 15:50:22:

vmquery -assignbyid A23456 8mm 1 0 915141022

The following command unassigns volume A23456, which is in pool 1 (NetBackup), with 
a status of 0:

vmquery -deassignbyid A23456 1 0
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NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmadd(1M), vmchange(1M), vmdelete(1M), vmpool(1M)
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NAME

vmrule - Manage barcode rules

SYNOPSIS

/usr/openv/volmgr/bin/vmrule [-h volume_database_host] -listall 
[-b] | -add barcode_tag media_type pool_name max_mounts 
“description” | -change barcode_tag media_type pool_name 
max_mounts “description“ | -delete barcode_tag

DESCRIPTION

Use this command to add, change, delete, or list barcode rules. The -h option is not 
required, but you must chose one and only one of the other four options.

OPTIONS

Note The following option is only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which contains 
information about the volumes in a robot. If no host is specified, the host 
where you execute the command is assumed.

-listall [-b]
List information about all barcode rules. You can use the -b option to 
specify a brief format for the barcode rule information that is displayed.

-add barcode_tag media_type pool_name max_mounts “description”
Add a new barcode rule.

-change barcode_tag media_type pool_name max_mounts “description”
Change a barcode rule.

-delete barcode_tag
Delete a barcode rule.

barcode_tag
Specifies the barcode prefix which will invoke the barcode rule.

media_type
Specifies the media type of the volume, a barcode rule attribute. This 
affects whether the rule will be used and also affects the media type for 
volumes added using a robot inventory update.
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Valid media types for NetBackup DataCenter are: 4mm, 8mm, 8mm2, 
8mm3, dlt, dlt2, dlt3, dtf, hcart, hcart2, hcart3, odiskwm, odiskwo, qcart, 
4mm_clean, 8mm_clean, 8mm2_clean, 8mm3_clean, dlt_clean, 
dlt2_clean, dlt3_clean, dtf_clean, hcart_clean, hcart2_clean, hcart3_clean.
Valid media types for NetBackup BusinesServer are: 4mm, 8mm, dlt, 
hcart, qcart, 4mm_clean, 8mm_clean, dlt_clean, hcart_clean.

pool_name
Specifies the pool to which the volumes will be added.

max_mounts
Maximum number of mounts allowed for this volume (when the volume 
is added). This option is used only for non-cleaning media.  When this 
limit is exceeded, the volume can only be mounted for read operations.

“description”
Description of the barcode rule. The double quote marks are required if 
the description contains any spaces.

EXAMPLES

The following command creates a rule that defines any tape with a barcode starting with 
ABC is a DLT tape in the NetBackup pool. The tape can be mounted up to 100 times for 
writes and is given a description.

vmrule -add ABC dlt NetBackup 100 "DLT cleaning tape"

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmupdate(1M)
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NAME

vmupdate - Inventory the media contents of a robotic library and update the volume 
database

SYNOPSIS

/usr/openv/volmgr/bin/vmupdate -rt robot_type -rn robot_number [-rh 
robot_host] [-h volume_database_host] [[-if 
inventory_filter_value] [-if inventory_filter_value] ...] [-full] 
[-recommend] [-interactive] [-involgrp volume_group] 
[-outvolgrp volume_group] [-mt media_type] [-p pool_name] 
[-use_barcode_rules] [-use_seed] [-mp media_id_prefix] 
[-no_sides] [-no_format_optical] [-overwrite_labels] 
[-empty_map]

DESCRIPTION

Inventory the media contents of a robotic library and update the volume database. If no 
options are specified, the volume configuration is updated to match the robot contents.

OPTIONS

-rt robot_type
Specifies the robot type of the robot to inventory.
Valid robot types for NetBackup DataCenter are: none, acs, lmf, odl, rsm, 
tl4, tl8, tld, tlh, tlm, ts8, tsd, tsh.
Valid robot types for NetBackup BusinesServer are: none, rsm, tl4, tl8, tld, 
ts8, tsd.

-rn robot_number
Unique, logical identification number for the robot to inventory.

-rh robot_host
Name of the host which controls the robot. If no host is specified, the host 
where you execute this command is assumed.

Note The following two options are only applicable for NetBackup DataCenter.

-h volume_database_host
Name of the host that has the volume database which contains 
information about the volumes in a robot. If no host is specified, the host 
where you execute this command is assumed.
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-if inventory_filter_value
Specifies inventory filter values. Multiple -if options may be specified. 
The inventory filter value is an ACS scratch pool ID, a TLH volume 
category, or an LMF barcode prefix.
The -if and -full options cannot be specified together.

-full
Specifies full inventory. The -full and -if options cannot be specified 
together.

-recommend
Lists changes required to update the volume configuration.

-interactive
Prompts you before updating the volume configuration.

-involgrp volume_group
Specifies the volume group for media moved into the robot.

-outvolgrp volume_group
Specifies the volume group for media moved out of the robot.

-mt media_type
Specifies the media type of the volume.
Valid media types for NetBackup DataCenter are: 4mm, 8mm, 8mm2, 
8mm3, dlt, dlt2, dlt3, dtf, hcart, hcart2, hcart3, odiskwm, odiskwo, qcart, 
4mm_clean, 8mm_clean, 8mm2_clean, 8mm3_clean, dlt_clean, 
dlt2_clean, dlt3_clean, dtf_clean, hcart_clean, hcart2_clean, hcart3_clean.
Valid media types for NetBackup BusinesServer are: 4mm, 8mm, dlt, 
hcart, qcart, 4mm_clean, 8mm_clean, dlt_clean, hcart_clean.

-p pool_name
Specifies the name of the volume pool to which new media will be 
assigned.

-use_barcode_rules
Specifies that barcode rules will be used for assigning attributes to new 
media.

-use_seed
Specifies automatic generation of media IDs for media with no barcodes.

-mp media_id_prefix
Specifies the prefix that is used as a seed to generate new media IDs for 
media with no barcodes.

-no_sides
Specifies that any new optical media IDs will not always contain platter 
side A or B.
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-no_format_optical
Specifies to NOT format new optical media.

-overwrite_labels
Specifies that existing labels will be overwritten when formatting optical 
media.

-empty_map
Specifies that volumes in the media access port (map) will be moved into 
the robot before the robot inventory is started. This option is only valid 
for TL8, TLD, or TLM robot types.

EXAMPLES

The following command updates the volume configuration on the host named mymaster 
to match the contents of TLD robot 7 connected to the host macris:

vmupdate -rt tld -rn 7 -rh macris -h mymaster

NOTES

Only limited validation of the option parameters is done.

SEE ALSO

vmcheckxxx(1M)
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Media Manager Reference Topics
 B

This chapter includes the following Media Manager reference and conceptual topics:

� Robot Overview

� Correlating Device Files to Physical Drives When Adding Drives

� Drive Cleaning

� Volume Pools and Volume Groups

� Barcodes

� vmd Security

� How Media Manager Selects a Drive for a Robotic Mount Request

� Administrators Quick Reference

� Media Manager Configuration File (vm.conf)

Robot Overview
In Media Manager, a robot is a peripheral device that contains a mechanism for the 
automated mounting and dismounting of media in tape drives. A robot may also be called 
a robotic library, media changer, automated library, jukebox, or tape stacker. Media 
Manager considers any of these types of devices to be robots. Media Manager software 
that controls robots is referred to as robotic control software.

Media Manager Robot Types
Media Manager classifies robots by robot type, according to one of the following:

� The physical characteristics of the robot.

Library usually refers to a larger robot, in terms of slot capacity or number of drives.

Stacker usually refers to a robot with one drive and low media capacity.

� The media type commonly used by that class of robots.
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4 MM and 8 MM are examples of media types.

The following table lists the Media Manager robot types, with drive and slot limits for 
each type. Visit the VERITAS support web site (http://www.support.veritas.com) 
to determine which robot type applies to the model of robot that you are using.

Media Manager Media Types
Media Manager uses media types to differentiate tape media with differing physical 
characteristics. Each Media Manager media type may represent a specific physical media 
type, for example Sony AIT media can have a Media Manager media type of 8MM, 
8MM2, or 8MM3.

The following table lists the Media Manager media types:

Media Manager Robot Types

Robot Type Description Drive Limits Slot Limits

RSM Removable Storage Manager 2 30

TL4 Tape Library 4MM 1 15

TL8 Tape Library 8MM 2 30

TLD Tape Library DLT 2 30

TS8 Tape Stacker 8MM 2 21

TSD Tape Stacker DLT 1 14

Media Manager Media Types

Media Type Description

QCART 1/4 inch cartridge tape

HCART 1/2 inch cartridge tape

4MM 4MM cartridge tape

8MM 8MM cartridge tape

DLT DLT cartridge tape
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Robot Attributes
Media Manager configures and controls a robot device differently depending on the robot 
type. The following tables list the attributes that dictate how these robot types differ.

Note See the NetBackup release notes or visit the VERITAS support web site for more 
detailed information on supported peripherals, platforms, and firmware levels 
tested.

HC_CLN 1/2 inch cleaning tape

4MM_CLN 4MM cleaning tape

8MM_CLN 8MM cleaning tape

DLT_CLN DLT cleaning tape

Media Manager Media Types (continued)

Media Type Description

RSM Robot Attributes

Attribute Comment

SCSI Control No

LAN Control No

Remote Robot Control No

NDMP Support No

Shared Drives Support No

Media Type Support 4MM

8MM

DLT

HCART

QIC
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Barcode Support Yes, if the robot supports barcodes. Barcodes are assumed to 
be the same as the media ID.

Drive Cleaning Support No, drive cleaning is supported using the RSM utilities in 
Windows 2000.

Media Access Port Support Eject is supported. Inject is not supported, but the Windows 
2000 RSM Inject wizard can be used.

Media Manager Tracks Slots No

For More Information See the RSM appendix in the NetBackup Media Manager 
system administrator’s guide for Windows.

Robot Examples Exabyte 210

Quantum DLTStor

Host Supported Windows 2000

TL4 Robot Attributes

Attribute Comment

SCSI Control Yes

NDMP Support No

Media Type Support 4MM

Barcode Support No, but the robot has inventory capability and can report 
whether a slot has media.

Drive Cleaning Support Yes

Media Access Port  Support No

Media Manager Tracks Slots Yes

For More Information See the NetBackup Media Manager device configuration guide 
for UNIX.

RSM Robot Attributes (continued)

Attribute Comment
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Robot Examples ADIC 4mm DAT Autochanger

HP DAT Autoloader

Host Supported Windows 

UNIX

TL8 Robot Attributes

Attribute Comment

SCSI Control Yes

NDMP Support Yes

Media Type Support 8MM

Barcode Support Yes

Drive Cleaning Support Yes

Media Access Port  Support Yes

Media Manager Tracks Slots Yes

For More Information See the NetBackup Media Manager device configuration guide 
for UNIX.

Robot Examples IBM 7331

Exabyte X200

Host Supported Windows 

UNIX

TL4 Robot Attributes (continued)

Attribute Comment
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TLD Robot Attributes

Attribute Comment

SCSI Control Yes

NDMP Support Yes

Media Type Support DLT

8MM

HCART

Barcode Support Yes

Drive Cleaning Support Yes

Media Access Port  Support Yes

Media Manager Tracks Slots Yes

For More Information See the NetBackup Media Manager device configuration guide 
for UNIX.

Robot Examples ADIC Scalar

HP SureStore DLT Library

STK 7430

Host Supported Windows 

UNIX

TS8 Robot Attributes

Attribute Comment

SCSI Control Yes

NDMP Support No

Media Type Support 8MM
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Barcode Support Yes

Drive Cleaning Support Yes

Media Access Port  Support No

Media Manager Tracks Slots Yes

For More Information See the NetBackup Media Manager device configuration guide 
for UNIX.

Robot Examples Exabyte 10x

Exabyte 210

Host Supported Windows

UNIX

TSD Robot Attributes

Attribute Comment

SCSI Control Yes

NDMP Support Yes

Media Type Support DLT

Barcode Support No, but the robot has inventory capability and can report 
whether a slot has media.

Drive Cleaning Support Yes

Media Access Port  Support No

Media Manager Tracks Slots Yes

For More Information See the NetBackup Media Manager device configuration guide 
for UNIX.

TS8 Robot Attributes (continued)

Attribute Comment
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Table-Driven Robotics
Table-driven robotics provides support for some new library devices without the need to 
modify any robotic library control binaries. This feature uses external device mapping 
files for supported robots and drives.

This means that support for your new or upgraded devices may be accomplished without 
waiting for a patch from VERITAS. Since the external device mapping files include 
pertinent information relating to the operation and control of libraries, support for some 
new devices may only require that you download an updated external mapping file when 
any device changes are made to your configuration.

See “External Device Mapping Files” on page 25 for information on how to download the 
latest mapping files for your devices.

Robotic Test Utilities
You can use the robotic test utilities for configured robots by executing 
/usr/openv/volmgr/bin/robtest and selecting the desired robotic library.

From each test utility, you can obtain a list of available test commands by entering a 
question mark.

Correlating Device Files to Physical Drives When Adding 
Drives

The following two topics may not be necessary, if you used the Device Configuration 
Wizard to configure your drives, and the drives and robotic libraries both support device 
serialization.

� Correlating On Windows Hosts.

� Correlating On UNIX Hosts.

Robot Examples Sun StorEdge L280

Quantum DLTStor

Host Supported Windows 

UNIX

TSD Robot Attributes (continued)

Attribute Comment
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Correlating On Windows Hosts
When selecting the drive address (for example, robot drive number) for a tape drive, 
match the logical device name with the drives in the physical drive layout as follows:

1. Note the SCSI target of the drive and check the Windows Tape Devices display to 
determine which device name (for example, Tape0) was assigned to the drive.

2. Correlate the SCSI target to the drive address using the robot’s interface panel or 
checking the indicators on the rear panel of the tape drive.

3. Determine the physical drive address (for example, number) by checking labels on the 
robot itself or by using the diagrams in the Robot Drive and Slot Layout appendix. 
This appendix shows the layout for many of the robots that Media Manager supports.

4. Configure the robot and then add the drives.

When you add the drives, check your notes to ensure that you are assigning the 
correct drive address to each device path.

5. Optionally, use the appropriate robotic test utility to verify the configuration.

a. Stop the NetBackup Device Manager service (ltid).

b. Start ltid to start the Automatic Volume Recognition process (avrd). 

You must stop and restart ltid to ensure that the current device configuration 
has been activated.

c. Use the robotic test utility to mount a tape on a drive.

d. Use the Device Monitor to verify the tape was mounted on the correct robot drive.

For example, assume you have the following drives in a TLD robot and have the 
device names configured as follows:

Drive 1: Tape0

Drive 2: Tape1

Also assume that in step c you requested that the tape be mounted on Drive 1. If the 
device name for the drive is correctly configured, the Device Monitor shows the tape 
mounted on Drive 1. Unload and unmount the tape from Drive 1 using the robotic 
test utility. Repeat the test for each drive.

During your testing, if the Device Monitor shows the tape mounted on a drive other 
than the drive you specified in the test utility, the device name for that drive is not 
correctly configured. For instance, if you mounted a tape on Drive 2 and the Device 
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Monitor shows the tape mounted on Drive 1, the device name for Drive 2 is incorrect. 
Replace the Drive 2 device name (Tape1) with the correct device name (Tape0) for 
Drive 1. You may need to use a temporary device name while making these changes. 

Correlating On UNIX Hosts
Establish device file to physical drive correlation during installation when you create the 
device files for each drive. The following is a general procedure:

1. Determine the physical location of each drive within the robotic library. This is 
usually shown on the connectors to the drives or in the vendor’s documentation. The 
Robot Drive and Slot Layout appendix shows drive locations in many of the robots 
that Media Manager supports.

2. Physically connect the drives to SCSI adapters in your host.

3. Record the adapter and SCSI addresses to which you connected each drive.

4. Create device files for each drive based on the SCSI addresses of the drives and 
adapters. Add the device file using your notes from step 3 to complete the correlation 
between device files and physical drive location.

5. Configure the robot and then add the drives.

When you add the drives, check your notes to ensure that you are assigning the 
correct drive address (for example, robot drive number) to each device path.

6. Optionally, you can use the appropriate robotic test utility to verify the configuration.

a. Stop the device daemon (ltid).

b. Start ltid to start the Automatic Volume Recognition daemon (avrd). 

You must stop and restart ltid to ensure that the current device configuration 
has been activated.

c. Use the robotic test utility to mount a tape on a drive.

d. Use the Device Monitor to verify the tape was mounted on the correct robot drive.

For example, assume you have the following drives in a TLD robot and have the 
device paths configured as follows:

Drive 1: /dev/rmt/0cbn

Drive 2: /dev/rmt/1cbn
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Also assume that in step c you requested that the tape be mounted on Drive 1. If the 
device path for the drive is correctly configured, the Device Monitor shows the tape 
mounted on Drive 1. Unload and unmount the tape from Drive 1 using the robotic 
test utility. Repeat the test for each drive.

During your testing, if the Device Monitor shows the tape mounted on a drive other 
than the drive you specified in the test utility, the device path for that drive is not 
correctly configured. For instance, if you mounted a tape on Drive 2 and the Device 
Monitor shows the tape mounted on Drive 1, the device path for Drive 2 is incorrect. 
Replace the Drive 2 device path (/dev/rmt/1cbn) with the correct device path 
(/dev/rmt/0cbn) for Drive 1. You may need to use a temporary device path while 
making these changes. 

Drive Cleaning
For drives in libraries that are under RSM robotic control, the Windows 2000 RSM 
software controls drive cleaning. Use the Windows 2000 administrative interfaces to 
manage drive cleaning.

Note Library-based cleaning is not supported by Media Manager for most robots, since 
robotic library and operating systems vendors have implemented this type of 
cleaning in many different ways.

This topic on drive cleaning covers the following areas:

� Frequency-Based Cleaning

� On-Demand Cleaning

� TapeAlert

� Using a Cleaning Tape

Frequency-Based Cleaning
When you add a drive, you can specify the number of hours (cleaning frequency) a drive 
will be used between drive cleanings. Media Manager updates the mount time for the 
drive each time a tape is unmounted. You can also change the cleaning frequency value.

If the following conditions are met, drive cleaning occurs when the accumulated mount 
time exceeds the time you specified for cleaning frequency:

� The drive is in a robotic library that supports cleaning (see “Robot Attributes” on 
page 231).

� A cleaning tape is configured and available in Media Manager for the robotic library.
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� The cleaning tape has cleanings remaining.

Media Manager cleans the drive immediately after the unmount. Drive cleaning never 
causes an unmount in the middle of an active backup. The mount time is reset after the 
drive is cleaned. The cleaning frequency value remains the same.

A cleaning can occur within a backup if you are spanning tapes. For example, if cleaning 
is due after the first tape is full, Media Manager cleans the drive before proceeding to the 
next tape.

Leaving media in a drive for extended periods does not affect cleaning frequency because 
Media Manager increments the mount time only when the media is actually assigned to a 
process.

To set, change or reset the cleaning frequency, use the tpclean command or the Drive 
Cleaning dialog (see “Cleaning Tape Drives” on page 38).

On-Demand Cleaning
If the drive is standalone or if a cleaning tape is not defined, the message NEEDS 
CLEANING appears in the Comment field of the output from the tpclean -L command 
or the Drive Cleaning dialog box. 

You can then use the tpclean command or the Drive Cleaning dialog (see “Cleaning 
Tape Drives” on page 38) to clean the drive and reset the accumulated mount time to zero 
after cleaning the drive.

You can manually clean a drive regardless of the cleaning frequency and accumulated 
mount time. You can clean standalone and robotic drives if a cleaning tape of the correct 
media type and residence for the drive has been added to the appropriate volume 
database.

TapeAlert
Reactive cleaning using TapeAlert is a function of the tape drive. If a drive supports the 
TapeAlert feature and TapeAlert is enabled on the drive, Media Manager polls the drive 
for status from TapeAlert. 

TapeAlert allows reactive cleaning for most drive types. Not all platforms, robots, and 
drives, at all firmware levels, support this type of reactive cleaning. In the cases where 
TapeAlert is not supported on a particular drive, frequency-based cleaning may be 
utilized (see “Frequency-Based Cleaning” on page 239 and “TapeAlert and 
Frequency-based Cleaning” on page 241).

Since TapeAlert provides the same type of cleaning as library-based cleaning (also known 
as robotic cleaning or auto cleaning), it is recommended that you disable library-based 
cleaning when using TapeAlert (for most vendor’s robots). 
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Requirements for TapeAlert and Media Manager

To use TapeAlert with Media Manager, you need the following conditions to be met. No 
additional configuration is needed.

� The drive must support the TapeAlert feature and the feature must be enabled on the 
drive.

To determine if drives support TapeAlert, see the VERITAS support site for 
information on drive support for TapeAlert.

� A cleaning tape is configured and available in Media Manager for the robotic library.

� The cleaning tape has cleanings remaining.

TapeAlert and Media Manager

A drive with TapeAlert knows how many read and write errors it has encountered within 
a certain time period. Although these errors are recoverable, once a threshold is reached a 
CLEAN_NOW or CLEAN_PERIODIC flag is set by TapeAlert.

If Media Manager finds either of these flags set, it performs a cleaning at one of the 
following times:

� At the end of a backup or restore to the drive.

� Prior to the next backup or restore to the drive.

TapeAlert and Frequency-based Cleaning

Using TapeAlert with frequency-based cleaning ensures that a given drive will get cleaned 
at least every x hours, depending on the cleaning frequency value. In addition the drive 
may be cleaned sooner, if the CLEAN_NOW or CLEAN_PERIODIC flags are set by the 
drive.

Using TapeAlert without frequency-based cleaning, ensures that the tape will be cleaned 
only when the drive sets its CLEAN_NOW or CLEAN_PERIODIC flags.

Using a Cleaning Tape
You can specify the number of cleanings that are allowed for a cleaning tape. This number 
is decremented with each cleaning and when it is zero, Media Manager stops using the 
cleaning tape. At this point, you can use a new cleaning tape or increase the number of 
cleanings allowed. You can also change this number of cleanings at any time in Media 
Manager.
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Volume Pools and Volume Groups
This topic on volume pools and groups covers the following areas:

� Volume Pools

� Volume Groups

� Volume Pools and Groups Example

� Scratch Volume Pools

� Moving Volumes

Volume Pools
A volume pool is used to identify a logical set of volumes by usage. Associating volumes 
with a volume pool protects them from access by unauthorized users, groups, or 
applications. You can create volume pools for user groups or other reasons; and as you 
add volumes, associate them with the appropriate pool. You can also move unassigned 
volumes to a different pool later.

With the exception of the NetBackup and DataStore volume pools, you must create a 
volume pool before you can add volumes to it. By default, Media Manager creates volume 
pools, named NetBackup and DataStore.

During initial configuration, it is easiest to create all of your volume pools first if you want 
to use volume pools other than the NetBackup volume pool. Then as you add volumes, 
you can assign them to these volume pools.

You can also configure a scratch volume pool (see “Scratch Volume Pools” on page 244).

Volume Groups
A volume group is a logical grouping that identifies a set of volumes that reside at the 
same physical location. Volume groups are an administration convenience for logically 
moving multiple volumes (where a logical move means to change the volume attributes to 
show the new location). Using a volume group lets you move a set of volumes between a 
robotic library and a standalone location, or delete them from the configuration by 
specifying the group name, rather than each individual media ID. Volume groups are also 
convenient for tracking location, such as when a group is moved offsite.

The following are the rules for assigning volume groups:

� All volumes in a group must be the same media type.

However, a media type and its corresponding cleaning media type are allowed in the 
same volume group (for example, DLT and DLT_CLN).
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� All volumes in a robotic library must belong to a volume group. You cannot add 
volumes to a robotic library without specifying a group or having Media Manager 
generate a name.

� The only way to clear a volume group name is to move the volume to standalone and 
not specify a volume group.

� More than one volume group can share the same location. For example, a robotic 
library can contain volumes from more than one volume group and you can have 
more than one standalone volume group.

� All members of a group must be in the same robotic library or be standalone. 

Do not confuse volume pools with volume groups. Remember that

� A volume pool identifies a set of volumes by usage.

� A volume group identifies a set of volumes by physical location and, like the volume 
pool, is specified when you add the volume. Groups are convenient for updating the 
configuration when moving volumes (for example from robotic to standalone).

Volume Pools and Groups Example
The following figure shows an example with one volume pool (NB_pool) and several 
volume groups. In this example, volumes can be moved between the groups in the robotic 
library and the groups that are offsite. All volumes, however, remain in the same pool.

Volume Pool With Multiple Volume Groups

Robotic

Group 1 Group 2 

Group 3 Group 4

Offsite 1

Offsite 2

Standalone
NB_pool
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In the following figure, members of the same volume pools are in different volume 
groups. The important thing to notice in this example is that the data intended for use by 
different departments are kept on separate volumes by assigning different volume pools. 
The volumes in a pool can be in more than one physical location and in more than one 
volume group.

In this example, the volumes in NB_pool_dept_1 are spread among the rob_A, 
standalone1, and offsite volume groups. These groups also have volumes from more than 
one pool (though the volumes in each group must all be the same type).

Volume Groups With Multiple Volume Pools

It is also possible to configure a scratch pool from which Media Manager can transfer 
volumes when another volume pool has no media available (see “Scratch Volume Pools” 
on page 244).

Scratch Volume Pools
The scratch pool is an optional volume pool that you can configure. Each media server in 
your configuration can have one scratch pool configured. If a scratch pool is configured, 
Media Manager moves volumes from that pool to other pools that have do not have 
volumes available.

Group 
offsiteGroup 

standalone1

Robot A

NB_pool
_dept_2

NB_pool
_dept_1

Standalone
Standalone

NB_pool
_dept_3

 

Group 
rob_A
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See “Adding a New Volume Pool or Scratch Volume Pool” on page 57 for configuration 
information.

For example in the following figure, the scratch pool is named Scratch_pool and Robot C 
contains volumes from that pool in addition to those from other pools. Assume the 
following

� NetBackup requires a DLT volume, so Media Manager attempts to assign one from 
NB_pool_dept_1 in Robot C.

� Robot C has no unassigned volumes available in the NB_pool_dept_1 pool.

Media Manager searches the scratch pool for an unassigned DLT volume in Robot C. If 
there is an available volume, Media Manager moves it to NB_pool_dept_1 and assigns it 
to NetBackup. Otherwise, a media unavailable status is logged.

Scratch Pools

The following list contains important notes on scratch pool usage:

� If the scratch pool contains assigned volumes, these volumes remain in the scratch 
pool. Media Manager does not move assigned volumes to other pools as it does with 
unassigned volumes.

 

NB_pool_dept_1

NB_pool_dept_2

Scratch_pool

Robot C - DLT

Group
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� Media Manager will not assign volumes while they are in a scratch pool. For example, 
if a NetBackup policy or schedule specifies the scratch pool, all requests for those 
volumes are denied.

� Volumes moved from a scratch pool to another pool remain in that new pool. Media 
Manager does not automatically move it again for any reason, but you can manually 
reassign it to another volume pool.

� To have Media Manager manage the allocation of your volumes to your volume 
pools, do one of the following:

- Create volume pools as required, but do not add any volumes to the pools.

- Create a scratch pool and add all of your volumes to it. Media Manager will move 
volumes to the other pools as they are required.

Moving Volumes
When you move volumes in or out of a robotic library, you must physically and logically 
move the volume (see the following figure).

� The physical part of the move is done when you insert or remove the volume. For 
some robot types, you can use Media Manager to physically move the volume (using 
Inject/Eject options).

� The logical part of the move is done when you use Media Manager to move volumes. 
Media Manager updates the volume database to show the volume at the new location.

Example of Moving Volumes

2. Move new volume
to robotic

1. Move full volume
to standalone

Example of replacing a full volume with
a new volume.

Update the volume configurationReplace the full with the new

1 2

Physical Move Logical Move

full new
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Common instances when you move volumes are as follows:

� Replacing full volumes in a robotic library. When a volume is full and there are no 
more empty slots in the robotic library, you move the full volume to standalone and 
configure a volume for the empty slot, or move a volume into that slot. Use the same 
process to replace a defective volume.

� Moving volumes from a robotic library to an offsite location or from an offsite location 
into a robotic library. When you move tapes to an offsite location, you move them to 
standalone.

� Changing the volume group for a volume or volumes.

In one move operation, you can move a single volume, multiple volumes, or combinations 
of single and multiple volumes. You are limited only in that you cannot move volumes to 
an invalid location (for example, DLT media to an 8-mm robot). 

The best approach is to keep your moves simple by selecting and moving only one type of 
media at a time to a single destination. For example, if you have to move 8 mm and 4 mm 
cartridge tapes, do it in separate moves.

Barcodes
Reading barcodes is a function of the robotic library hardware. When a robotic library has 
a barcode reader, it scans the media for barcodes and saves the results. This associates the 
slot number and the barcode with the media in that slot. Media Manager obtains this 
association from the robotic library.

VERITAS suggests that you use media with barcodes in robots that can read barcodes. 
Barcodes offer the following advantages:

� Automatic media ID assignment.

When you add new media to a robot, Media Manager is able to assign media IDs 
according to the criteria that you specify.

� More accurate tracking of volume location.

The Update Volume Configuration option can easily determine which volumes are in 
a robot.

� Increased performance.

Media Manager functions well whether or not barcodes are used. However, not using 
barcodes can adversely affect performance for some robots. 

A robot that reads barcodes will perform a scan each time it moves a tape. This is 
normal and is done in order to store the correct barcode in memory or to verify a 
previously saved barcode. However, if a barcode is missing, the robot will retry the 
scan multiple times, degrading performance.
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Note Volumes in an RSM robot use the media name as a volume identifier. This volume 
identifier is used as the Media Manager media ID. The last six characters of the 
media name are used. If these characters contain spaces, only the characters back to 
the first space are used.

When selecting barcodes for your volumes keep the following points in mind:

� Barcodes appear on labels that you attach to the outside of tape volumes.

� Media Manager supports barcodes with a maximum of eight characters (a maximum 
of six characters in RSM robots).

� When you buy barcode labels for use with Media Manager, always follow the robotic 
library vendor’s recommendations. The following are some general guidelines:

Ensure that the barcodes have the correct number of characters.

Barcodes can represent any combination of alpha and numeric characters, but 
different robots support different lengths of barcodes. See the vendor’s 
documentation to determine the requirements for a specific robot type.

Use barcodes without spaces (leading spaces, trailing spaces, or spaces between any 
characters). Otherwise, the robot or Media Manager can have difficulty interpreting 
them.

� You can match barcodes to media IDs by getting custom labels with six-character 
barcodes in the same series as your media IDs. For example, to match a set of media 
IDs from AA0000 to ZZ9999, get barcode labels in that series.

� When a robotic library can contain more than one media type, a good strategy for 
assigning barcodes is to assign specific characters in the barcode to different media 
types using media ID generation rules (see “Media ID Generation Rules” on 
page 250). Another approach is to use barcodes to differentiate between data tapes 
and cleaning tapes, or between volume pools.

Barcode Rules
A barcode rule specifies the criteria for assigning attributes to new robotic volumes. These 
attributes are assigned by Media Manager according to the barcode on the volume that is 
detected by the robotic library. In Media Manager, you choose whether to use barcode 
rules when you set up the robot inventory update operation.
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The following table shows some example barcode rules. Rules are sorted first according to 
the number of characters in the barcode tag and then in the order you add them. Two 
exceptions are the <NONE> and <DEFAULT> rules, which are always at the end of the 
list.

When a robot update operation uses Media Manager barcode rules and a new barcode is 
detected in a slot, Media Manager searches the rules starting at the top of the list and 
checks for a barcode tag that matches the new barcode. If a tag matches, the media type 
for the rule is checked to ensure that it is compatible with the type you specified for the 
robot update. If the media type also matches, Media Manager uses the rule’s media type, 
volume pool, maximum number of mounts (or number of cleanings), and description 
when it assigns attributes in the volume database.

Note Media Manager will not use barcode rules for barcodes that are being used by 
existing volumes.

For example, assume that you select the following Update Options for a new 8-mm tape in 
a TS8 robot:

Media Type: 8MM

Volume Group: 00_000_TS8

Use Barcode Rules: YES

Volume Pool: DEFAULT

Example Barcode Rules

Barcode Tag Media Type Volume Pool
Max Mounts/
Cleanings Description

0080 8MM b_pool 55 new 008 volumes

DLT DLT d_pool 200 dlt backup

CLD DLT_CLN None 30 dlt cleaning

CLT 8MM_CLN None 20 8-mm cleaning

TS8 8MM t_pool 0 8-mm backup

TS 8MM None 0 8-mm no pool

<NONE> DEFAULT None 0 no barcode

<DEFAULT> DEFAULT NetBackup 0 other barcodes
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If a new tape in this robotic library has a barcode of TS800001, Media Manager uses the 
rule with the barcode tag of TS8 and uses the following attributes for the tape:

Media ID: 800001 (last six characters of barcode)

Volume Group: 00_000_TS8

Volume Pool: t_pool

Max Mounts: 0 (infinite)

If a new tape has a barcode of TS000001, Media Manager uses the rule with the barcode 
tag of TS and the attributes for the tape are:

Media ID: 000001 (last six characters of barcode)

Volume Group: 00_000_TS8

Volume Pool: None

Max Mounts: 0 (infinite)

Media ID Generation Rules

Note To use media ID generation rules, the robot must support barcodes and the robot 
type cannot be RSM.

Using media ID generation rules allows you to manage your barcodes when you do not 
want to use the default rule for media ID generation. You control how Media Manager 
media IDs are created by defining rules that specify which characters of a barcode on tape 
will be used in the media ID. You also can specify that alphanumeric characters are to be 
inserted into the ID.

For example, two eight-character barcodes might be S00006L1 and 000006L1. If you do 
not specify media ID generation rules, Media Manager uses the right-most six characters 
of the barcode to create its media IDs. In this example, the same media ID for the two 
barcodes would be created.

Rules can be defined with respect to a robot and barcode lengths. Multiple barcode 
creation entries can be specified, allowing the ID generation to be specific for each robot; 
or for each barcode format having different numbers of characters in the barcode. This 
allows flexibility for multi-media. 
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vmd Security
Media Manager vmd security works in conjunction with NetBackup 
authentication/authorization security to control user access to vmd (the Media Manager 
volume daemon).

Media Manager vmd security consists of the following levels of security. Each successive 
level provides more security. These levels are explained in the following topics:

� “Media Manager vmd Authentication/Authorization” on page 253.

� “Media Manager Server-Based vmd Security” on page 254.

� “Media Manager Enhanced vmd Authorization” on page 255.

Possible NetBackup and Media Manager Conflicts
Media Manager authentication/authorization may affect systems where NetBackup 
authentication/authorization has been enabled.

Connections to vmd will fail if the following are all true:

� Authentication/authorization are enabled.

� An AUTHORIZATION_REQUIRED entry is present in vm.conf.

� The caller of vmd does not have the required permission to use vmd functions. 

If authentication/authorization is needed in NetBackup but not in Media Manager, you 
can do one of the following:

� Add SERVER entries in vm.conf.

� Have no SERVER and no AUTHORIZATION_REQUIRED entries in vm.conf.

NetBackup Authentication/Authorization
NetBackup authentication verifies NetBackup client to server access and also controls 
access to the services available on that host. 

NetBackup authorization verifies if a NetBackup administration user has permission to use 
the services available on that host. Authorization provides additional security over the 
security provided by authentication.

The steps you use to set up security levels for your NetBackup master server apply 
generally to setting up security for Media Manager media servers. See the NetBackup 
system administrator's guide (UNIX or Windows) for more information including the 
following:

� Explanations of authentication and authorization.
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� Explanations of Enhanced Authentication.

� Explanations of Enhanced Authorization.

� Definition of the NetBackup configuration file (bp.conf).

� Definitions of the methods.txt, methods_allow.txt, and authorize.txt files.

� Information on bpauthsync(1M), vopied(1M), and vopie_util(1M)man pages.
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Media Manager vmd Authentication/Authorization
Media Manager security for vmd works in conjunction with the following to control 
access to vmd:

� NetBackup authentication/authorization

� Media Manager server-based security

� Media Manager enhanced authorization 

The following two tables provide an overview of Media Manager vmd security. Server 
Name, used in these matrices, refers to SERVER entries in the vm.conf file. 

See “Media Manager Configuration File (vm.conf)” for more information about SERVER, 
AUTHORIZATION_REQUIRED, and PREFERRED_GROUP entries.

No vm.conf Entry Present

The following table describes Media Manager vmd security when there is no 
AUTHORIZATION_REQUIRED entry in the vm.conf file.

If Authentication is not enabled (see the fourth row in the table), the resulting security 
reduces to Media Manager server-based security.

vmd Security Matrix - No AUTHORIZATION_REQUIRED Entry in vm.conf

Access to vmd
Functionality?

Server Name
is in vm.conf

No Server Names
in vm.conf
(or there is no
vm.conf File)

Server Name is Not
in vm.conf (other
Server Names are)
in vm.conf

Authentication Failed Denied Denied Denied

Authentication Enabled
and
User is Authorized

Allowed Allowed Allowed (overrides
server-based
security)

Authentication Enabled
and
User is Not Authorized

Allowed (uses
server-based
security)

Allowed (uses
server-based
security)

Denied

Authentication Not Enabled Allowed Allowed Denied
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vm.conf Entry Present

The following table describes Media Manager vmd security when there is an 
AUTHORIZATION_REQUIRED entry in the vm.conf file.

Your level of security is dependent upon your use of the following:

� Authentication

� Authorization

� SERVER entries 

Media Manager Server-Based vmd Security
SERVER entries in vm.conf are used for server-based Media Manager vmd security. 
Without any SERVER entries present on a particular host and without the 
AUTHORIZATION_REQUIRED entry present, other hosts can access vmd on the host. You 
can add SERVER entries allowing only specific hosts to remotely access vmd.

If a host’s vm.conf file contains any SERVER entries, there must also be a SERVER entry 
for that host or it will not be able to manage its own devices.

The fourth row of the table in “No vm.conf Entry Present” on page 253 provides an 
overview of Media Manager server-based vmd security.

vmd Security Matrix - AUTHORIZATION_REQUIRED Entry is in vm.conf

Access to vmd
Functionality?

Server Name
is in vm.conf

No Server Names
in vm.conf

Server Name is Not
in vm.conf (other
Server Names are)
in vm.conf

Authentication Failed Denied Denied Denied

Authentication Enabled
and
User is Authorized

Allowed Allowed Allowed (overrides
server-based
security)

Authentication Enabled
and
User is Not Authorized

Allowed (uses
server-based
security)

Denied (disables
server-based
security)

Denied

Authentication Not Enabled Allowed Denied Denied
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Media Manager Enhanced vmd Authorization
The set of commands that Media Manager Enhanced Authorization allows non-root users 
to execute are limited to those commands that interact with vmd. Other administration 
commands that manipulate the Media Manager database and configuration files directly 
can not be used by non-root administrators through Enhanced Authorization.

The Media Manager commands that are allowed with Enhanced Authorization follow:

� vmadd

� vmchange

� vmdelete

� vmoprcmd

� vmpool

� vmquery

� vmrule

Setting up Enhanced Authorization

If you want to allow nonroot users to administer Media Manager or control user access to 
administer Media Manager vmd commands, use one of the following methods:

� See the Managing NetBackup chapter of the UNIX NetBackup system administrator’s 
guide for instructions on using the nonroot_admin script.

� See the Enhanced Authentication and Authorization chapter of the UNIX NetBackup 
system administrator’s guide for instructions on using enhanced authentication and 
authorization.

How Media Manager Selects a Drive for a Robotic Mount 
Request

When a mount request is issued, ltid queries vmd on the volume database host(s) for the 
media ID specified. If the media ID is found, vmd returns the location of the media (which 
robotic library and the storage slot number, if applicable).

If a drive exists that meets the following criteria, the mount request is forwarded to the 
appropriate robotic daemon.

� The drive is configured.

� The drive is in the robotic library that contains the media.
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� The drive allows the requested media density.

The robotic daemon is managing the drives and requests for drives in the robotic library 
that contains the requested media. The daemon (for example, tldd) does the following:

� Determines which of the drives are currently available. Some of the things that are 
checked to determine drive availability follow. Is the drive

- Configured as DOWN?

- Already assigned?

- Of a compatible type?

- Reserved by another host?

� Picks the drive that was used least recently.

The time stamp used by drive selection is contained in robotic daemon memory. If the 
daemon is stopped and restarted, everything starts out equal again. The first drive as 
shown by tpconfig -d in the drive configuration will be used first, then the second, 
and so on. This time stamp is based on the dismount time, not the mount time.

Administrators Quick Reference
The following tables provide a quick reference to information that you will frequently use 
while using Media Manager. 

Media Manager Commands
See “Media Manager Man Pages” on page 169 for detailed information on most of the 
commands shown in the following table.

The jnbSA command is located in the directory /usr/openv/netbackup/bin. The 
other commands listed are located in /usr/openv/volmgr/bin.

Commands

Command Description

Administrator Utilities

jnbSA Starts the Java media and device management, and device monitor 
administrative interfaces.

vmadm Starts the character-based, menu driven media management utility.
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tpconfig Starts the character-based, menu driven device utility for device configuration.

robtest Starts the robotic test utilities.

NOTE: This utility is not officially supported.

Starting Daemons

avrd The Automatic Volume Recognition daemon. This daemon is started by ltid.

ltid Starts the Media Manager device daemon. Starting ltid also starts the robotic, 
robotic control, and Media Manager volume and avrd daemons.

tl4d The Tape Library 4MM robotic daemon. This daemon is started by ltid.

tl8cd Starts the Tape Library 8MM robotic-control daemon. This daemon is started by 
ltid.

tl8d The Tape Library 8MM robotic daemon. This daemon is started by ltid.

tldcd Starts the Tape Library DLT robotic-control daemon. This daemon is started by 
ltid.

tldd The Tape Library DLT robotic daemon. This daemon is started by ltid.

ts8d The Tape Stacker 8MM robotic daemon. This daemon is started by ltid.

tsdd The Tape Stacker DLT robotic daemon. This daemon is started by ltid.

vmd The Media Manager volume daemon. This daemon is started by ltid.

Stopping Daemons

kill pid Stops the process for the daemon with the specified pid (process id). 

This is a system command with a path of /usr/bin/kill or /bin/kill.

stopltid Stops the device, robotic, and robotic-control daemons.

tldcd -t Stops the Tape Library DLT robotic-control daemon.

tl8cd -t Stops the Tape Library 8MM robotic-control daemon.

Monitoring Processes

Commands (continued)

Command Description
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Log Files
The following table contains descriptions of important Media Manager log files.

Media Manager Configuration File (vm.conf)
The /usr/openv/volmgr/vm.conf file contains entries for media and device 
management. This file usually is created by NetBackup, but if it does not exist you may 
need to create it to add entries.

The entries that this file can contain are as follows. See “Example vm.conf File” on 
page 264 for an example configuration file.

vmps Lists the active processes.

Commands (continued)

Command Description

Logs

Log File Description

System Log (syslog) Contains general Media Manager logging, including errors. All log 
messages use the daemon facility. 

For debug logging, use the -v option on the command starting the 
daemon or use VERBOSE in the vm.conf file.

daemon/log.ddmmyy Contains debug information for the volume daemon (vmd) and its 
associated processes (oprd and rdevmi). 

The path is /usr/openv/volmgr/debug/daemon.

reqlib/log.ddmmyy Contains debug information on the processes that request vmd. 

The path is /usr/openv/volmgr/debug/reqlib.

tpcommand/log.ddmmyy Contains debug information for device configuration. Includes 
information for tpconfig, tpautoconf, and the NetBackup GUIs.

The path is /usr/openv/volmgr/debug/tpcommand.

ltid/log.ddmmyy Contains debug information for ltid, the Media Manager                   
device daemon.

The path is /usr/openv/volmgr/debug/ltid.
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Authorization Required

AUTHORIZATION_REQUIRED

If this entry is specified, Media Manager and NetBackup utilities must have authorization 
to connect to vmd; or a SERVER entry must be present in the vm.conf file. This entry is 
recommended for maximum security.

If this entry is not specified, Media Manager and NetBackup utilities may connect to vmd 
without specific authorization, except in the case when a non-matching SERVER entry is 
present in vm.conf.

Client Port Range

CLIENT_PORT_WINDOW = start end

Specifies the range of nonreserved ports on this computer that are used for connecting to 
vmd on other computers. 

For example the following entry permits ports from 4800 through 5000:

CLIENT_PORT_WINDOW = 4800 5000

If you specify 0 for start, the operating system determines the nonreserved port to use. If 
you do not specify a CLIENT_PORT_WINDOW entry, the operating system determines the 
nonreserved port. 

Days To Keep Debug Logs

DAYS_TO_KEEP_LOGS = days

Specifies the number of days to keep debug logs before vmd deletes them. 0 means that the 
logs are not deleted. The default is 0.

Disallow Non-NDMP Request on NDMP Drive

DISALLOW_NONNDMP_ON_NDMP_DRIVE

In NetBackup, all read types of operations (restore, the read-portion of duplicates, import, 
and verify) and the write-portion of duplicates are not scheduled. Therefore these 
operations compete for available drives.

NetBackup attempts to use an available drive based on the type of request:

� For a NDMP backup or restore request, the drive must be a NDMP drive. 
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� For a non-NDMP request of any kind, NetBackup always tries to find an available 
non-NDMP drive. But, if a non-NDMP drive is not available and a NDMP drive is 
available, the operation will be done using the slower NDMP drive.

If a DISALLOW_NONNDMP_ON_NDMP_DRIVE entry is specified on master or media 
servers, NetBackup will not assign a non-NDMP request to available NDMP drives. 

Be aware when specifying this entry, that because some operations may have to wait 
for available non-NDMP drives to become available, the media mount timeout value 
may have to be increased (by using an entry in the UNIX bp.conf file or in the 
registry on Windows).

Do Not Eject Standalone Tapes

DO_NOT_EJECT_STANDALONE

If this entry is specified, tapes in any standalone drives will not be ejected when a backup 
has completed (tapes will be ejected, if end of media is reached during a backup). This 
entry can be used in a NetBackup environment, where it is desirable to keep a standalone 
drive ready after successful backups are performed.

Enable Automatic Path Remapping

ENABLE_AUTO_PATH_CORRECTION

Enables automatic device path remapping. With this entry when the device daemon 
(ltid) is started, an attempt is made to discover attached devices and automatically 
update the device configuration for any device paths that are incorrect in the device 
configuration.

New devices will not be added. Using this option will increase the amount of time it takes 
for ltid to restart. 

Media ID Generation

MEDIA_ID_BARCODE_CHARS = robot_num barcode_length media_ID_rule

Note To use this entry, the robot must support barcodes and the robot type cannot be 
RSM.

This entry controls Media Manager media ID generation. You choose how IDs are created 
by defining rules that specify which characters of a barcode on tape will be used. You also 
can specify alphanumeric characters to be inserted in the ID.
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Multiple barcode creation entries can be specified, allowing the media ID generation to be 
specific for each robot; or for each barcode format having different numbers of characters 
in the barcode. This allows flexibility for multi-media. 

If MEDIA_ID_BARCODE_CHARS entries are not present or you enter an invalid entry, 
Media Manager uses the rightmost six characters of the barcode to create its media ID.

robot_num is the robot number.

barcode_length is the length of the barcode.

A media_ID_rule consists of a maximum of six fields delimited by colons. Numbers in the 
fields of the rule define the positions of the characters in the barcode that are to be 
extracted (numbering is from the left). For example, 2 in a field extracts the second 
character from the barcode. The numbers can be specified in any order.

Characters prefixed by # in a field result in that character being inserted in that position in 
the generated ID. Any alphanumeric characters that are specified must be valid for a 
media ID. You can use rules to create media IDs of many varied formats, but keep in mind 
that the difference in the label on the media and the generated media ID may make it 
difficult to manage your media. The following is an example rule and the resulting media 
ID:

Barcode on the tape: 032945L1
Media ID rule:       #N:2:3:4:5:6
Generated media ID:  N32945

Also see “Media ID Generation Rules” on page 250.

Media ID Prefix

MEDIA_ID_PREFIX = media_id_prefix

Defines the media ID prefixes to use for media without barcodes. You add the media to a 
robot with Update Volume Configuration option.

See “Changing the Update Options” on page 103.

Preferred Group

PREFERRED_GROUP = netgroup_name

This entry is used by all callers in Media Manager and NetBackup (other than 
bpgetmedia and bptm) for authentication/authorization for vmd. netgroup_name is case 
sensitive.
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If this entry is specified, a check is made to determine if the user is in the netgroup using 
the innetgr() function (refer to the innetgr man page). If a PREFERRED_GROUP entry 
is not specified or the user is not a member of the netgroup, the local group name is 
obtained. 

The following is an example:

PREFERRED_GROUP =  nbadmins

Prevent Media Removal (TL8 Robots)

PREVENT_MEDIA_REMOVAL

Note Specifying this entry changes the default operation for TL8 robots. Without this 
entry present, Media Manager allows the removal of media.

If this entry is specified, TL8 robots will execute the SCSI command PREVENT MEDIUM 
REMOVAL. You then will not be able to open the robot’s main door or gain access to the 
media access port while the robotic control daemon is running. You can override this 
action by doing one of the following:

� Use the test utility and execute allow media removal.

� Use inject/eject for access, when adding or moving volumes.

Random Port Numbers

RANDOM_PORTS = YES|NO

Specifies whether Media Manager chooses port numbers randomly or sequentially when 
it requires a port number for communication with Media Manager on other computers. 

� If RANDOM_PORTS = YES (the default), Media Manager chooses port numbers 
randomly from those that are free in the allowed range. For example, if the range is 
from 1024 through 5000, Media Manager chooses randomly from the numbers in this 
range.

� If RANDOM_PORTS = NO, Media Manager chooses numbers sequentially, starting 
with highest number that is available in the allowed range. For example, if the range 
is from 1024 through 5000, Media Manager chooses 5000 (assuming it is free). If 5000 
is being used, port 4999 is chosen.

By default, a RANDOM_PORTS entry is not present in the Media Manager configuration 
file. This means that Media Manager uses the random method for selecting port numbers.

If you are specifying RANDOM_PORTS = NO in the NetBackup configuration file, you 
should also specify RANDOM_PORTS = NO in the Media Manager configuration file.
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Required Network Interface

REQUIRED_INTERFACE = host_name

Specifies the network interface that Media Manager uses when connecting to another 
Media Manager server. A Media Manager server can have more than one network 
interface and by default, the operating system determines the one to use. To force Media 
Manager connections to be through a specific network interface, use this entry and specify 
the network host name of that interface. 

In the following example, host1 is the network host name of the interface.

REQUIRED_INTERFACE = host1

Refer to the NetBackup system administrator’s guide for more information on NetBackup 
network configuration.

Scratch Pool Configuration

SCRATCH_POOL = pool_name

Configures the specified volume pool as the scratch pool. The scratch pool is a special 
volume pool from which media is moved as needed into volume pools that have no 
available media.

You can specify any scratch pool name, except the names: NetBackup, DataStore, or None. 
If the specified volume pool does not exist, Media Manager creates it and sets the host, 
user, group, and description for the pool to ANYHOST, root, NONE, and Scratch Pool, 
respectively.

If you subsequently delete the SCRATCH_POOL entry, the specified volume pool will no 
longer be the scratch pool.

See “Adding a New Volume Pool or Scratch Volume Pool” on page 57.

Server Entry

SERVER = host_name

This entry is used for security and specifies which hosts can monitor and control devices 
on this host. Without any SERVER entries and authentication enabled, any host can 
manage the devices and volumes on the local host.

For security you can add entries allowing only specific hosts to remotely access the 
devices. If a host’s vm.conf file contains any SERVER entries, there must also be a 
SERVER entry for that host or it will not be able to manage its own devices.
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Verbose Message Logging

VERBOSE

Causes most Media Manager daemons to be started with verbose logging enabled.

Use this option only if problems occur or if requested by VERITAS support. After the 
problem is resolved, remove any debug logs that were created or add a 
DAYS_TO_KEEP_LOGS entry.

Example vm.conf File
The following is an example of a vm.conf file, on host yak:

SERVER = yak

SERVER = whale

MEDIA_ID_PREFIX = NV

MEDIA_ID_PREFIX = NETB

SCRATCH_POOL = ScratchPool
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 C

This appendix explains how to configure drives and robots using the device management 
configuration utility, tpconfig. This menu-driven utility creates and updates the 
configuration files that define drives and robots to Media Manager.

There are also other Media Manager interfaces available to configure drives and robots 
(see “Administrator and User Interfaces” on page 2). The terminology, general concepts, 
and results are the same, regardless of which interface you use.

Terms and Concepts
The following Media Manager terms and concepts are used when configuring drives and 
robots.

Robot Number

A robot number is the unique, logical identification number of a robot. You assign it when 
you add a robot to the configuration. tpconfig prompts you to enter a number or accept 
the next available robot number which it displays. This number identifies the robot in 
displays and listings, and it follows the robotic type in parentheses, such as TL8(2). It is 
also used when entering the robot's media in the volume database, as described in 
“Managing Media” on page 45.

Robotic Control Path

The control path to a robot is through a SCSI connection. For most robots, you or the 
operating system creates this path in the /dev directory when you add a robot to the 
configuration. When tpconfig prompts you, enter the path to the robotic control as 
found in the /dev directory. If the entries do not exist, see the NetBackup Media Manager 
device configuration guide.
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No Rewind On Close Device Name

This device name applies to all devices. This type of device remains at its current position 
on a close operation.

You specify a no rewind on close device name when you add a drive. Usually the device 
name is preceded or followed by the letter n. If the device name entries do not exist, you 
must create them as explained in the NetBackup Media Manager device configuration 
guide.

In tpconfig displays and listings, these device names are shown under the heading 
DrivePath.

Drive Status

Drive status can be UP or DOWN, and indicates whether Media Manager considers a 
drive available. You specify the initial drive status when you add a drive to the 
configuration. You can change the status, using the Update option of the Drive 
Configuration menu in tpconfig or if ltid has been started, by using a Device Monitor 
interface or vmoprcmd.

Volume Database Host Name

The volume database host name identifies the host where the volume database is located. 
A volume database host name is associated with each robot and the entire set of 
standalone drives on a device host.

Starting the tpconfig Utility
You can start tpconfig from the vmadm Media Management menu or with the following 
command from the command line. You must have root user privileges.

/usr/openv/volmgr/bin/tpconfig
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The following menu appears:

Note If the Media Manager device daemon is running, you should stop it with the 
stopltid command (see “Media Manager Device Daemon (ltid)” on page 160).

� Drive Configuration opens a menu for adding, deleting, updating definitions of 
drives, or listing definitions of drives and robots in the drive and robot databases.

� Robot Configuration opens a menu for adding, deleting, updating definitions of 
robots, or listing definitions of drives and robots in the drive and robot databases.

� Volume Database Host Configuration opens a menu for updating or listing 
the name of the host where the volume database for a specific device resides.

� Print Configuration on the main menu and the List Configuration 
commands on subsequent menus allow you to display the current configuration on 
the screen or write it to a file.

Specifying just the -d option on the tpconfig command also writes the current 
configuration to stdout (the screen) without invoking the menus.

Other command options are available. Run tpconfig -help or see the tpconfig 
man page.

� Online help is available on the main menu and most submenus.

� Quit terminates the utility and returns you to the UNIX prompt.

You can return to the main menu from anywhere in the utility by entering Ctrl C or using 
the Escape key.

Device Management Configuration Utility

1) Drive Configuration
2) Robot Configuration
3) Volume Database Host Configuration
4) Print Configuration
5) Help
6) Quit

Enter option:
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Adding Robots
When you configure robots and drives using tpconfig, the most efficient process is to 
first add the robot using the Robot Configuration menu and then add the drives using the 
Drive Configuration menu.

If you want to reconfigure drives configured as standalone to indicate that they are in a 
robot, use the Update option of the Drive Configuration menu. See “Updating Drive 
Configurations” on page 270.

The procedure for adding a robot follows:

1. Select the Robot Configuration menu. If any robots exist, they are displayed above 
this menu.

2. Select the Add option.

From the list of possible robot types displayed, select the one you want to add.

3. Enter a robot number you know is unused or accept the default number.

4. Indicate where the robotic control for the library is by entering the device file path or 
library name. The Help option on the Robot Configuration menu has examples of 
typical path names.

5. If no conflicts are detected with the new configuration, you see a message that the 
robot has been added.

Adding Drives

1. Select the Drive Configuration menu.

2. Select the Add option.

3. Type a drive name or use the Enter key to use the default drive name that is shown.

Specify a name, from the ASCII character set, that will be used by Media Manager to 
identify the drive.

4. From the list of possible drive types displayed, select the one you want to add.

5. Enter the no rewind on close device path as shown in the /dev directory.

The Help option on the Drive Configuration menu has examples of typical path 
names.
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6. Enter the drive status (Up or Down).

7. If a robot exists that the drive could be added to, indicate whether the drive should be 
added to the robot or be a standalone drive.

If there are no robots to which the drive can be added, tpconfig automatically adds 
the drive as a standalone drive.

If you choose to add a drive to a robot and more than one possible robot exists, enter 
the robot number that will control the drive.

Depending on the type of robot, you may also be prompted to add the robot drive 
number (see “Robot Drive Number” on page 35).

8. When finished, you see a message that the drive has been added, followed by a listing 
of the drive.

Updating Robot and Drive Configurations

Updating Robot Configurations
You can change the robot number or the robotic control path for a robot as explained in 
the following steps:

1. On the main menu, choose Robot Configuration.

Note If only one robot is configured, step 2 is skipped.

2. On the Robot Configuration menu, choose Update. The following prompt is 
displayed

Enter the robot number of the library you want to change.

3. The following prompt is displayed:

Enter a new robot number to replace the existing robot number, or press Enter to 
retain the current robot number.

Enter robot number to update:

   Enter new robot number or <RETURN> to use existing (n):
Appendix C, Using tpconfig 269



Updating Robot and Drive Configurations
4. You are prompted to enter robotic control information. The actual prompts depend on 
the type of robotic library you are updating.

Enter the appropriate robotic control path or host name associated with the robot.

When you are done, a message confirming that the robot has been updated is 
displayed.

Updating Drive Configurations
To change information about a drive (for example, to add it to a robot) perform the 
following steps:

1. On the main menu, choose Drive Configuration.

2. On the Drive Configuration menu, choose Update.

3. Enter the name of the drive you want to update, when the following prompt is 
displayed:

4. The current drive information is displayed, followed by prompts to change each field. 
Enter a new value or use the Enter key to keep the existing value.

One of the prompts asks if you want to configure the drive in a robot and, if so, adds 
the drive immediately or gives you the opportunity to choose from any existing robot 
of the appropriate type.

5. When you have responded to all prompts, a revised Drive Information display 
appears, along with the following prompt:

Enter y to update the drive or n to keep the original configuration.

6. A message confirming that the drive has been updated (or not updated) is displayed. 

   Enter name of drive to update:

   Are you sure you want to UPDATE drive name xxxxx? (y/n) n:
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Deleting Drives and Robots

Deleting Drives

1. On the main menu, choose Drive Configuration.

2. On the Drive Configuration menu, choose Delete.

3. Enter the name of the drive you want to delete, when the following prompt is 
displayed:

4. Drive information and a prompt similar to the following are displayed:

5. Enter y to delete the drive, or n (Enter) to cancel the action.

a. If you respond with y, a message confirming the drive has been deleted is 
displayed.

b. If you respond with n (or Enter), pressing any key returns you to the Drive 
Configuration menu and the delete action is canceled.

Deleting Robots

1. On the main menu, choose Robot Configuration.

2. On the Robot Configuration menu, choose Delete.

Note If only one robot is configured, step 3 is skipped.

3. The following prompt is displayed:

 Enter name of drive to delete:

   Are you sure you want to DELETE drive name xxxxx? (y/n) n:

   Enter robot number to delete:
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Enter the robot number of the robot you want to delete.

4. A prompt similar to the following is displayed:

5. Enter y to delete the robot, or n (or Return) to cancel the action.

a. If you respond with y, a message confirming that the robot has been deleted is 
displayed.

b. If you respond with n, pressing any key returns you to the Robot Configuration 
menu and the delete action is canceled.

Specifying the Volume Database Host
A volume database host is associated with each robot and set of standalone drives on a 
device host. It identifies the host where the volume database for the device is located.

By default, the volume database host name for standalone and robotic drives is the global 
device database.

VERITAS recommends that the volumes for the entire configuration be defined in one 
volume database. 

1. On the main menu, choose Volume Database Host Configuration.

The current volume database hosts for all defined devices are displayed, along with 
the Volume Database Host Configuration menu and a prompt.

2. Select Update to change a host name. The following prompt is displayed:

3. Enter a robot number or n to change the host name for all standalone drives. The 
following prompt is displayed:

 Deleting robotic definition:
 TLD(0) robotic path = /dev/sg/c1t0d0s0, volume database host=vat
 Any drives defined on this robot will be changed to standalone drives
 Do you want to proceed? (y/n) n:

Enter robot number (or ’n’ for standalone drives):

   Enter new Volume Database Host name:
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4. Enter a new name. The updated list of host names is displayed, along with the menu 
options and prompt.

Displaying and Printing the Configuration
You can display the current configuration from every menu in tpconfig by using the 
Print Configuration option on the main menu, or the List Configuration 
option on the subsequent menus.

You can print the configuration using the Print Configuration option on the main 
menu. When prompted, specify a file where the configuration will be written, or press 
Enter to display the configuration on the screen.

In addition, you can specify the -d option on the tpconfig command to write the 
current configuration to stdout without invoking the menus.
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Using vmadm
 D

This appendix explains how to use the media management utility (vmadm) to add, delete, 
or change media in the Media Manager volume configuration. This utility has a 
character-based interface that can be used at most terminals.

There are also other Media Manager interfaces available to configure media (see 
“Administrator and User Interfaces” on page 2). The terminology, general concepts, and 
results in the database are the same, regardless of which interface you use.

Starting the vmadm Utility

1. The Media Manager volume daemon, vmd, must be active to make any changes with 
vmadm. You can start vmd by entering /usr/openv/volmgr/bin/vmd at the UNIX 
prompt or you can use the Initiate Media Manager Volume Daemon command 
on the Special Actions menu. You need root privileges to start vmd.

2. To start vmadm, enter the command (requires root privileges):

/usr/openv/volmgr/bin/vmadm
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The main menu appears. 

The Volume Database Host shown at the top of the main menu is the host where the 
volume database is located and the Media Manager volume daemon (vmd) is running. 

The following list summarizes each menu command. The remaining topics in this chapter 
explain how to perform common operations.

a) Add Volumes

 Add one or more volumes.

d) Delete Volumes

Delete one or more volumes.

m) Move Volumes

 Move one or more volumes.

p) Print Information about Volumes

Print or display information about selected volumes based on criteria you provide.

c) Configure Volume Pools

Add a new volume pool, delete an existing one, change information about a volume 
pool, or list information about the currently defined volume pools.

s) Special Actions

 Opens a menu with special actions.

u) Device Configuration Utility

        Volume Database Host:  shark
        Media Management
        -----------------
        a) Add Volumes
        d) Delete Volumes
        m) Move Volumes
        p) Print Information about Volumes

        c) Configure Volume Pools
        s) Special Actions

        u) Device Configuration Utility

        h) Help
        q) Quit
        ENTER CHOICE:
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Start the tpconfig device configuration utility.

See the appendix “Using tpconfig” on page 265.

h) Help

 Provides on line help.

q) Quit

Terminates the utility and returns you to the UNIX prompt. You can abort many 
operations by pressing the ESC key.

Configuring Volume Pools
A volume pool identifies a logical set of volumes that are associated by usage rather than 
physical location. For example, you can create a volume pool for each storage application 
you are using. Then, as you add volumes to use with an application, you can associate 
them with a volume pool. You can also move volumes to a different pool later. Volumes 
associated with a particular volume pool are grouped together and protected from access 
by unauthorized users, groups, or applications.

Before adding volumes to a pool, you must add the pool and configure its attributes as 
explained in the following topics. 

Note You do not have to configure a pool for NetBackup or DataStore. Media Manager 
automatically reserves a pool named NetBackup that you specify when adding 
NetBackup volumes and a pool named DataStore when adding DataStore volumes.
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When you enter c on the main menu, the following menu appears:

The following list summarizes the operations you can perform from this menu:

a) Add Pool

Defines a new volume pool. After choosing this option, you are prompted to define 
the following:

- Volume pool name: Name for the new volume pool. Enter a name of 20 ASCII 
characters or less. Names are case-sensitive, and no spaces or special characters 
are allowed.

- Description: Enter the description of the new volume pool (30 ASCII characters or 
less).

- Pool host name: Name of the host that can request and use volumes in this 
volume pool.

Entering a specific host name allows only that host to access the volume pool.

Using the default, ANYHOST, allows any host to access the volume pool.

Note If you have a single NetBackup server, use ANYHOST or the name of the server (not a 
client).

- Pool user name: Login name of the user that is allowed to request and use 
volumes in the volume pool.

                   Display Mode:  BRIEF
             Output Destination:  SCREEN

             Configure Volume Pools
             ----------------------
             a)  Add Pool
             c)  Change Pool
             d)  Delete Pool
             l)  List Pools
             s)  List Scratch Pools

             m)  Mode (brief or full)
             o)  Output Destination (screen or file)
             h)  Help
             q)  Quit Menu

             ENTER CHOICE:
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Entering a specific name allows only the processes running as that user to access 
the volume pool. If a different user requests the pool, then Media Manager 
verifies the group name (see Pool group name).

Using the default, ANY, allows any user to access the pool.

For NetBackup, enter root for the pool user name.

- Pool group name: Name of the user group that can request and use volumes in 
this volume pool.

Entering a specific name allows any processes running as that user group to 
access the volume pool.

Using the default, NONE, allows only the user specified by User Name to request 
or access the volume pool. All other users in any groups are denied access.

- Scratch pool: Yes or No.

c) Change Pool

Changes the description, pool host name, pool user name, pool group name, or 
changes a pool to become the scratch pool. You are prompted for each of these items.

- Scratch pool: Yes or No.

d) Delete Pool

Deletes the volume pool and its allocated name, description, and access permissions.

l) List Pools

Lists the currently defined volume pools and their associated descriptions and 
permissions.

m) Mode (brief or full)

 Toggles the display mode to BRIEF or FULL.

o) Output destination (screen or file)

Toggles between the output destination between SCREEN and FILE. (SCREEN is the 
default). If you choose to write to a file, you can define your own file name or you can 
use the default file, /tmp/vmadm_pool_output. 
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Adding Volumes for Standalone Drives

Adding a Single Standalone Volume

1. On the main menu, choose a for Add Volumes.

2. The following prompt appears:

Enter s to add a single volume.

You are prompted for the media type with a menu similar to the following that 
displays the possible types:

Enter the number for the type of media you want to add. 

3. If you are adding a cleaning tape, you are prompted for the number of cleanings you 
want available. For any other media type, the next step occurs immediately. 

4. You are prompted to enter the media ID. Enter a 1 to 6 ASCII character name.

5. You are prompted for a description. Enter 1 to 25 characters of text to describe the 
media being added.

   Add Single Volume, Range of Volumes, or Auto-Populate? (s/r/a):

             Adding Volumes
             --------------
             Media Type
             ---------- 
             1)   DLT cartridge tape
             2)   8MM cartridge tape
             3)   4MM cartridge tape
             4)   QIC - 1/4” cartridge tape
             5)   DLT cleaning tape
             6)   8MM cleaning tape
             7)   4MM cleaning tape
              Enter Choice [1-7]:
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6. If the media is not a cleaning media type you are prompted to enter the volume pool: 

If you enter 1 (None) the volume is assigned to a generic volume pool and is available 
to any user or application. Enter 2 if you want the volume to be available to 
NetBackup only, or enter another choice to have the volume assigned to one of the 
volume pools listed.

For all media types, you are prompted to enter the physical location of the volume 
using a menu of possible locations, similar to the following menu for an 8mm 
cartridge tape.

Enter 1 for a volume for a standalone drive.

7. You are prompted to enter the volume group, by a menu similar to the following:

             Volume Pool
             ---------- 
             1)  None
             2)  NetBackup
             3)  oldpool
             4)  newpool
             5)  POOL1
             6)  POOL2
             Enter Choice:

             Physical Location
             -----------------
             1)  Not in robotic device
             2)  RSM - Removable Storage Manager
             3)  TL8 - Tape Library 8MM
             4)  TLD - Tape Library DLT
             5)  TLM - Tape Library Multimedia
             6)  TS8 - Tape Stacker 8MM
             Enter Choice [1-6]:

              Volume Group
              ------------
              1)  tl8grp1
              2)  No Volume Group
              3)  Specify New Volume Group Name
              4)  Auto-Generate New Volume Group Name
              Enter choice:
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You may

- Choose from any existing standalone volume groups that allow this volume’s 
media type.

- Elect not to associate the volume with any volume group (if the option is offered).

- Enter a new name of your own choice.

- Have a name generated by vmadm, if the name of volume group is not important 
in this case.

8. The volume is added and you are returned to the main menu.

Adding a Range of Standalone Volumes

1. On the main menu, choose a for Add Volumes.

2. The following prompt appears:

Enter r to add a range of volumes.

3. You are prompted for the media type with a menu similar to the following that 
displays the possible types.

Enter the number for the type of media you want to add.

   Add Single Volume, Range of Volumes, or Auto-Populate? (s/r/a):

              Adding Range of Volumes
              -----------------------
              Media Type
              ---------- 
             1)   DLT cartridge tape
             2)   8MM cartridge tape
             3)   4MM cartridge tape
             4)   QIC - 1/4” cartridge tape
             5)   DLT cleaning tape
             6)   8MM cleaning tape
             7)   4MM cleaning tape
              Enter Choice [1-7]:
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4. If you selected to add a range of cleaning tapes, you are prompted to enter a single 
number which indicates the number of cleanings you want available on each volume 
in the range. For any other media type, the next step occurs immediately.

5. You are prompted for a description. Enter 1 to 25 characters of text to describe the 
media being added. This description applies to all of the volumes in the range.

You are then prompted to enter the volume pool.

For a range of standalone volumes, enter 1. If you enter 1, the volumes are associated 
with a generic volume pool and are available to any user or application.

Enter 2 if you want the volumes to be available to NetBackup only.

Enter another choice to have the volumes assigned to one of the volume pools listed.

6. You are prompted to enter the physical location of the volumes using a menu of 
possible locations, similar to the following menu for an 8mm cartridge tape:

             Volume Pool
             ----------
             1)  None
             2)  NetBackup
             3)  oldpool
             4)  oldpool4
             5)  POOL1
             6)  POOL2
             Enter Choice:

             Physical Location
             -----------------
             1)  Not in robotic device
             2)  RSM - Removable Storage Manager
             3)  TL8 - Tape Library 8MM
             4)  TLD - Tape Library DLT
             5)  TLM - Tape Library Multimedia
             6)  TS8 - Tape Stacker 8MM
             Enter Choice [1-6]:
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7. You are prompted to enter the volume group, by a menu similar to the following:

You may

- Choose from any existing standalone volume groups that allow this volume’s 
media type.

- Elect not to associate the volume with any volume group (if the option is offered).

- Enter a new name of your own choice.

- Have a name generated by vmadm, if the name of volume group is not important 
in this case.

8. You are prompted to enter the media ID naming mode with a menu displaying the 
possible modes.

Enter the desired naming mode. When the volumes are added, the digit field is 
incremented by one for each volume. (Only numbers are incremented.)

9. You are prompted for the media ID of the first volume:

If you had selected naming mode e and entered the 4-character, 2-digit ID, tape01, 
the media ID of the first volume added would be TAPE01, the second TAPE02, and so 
on.

             Volume Group
             ------------
             1)  tl8grp1
             2)  No Volume Group
             3)  Specify New Volume Group Name
             4)  Auto-Generate New Volume Group Name
             Enter choice:

   Media ID Naming Mode
   --------------------
   a)  0 characters and 6 digits
   b)  1 character  and 5 digits
   c)  2 characters and 4 digits
   d)  3 characters and 3 digits
   e)  4 characters and 2 digits
   Enter Choice:

   Enter Media ID for first volume -- using naming mode e:
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10. You are prompted for the number of volumes to add.

11. The volumes are added to the database and you are returned to the main menu.

If any volume cannot be added (for example, if the range you specified overlaps with 
existing volumes), the operation aborts but volumes added before the failure remain 
in the database. 

Adding Volumes to a Robot

Auto-Populating a Robot
You can use auto-populate for robots that support barcodes and for robots that do not 
support barcodes with some operational limitations (see “Robot Attributes” on page 231). 
The easiest way to add new media to a robot is to physically add the media and then use 
Media Manager’s auto-populate feature to update the volume database to agree with the 
contents of the robot. The database update includes automatic creation of media IDs.

If the robot supports barcodes and the volumes have readable barcode labels, 
auto-populate generates media IDs for new volumes based on the last six characters of the 
barcodes as the default or the specific characters that you specify if you are using Media 
ID generation rules. 

When you use barcode rules, new media that is added through a barcode rule is also 
assigned a media type, pool name, maximum number of mounts (or cleaning count), and 
description (see “Configuring Barcode Rules” on page 329).

If the robot does not support barcodes or the media does not have readable barcodes, the 
new media IDs are based on a media ID prefix that you specify.

Using Auto-Populate
The auto-populate operation is the same as an inventory and update operation 
(“Inventory and Update Robot Volume Configuration” on page 318). The following 
procedure explains how to auto-populate a robot and refers you to the update procedure 
at the proper time.

1. Insert the new media into the robot.

2. Check the barcode capabilities of the robot and its media.

   Enter Number of Volumes in Range:
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Before starting an auto-populate operation, perform “Inventory and Compare Robot 
Volume Configuration” on page 316 and check whether the following are true:

- The robot supports barcodes.

- The new media that was inserted has readable barcodes.

If either of the above statements is not true, save the results of the verify for reference, 
in case you assign a media ID prefix later in this procedure. You do not need a prefix if 
the robot supports barcodes and the media has a readable barcode.

3. Create barcode rules (optional).

Refer to “Configuring Barcode Rules” on page 329 and create any additional barcode 
rules that you want to use for auto-populating the database, for the media you have 
inserted into the robot.

4. For robot types that are not API robots, create media ID generation rules (optional). 

See “Configuring Media ID Generation Rules” on page 130 for more information.

5. Ensure that the appropriate control daemons are active on the robot control host.

6. On the main menu, choose a for Add Volumes.

7. Respond to the prompt with a, to use auto-populate.

This brings up a robot selection prompt for selecting the robot where you added the 
media.

The remaining steps are the same as for a robot inventory and update operation. Go to 
step 6 under “Inventory and Update Robot Volume Configuration” on page 318.

Adding a Single Volume to a Robot (Without Auto-Populate)
The following procedure explains how to add a single volume to a robot using the s 
option, rather than Auto-Populate.

Note The first seven steps of this procedure are the same as adding a standalone volume 
(see “Adding a Single Standalone Volume” on page 280) and are only summarized 
here. Refer to that procedure.

1. On the main menu, choose a for Add Volumes.

2. Respond to the prompt with s, to add a single volume.

3. Enter the number for the type of media you want to add.
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4. If you selected a cleaning tape, enter the number of cleanings you want available.

5. Enter a single media ID for tape. A media ID can contain from 1 to 6 characters.

6. Enter a media description (1 to 25 characters).

7. Select a volume pool.

8. Specify that you want the volume added to a robot. You are prompted to enter the 
physical location of the volume using a menu of possible locations, similar to the 
following menu for an 8mm cartridge tape:

Enter the number of the type of device to which you want to add a volume. If a device 
of the specified type does not currently exist, step 10 occurs immediately.

9. The devices of the selected type that currently have volumes in the database are 
displayed, along with the option to specify a new one, similar to the following:

Enter the number of the robot you want to add to, or n to specify a new robot.

10. If you enter n or the robot you chose does not exist, you are prompted for a new, 
unique robot number (which must match the number that will be used when you 
configure the robot or was used when you configured the robot) and the new robot 
control host (where the robotics are controlled). Otherwise, the next step occurs.

11. You are prompted for a slot number for the volume. See the appendix “Robot Drive 
and Slot Layouts” on page 335.

             Physical Location
             -----------------
             1)  Not in robotic device
             2)  RSM - Removable Storage Manager
             3)  TL8 - Tape Library 8MM
             4)  TLD - Tape Library DLT
             5)  TLM - Tape Library Multimedia
             6)  TS8 - Tape Stacker 8MM
             Enter Choice [1-6]:

             Applicable Robot List
             ---------------------
             22)  TL8 - Tape Library 8MM  (bobcat)
             n)   New Robot Number
             Enter Choice:
Appendix D, Using vmadm 287



Adding Volumes to a Robot
12. You are prompted to enter the volume group by a menu similar to the following:

You may choose from any existing volume groups on the device.

Note For some robots, you are asked whether the volume should be injected using the 
media access port. This prompt occurs for robot types that support media access 
ports. This prompt may appear for some robots that do not have these ports, since 
the Media Manager robot type for the robot only indicates that media access ports 
are possible.

13. A reminder to insert the volume in the media access port or into the specified slot of 
the robot is displayed, and you are then returned to the main menu.

If you do not insert the volume now, it is still added to the database and logically 
associated with the robot.

If the robot is not an RSM robot and it has a barcode reader, the barcode is read and 
added to the database when you add the volume, provided you also physically insert 
the volume in the proper slot.

If you insert the volume later, then you must use Update/Validate Barcodes 
for Volumes on the Special menu at that time (see “Updating Barcodes for 
Selected Volumes in a Robot” on page 313).

Adding a Range of Volumes to a Robot (Without 
Auto-Populate)

The following procedure explains how to add a range of volumes to a robot by using the r 
option, rather than Auto-Populate.

Note The first six steps of this procedure are the same as adding a standalone volume (see 
“Adding a Range of Standalone Volumes” on page 282) and are only summarized 
here. Refer to that procedure.

             Volume Group
             ------------
             1)  tl8grp1
             2)  Specify New Volume Group Name
             3)  Auto-Generate New Volume Group Name
             Enter choice:
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1. On the main menu, choose a for Add Volumes.

2. Respond to the prompt with r, to add a range of volumes.

3. Enter the number for the type of media you want to add.

4. If you selected a range of cleaning tapes, enter a single number that indicates the 
number of cleanings you want available on each volume in the range. 

5. Enter a description (1 to 25 characters) that applies to all media in the range. 

6. Select a volume pool.

7. Specify that you want to add the volumes to a robot. You are prompted for the 
physical location of the volumes using a menu of possible locations, similar to the 
following menu for an 8 mm cartridge tape:

Enter the number of the type of robot to which you want to add the volumes. (If a 
device of the specified type does not currently exist, step 8 is skipped and step 9 
occurs.) 

8. The devices of the selected type that currently exist in the database are displayed, 
along with the option to specify a new robot, similar to the following:

Enter the number of the robot you want to add to, or n to specify a new robot.

             Physical Location
             ----------------- 
             1)  Not in robotic device
             2)  RSM - Removable Storage Manager
             3)  TL8 - Tape Library 8MM
             4)  TLD - Tape Library DLT
             5)  TLM - Tape Library Multimedia
             6)  TS8 - Tape Stacker 8MM
             Enter Choice [1-6]:

             Applicable Robot List
             ----------------------
             22) TL8 - Tape Library 8MM  (bobcat)
             n)  New Robot Number
             Enter Choice:
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9. If you enter n or the robot you chose does not exist, you are prompted for a new, 
unique robot number and the new control host. Otherwise, the next step occurs. 

10. You are prompted to enter the volume group, by a menu similar to the following:

You may choose from any existing volume groups on the device.

11. You are prompted for a slot number for the volume. See the appendix “Robot Drive 
and Slot Layouts” on page 335.

12. At this point, the procedure is similar to adding a standalone volume. You are 
prompted to enter the media ID naming mode with a menu displaying the possible 
modes.

Enter the desired naming mode. When the volumes are added, the digit field is 
incremented by one for each volume. Only numbers are incremented.

13. For all devices, you are prompted for the media ID of the first volume. The prompt is 
appropriate for the media type and is similar to one of the following:

(xxx is the slot number you entered in step 11.)

             Volume Group
             ------------
             1)  tl8grp1
             2)  Specify New Volume Group Name
             3)  Auto-Generate New Volume Group Name
             Enter choice:

   Media ID Naming Mode
   --------------------
   a)  0 characters and 6 digits
   b)  1 character  and 5 digits
   c)  2 characters and 4 digits
   d)  3 characters and 3 digits
   e)  4 characters and 2 digits
   Enter Choice:

   Enter Media ID for slot xxx, side A -- using naming mode e:
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or

or

If you had selected naming mode e and entered the ID, tape01, the media ID of the 
first volume added would be TAPE01, the second TAPE02, and so on.

14. You are prompted for the number of volumes to add.

Where x and y represent the range of volumes available.

15. The volumes are added to the database and you are returned to the main menu.

If any volume cannot be added (for example, if the range you specified overlaps with 
existing volumes), the operation aborts, but volumes added before the failure remain 
in the database.

If you do not insert the volume now, it is still added to the database and logically 
associated with the robot.

If the robot is not an RSM robot and it has a barcode reader, the barcode is read and 
added to the database when you add the volume, providing you also physically insert 
the volume in the proper slot. If you insert the volume later, then you must use 
Update/Validate Barcodes for Volumes on the Special menu at that time 
(see “Updating Barcodes for Selected Volumes in a Robot” on page 313).

   Enter Media ID for slot xxx -- using naming mode a:

   Enter 3 Character Prefix for ALL Media IDs:

   Enter Number of Volumes in Range [x-y]:
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Displaying the Volume Configuration

1. On the vmadm menu, choose p for Print Information about Volumes. The 
current print criteria are displayed along with a menu which allows you to change the 
criteria, similar to the following example: 

2. To accept the current settings, select s for Search. With the settings shown in the 
example, you would receive brief information about all volumes on your screen.

3. To change the print criteria, select one of the following options: 

                 Display Filter:  ALL
                   Display Mode:  BRIEF
             Output Destination:  SCREEN

             Display Options
             ---------------
             s)  Search
             m)  Mode (brief or full)
             o)  Output Destination (screen or file)
             f)  Filter
             h)  Help
             q)  Quit Menu
             ENTER CHOICE:

m Select m to toggle the display mode. 
FULL mode displays the most extensive information about each selected volume. 
BRIEF mode displays a subset, one line of information about each selected volume. In 
this mode, volumes are listed in alphabetical order by media ID. The default mode is 
BRIEF. 

o Select o to toggle the output destination between the screen and a file of your choice. 
When you switch from the screen setting to a file, you are prompted for the file name. 
You must enter an absolute path or the enter key for the default file 
/tmp/vmadm_output.
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Displaying the Volume Configuration
4. After you change a print option, you must select s for the information to be printed or 
displayed. If you choose to copy the information to a file, you receive a message after 
you select s that output is written to the file.

vmadm uses the more utility to display information on the screen.

f Select f to change the display filter that determines which volumes are displayed. The 
following options are shown:

  1) ALL

  2) MEDIA ID

  3) MEDIA TYPE

  4) VOLUME GROUP

  5) ROBOT NUMBER

  6) ROBOT TYPE

  7) VOLUME POOL

For entries 2 through 7, you are prompted to enter the appropriate value. Menus of the 
possibilities are provided for entries 3 through 7. The default is the last value chosen and 
is shown in parentheses following the prompt. Initially, information about all volumes is 
shown.
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Displaying the Volume Configuration
The amount of information displayed depends on the mode that you specify. FULL mode 
displays all available information about the selected volumes in a format similar to the    
following example for a single volume:

For a standalone volume, fields that do not apply (for example, robot type, robot number, 
and so on) are not included in the FULL mode display.

For a cleaning tape, number of mounts is replaced by cleanings left.

The status field is not displayed unless the media is assigned.

BRIEF mode displays a subset of the most pertinent information, showing one line per 
volume, by default in alphabetical order by media ID, similar to the example below:

   media ID:                   MIN028
   media type:                 8MM cartridge tape (4)
   barcode:                    00000018
   media description:          configured by GJK
   volume pool:                POOL2 (7)
   robot type:                 TL8 - Tape Library 8MM (6)
   robot number:               0
   robot slot:                 28 (C08)
   robot control host:         hare
   volume group:               TL8-0
   vault name:                 V1
   vault sent date:            Wed Dec 02 09:34:01 1993
   vault return date:          Tue Feb 17 09:34:01 1994
   vault slot:                 546
   vault session id:           37
   created:                    Mon Nov 29 08:39:09 1993
   assigned:                   Tue Nov 30 20:51:28 1993
   last mounted:               Sun Dec  5 20:51:49 1993
   first mount:                Tue Nov 30 20:54:00 1993
   expiration date:            ---
   number of mounts:           6
   max mounts allowed:         ---
   status:                     0x0

media   media   robot  robot  robot  side/  optical  # mounts/      last
 ID     type    type     #    slot   face   partner  cleanings   mount time
--------------------------------------------------------------------------
000001  DLT     TLD      1      1     -       -          17     06/03/1996 00:01
000002  DLT     TLD      1     12     -       -          14     06/03/1996 00:02
000022  DLT     TLD      0      7     -       -           1     04/18/1996 09:25
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Moving Volumes
Even when the same kind of information is returned, such as media type and robot type, 
the FULL display expands the description and is more complete. 

Moving Volumes
When you move volumes in or out of a robot, or from one robot to another, you must 
physically and logically move the volume. The physical part of the move is when you 
remove or insert the volume. The logical move changes the volume database to show the 
volume at the new location. 

You can perform the following types of logical moves:

� Move single volumes

� Move multiple volumes

� Move volume groups

Common instances where you use the move options are:

� Replacing full volumes in a robot. When a robotic volume is full and there are no 
more empty slots in the robot, you move the full volume to standalone, and then 
configure a volume for the empty slot or move a volume into that slot. You could use 
a similar process to replace a defective volume.

� Moving volumes from a robot to an offsite location or from an offsite location into a 
robot. When you move tapes to an offsite location you move them to standalone.

� Moving volumes from one robot to another (for example, if a robot is down).

Moving Volumes (With Inventory and Update)
Inventory a Robot and Update Volume Configuration on the Special 
Actions menu provides the easiest way to logically move media when the following are 
true:

� The move involves a robot that supports barcodes, see “Robot Attributes” on 
page 231.

� The media has readable barcodes.

See “Inventory and Update Robot Volume Configuration” on page 318 for instructions on 
using this option.

If the robot does not support barcodes or the barcodes are unreadable, use the move 
procedures explained in the following topics.
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Moving Volumes
Moving a Single Volume (Without Inventory and Update)

1. On the main menu, choose m to Move Volumes.

2. The following prompt is displayed:

Enter s to move a single volume.

3. You are prompted for the media ID of the volume you want to move:

4. The current residence of the volume is displayed, along with the possible locations to     
which it could be moved, similar to the following example:

5. Enter the new residence for the volume.

   Move Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Changing Volume Residence
             -------------------------
             Enter Media ID:

  Current Residence of 000003:
  robot type:         TL8 - Tape Library 8MM  (6)
  robot number:       10
  robot control host: dill
  volume group:       Sca1000
  robot slot:         4
  barcode:            000003

  New Residence:

  Physical Location
  -----------------
  1)  Not in robotic device
  2)  RSM - Removable Storage Manager
  3)  TL8 - Tape Library 8MM
  4)  TLD - Tape Library DLT
  5)  TLM - Tape Library Multimedia
  6)  TS8 - Tape Stacker 8MM
  Enter Choice [1-6]: (3)
296 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



Moving Volumes
a. If you move a volume out of an TLD or TL8 robot to a standalone location, you 
are asked whether the volume should be ejected using the media access port. This 
is the final step in the procedure.

Note This prompt occurs for robot types that support media access ports (and if vmadm 
supports the eject operation for the robot type). This prompt may be shown for 
some robots that do not have this support, since the robot type for the robot only 
indicates that media access ports are possible.

b. If you choose to move a volume into a robot, you are prompted with a menu of 
possible robots, similar to the following:

Enter the number of the appropriate robot. If you choose n, you are prompted to 
enter a new robot number and robot control host.

You are prompted for the tape slot to which the volume should be moved. See the 
appendix “Robot Drive and Slot Layouts” on page 335.

6. You are prompted to enter the volume group, by a menu similar to the following:

You may do one of the following:

- Choose from any volume groups in the list.

- Elect not to associate the volume with any volume group (if the option is offered).

- Enter a new name of your own choice.

- Have a name generated by vmadm, if the name of volume group is not important 
in this case.

             Applicable Robot List
             ---------------------
             10) TL8 - Tape Library 8MM (dill)
             20) TL8 - Tape Library 8MM (dill)
             n)  New Robot Number
             Enter choice:

             Volume Group
             ------------ 
             1)  tl8grp1
             2)  No Volume Group
             3)  Specify New Volume Group Name
             4)  Auto-Generate New Volume Group Name
             Enter choice:
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Moving Volumes
7. If you move a volume from or to robots that support media access ports (and vmadm 
supports that robot with eject or inject), you are asked whether the volume should be 
ejected and then injected using the media access port.

Moving a volume in vmadm changes only its logical residence in the volume database. It 
must also be moved physically, unless it is injected or ejected using the media access port.

When you move a volume to a robot (other than RSM) that has a barcode reader, Media 
Manager performs a Validate and Update Barcode operation on that volume.

Moving Multiple Volumes
Moving multiple volumes is similar to moving single volumes, except that once you 
choose where you want the volumes to be moved, you are prompted to continue entering 
media IDs of volumes to move. You also do not have the option to eject and inject volumes 
using the media access port.

1. On the main menu, choose m to Move Volumes.

2. The following prompt is displayed:

Enter m to move multiple volumes.

3. You are prompted for the media ID of the first volume you want to move:

   Move Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Moving Volumes
             --------------
             Enter First Media ID:
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Moving Volumes
4. The current residence of the volume is displayed, along with the possible locations to 
which it could be moved, similar to the following menu:

 

5. Enter the new residence for the volumes, which you will specify next.

6. If you move the volumes into a robot, you are prompted with a menu of possible 
libraries, similar to the following:

Enter the number of the appropriate robot. If you choose n, you are prompted to enter 
a new robot number and a new robot control host.

  Current Residence for all volumes in list:
  robot type:         TL8 - Tape Library 8MM  (6)
  robot number:       10
  robot control host: dill
  volume group:       Sca1000
  robot slot:         3
  barcode:            000002

  New Residence for all volumes in list:

  Physical Location
  -----------------
  1)  Not in robotic device
  2)  RSM - Removable Storage Manager
  3)  TL8 - Tape Library 8MM
  4)  TLD - Tape Library DLT
  5)  TLM - Tape Library Multimedia
  6)  TS8 - Tape Stacker 8MM
  Enter Choice [1-6]: (3)

             Applicable Robot List
             ---------------------
             10) TL8 - Tape Library 8MM (dill)
             20) TL8 - Tape Library 8MM (dill)
             n)  New Robot Number
             Enter choice:
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Moving Volumes
7. You are prompted to enter the volume group, by a menu similar to the following:

You may

- Choose from any volume groups in the list.

- Elect not to associate the volume with any volume group (if the option is offered).

- Enter a new name of your own choice.

- Have a name generated by vmadm, if the name of volume group is not important 
in this case.

8. Depending on the device, you are prompted for a media ID or to specify location 
information for each volume.

9. At this point, the volumes are moved, messages confirming the moves are displayed, 
and you are returned to the main menu.

Moving volumes in vmadm changes only their logical residence in the volume database. 
They must also be moved physically. When you move volumes to a robot (other than 
RSM) that has a barcode reader, Media Manager performs a Validate/Update Barcode 
operation on those volumes.

Moving a Volume Group
A volume group can be moved to a new robot or made standalone. All volumes must 
have their new slot numbers identified, as the move operation leaves slot numbers 
unmodified.

See “Volume Pools and Volume Groups” on page 242, for a definition of a volume group.

Note If a volume group is moved back into a robot, every volume must be returned to its 
original slot.

             Volume Group
             ------------
             1)  tl8grp1
             2)  No Volume Group
             3)  Specify New Volume Group Name
             4)  Auto-Generate New Volume Group Name
             Enter choice:
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Moving Volumes
1. On the main menu, choose m for Move Volumes.

2. The following prompt is displayed:

Enter v to move a volume group. 

3. A menu of possible groups is displayed, similar to the following menu:

Enter the number of the volume group you want to move.

4. The current residence of the volume group is displayed, along with a prompt to 
choose the new location, similar to the following menu:

You can move a volume group only between a robotic location and standalone. To 
move a group from one robot to another, you must move the group to standalone, as 
an intermediate step, and then to the new robot.

  Move Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Volume Group
             ------------
             1)  00_025_TL8
             2)  10i-1
             3)  10i-2
             4)  axc
             Enter choice:

  Current Residence for Volume Group 00_025_TL8:
  ----------------------------------------------
  robot type:         TL8 - Tape Library 8MM  (3)
  robot number:       25
  robot control host: bobcat

  New Residence:

  Physical Location
  -----------------
  1)  Not in robotic device
  Enter Choice [1-1]: (1)
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Deleting a Single Volume
If you selected a standalone volume group to move, the physical locations listed 
would not offer option (1), but would show the robot type to which the volumes could 
be moved, as in the following sample menu:

Enter the new residence for the volume group. The volumes are logically moved and 
you are returned to the main menu.

Moving volumes in vmadm changes only their logical residence in the volume database. 
They must also be moved physically.

Deleting a Single Volume

Note You cannot delete volumes that are assigned, until they are unassigned. Only 
NetBackup uses the assigned state. See “Deassigning Volumes” on page 83 for more 
information.

1. On the main menu, choose d for Delete Volumes.

2. The following prompt appears:

Enter s to delete a single volume.

3. You are then prompted for the media ID of the volume you want to delete:

             New Residence:
             Physical Location
             -----------------
             1)  RSM - Removable Storage Manager
             2)  TL8 - Tape Library 8MM
             3)  TLD - Tape Library DLT
             4)  TLM - Tape Library Multimedia
             5)  TS8 - Tape Stacker 8MM
             Enter Choice [1-5]:

  Delete Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Deleting Volume
             ---------------
             Enter Media ID:
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Deleting Multiple Volumes
4. The deletion is confirmed with a message, and you are returned to the main menu.

The volume is deleted from the database, not physically from the device.

Deleting Multiple Volumes

Note You cannot delete volumes that are assigned, until they are unassigned. Only 
NetBackup uses the assigned state. See “Deassigning Volumes” on page 83 for more 
information.

1. On the main menu, choose d for Delete Volumes.

2. The following prompt appears:

Enter m to delete multiple volumes. 

3. You are then prompted for the media ID of the volume you want to delete:

Pressing the Escape key cancels the operation. Continuing causes the volume to be 
deleted, when all the desired volumes have been entered. You continue to be 
prompted for media IDs until you press only the Enter key.

4. The volumes are deleted, messages confirm each deletion, and you are returned to the 
main menu.

The volumes are deleted from the database, not physically from the device.

Deleting a Volume Group

Note You cannot delete volumes that are assigned, until they are unassigned. Only 
NetBackup uses the assigned state. See “Deassigning Volumes” on page 83 for more 
information.

   Delete Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Deleting Volumes
             ---------------
             Enter Media ID:
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Changing a Volume’s Description
1. On the main menu, choose d for Delete Volumes.

2. The following prompt appears:

Enter v to delete a volume group.

3. A menu of the possible volume groups is displayed, similar to the following:

Enter the number of the volume group you want to delete.

4. The volumes in the specified group are deleted and you are returned to the main 
menu.

The volumes are deleted from the database, not physically from the device.

Changing a Volume’s Description

1. On the main menu, choose s for Special Actions.

2. Choose d for Change Media Description for Volume.

3. The following prompt appears:

Enter the media ID of the volume whose description you want to change.

   Delete Single Volume, Multiple Volumes, or Volume Group? (s/m/v):

             Volume Group
             ------------
             1)  00_025_TL8
             2)  10i-1
             3)  10i-2
             4)  cc
             Enter choice:

             Changing Media Description for Volume
             -------------------------------------
             Enter Media ID:
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Changing a Volume’s Volume Pool
4. The current media description and a prompt for the new description is displayed, 
similar to the following:

Enter the new description and press Enter. You are returned to the Special 
Actions menu.

Changing a Volume’s Volume Pool
Volumes are in a specific volume pool or are associated with a generic volume pool. The 
volume pool row in the Print Information about Volumes FULL display mode, 
shows the name of the volume pool to which the volumes belong (if any).

Once associated with a pool, volumes are assigned or unassigned. Only the NetBackup 
application use the assigned state. A NetBackup volume becomes assigned when it is 
requested by a user or an application. The time of the assignment appears in the assigned 
row in the Print Information about Volumes FULL display mode.

A volume must be in an unassigned state before you can change its volume pool. 
Attempting to change its volume pool while the volume is assigned results in an error.

1. Deassign the volume if it is assigned to NetBackup (See “Deassigning Volumes” on 
page 83 for more information).

2. On the main menu, choose s for Special Actions.

3. Choose p for Change Volume Pool for Volumes. 

             Current Media Description for 000000: test
             Enter Media Description (25 char max):
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Changing the Expiration Date for Volumes
4. The list of defined volume pools appears:

Enter 1, if you want the volume associated with the generic volume pool; the volume 
will be available to any user or application. Enter 2 if you want the volume to be 
available to NetBackup only; or enter another choice to have the volume associated 
with one of the volume pools listed. 

5. You are prompted for the media ID of the volume to change. You will continue to be 
prompted for media IDs until you press the Enter key without typing a media ID. 

Changing the Expiration Date for Volumes
The administrator can change the expiration date for any volume in the volume database. 
The expiration date refers to the age of the media (not the data on the media) and is the 
time at which the media is considered too old to be reliable.

When its expiration date has passed a volume can still be read, but it will not be mounted 
for a write access. Requesting write access to a volume whose expiration date has passed 
results in an error; requesting read access results in a warning being logged to the system 
console log. 

You can set or change an expiration date for a single volume or for multiple volumes.

1. On the main menu, choose s for Special Actions.

2. Choose e for Change Expiration Date for Volumes.

At the prompt, enter 0 for no expiration date or enter a date in one of the following 
formats: 

- mm/dd/yy hh/mm/ss

- mm/dd/yyyy hh/mm/ss

             Changing Volume Pool for Volumes
             ------------------------------- 
             Volume Pool
             ----------
             1)  None
             2)  NetBackup
             3)  oldplatters
             4)  newplatters
             5)  POOL1
             6)  DataStore
             Enter Choice:
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Changing the Volume Group for Volumes
- mm/dd/yy

- mm/dd/yyyy

- mm/dd

3. You are then prompted to enter the media ID of the volume to associate with this 
expiration date. You will continue to be prompted for media IDs until you press the 
Enter key without typing a media ID.

Changing the Volume Group for Volumes

1. On the main menu, choose s for Special Actions.

2. Choose g for Change Volume Group for Volumes.

The following prompt appears:

3. Enter the media ID of the first volume you want to change and press Enter. You will 
continue to be prompted for media IDs until you press the Enter key without typing a 
media ID.

As you enter the media IDs, Media Manager validates them to ensure they have 
common media types and residences.

4. When you exit from this prompt, a list similar to the following appears:

The list will include existing volume groups that are valid for the media you specified 
in step 3, (00_000_TL8 in this example), and also have options for specifying a new 
volume group name or having vmadm generate a new name.

             Changing Volume Group for Volumes
             ---------------------------------
             Enter Media ID:

             Volume Group
             --------------
                  1) 00_000_TL8
                  2) Specify New Volume Group Name
                  3) Auto-Generate New Volume Group Name
            Enter Choice:
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Change Vault Name for Volumes
If you choose to specify a new volume group name, a prompt appears allowing you to 
enter the name.

Change Vault Name for Volumes
You can set, clear, or change the vault name that contains the volume. This field is used by 
NetBackup Vault to determine what offsite location the volume is located in while offsite. 
You can change the vault name for a single volume or for multiple volumes, as follows:

1. On the main menu, choose s for Special Actions.

2. Choose a for Change Vault Parameters for Volumes.

3. Choose n for Change Vault Name for Volumes.

The following prompt appears:

Enter the new vault name. Entering a hyphen means that the name will be cleared.

4. You are prompted for the media IDs for which you want this vault name applied. You 
will continue to be prompted for media IDs until you press the Enter key without 
typing a media ID. If you enter the ESC key, your changes will not be applied.

Change Date Volumes are Sent to Vault
You can set, clear, or change the date a volume is sent to the vault. This field is used by 
NetBackup Vault to record when a volume was sent to an offsite vault.

You can change this date for a single volume or for multiple volumes, as follows:

1. On the main menu, choose s for Special Actions.

2. Choose a for Change Vault Parameters for Volumes.

3. Choose s for Change Date Volumes are sent to Vault.

             Changing Vault Name for Volumes
             ---------------------------------
             (enter ’-’ to clear vault name)
             Enter Vault Name(25 chars max):
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Change Date Volumes Return from Vault
The following prompt appears:

Enter the new date the volume is sent offsite. Entering 0 means that the date will be 
cleared.

4. You are then prompted for the media IDs for which you want this date applied. You 
will continue to be prompted for media IDs until you press the Enter key without 
typing a media ID. If you enter the ESC key, your changes will not be applied.

Change Date Volumes Return from Vault
You can set, clear, or change the date a volume returns from the vault. This field is used by 
NetBackup Vault to record when a volume is requested to be returned from the vault. You 
can change this date for a single volume or for multiple volumes, as follows:

1. On the main menu, choose s for Special Actions.

2. Choose a for Change Vault Parameters for Volumes.

3. Choose r for Change Date Volumes return from Vault.

The following prompt appears:

Enter the new date. Entering 0 means that the date will be cleared.

4. You are then prompted for the media IDs for which you want this date applied. You 
will continue to be prompted for media IDs until you press the Enter key without 
typing a media ID. If you enter the ESC key, your changes will not be applied.

             Changing Date Volume(s) Sent to Vault
             ---------------------------------
             (vault sent date of 0 means clear entry)
             Enter date volumes(s) sent to vault:

             Changing Date Volume(s) return from Vault
             ---------------------------------
             (vault return date of 0 means clear entry)
             Enter date volume(s) return from vault):
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Change Vault Slot for Volumes
Change Vault Slot for Volumes
You can set, clear, or change the slot that the volume is contained in at the vault. This field 
is used by NetBackup Vault to determine what slot the volume is located in while in the 
vault. You can change the slot for a single volume or for multiple volumes, as follows:

1. On the main menu, choose s for Special Actions.

2. Choose a for Change Vault Parameters for Volumes.

3. Choose s for Change Vault Slot for Volumes.

The following prompt appears:

Enter the new vault slot. Entering 0 means that the slot will be cleared.

4. You are then prompted for the media IDs for which you want this slot applied. You 
will continue to be prompted for media IDs until you press the Enter key without 
typing a media ID. If you enter the ESC key, your changes will not be applied.

Change Vault Session ID for Volumes
You can set, clear, or change the vault session ID that a volume was processed in. This 
field is used by NetBackup Vault to determine what session was used for a volume when 
it was vaulted. You can change the session ID for a single volume or for multiple volumes, 
as follows:

1. On the main menu, choose s for Special Actions.

2. Choose a for Change Vault Parameters for Volumes.

3. Choose i for Change Vault Session ID for Volumes.

The following prompt appears:

             Setting Vault Slot for Volumes
             ---------------------------------
             Enter Vault Slot: (0)

             Setting Vault Session ID for Volumes
             ---------------------------------
             Enter Vault Session ID: (0)
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Setting the Maximum Mounts for Volumes
Enter the new session ID. Entering 0 means that the session ID will be cleared.

4. You are then prompted for the media IDs for which you want this session ID applied. 
You will continue to be prompted for media IDs until you press the Enter key without 
typing a media ID. If you enter the ESC key, your changes will not be applied.

Setting the Maximum Mounts for Volumes
You can set or change the maximum number of times a volume can be mounted. Once this 
number is reached, any further requests to mount the volume for a write operation result 
in an error. Specifying a maximum allowed mount count of 0, means there is no limit on 
the number of times a volume can be mounted.

To help determine the maximum mount count to use, consult your vendor documentation 
for information on the expected life of the media.

You can set the maximum allowed mounts for a single volume or for multiple volumes, as 
follows:

Note You cannot set the maximum number of mounts for a cleaning cartridge.

1. On the main menu, choose s for Special Actions.

2. Choose s for Set Maximum Allowed Mounts for Volumes.

A prompt is displayed for specifying a maximum mount count. Entering 0 means 
there is no limit to the number of times the volume can be mounted. 

3. You are then prompted for the media IDs for which you want this maximum allowed 
mounts applied. You will continue to be prompted for media IDs until you press the 
Enter key without typing a media ID.

Changing the Cleanings Allowed for a Cleaning Tape
When you added cleaning tapes, you specified a cleaning count. If you need to adjust that 
count, use the following procedure:

1. On the main menu, choose s for Special Actions.

2. Choose m for Modify Number of Cleanings on Cleaning Cartridge.
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Starting and Stopping the Media Manager Volume Daemon
3. The following prompt appears:

Enter the media ID of the cleaning tape for which you want to change the cleaning 
count.

4. The current number of cleanings and a prompt to enter a new number for the cleaning 
count is displayed, similar to the following:

5. Enter a new number. The cleaning count is changed to the new number and you are 
returned to the Special Actions menu.

For more information about cleaning tapes, see the tpclean(1M) man page.

Starting and Stopping the Media Manager Volume Daemon
The Media Manager volume daemon, vmd, must be active to perform the operations in 
vmadm, even though you can start the utility without vmd running.

You can start vmd by entering the following command:

/usr/openv/volmgr/bin/vmd

You can also control vmd from vmadm, as follows:

To Start the Volume Daemon

1. On the main menu, choose s for Special Actions. 

2. Choose i for Initiate Media Manager Volume Daemon. This starts vmd and 
you are returned to the Special Actions menu.

             Changing Cleaning Count for Volume
             ----------------------------------
             Enter Media ID:

          Current Number of Cleanings for TEST:26
          Enter New Number of Cleanings:
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Updating Barcodes for Selected Volumes in a Robot
To Stop the Volume Daemon

1. On the main menu, choose s for Special Actions.

2. Choose t for Terminate Media Manager Volume Daemon. This stops the 
daemon and returns you to the Special Actions menu.

Updating Barcodes for Selected Volumes in a Robot
Use Update/Validate Barcode for Volumes on the Special Actions menu to 
check the barcodes of selected volumes in robots (that can read barcodes) and update the 
volume database if necessary. “Robot Attributes” on page 231 lists the robots that support 
barcodes.

Use this option only to fill in barcodes that are missing from the database. For example, if 
you logically add a new volume but do not physically insert it into the robot, the database 
will not include the barcode. In this case, you can use the Update/Validate Barcode 
option to fill in the missing barcode.

Do not use this option to correct a database entry that shows an incorrect media ID in a 
slot. Here, you must update the database by using a move option (see “Moving Volumes” 
on page 295) or the inventory and update option (see “Inventory and Update Robot 
Volume Configuration” on page 318).

1. Ensure that the appropriate robotic daemons are active on the robot control host. To 
start the daemons, see “Robotic Daemons” on page 162.

2. On the main menu, choose s for Special Actions. 

3. Choose u for Update/Validate Barcode for Volumes.

The following prompt appears:

4. Enter the media ID of the first volume you want to update and press the Enter key. 
You will continue to be prompted for media IDs until you press the Enter key without 
entering a media ID.

When you press the Enter key to exit from the Enter Media ID prompt, the barcodes 
are updated and you are returned to the Special Actions menu.

   Validating/Updating Barcodes for Volumes
   ----------------------------------------
   Enter Media ID:
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Inventory and Report Robot Volume Configuration
Use Inventory a Robot and Report Contents from the Special Actions 
menu, to inventory a selected robot and obtain a report that shows which media ID is in 
each slot. If the robot can read barcodes (see “Robot Attributes” on page 231) then barcode 
information is included in the report.

Note If a volume happens to be in a drive, the report shows it in the slot it came from.

This option does not check or change the database, but is useful for listing the contents of 
a robot.

1. Ensure that the appropriate control daemon is active on the host that controls the 
robot you are going to inventory. See “Robotic Daemons” on page 162.

2. On the main menu, choose s for Special Actions.

3. Choose c for Inventory a Robot and Report Contents.

If the volume database has entries for robotic volumes, vmadm lists the robot number, 
robot type, and robot control host for those robot types. For example:

a. If the desired robot is not in the list, choose none of the above and go to 
step 4.

b. If the desired robot is in the list, enter the number corresponding to the robot (for 
example, enter 3 for TL8 0 on whale) and go to step 5.

c. If the desired robot is a RSM type, the menu shows a robot control host of NONE. 
If you choose a RSM robot, you are prompted for the Robot Control Host. At this 
prompt, enter the host on which the RSM daemon (rsmd) is running. 

             Robot from Volume Configuration
             -------------------------------
             1)  TLD 2 -- breaker
             2)  TL4 3 -- breaker
             3)  TL8 0 -- whale
             4)  none of the above
             Enter choice:
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d. If the volume database has no entries for robotic volumes, you are prompted to 
specify a robot control host on which to search the device configuration for robots.

Respond to this prompt as explained in step 4.

4. If the device configuration has no robots or you have chosen none of the above in 
step 3, you are prompted to select a robot control host on which to search the device 
configuration for robots:

a. Enter a host name and then the Enter key, or press Enter without typing a name to 
select the default host shown in the parentheses. Media Manager searches for 
robots in the device configuration on the selected host.

Note For NetBackup BusinesServer, press Enter to select the default control host.

Note If Media Manager does not find any robots in the device configuration, vmadm 
displays a “robot not obtained” message.

b. If Media Manager finds robots in the device configuration, it lists their robot 
number, robot type, and robot host. For example:

To report the contents of a robot in the list, enter the number corresponding to the 
robot (for example, 1 for TLD 0 on shark) and go to step 5.

If a list appears but the desired robot is not shown, choose none of the above. 
In this case, vmadm shows a “robot not obtained” message and you must 
configure the robot before you can perform the inventory and report.

5. When you have selected a robot, vmadm displays a report that shows the contents of 
the robot.

            Enter Robot Control Host:   (whale)

            Enter Robot Control Host:   (whale)

             Robot from Device Configuration
             -------------------------------
             1)  TLD 0 -- shark
             2)  TLD 1 -- shark
             3)  none of the above
             Enter choice:
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For robots with a barcode reader, Media Manager obtains the barcode and includes it 
in the report. If the robot does not support barcodes or the media does not have a 
readable barcode, <none> appears in place of the barcode.

Inventory and Compare Robot Volume Configuration
Use the Inventory a Robot and Compare with Volume Configuration on the 
Special Actions menu to physically inventory a robot, compare the results with the 
contents of the volume database, and obtain a list of recommended changes.

The report shows discrepancies between the contents of the robot and the contents of the 
volume database. If the robot can read barcodes, then barcode information is included in 
the report.

This option does not change the database, but is useful for verifying whether the volume 
database is correct after tapes have been physically moved in the robot. If the report 
shows that the media in a slot does not match what is in the database, you can physically 
move the media or change the database using a move option (see “Moving Volumes” on 
page 295) or the inventory and update option (see “Inventory and Update Robot Volume 
Configuration” on page 318).

1. Ensure that the appropriate control daemon is active on the host that controls the 
robot you are going to inventory. See “Robotic Daemons” on page 162.

2. On the main menu, choose s for Special Actions.

3. Choose v for Inventory a Robot and Compare with Volume 
Configuration.

If the volume database has entries for robotic volumes, vmadm lists the robot number, 
robot type, and robot host for those robots. For example:

             Robot from Volume Configuration
             -------------------------------
             1)  TLD 2 -- breaker
             2)  TL4 3 -- breaker
             3)  TL8 0 -- whale
             4)  none of the above
             Enter choice:
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a. If the desired robot is not in the list, choose none of the above and go to 
step 4.

b. If the desired robot is a RSM type, the menu shows a robot control host of NONE. 
If you choose a RSM robot, you are prompted for the Robot Control Host. At this 
prompt, enter the host on which the RSM daemon (rsmd) is running. 

c. If the desired robot is in the list, enter the number corresponding to the robot (for 
example, enter 3 for TL8 0 on whale) and go to step 5.

d. If the volume database has no entries for robotic volumes, you are prompted to 
specify a robot control host on which to search the device configuration for robots.

Respond to this prompt as explained in step 4.

Note A robot does not appear in the list, if it does not have any volume entries in the 
volume database you are using for the compare. 

4. If the volume database has no robotic volumes or you have chosen none of the 
above in step 3, you are prompted to select a robot control host on which to search 
the device configuration for robots:

a. Enter a host name and then the Enter key, or press Enter without typing a name to 
select the default host shown in the parentheses. Media Manager searches for 
robots in the device configuration on the selected host.

Note For NetBackup BusinesServer, press Enter to select the default control host.

Note If Media Manager does not find any robots in the device configuration, vmadm 
shows a “robot not obtained” message. 

            Enter Robot Control Host:   (whale)

          Enter Robot Control Host:   (whale)
Appendix D, Using vmadm 317



Inventory and Update Robot Volume Configuration
b. If Media Manager finds robots in the device configuration, it lists their robot 
number, robot type, and robot host. For example:

To inventory and compare the volume database entries for a robot in the list, enter 
the number corresponding to the robot (for example, 1 for TLD 0 on shark) and go 
to the next step.

If a list appears but the desired robot is not shown, choose none of the above. 
In this case, vmadm displays a “robot not obtained” message and you must 
configure the robot and insert media before you can perform the inventory and 
update.

5. When you have selected a robot, vmadm displays a report comparing the contents of 
the robot with the contents of the volume database.

See “Comparing Robot Contents with the Volume Configuration” on page 97 for 
example reports.

For robots that have a barcode reader, Media Manager determines whether the 
barcodes in the robot match those in the volume database. When the report shows 
<none>, it means that the media does not have a barcode.

For robots that cannot read barcodes, vmadm verifies only whether the volume 
database correctly shows whether a slot contains media.

Inventory and Update Robot Volume Configuration
Use Inventory a Robot and Update Volume Configuration on the Special 
Actions menu to inventory a robot and compare the results with the contents of the 
volume database. 

You can then optionally update the volume database to agree with what is in the robot. 
When you insert new media, the database update includes automatic creation of media 
IDs (based on barcodes or a prefix that you specify). If you use barcode rules, new media 
that is added through a barcode rule can also be assigned a media type, volume pool, 
maximum number of mounts (or number of cleanings), and description (see “Configuring 
Barcode Rules” on page 329).

             Robot from Device Configuration
             -------------------------------
             1)  TLD 0 -- shark
             2)  TLD 1 -- shark
             3)  none of the above
             Enter choice:
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Note insert means the media is placed physically in the robot without using an add or 
move option to update the database. remove means to take media out of a robot 
without using a move option.

See “Updating the Volume Configuration for a Robot” on page 99 for instructions on 
when to use and when not to use the Inventory and Update option.

To Inventory and Update Robot Volume Configuration

1. Check the barcode capabilities of the robot and its media (optional).

Before doing an inventory and update, perform “Inventory and Compare Robot 
Volume Configuration” on page 316 and check whether the following are true:

- The robot supports barcodes.

- The new media that was inserted has readable barcodes.

If the robot does not support barcodes or the media does not have readable barcodes, 
save the results of the verify for reference, in case you assign a media ID prefix later in 
this procedure.

2. For robot types that are not API robots, create media ID generation rules (optional). 

See “Configuring Media ID Generation Rules” on page 130 for more information.

3. Create barcode rules (optional).

Refer to “Configuring Barcode Rules” on page 329 and create any barcode rules that 
you want to use for updating the database for media that has been inserted into the 
robot.

4. Ensure that the appropriate control daemons are active on the robot control host.

To start the daemons, see “Robotic Daemons” on page 162.

5. On the main menu, choose s for Special Actions.

6. Choose r for Inventory a Robot and Update Volume Configuration.
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If the volume database has entries for robotic volumes, vmadm lists the robot number, 
robot type, and robot host for those robots. For example:

a. If the robot you want to inventory and update is in the list, enter the number 
corresponding to the robot (for example, enter 3 for TL8 0 on whale) and go to 
step 8.

b. If the desired robot is not in the list, choose none of the above and go to 
step 7.

c. If the desired robot is a RSM type, the menu shows a robot control host of NONE. 
If you choose a RSM robot, you are prompted for the Robot Control Host. At this 
prompt, enter the host on which the RSM daemon (rsmd) is running. 

d. If the volume database has no entries for robotic volumes, you are prompted to 
specify a robot control host on which to search the device configuration for robots.

Respond to this prompt as explained in step 7.

Note A robot does not appear in the list if it does not have any volume entries in the 
volume database you are updating. This will be the case, if you configure a new 
robot and are adding media to it using the inventory and update option.

7. If the volume database has no robotic volumes or you have chosen none of the 
above in step 6, you are prompted to select a robot control host on which to search 
the device configuration for robots:

             Robot from Volume Configuration
             -------------------------------
                  1)  TLD 2 -- breaker
                  2)  TL4 3 -- breaker
                  3)  TL8 0 -- whale
                  4)  none of the above
             Enter choice:

            Enter Robot Control Host:   (whale)

            Enter Robot Control Host:   (whale)
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a. Enter a host name and then the Enter key, or press Enter without typing a name to 
select the default host shown in the parentheses. Media Manager searches for 
robots in the device configuration on the selected host.

Note For NetBackup BusinesServer, press Enter to select the default control host.

Note If Media Manager does not find any robots in the device configuration, vmadm 
shows a “robot not obtained” message.

b. If Media Manager finds robots in the device configuration, it lists their robot 
number, robot type, and robot host. For example:

To inventory and update the volume database entries for a robot in the list, enter 
the number corresponding to the robot (for example, 0 for TLD 1 on shark) and go 
to step 8.

If a list appears but the desired robot is not shown, choose none of the above. 
In this case, vmadm shows a “robot not obtained” message and you must 
configure the robot and insert media before you can perform the inventory and 
update.

             Robot from Device Configuration
             -------------------------------
                  1)  TLD 0 -- shark
                  2)  TLD 1 -- shark
                  3)  none of the above
             Enter choice:
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8. When you have selected a robot, the Inventory and Update Robot menu 
appears. For example:

Inventory a robot and update its volume database entries as follows:

a. Use the m option to toggle the update mode.

- INTERACTIVE causes vmadm to display a list of recommended changes after 
the inventory, and prompts you to confirm whether to proceed with updating 
the database.

- NOT INTERACTIVE causes vmadm to make the recommended database 
changes without prompting for a confirmation.

You may want to use the NOT INTERACTIVE mode after you become 
familiar with performing robot inventories

b. To view the current inventory and update settings or change them, choose o and 
refer to “Changing Update Options” on page 323”.

c. When the update options are as you want them, choose the u option to start the 
inventory and update operation.

See “Updating the Volume Configuration for a Robot” on page 99 for example 
reports.

  Inventory and Update Robot:  TLD (10) - whale

  Update Mode:  INTERACTIVE

  Inventory and Update
  --------------------
  u)  Inventory Robot and Update Volume Configuration

  m)  Change Update Mode
  o)  Change Update Options

  h)  Help
  q)  Quit Menu

  ENTER CHOICE:
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Changing Update Options
When you choose o from the Inventory and Update Robot menu, the Update 
Options menu appears. The example below shows the defaults for a new installation.

These are also the defaults each time you enter the options menu, with the possible 
exception of the Media ID Prefix. The Media ID prefix default will be the last entry in the 
vm.conf file, if one exists (see step 5 below).

For most configurations, the default update options work well. You should only change 
the defaults if your configuration has special hardware or usage requirements.

1. Choose whether to use barcode rules when adding new media, by using the b option 
to toggle Use Barcode Rules between YES and NO.

Note Media Manager attempts to use barcode rules only for barcodes that are not already 
in the volume database.

- YES causes Media Manager to search existing barcode rules and apply them to 
new media that has been inserted into a robot.

- NO causes Media Manager to ignore the barcode rules.

  Update Robot:  TL8 (10) - whale

  OPTION FOR REMOVED MEDIA
  ------------------------
          Volume Group:  DEFAULT
  OPTIONS FOR ADDED OR MOVED MEDIA
  --------------------------------
          Volume Group:  DEFAULT
     Use Barcode Rules:  YES
            Media Type:  DEFAULT
       Media ID Prefix:  DEFAULT
           Volume Pool:  DEFAULT

                   Update Options
                   --------------
   b)  Use Barcode Rules   r)  Volume Group for REMOVED media
   m)  Media Type          a)  Volume Group for ADDED or MOVED media
   i)  Media ID Prefix     p)  Volume Pool

   h)  Help
   q)  Quit Menu

   ENTER CHOICE:
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See “Configuring Barcode Rules” on page 329 for more information on barcode rules 
and how to define them.

2.  Choose m to open a menu that shows the media types that are valid for this robot. The 
menu will be similar to the following.

a.  If you are not using barcode rules:

- Media Manager uses the default media type for the robot (see the table 
“Default Media Types for Robots” on page 109).

- To use a media type other than the default, choose one from the menu.

b. If you are using barcode rules:

- Choose DEFAULT to let the barcode rule determine the media type that is 
assigned.

Note If you also choose DEFAULT for the barcode rule, Media Manager assigns the 
default media type for the robot (see the table “Default Media Types for Robots” on 
page 109).

- To use a media type other than the default, choose a specific type from the 
menu.

The update media type always overrides the rule. If you specify any value 
other than DEFAULT on the Update Options menu, the media type for the 
rule must be the same type or DEFAULT in order to obtain a match (except for 
cleaning media as explained below). 

The following list shows what happens for various combinations of update 
and barcode rule media types.

       Update Options  Barcode Rule      Rule     Media Type in
       Media Type      Media Type        Used     Volume Database
       ----------      ----------        -----    ---------------
       DLT             DEFAULT           Yes         DLT
       DLT             DLT               Yes         DLT
       DLT             DLT CLEAN         Yes         DLT CLEAN
       DLT CLEAN       DLT               No          DLT CLEAN

          Media Type
          ----------
            1)  DEFAULT
            2)  DLT cartridge tape
            3)  DLT cleaning tape
            Enter Choice [1-3]:  (1)
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       DLT CLEAN       DLT CLEAN         Yes         DLT CLEAN
       DLT CLEAN       DEFAULT           Yes         DLT CLEAN
       DLT             (8MM, 4MM ...)    No          DLT
       DEFAULT         DEFAULT           Yes         DLT
       DEFAULT         DLT               Yes         DLT
       DEFAULT         DLT CLEAN         Yes         DLT CLEAN
       DEFAULT         (4MM ...)         No          Robot-type dependent

- The third barcode rule in the list shows Media Manager’s ability to automatically 
add cleaning cartridges with regular media, when you execute an update for a 
robot.

If the media you insert includes a cleaning tape, then Media Manager 
automatically adds the tape correctly, if the following are true:

- The update media type is for the regular media (DLT in this example).

- The barcode on the tape matches a barcode tag and the barcode rule media 
type is the cleaning media (DLT CLEAN in this example).

Also see “Example 5: Add cleaning tapes to a robot” on page 121.

- The fifth and sixth rules in the list illustrate how to add only cleaning media.

In the fifth rule, you specify the cleaning media type on both the Update 
Options menu and in the barcode rule. In the sixth rule, you specify the cleaning 
media on the Update Options menu and choose default in the barcode rule.

3. Choose a to open a menu for selecting the volume group that Media Manager will 
assign to media that you have inserted into the robot (or moved to a new location 
within the robot).

The menu will be similar to the following: 

The menu always has choices for:

- Specifying a new volume group name.

- Auto generating a new volume group (default). You can also auto generate a new 
volume group name by entering DEFAULT for the new volume group name.

Other choices that are available depend on the selected media type.

             Volume Group
             ------------
             1)  00_000_TL8
             2)  Specify New Volume Group Name
             3)  Auto-Generate New Volume Group Name
             Enter choice:
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- If Media Type is DEFAULT, the menu shows existing volume groups that are 
valid for the robot’s default Media Type.

- If Media Type is other than DEFAULT, the menu shows the existing volume 
groups that are valid for the media type.

4. Choose r to open a menu for selecting the volume group that Media Manager will 
assign to media that you have removed from the robot.

The menu will be similar to the following: 

The menu always has choices for:

- Specifying no volume group name.

- Specifying a new volume group name.

- Auto generating a new volume group (default). You can also auto generate a new 
volume group name, by entering DEFAULT for the new volume group name.

Other choices that are available depend on the selected media type.

- If Media Type is DEFAULT, the menu shows existing volume groups that are 
valid for the robot’s default Media Type.

- If Media Type is other than DEFAULT, the menu shows the existing volume 
groups that are valid for the media type.

5. Specify a value for Media ID prefix if either of the following conditions are true (see 
step 1 under “Inventory and Update Robot Volume Configuration” on page 318):

- The robot does not support barcodes

- The media that was inserted does not have readable barcodes.

If neither of the above conditions are true, a prefix is not required since Media 
Manager assigns the last six characters of the barcode or the specific characters that 
you specify if you are using Media ID generation rules as the media ID for media 
added to the robot. This applies whether or not a barcode rule is used.

             Volume Group
             ------------
             1)  00_000_NON
             2)  No Volume Group
             3)  Specify New Volume Group Name
             4)  Auto-Generate New Volume Group Name
             Enter choice:
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To select a value for Media ID prefix, choose i from the Update Options menu to 
display a selection list that is similar to the following:

Choose one of the following from the list:

- If there are existing media ID prefixes, you can choose one of them from the list. 
The existing prefixes come from MEDIA_ID_PREFIX entries that you added to 
the vm.conf file on the host where you are running vmadm. For example, entries 
for the list above would be:

MEDIA_ID_PREFIX = NV

MEDIA_ID_PREFIX = NETB

MEDIA_ID_PREFIX = ADD

- Default Media ID Prefix

In this case, Media Manager first checks the vm.conf file for MEDIA_ID_PREFIX 
entries.

- If vm.conf has MEDIA_ID_PREFIX entries, then Media Manager assigns the 
last one as the default prefix.

- If vm.conf does not have any prefix entries, Media Manager assigns the 
letter A as the default prefix.

- Use No Media ID Prefix

This operation will succeed only if the robot supports barcodes and the media has 
readable barcodes. Otherwise, Media Manager is unable to assign new media IDs 
and the operation fails (with an accompanying error message).

This choice may be useful if you are using media with barcodes and want updates 
to fail when unreadable or missing barcodes are encountered.

- Specify New Media ID Prefix

             Media ID Prefix
             -------------
               1)  NV
               2)  NETB
               3)  ADD
               4)  Default Media ID Prefix
               5)  Use No Media ID Prefix
               6)  Specify New Media ID Prefix
             Enter choice:
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You can specify a new media ID prefix having from one to five alpha-numeric 
characters. Media Manager assigns the remaining numeric characters. For 
example, if the prefix is NETB, the media IDs are NETB00, NETB01, and so on.

Note A new media ID prefix is used only for the current operation. It is not added to 
vm.conf and does not appear in the Media ID prefix list the next time you use the 
Update Options menu.

6. Choose p to change the volume pool from the default. A menu similar to the 
following appears:

If you are using barcode rules:

- Choose Default Volume Pool to let the barcode rule determine the volume 
pool that is assigned. 

- To use a volume pool other than the default, choose one from the menu.

The Update Options volume pool always overrides the rule.

If you are not using barcode rules:

- Choose Default Volume Pool to use the NetBackup volume pool for data 
volumes and no volume pool for cleaning tapes (the same as choosing None). 

- To use a volume pool other than the default, choose one from the menu.

7. When you are satisfied with the settings, choose q to return to the Inventory and 
Update Robot menu.

             Volume Pool
             ----------
               1)  None
               2)  NetBackup
               3)  a_pool
               4)  DataStore
               5)  Default Volume Pool
             Enter choice:
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Configuring Barcode Rules
A barcode rule specifies criteria for creating volume database entries for new robotic 
volumes that you are adding through an auto-populate or inventory and update 
operation (see “Auto-Populating a Robot” on page 285 and “Inventory and Update Robot 
Volume Configuration” on page 318). You select whether to use barcode rules when you 
set up the auto-populate, or inventory and update.

The following are some example barcode rules.

  Barcode    Media      Volume     Max Mounts/
  Tag        Type       Pool       Cleanings    Description
  -------------------------------------------------------------
  0080       8MM        b_pool      55          new 008 volumes
  DLT        DLT        d_pool     200          dlt backup
  CLD        DLT_CLN    None        30          dlt cleaning
  CLT        8MM_CLN    None        20          8mm cleaning
  TS8        8MM        t_pool       0          8mm backup
  TS         8MM        None         0          8mm no pool
  <NONE>     DEFAULT    None         0          no barcode
  <DEFAULT>  DEFAULT    NetBackup    0          other barcodes

Barcode Rule Sorting
Rules are sorted, first according to the number of characters in the barcode tag (see 
example list above) and then in the order you add them. The two exceptions are the 
<NONE> and <DEFAULT> rules which are always at the end of the list. 

When an inventory and update, or auto-populate operation uses barcode rules and a new 
barcode is detected in a slot, Media Manager searches the rules starting at the top of the 
list and checks for a barcode tag that matches the new barcode. If a barcode tag matches, 
the media type for the rule is checked to ensure that it is compatible with what you 
specified for the inventory and update. If the media type also matches, Media Manager 
uses the rule’s media type, volume pool, max mounts (or number of cleanings), and 
description to create a volume database entry for the media ID.

Note Media Manager attempts to use barcode rules only for barcodes that are not already 
in the volume database.

Barcode Rule Examples
For example, assume that during an inventory and update for a TS8 robot, you select the 
following update options for a new 8 mm tape (see “Inventory and Update Robot Volume 
Configuration” on page 318):
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Media Type: 8MM

Volume Group: 00_000_TS8

Use Barcode Rules: YES

Volume Pool: DEFAULT

If a new tape in this robot has a barcode of TS800001 and there are no media generation 
rules defined, Media Manager uses the rule with the barcode tag named TS8 and includes 
the following values in the volume database entry for the tape:

Media ID:     800001 (last six characters of barcode)

Volume Group: 00_000_TS8

Volume Pool:  t_pool

Max Mounts:   0 (infinite)

If a new tape has a barcode of TS000001 and there are no media generation rules defined, 
the rule named TS is used and volume database entry for the tape will contain:

Media ID:     000001 (last six characters of barcode)

Volume Group: 00_000_TS8

Volume Pool:  None

Max Mounts:   0 (infinite)
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Barcode Rule Menu
To configure barcode rules, choose Configure Barcode Rules from the Special 
Actions menu. The following menu appears:

Adding a Barcode Rule
To add a new barcode rule, choose a from the Configure Barcode Rules menu and 
enter the following information at the prompts:

Barcode Tag

Enter a barcode tag for the rule. The tag can have from 1 to 16 characters and no spaces. 

The only rules where you can use special characters in the barcode tags areas follows:

<NONE >

Matches when rules are used and the media has an unreadable barcode, or the robot 
does not support barcodes.

<DEFAULT>

For media with barcodes, this tag matches when none of the other barcode tags 
match, providing the media type in the <DEFAULT> rule and the media type on the 
Update Options menu are compatible. The Update Options menu is where you 
set up the criteria for an inventory and update operation (see “Inventory and Update 
Robot Volume Configuration” on page 318).

                   Display Mode:  BRIEF
             Output Destination:  SCREEN

            Configure Barcode Rules
            -----------------------
            a)  Add Rule
            c)  Change Rule
            d)  Delete Rule
            l)  List Rules

            m)  Mode (brief or full)
            o)  Output Destination (screen or file)
            h)  Help
            q)  Quit Menu

            ENTER CHOICE:
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Description

Enter a 1 to 25 character description of the rule that will be assigned to new volumes when 
the rule is used.

Media Type

A rule is disregarded if the media type in the rule is not compatible with the media type 
for the update. See “Inventory and Update Robot Volume Configuration” on page 318.

Select the media type for this rule, as follows:

� Select DEFAULT to have the rule match any media type that you select on the Update 
Options menu. If you also select DEFAULT for the update, Media Manager uses the 
default media type for the robot. See “Changing the Update Options” on page 103.

� Select a specific media type to have the rule match only when you select that specific 
media type or DEFAULT on the Update Options menu. If you choose DEFAULT 
for the update, Media Manager assigns the rule’s media type.

The following example shows the results with various combinations of update selections 
and barcode rule media types for a TLD robot.

  Update Options  Barcode Rule      Rule     Media Type in
  Media Type      Media Type        Used     Volume Database
  ----------      ----------        -----    ---------------
  dlt             default           Yes        dlt
  dlt             dlt               Yes        dlt
  dlt             dlt clean         Yes        dlt clean
  dlt clean       dlt               No         dlt clean
  dlt clean       dlt clean         Yes        dlt clean
  dlt             (8mm, 4mm ...)    No         dlt
  default         default           Yes        dlt
  default         dlt               Yes        dlt
  default         dlt clean         Yes        dlt clean
  default         (4mm ...)         No         Robot-type dependent

Maximum Allowed Mounts or Number of Cleanings

When a barcode rule is used, Media Manager adds the number you specify to the volume 
database for the media ID. 

For

� Media other than cleaning tapes, enter the maximum number of mounts to allow for 
this media ID (also see “Setting the Maximum Mounts for Volumes” on page 311).

� Cleaning tapes, enter the number of cleanings to allow (also see “Changing the 
Cleanings Allowed for a Cleaning Tape” on page 311).
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Configuring Barcode Rules
Volume Pool

Specify a volume pool for the volume. This is the pool that the volume will be added to, 
when a barcode matches the rule.

Whenever the barcode rule is used, and the Update Options menu shows

� DEFAULT for the volume pool, then the volume is assigned to the pool specified in 
the barcode rule.

� A specific volume pool, then that selection overrides the pool specified in the barcode 
rule.

Changing a Barcode Rule
To change a barcode rule, choose c from the Configure Barcode Rules menu and 
select the desired rule from the resulting list. You are then prompted to change the 
description, Media Type, Maximum Allowed Mounts (or Number of Cleanings), and 
Volume Pool.

For Media Type, Maximum Allowed Mounts, and Number of Cleanings, the current value 
appears in parentheses (pressing the Enter key without typing a new value leaves the 
value unchanged).

Note You cannot use Change Barcode Rule to change the barcode tag. To change a 
barcode tag, delete the rule and then add a rule with the new tag.

Deleting a Barcode Rule
To delete a barcode rule, choose d from the Configure Barcode Rules menu and 
select the desired rule from the list.

Listing Barcode Rules
To list existing barcode rules, set the Display Mode and Output Destination options 
and then choose l (List Rules) from the Configure Barcode Rules menu.
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Configuring Barcode Rules
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Robot Drive and Slot Layouts
 E

This appendix contains diagrams of slot layouts and drive locations in some of the more 
popular robots supported by Media Manager. If your robot is not included here, see the 
vendor’s documentation for the device.
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ADIC Scalar 218 (TLD)
ADIC Scalar 218 (TLD)

Note With a barcode reader installed, the slot physically labeled as slot 1 is disabled, and 
physical slots 2 through 18 become known in Media Manager as slots 1 through 17. 
With a virtual media access port configured, physical slot 12 becomes the port and 
physical slots 2-11 and 13-18 become known in Media Manager as slots 1-16.

Exabyte 430
Sony LIB-304 (TL8)

Drive 2 Drive 1 

Slot 1 Slot 12

Slot 13 Slot 18

. . .20  11

Fixed Cartridge Slots Tape Drives

Magazine 1Magazine 2

. . .10  1

. . .21  30 1  4

Media access port

32
336 NetBackup BusinesServer Media Manager System Administrator’s Guide for UNIX



ADIC VLS DLT (TSD)
ADIC VLS DLT (TSD)

ATL 2/28 DLT Library (TLD)

Drive 1 (the only drive)

SlotSlot

1 72 3 4 5 6

Drive 2

Drive 1

I/E slot 1

I/E slot 2

I/E slot 3

I/E slot 4

.

.

.

.

.

.

.

.

.

Slot 8

Slot 1

Slot 16

Slot 9 Slot 17

Slot 24

(Not Used) (Not Used) (Not Used)
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ATL P1000 Sun StorEdge L1000 (TLD)
ATL P1000 
Sun StorEdge L1000 (TLD)

The slot mapping shown below apply to libraries that are configured with 25 slots. Other 
configurations may vary.

Slot 5

Slot 4

Slot 6

Slot 7

Slot 8

Slot 9

Slot 18

Slot 25

Slot 10

Slot 17

Slot 1

Slot 2

Slot 3

Drive 1 Drive 2

Drive 3 Drive 4

Back (Inside view of back wall from the front

Front (Inside view of front wall from the back

Media 
Access 
Port
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ATL M1500 M4 Data M1500 (TLD)
ATL M1500 
M4 Data M1500 (TLD)

The slot mapping below shows a robot with two units, each unit having two removable 
magazines. For NetBackup BusinesServer, only a single unit is allowed and the fixed slot 
is 21.

Front View

Top Unit

Bottom Unit

Removable

Magazine

Removable

Magazine

Removable

Magazine

Removable

Magazine

Slot 1

Slot 10

Top Unit - (Front) Bottom Unit - (Front)

Slot 20

Slot 11

Slot 21

Slot 30

Slot 40

Slot 31

Top View of Magazines

Slot 41 Slot 42
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Breece Hill Q2.15 IBM 7337-305 IBM 3447-105 (TLD)
Breece Hill Q2.15
IBM 7337-305 
IBM 3447-105 (TLD)

Breece Hill Q7 (TLD)

Drive 1 Drive 2 

(Top View)

Slot 1 Slot 10

Slot 11 Slot 15

Drive 1

Drive 2

Face 0 Face 3Face 2Face 1

.

.

.

.

.

.

.

.

.

.

.

.

Slot 8

Slot 14Slot 7

Slot 1 Slot 15

Slot 21 Slot 28

Slot 22
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Compaq 35/70 (TLD)
Compaq 35/70 (TLD)

Exabyte 10i, 10e, 10h
Exabyte 210
Exabyte EZ17 (TS8)

Drive 1 Drive 2

.

.

.

.

.

.

.

.

.

Slot 5

Slot 1 Slot 6

Slot 10 Slot 15

Slot 11

Drive 1

.

.

.

Drive 1

Drive 2

Drive 1

.

.

.

.

.

.

EZ17Fixed Slot 0
EXB-210

EXB-10i and 10e

Slot 1

Slot 7

Slot 10

Slot 1

Slot 1

Slot 10
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Exabyte 18D (TLD)
Exabyte 18D (TLD)

Exabyte 220
ADIC Scalar AIT 220 
Sun StorEdge L400 (TL8)

Drive 1

.

.

.

Slot 1

Slot 8

Drive 1

Drive 2

Face 0 Face 1

.

.

.

.

.

.

Fixed Slot 0

Slot 11

Slot 20

Slot 1

Slot 10
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Exabyte 230D (TLD)
Exabyte 230D (TLD)

HP SureStore 1/9
Sun StorEdge L9 (TLD)

This is a top view of the robot.

Drive 2

Drive 1

Fixed slot - 0

Face-0 Face-1 Face-2 Face-3 Face-4 Face-5

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Slot 5 Slot 10 Slot 15 Slot 20 Slot 25 Slot 30

Slot 1 Slot 6 Slot 11 Slot 16 Slot 21 Slot 26

Drive 1
Slot
7

Slot
1

Slot
2

Slot
3

Slot
4

Slot
8

Slot
5

Slot
9

Slot
6
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ADIC Fastor (TLD)
ADIC Fastor (TLD)

.

.

.

 

Slot 6

Slot 7

Slot 1

Slot 5

 

Drive 1

BackFront
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IBM 7331 (TL8)
IBM 7331 (TL8)

Note Supported only on UNIX device hosts.

NEC Autoloader DLT (TLD)
The following diagram shows a standard model.

Slot 1

Slot 10
.
.
.

Slot 11

Slot 20

Slot 21

Slot 22

.

.

.

Drive 2

Drive 1
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NEC Autoloader DLT (TLD)
The following diagram shows a model with a barcode reader.

F
R

O
N

T

B
A

C
K

Magazine

Fixed Slots

Drive

.

.

.

Slot 7

Slot 1

.

.

.

Slot 10

Slot 8

F
R

O
N

T

B
A

C
K

Magazine

Fixed Slots

Drive

.

.

.

Slot 7

Slot 1

.

.

.

Slot 10

Slot 8

(Invalid Slot)

Barcode 
Reader
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Overland Data LXBx110 Overland Data LXBx210 Compaq TL891 Compaq TL892 (TLD)
Overland Data LXBx110 
Overland Data LXBx210 
Compaq TL891
Compaq TL892 (TLD)

.

.

.

Slot 10

Slot 1

Front

(Tape Holder)

(LXBx210 has two drives inside)

(LXBx110 has one drive inside) 
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Overland Data Library Pro (TL8)
Overland Data Library Pro (TL8)
The following is the top view.

.

.

.

Slot 19

Drive 2

Drive 1

Slot 1

Media 
access 
port

Picker
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Overland Data NEO Overland Data LxL1u11 (TLD)
Overland Data NEO
Overland Data LxL1u11 (TLD)

The following diagram shows a robot with the media access port enabled.

The following diagram shows a robot with the media access port disabled and is also 
similar to the LxL1u11 model which only supports one drive and 11 slots.

FRONT

BACK

Drive 2

.

.

.

Slot 1

Slot 12

Drive 1

.

.

.

Slot 13

Slot 25

Media 
access 
port

FRONT

BACK

Drive 2

.

.

.

Slot 1

Slot 13

Drive 1

.

.

.

Slot 14

Slot 26
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Compaq Storage Works MSL 5026 Compaq Storage Works MSL 5052 (TLD)
Compaq Storage Works MSL 5026
Compaq Storage Works MSL 5052 (TLD)

The following diagram shows a 5026 robot model.

The following diagram shows a 5052 robot model.

FRONT

BACK

Drive 2

.

.

.

Slot 0

Slot 11

Drive 1

.

.

.

Slot 12

Slot 24

Media 
access 
port

Drive 2

.

.

.

Slot 0

Slot 11

Drive 1

.

.

.

Slot 12

Slot 24

Media 
access 
port

TOP FRONT

Drive 4

.

.

.

Slot 25

Slot 36

Drive 3

.

.

.

Slot 37

Slot 49

Media 
access 
port

BOTTOM BACK

BOTTOM FRONT

TOP BACK
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STK 9730 STK 9738 DELL 130T HP SureStore E 3/30 (A4853A) (TLD)
STK 9730 
STK 9738 
DELL 130T
HP SureStore E 3/30 (A4853A) (TLD)

If auto cleaning is set, slots 9 through 30 (or 9 through 28) become slots 8 through 29 (or 8 
through 27). The slot labeled below as slot 8 becomes reserved for library use (for a 
cleaning tape). Other configurations may vary.

Column 0 Column 1 Column 2

Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Slot 8

Slot 14

Slot 13

Slot 12

Slot 11

Slot 10

Slot 9

Slot 15

Slot 16

Slot 17

Slot 18

Slot 24

Slot 25

Slot 26

Slot 27

Slot 28

Slot 19

Slot 20

Slot 21

Slot 22

Slot 23

Slot 29

Slot 30

Drive Slot 4

Drive Slot 3

Drive Slot 2

Drive Slot 1
Media 
access 
port

Represents a cleaning cartridge 
cell if auto clean is enabled

Note: If a drive is not installed in slot 3, 

additional storage cells can be 

Cartridges MAPDrives

1-4 128 or 30
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STK L20 NCR 6461 (TLD)
STK L20
NCR 6461 (TLD)

If the media access port is turned on in the configuration, slot 20 becomes the media access 
port and is unusable for storage.

Drive 
2

Drive 
1

.

.

.

Slot 1

Slot 10

.

.

.

Slot 19

Slot 11

Slot 20 / 
Port
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Glossary
access control list (ACL)

Security information associated with files on some file systems. 

ACS

Automated Cartridge System. ACS can refer to any of the following:

� A type of Media Manager robotic control. This robot type is supported only by 
NetBackup DataCenter servers.

� The StorageTek (STK) system for robotic control.

� The highest-level component under STK’s ACS library software, which refers to a 
specific standalone robotic library or to multiple libraries connected with a media 
passthru mechanism.

active job

A job for which NetBackup is currently processing backup or restore data.

activity logs

See “debug logs.”

activity monitor

A NetBackup administration utility that displays information about NetBackup jobs and 
provides limited control over them.

administration client

See “remote administration console.” 

administrator

A user that is granted special privileges to install, configure, and manage the operation of 
a system, network, or application.
353



AIT

Sony Advanced Intelligent Tape, a type of tape drive or media type.

alternate-client restore

See “redirected restore (different client).”

alternate-target restore

See “redirected restore (different target).” 

alternate path restore

See “redirected restore (different path).” 

alternate read server

A server used to read a backup image which was originally written by a different media 
server. The media server specified as Alternate Read Server must have access to the media 
containing the backup image or images it is configured to read.

archive

A special kind of backup where NetBackup backs up the selected files, and if the backup 
is successful, deletes the files from the local disk. In this manual, references to backups 
also apply to the backup portion of archive operations except where otherwise noted.

archive bit

A file-status bit that the Microsoft based operating system sets when it writes a file, 
thereby indicating that the file has changed.

attributes for a policy

Configuration parameters that control the behavior of NetBackup during operations 
involving this policy.

autochanger

See “robotic library.” 

autoloader

See “robotic library.” 

automatic backup

A scheduled backup by the master server.
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back up

The act of copying and saving files and folders to storage media.

backup

Refers to the process of copying and saving files and directories to storage media. For 
example, the backup is complete. This term can also refer to the collection of data that 
NetBackup saves for a client during a backup or archive. For example, duplicate the backup.

Backup is two words when used as a verb. For example, back up the file.

backup, archive, and restore interface

The name of the NetBackup Microsoft Windows and Java based user interfaces for clients. 
On servers these interfaces can be started through the NetBackup Administration 
Console.

backup window

The period of time during which backups can begin.

block size

The number of bytes in each block of data written on the media during a backup.

bp

A backup, archive, and restore utility for users on NetBackup UNIX clients. It has a 
character-based, menu interface that can be run from terminals that do not have X 
Windows capabilities.

bpadm

An administrator utility that runs on NetBackup UNIX servers. It has a character-based, 
menu interface that can be run from terminals that do not have X Windows capabilities.

bp.conf file

A NetBackup configuration file on UNIX servers and also on UNIX, Macintosh, and OS/2 
clients.

bp.ini file

NetBackup initialization file for Novell NetWare target clients.

bpcd

NetBackup Client service on Windows and the NetBackup Client daemon on UNIX. 
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bprd

NetBackup Request Manager service on Windows and NetBackup Request daemon on 
UNIX.

cancel a job

Terminating a job and removing it from the job queue.

carousel

See “robotic library.” 

catalogs

Internal NetBackup and Media Manager databases. These catalogs contain information 
about configuration, media, devices, status, errors, and the files and directories in the 
stored backup images.

CDF

Context-dependent file, which is a type of directory structure on a Hewlett-Packard 
system.

changer

See “robotic library.” 

class

See “policy.”

client

The system with the files to back up, archive, or restore.

client-user interface

See “user interface.”

cluster

See master and media server cluster.

command lines

Commands that users can execute either from the system prompt or in scripts.

compression

The process of compacting data to enable more efficient transmission and storage.
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configuration

The parameters that govern the behavior of an application. This term can also refer to the 
manner in which a network or system is laid out or connected (for example, a network 
configuration).

consolidated eject

A process of ejecting media for more than one Vault session at a time. A Consolidated 
Eject can be performed for one or more logical vaults at one time.

consolidated report

A process of generating reports for more than one Vault session at a time. A Consolidated 
Report can be performed for one or more logical vaults at one time. Consolidated reports 
are organized by report title, not by vault.

cpio

A UNIX command that can be used for copying files to or from a cpio archive on disk or 
tape.

ctime

The time that a UNIX inode was changed.

cumulative-incremental backup

A backup that is scheduled by the administrator on the master server and backs up files 
that have changed since the last successful full backup. All files are backed up if no prior 
backup has been done. Also see “differential-incremental backup.” 

daemon

A program on a UNIX system that runs in the background and performs some task (for 
example, starting other programs when they are needed). Daemons are generally referred 
to as services or processes on Windows server systems.

database-agent clients

Clients with additional NetBackup software that is designed to back up relational 
databases.

database-extension clients

See “database-agent clients.” 
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debug logs

Logs that can be optionally enabled for specific NetBackup and Media Manager programs 
and processes and then used to investigate problems.

destination storage unit

A storage unit to which Vault sends the data from a duplication operation. If the 
duplicated backup images are to be vaulted, then the destination storage unit must 
correspond to the robotic volume group.

device delays

Delays caused by the device that are beyond the control of the storage application. An 
example is the time required to position tape under the read and write heads. 

device host

A host (that has Media Manager installed) where a drive or robotic control is attached or is 
defined.

device monitor

A Media Manager administration utility that provides monitoring and manual control of 
Media Manager storage devices. For example, an administrator or computer room 
operator can use this utility to manually reset devices or set them to the UP or DOWN 
state.

DHCP

Dynamic host configuration protocol. This TCP/IP protocol automatically assigns 
temporary IP addresses to hosts when they connect to the network.

differential-incremental backup

Scheduled by the administrator on the master server and backs up files that have changed 
since the last successful incremental or full backup. All files are backed up if no prior 
backup has been done. Also see “cumulative-incremental backup.” 

directory depth

The number of levels below the current directory level that the NetBackup interfaces 
show in their directory and file list displays.

directory tree

The hierarchical structure in which files are organized on a disk. Each directory lists the 
files and directories that are directly below it in the tree. On UNIX, the topmost directory 
is called the root directory.
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disaster recovery

Recovering data from backups after a disk crash or other catastrophe.

disk

Magnetic or optical disk storage media.

disk-image backup

A bit-by-bit rather than a file system backup of a disk drive on a Windows platform.

DLT

Digital-linear tape or tape drive type.

Domain Name Service (DNS)

A program that handles name translation for network communications.

drive cleaning

The use of a special cleaning tape to clean the heads on a drive.

duplicate image

A copy of a backup image.

eject

Move media out of a robotic library.

encryption

Provides additional security by encrypting backup data on the client. This capability is 
available only with the NetBackup Encryption option.

entry and exit ports

See “media access port.” 

exclude list

A list that designates files or directories to exclude from automatic backups.

expiration (image)

The date and time when NetBackup stops tracking a backup image.
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expiration (volume)

The date and time when the physical media (tape) is considered to be no longer usable.

external media ID

This is an identifier written on a media cartridge or canister to help the operator identify 
the volume before inserting it into a drive or robot. For labeled media, the external media 
ID should be the same as the media ID recorded on the media.

EVSN

See “external media ID.”

FlashBackup

A special type of raw-partition backup that requires the NetBackup FlashBackup 
separately-priced option (this option is available only for NetBackup DataCenter).

flush level

Controls how often Netbackup clears its log files on a Novell NetWare or Microsoft 
Windows client platform.

fragment

A part of a backup or archive image. NetBackup can be configured to divide images into 
fragments when they exceed a certain size or span tapes.

frequency (backup)

How often NetBackup performs scheduled backups. For example, if the frequency is 
seven days then backups occur once a week.

FROZEN media state

If a volume is FROZEN, NetBackup keeps it indefinitely and can restore from it but not 
use it for further backups or archives.

full backup

A backup that copies, to a storage unit, all files and directories that are beneath a specified 
directory.

FULL media state

If this appears in a report or listing, it indicates the volume is FULL and cannot hold more 
data or be used for further backups.
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global attributes

NetBackup configuration attributes that affect all policies.

GDM Dashboard

The name for the Global Data Manager interface. The Dashboard enables monitoring job 
and drive activity on multiple master servers, as well as providing alerts to problem 
conditions.

GDM Managed Server

A NetBackup master server that appears as a managed master server in the left pane of 
the GDM Dashboard.

GDM Server

A NetBackup master server that has the Global Data Manager license activated. When 
logging into this host, the user can monitor the activity on multiple master servers using 
the GDM Dashboard interface. If the host has installed the Advanced Reporter option, the 
reports show information on multiple master servers.

Global Data Manager (GDM)

A separately-priced option (for UNIX servers) that provides an interface with a tree view 
where the administrator can view and administer multiple master servers. The server 
where the option is installed is called a GDM Server.

Global Device Database

A single host that serves as the repository for global device configuration information. 
When you install NetBackup, by default the master server is configured as the global 
device database host.

GNU tar

A public domain version of the UNIX tar program.

goodies directory

A directory containing programs, scripts, and other files that are not formally supported.

GUI

Graphical user interface.
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hard link 

On UNIX, a hard link is a pointer to the inode for the data. On a Windows server, a hard 
link is a directory entry for a file. Every file can be considered to have at least one hard 
link. On NTFS volumes each file can have multiple hard links, and a single file can appear 
in many directories (or even in the same directory with different names).

heap level

A parameter for memory-heap debugging on a Novell NetWare or Windows NetBackup 
client.

hierarchical storage management

The process of automatically migrating selected files from a managed file system to 
specified migration levels on secondary storage, while maintaining transparent access to 
those files.

host

A computer that executes application programs.

host name

Name by which a host computer is identified by programs and other computers in the 
network.

HSM

See storage migrator.

image

The collection of data that NetBackup saves for an individual client during each backup or 
archive. The image contains all the files, directories, and catalog information associated 
with the backup or archive.

import

The process of recreating NetBackup records of images so the images can be restored.

include list

A list that designates files or directories to add back in from the exclude list.

incremental backup

See “cumulative-incremental backup” and “differential-incremental backup.” 
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inject

Move media into a robotic library.

inport

See “media access port.” 

inode

A UNIX data structure that defines the existence of a single file.

install_path

Directory where NetBackup and Media Manager software is installed. The default on 
Windows servers is C:\Program Files\VERITAS and on UNIX it is /usr/openv.

jbpSA

The Java-based NetBackup interface for performing user backups, archives, and restores.

jnbSA

The Java-based NetBackup interface for administrators.

job

A parcel of work submitted to a computer. NetBackup jobs are backups, archives, or 
restores.

kernel

The nucleus of an operating system.

keyword phrase

A textual description of a backup.

kill a job

See “cancel a job.”

label

Identifier of a tape or optical disk volume. A recorded label includes a media ID.

A barcode label allows a barcode scanner to be used for media tracking.

library

See “robotic library.”
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link

See “hard link” or “symbolic link.” 

LMF - Library Management Facility

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

load

(noun) Amount of work that is being performed by a system or the level of traffic on a 
network. For example, network load affects performance.

(verb) Copy data to internal memory. For example, load the installation program.

(verb) Used to indicate tape drive initialization done when new media is being added.

logs

Files where a computer or application records information about its activities.

mailslot

See “media access port.” 

man pages

Online documentation provided with UNIX computer systems and applications.

Master and media server cluster

A NetBackup master server and the remote media servers that it is using for additional 
storage. It is possible to configure clusters only with NetBackup DataCenter servers. 
NetBackup BusinesServer supports only a single server, the master.

Master of Masters

A NetBackup host where Global Data Manager software is installed. When logging into 
this host, the interface has a tree view where the administrator can view and administer 
multiple master servers.

master server

The NetBackup server that provides administration and control for backups and restores 
for all clients and servers in a master and media server cluster. NetBackup BusinesServer 
supports only a single server and it is the master.
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media

Physical magnetic tapes, optical disks, or magnetic disks where data are stored.

media access port

A slot or other opening in a robot where you can insert or remove a tape without having 
to access the interior of the robot. After inserting a tape, you move it to a slot by using an 
inject command. Prior to removing a tape, you move it to the port by using an eject 
command. The inject and eject commands are supported through the add and move 
screens in the Media Manager administration interface.

media host

NetBackup server to which the job (client) is sending the data.

media ID

An identifier that is written on a volume as part of the recorded label.

Media Manager

Software that is part of NetBackup and manages the storage devices and removable 
media.

Media Manager Host

Host where Media Manager is installed (may have devices attached).

media server

A NetBackup server that provides storage within a master and media server cluster. The 
master can also be a media server. A media server that is not the master is called a remote 
media server. NetBackup BusinesServer does not support remote media servers.

menu interface

A character-based interface for use on terminals that do not have graphical capabilities.

mount 

Make a volume available for reading or writing.

mount point

The point where a file system on a disk logically connects to a system’s directory structure 
so the file system is available to users and applications.
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MPX

See “multiplexing.” 

mtime

The point in time when a UNIX or NTFS file is modified.

multiplexing

The process of sending concurrent-multiple backups from one or more clients to a single 
storage device and interleaving those images onto the media.

multiplexed group

A set of backups that were multiplexed together in a single multiplexing session.

NDMP

Network data management protocol. NetBackup requires the NetBackup for NDMP 
separately-priced option to support NDMP.

NetBackup Client service

NetBackup Windows service that runs on clients and servers and listens for connections 
from NetBackup servers and clients in the network. When a connection is made, this 
service starts the necessary programs.

NetBackup configuration options

On UNIX servers and on UNIX and Macintosh, clients, these settings are made in the 
bp.conf file. On NetWare target and OS/2 clients, they are in the bp.ini file. On 
Windows servers and Windows clients, these settings are called properties and are made 
through the Backup, Archive, and Restore interface or the Host Properties dialog in the 
NetBackup Administration Console.

NetBackup databases

See catalogs. 

NetBackup Database Manager service

NetBackup Windows service that runs on the master server and manages the NetBackup 
internal databases (called catalogs). This service must be running on the master server 
during all NetBackup administrative operations.
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NetBackup Device Manager service

The NetBackup Windows service that runs on a NetBackup server and starts the robotic 
control processes and controls the reservation and assignment of volumes. This service 
runs only if the server has devices under Media Manager control. The process is ltid.

NetBackup properties

Same as NetBackup configuration options but are called NetBackup properties on 
Microsoft Windows platforms.

NetBackup Request Manager service

The NetBackup Windows service that runs on the master server and starts the scheduler 
and receives requests from clients.

NetBackup Volume Manager service

A NetBackup Windows service that runs on a NetBackup server, allows remote 
administration of Media Manager, and manages volume information. The process is vmd.

NIS

Network information service.

NLM

NetWare loadable module.

NFS

Network file system.

nonrobotic

See “standalone.” 

ODL

Optical disk library. This robot type is supported only by NetBackup DataCenter servers.

offsite volume group

A volume group in which media will appear after having been ejected from the robot for 
vaulting. When Vault ejects media it is moved from the robotic volume group to the 
off-site volume group.
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offsite volume pool

A volume pool that contains media that is to be ejected and vaulted. Backup images 
written to an off-site volume pool by an original NetBackup backup policy or by Vault’s 
duplication feature will be ejected and vaulted. More than one off-site volume pool can be 
specified for the Eject step of a Vault profile.

original backup

A backup image created by a backup job. A single backup image or all backup images 
created by an Inline Tape Copy (multiple copy) configuration are considered original 
backups. A backup image created by a duplication job is not an original backup.

outport

See “media access port.” 

partitions

The logical partitions into which a magnetic disk is divided.

patch

A program that corrects a problem or adds a feature to an existing release of software.

path length

Number of characters in a pathname.

pathname

The list of directories in the path to a destination directory or file.

PC clients

NetBackup clients that have Microsoft Windows, Macintosh, or IBM OS/2 operating 
systems.

peername

The name by which a computer identifies itself when establishing connections to other 
systems.

policy

Defines the backup characteristics for a group of one or more clients that have similar 
backup requirements.
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port

A location used for transferring data in or out of a computer.

Also see “media access port.” 

primary copy

The copy of an image that NetBackup uses to satisfy restores. When NetBackup duplicates 
an image, the original is designated as the primary copy.

privileges

The tasks or functions that a user, system, or application is authorized to perform.

profile

A vault profile is a way to save configuration settings. Specific parameters for duplication, 
catalog backup, eject, and report or any combination of these steps, are configured within 
a profile.

progress report

Log where NetBackup records events that occur during user operations.

proxy restore

A proxy restore allows the user to restore files that he has write access to, on a machine 
other than his desktop. The files must be in a backup of the machine to which they are 
being restored.

QIC

Quarter-inch-cartridge tape.

queued job

A job that has been added to the list of jobs to be performed.

raw-partition backup

Bit-by-bit backup of a partition of a disk drive on UNIX. On Windows, this is called a 
disk-image backup.

rbak

The program that Apollo clients use to read data from tape during a restore.
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recorded media ID

This is an identifier written as part of the label on a volume and used by Media Manager 
to ensure that the correct volume is mounted. The recorded media ID should match the 
external media ID.

redirected restore (different client)

Restoring files to your client when they were originally backed up from a different client. 
The administrator using the interface on the master server can direct a restore to any client 
(this variation is called a server directed restore).

redirected restore (different target)

On a Novell NetWare server platform running the NetBackup target version of client 
software, this operation restores files to a different target than the one from which they 
were backed up.

redirected restore (different path)

Restores files to a different directory than the one from which they were backed up.

registry

A Microsoft Windows database that has configuration information about hardware and 
user accounts.

remote administration console

A Windows NetBackup client that has the administration interface software installed and 
can be used to administer NetBackup servers.

remote media server

A media server that is not the master. Note that only NetBackup DataCenter supports 
remote media servers. NetBackup BusinesServer supports only a single server, the master.

residence

In Media Manager, information about the location of each volume is stored in a volume 
database. This residence entry contains information, such as robot number, robot host, 
robot type, and media type.

resource

A Novell NetWare term that refers to a data set on the target. For example, in DOS, 
resources are drives, directories, and files. Also see “target service.” 
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restore

(verb) The act of restoring selected files and directories from a previous backup or archive 
and returning them to their original directory locations (or to a different directory).

(noun) The process of restoring selected files and directories from a previous backup and 
returning them to their original directory locations (or to a different directory).

retention level

An index number that corresponds to a user-defined retention period. There are 10 levels 
from which to choose (0 though 9) and the retention period associated with each is 
configurable. Also see “retention period.” 

retention period

The length of time that NetBackup keeps backup and archive images. The retention 
period is specified on the schedule.

robotic arm

The component of a robotic library that physically selects the media (tape or optical disk).

robotic library

Refers to a robot and its accompanying software. A robotic library includes a collection of 
tapes or optical platters used for data storage and retrieval. For example, a Tape Library 
DLT (TLD) refers to a robot that has TLD robotic control.

robotic volume group

A volume group from which media will be ejected and vaulted. When Vault duplicates 
backups, they are duplicated to media in the robotic volume group.

root

The highest level directory in a hierarchical directory structure. In MS-DOS, the root 
directory on a drive is designated by a backslash (for example, the root on drive C is C:\). 
On UNIX, the root directory is designated by a slash (/).

Also, a UNIX user name having administration capability.

RS-232

An industry-standard interface for serial communications and sometimes used for 
communicating with storage peripherals. 
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RSM Interface

Application in Windows 2000 used to manage Removable Storage Manager (RSM) 
devices.

RSM - Removable Storage Manager

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

Also, a component of the Windows 2000 operating system that manages storage devices.

RVSN

See “recorded media ID.” 

schedules 

Controls when backups can occur in addition to other aspects of the backup, such as: the 
type of backup (full, incremental) and how long NetBackup retains the image.

SCSI

Small computer system interface. This is a type of parallel interface that is frequently used 
for communicating with storage peripherals.

server-directed restore

Using the user interface on the master server to restore files to any client. Only the 
administrator can perform this operation.

server independent restore

Restoring files by using a NetBackup server other than the one that was used to write the 
backup. This feature is available only with NetBackup DataCenter.

server list

The list of servers that a NetBackup client or server refers to when establishing or 
verifying connections to NetBackup servers. On a Windows server and Microsoft 
Windows clients, you update the list through a dialog box in the interface. On a UNIX 
server and UNIX and Macintosh clients, the list is in the bp.conf file. On NetWare target 
and OS/2 clients, the list is in the bp.ini file.

service

A program on a Windows server system that runs in the background and performs some 
task (for example, starting other programs when they are needed). Services are generally 
referred to as daemons on UNIX systems.
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session

An instance of NetBackup checking its schedules for backups that are due, adding them to 
its worklist, and attempting to complete all jobs in the worklist. For user backups and 
archives, a session usually consists of a single backup or archive.

Session (Vault)

A vault session consists of executing a particular profile or profiles.

shared drives

See “Shared Storage Option (SSO).” 

Shared Storage Option (SSO)

A separately priced VERITAS software option that allows tape drives (standalone or in a 
robotic library) to be dynamically shared among multiple NetBackup and Storage 
Migrator servers.

This option is supported only on NetBackup DataCenter servers.

SMDR

Storage management data requestor, a Novell NetWare program that provides its services 
transparently to all SMS modules and lets remote and local modules communicate with 
one another.

SMS

Novell NetWare storage management services.

source volume group

A volume group from which Vault can select backups to duplicate. This parameter is used 
to restrict the list of backups from all backups that reside on media in any volume group 
to backups that reside on media in a single volume group. Where a volume group 
corresponds to a particular robot, the profile will duplicate only backups on media in that 
robot. The Source Volume Group is normally only specified if you have multiple robots 
attached to the same server, for example you want to duplicate backups that reside in 
robot 0 to media that reside in robot 1.

SSO

See “Shared Storage Option (SSO).” 

stacker

Usually a small robotic library that contains one drive only. See “robotic library.” 
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standalone

A qualifier used with drives and media to indicate they are not associated with a robot. 
For example, a standalone tape drive is one where you must manually find and insert 
tapes before using them. A standalone volume is one that is located in a standalone drive 
or is stored outside of a drive and designated as standalone in the volume configuration.

status code

A numerical code, usually accompanied by a troubleshooting message, that indicates the 
outcome of an operation.

storage migrator

Refers to the VERITAS Storage Migrator line of hierarchical storage management products 
for UNIX and Windows. These products make extra room on a disk by transparently 
moving data to other storage and then transparently retrieving the data when it is needed 
by a user or application.

Storage Migrator is available only for NetBackup DataCenter servers.

storage unit

Refers to a storage device where NetBackup or Storage Migrator stores files. It can be a set 
of drives in a robot or consist of one or more single tape drives that connect to the same 
host.

SUSPENDED media state

If a volume is SUSPENDED, NetBackup can restore from it but cannot use it for backups. 
NetBackup retains a record of the media ID until the last backup image on the volume 
expires. 

symbolic link

On a UNIX system, this is a pointer to the name of the file that has the source data.

TapeAlert

Allows reactive cleaning for most drive types and is a function of the tape drive.

tape format

The format that an application uses to write data on a tape.

tape marks

A mark that is recorded between backup images on a tape.
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tape overhead

The space required for data that is not part of the backup images. For example, tape marks 
and catalogs of what are on the tape are considered overhead.

tape spanning

Using more than one tape to store a single backup image.

tar

Tape Archive program that NetBackup uses to extract backup images during a restore.

target

See “target service.” 

target service

A Novell NetWare service that needs storage management. The SMS views all services 
(for example, print services, communication services, workstations) as targets.

Target Service Agent

A Target-service agent is a Novell NetWare agent that prepares the target's data for SMS 
during a backup and for the target during a restore.

TLD - Tape Library DLT

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

TLH - Tape Library Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TLM - Tape Library Multimedia

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TL4 - Tape Library 4MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.
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TL8 - Tape Library 8MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

timeout period

The period of time that an application has allotted for an event to occur.

TIR

See “true image restore.” 

tpconfig

A Media Manager administration utility for configuring devices which is started from the 
command line. On UNIX, it has a character-based menu interface that can be run from 
terminals that do not have X Windows capabilities. tpconfig also has a command line 
interface.

transfer rate

The rate at which computer information is transferred between a source and a destination.

transport

See “robotic arm.” 

true image restore

Restores the contents of a directory to what it was at the time of any scheduled full or 
incremental backup. Previously deleted files are ignored.

TS8 - Tape Stacker 8MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

TSA

See “Target Service Agent.” 

TSD - Tape Stacker DLT

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.
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TSH - Tape Stacker Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

unassigned media

Media that contain no valid images. A piece of unassigned media has an entry in the 
volumes database but no entries in the images database. Unassigned Media do not have a 
“time assigned” in the Media section of the GUI.

user interface

The program used to perform user backups, archives, and restores.

user operation

A backup, archive, or restore that is started by a person on a client system.

Vault

Vault is a separately-priced NetBackup option that provides offsite backup management. 
Vault automatically duplicates specified backup images, and automates the process of 
offsite media rotation (a critical component of any backup or disaster recovery strategy). 
Vault manages offsite storage and retrieval of media for original backups, duplicate 
backups, and catalog backups. Additionally, NetBackup Vault generates reports to track 
the location and content of each piece of media.

vault

In the context of the NetBackup Vault, a vault is logical entity associated with a particular 
robot that acts as a designated holding place for backups that will eventually be sent to a 
physical offsite vault. The term ‘vault’ is used to refer both to the process, and to the 
physical storage location of a set of tapes offsite.

vault process

Vaulting is the process of choosing backup images to duplicate or eject, optionally 
duplicating backups, ejecting duplicate or original media, storing it at an offsite location, 
and later returning expired media to your robot. Vaulting is an integral part of the disaster 
recovery process.

verbose flag

Configuration file entry that causes a higher level of detail to be written in the logs.
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verify

An operation that compares the list of files that are actually on a volume with what 
NetBackup has recorded as being on it. The data that is on the media is not verified.

vmadm

A Media Manager administrator utility for managing volumes. It runs on UNIX and has a 
character-based, menu interface that can be run from terminals.

vm.conf

A Media Manager configuration file with entries that include the servers that can manage 
local devices and default media ID prefixes for media that do not contain barcodes.

volume

Media Manager volumes are logical units of data storage or cleaning capability on media 
that have been assigned media IDs and other attributes, which are recorded in the Media 
Manager volume database.

volume configuration

Refers to configuration information that is stored in the Media Manager volume database.

volume database

An internal database where Media Manager keeps information about volumes. All hosts 
(where Media Manager is installed) have a volume database. However, the database is 
empty unless the host is designated as a volume database host.

volume database host

The host (where Media Manager is installed) that contains information about the volumes 
that Media Manager uses in a device. Because NetBackup BusinesServer supports only a 
single server, the volume database host is always on the same server.

volume group

A set of volumes that are configured within Media Manager to reside at the same physical 
location (for example, in a specific robot).

volume pool

A set of volumes that are configured within Media Manager to be used by a single 
application and are protected from access by other applications and users.

wakeup interval

The time interval at which NetBackup checks for backups that are due.
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wildcard characters

A character that can be used to represent other characters in searches.

Microsoft Windows

(noun) Describes a line of operating systems developed by Microsoft, Inc.

For more information on the Windows operating systems that NetBackup supports, refer 
to the VERITAS support web site at http://www.support.veritas.com.

Windows

(adjective) Used to describe a specific product or clarify a term. Some examples are: 
Windows 95, Windows 98, Windows NT, Windows 2000, Windows servers, Windows 
clients, Windows platforms, Windows hosts, and Windows GUI.

Windows servers

A term that defines the Windows server platforms that NetBackup supports; those 
platforms are: Windows NT and 2000.

Windows clients

A term that defines the Windows client platforms that NetBackup supports; those 
platforms are: Windows 95, 98, ME, NT, 2000, XP (for 32- and 64-bit versions), and LE.

Windows Display Console

A NetBackup-Java interface program that runs on Windows 2000, NT, 98, and 95 
computers. Users can start this interface on their local system, connect to a UNIX system 
that has the NetBackup-Java software installed, and then perform any user operations 
that their permissions allow.

WORM media

Write-once, read-many media for optical disks. NetBackup BusinesServer does not 
support WORM media.

xbp

The X Windows-based backup, archive, and restore program for users on NetBackup 
UNIX clients.
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display the window 137
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Empty media access port prior to update 102
ENABLE_AUTO_PATH_CORRECTION, 
vm.conf entry 260
Enhanced Authorization

allowable Media Manager commands 
255
setting up 255

Exabyte robot slot diagram
10i,10e,10h (TS8) 341
18D (TLD) 342
210 (TS8) 341
220 (TL8) 342
230D (TLD) 343
430 (TL8) 336
EZ17 (TS8) 341

Expiration date, volume
definition 55
changing (see Changing)

External device mapping files 25
External media ID

drive status 144
pending requests 145

F
File

name on tpreq 165
positioning to on tape 166
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Filter, volume list
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by robot number 293
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First mount time field 55
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for move volumes 79
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G
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H
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for device monitor 148
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N
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Optical disk

partner ID 54
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Overland Data robot slot diagram
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LXBx110 (TLD) 347
LXBx210 (TLD) 347
LxL1u11(TLD) 349
NEO (TLD) 349
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daemons 159
drive cleaning 239
Media Manager 1
robots 229
vmadm 275
volume groups 242
volume pools 242

P
Partially-configured devices 26
Partner field 54
Pending requests

barcode field 146
density field 145
device host name 145
external media ID field 145
mode field 146
recorded media ID field 145
request ID field 145
time field 146
user field 145
volume group field 146

Permissions, for device access 167
Pool (see Volume pool)
Positioning tape files 166
PREFERRED_GROUP, vm.conf entry 261
PREVENT_MEDIA_REMOVAL, vm.conf 
entry 262
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Preview volume configuration update 101, 
102, 103
Printing

device configuration 273
volumes report 292

Processes
check with vmps 163
robotic 159
robotic control 160

R
RANDOM_PORTS, vm.conf entry 262
Reactive cleaning 240
Reading tape files 166
Ready status 144
Recorded media ID

drive status 144
pending requests 145

Recycle media 92
Refresh rate, changing 146
Related manuals xxii
Removable Storage Manager (RSM)

robot types 28
robots 101, 112

Removing
tape files 167
volumes 99

Replace media 90
ReqId (see Request ID)
Request ID field

drive status 144
pending requests 145

Requests
overview 151
assigning 153
denying 157
display pending 151
example assignment 154
identification number

drive status 144
pending requests 145

resubmitting 156
user tape 165

REQUIRED_INTERFACE, vm.conf entry 
263
Reset drive 150, 214
Reset mount time 39
Residence

defined 65

in update options 105
update volume configuration 100

Retention period
expiring backups, with bpexpdate 84

Rewinding tape files 167
right-click shortcut menus 5
Robot

add (see Adding)
attributes 231
barcode rules 124, 329
barcode update 134, 313
delete (see Deleting)
destination for move volume 78
device file 30, 268
device host 27
drive number 35
for new volume 70
host, definition 53
inventory 74, 94
inventory and compare contents 97, 316
number 28, 268
process 159
robotic daemons 163
show robot contents 314
type 28, 268
update configuration (see Updating)
update volume configuration 99, 318
volume database host 28
with more than one type of drive 75

Robot drive number 269
Robot number

for add drive 269
for add robot 268

Robot type
RSM 230
TL4 230
TL8 230
TLD 230
TS8 230
TSD 230

Robotic
cleaning 240
control process 160
device file 30
drive 269
library 35
test utilities 236

Robotic control path (see Robotic device file)
robtest 236, 257
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SCRATCH_POOL, vm.conf entry 263
Scripts
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vmps 163

SERVER, vm.conf entry 23, 263
Shared field

drive status 143
Shortcut menus 5, 19, 55, 146
Show All Columns command 49, 55
Show robot contents 95, 314
Slot number

add volume 71
for move volumes 79

Sony robot slot diagram
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Standalone drive 269
add drive 35

Start/Stop Media Manager Device Daemon 
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Status

volume 54
STK robot slot diagram

9730 (TLD) 351
9738 (TLD) 351
L20 (TLD) 352

stopltid command 160, 170
Storage devices
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Sun robot slot diagram

StorEdge L1000 (TLD) 338
StorEdge L400 (TL8) 342
StorEdge L9 (TLD) 343

syslogd 163
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removing tape files 167
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Terminating drive assignment 150
Time
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command 172
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command 174
daemon 162

tl8d
command 174
daemon 162

TLD (see Tape Library DLT)
tldcd

command 178
daemon 162
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command 178
daemon 162

Toolbars, viewing and customizing 48
tpclean command 181
tpconfig

overview 265
adding drive 268
adding robot 268
command 184
deleting drive 271
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deleting robots 271
menus 267
online help 267
printing device configuration 273
starting 266
stopping 267
update drive configuration 270
update robot configuration 269
update volume database hostname 272

tpreq
command 191
requesting tapes 165

tpunmount
command 194
removing tape files 167

TS8 (see Tape Stacker 8MM)
ts8d

command 195
daemon 162

TSD (see Tape Stacker DLT)
tsdd

command 197
daemon 162

Type field
4mm 142
8mm 142
dlt 142
hcart 142
qscsi 142

U
Up drive

standard mode (AVR) 140
Update and rescan barcodes 134
Update robot 318

procedure 101
update options 103, 323

Update volume configuration
when not to use 100
when to use 99

Updating
barcodes 134, 313
drive configuration 270
robot configuration 269
volume database hostname 272

User
access to devices 167
tape requests 165

User field

drive status 143
pending requests 145

Using Media Manager devices with other 
applications 2

V
VERBOSE, vm.conf entry 264
VERITAS support web site 25
vm.conf file

adding SERVER entries 23
AUTHORIZATION_REQUIRED entries 
259
CLIENT_PORT_WINDOW entries 259
DAYS_TO_KEEP_LOGS entries 259
DISALLOW_NONNDMP_ON_NDMP_
DRIVE entries 259
DO_NOT_EJECT_STANDALONE 
entries 260
ENABLE_AUTO_PATH_CORRECTIO
N entries 260
MEDIA_ID_BARCODE_CHARS entries 
260
MEDIA_ID_PREFIX entries 261
overview 258
PREFERRED_GROUP entries 261
PREVENT_MEDIA_REMOVAL entries 
262
RANDOM_PORTS entries 262
REQUIRED_INTERFACE entries 263
SCRATCH_POOL entries 263
SERVER entries 263
VERBOSE entries 264

vmadd command 199
vmadm

overview 275
add volume (see Adding)
barcode update 313
change volume’s volume pool 305
changing

media description 304
volume expiration date 306
volume maximum mounts 311

command 202, 275
deleting

multiple volumes 303
single volume 302
volume group 304

displaying volume configuration 292
inventory and report robot contents 314
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changing description 304

moving
volume group 300

moving volumes (see Move volumes)
online help 277
printing volume configuration 292
starting vmadm 275
stopping vmd 313
verify robot contents 316
verify selected robot volumes 313
volume configuration

barcode rules 329
update robot 318

vmchange command 203
vmcheckxxx command 209
vmd

command 161, 211, 312
daemon 159, 161
security 251
starting 161

by command 161, 312
using vmadm 312

stopping 161, 313
vmdelete command 213
vmoprcmd command 214
vmpool command 217
vmps script 163
vmquery command 220
vmrule command 224
vmupdate command 226
Volume configuration wizard 6, 74
Volume database host

changing 272
for robot 28

Volume group
add volume 72
changing 307
changing name 88
definition 242
deleting 81
deleting (see Deleting)
for move volume 78
moving 89
pending request field 146
rules for assigning 242
volumes list 51, 53

Volume header device 268
Volume is in a robotic library

for move volume 78
for new volume 70

Volume pool
overview 57, 242
add volume 73
adding 57
change assignment 305
changing attributes 59, 277
changing for a volume 60
configuring a scratch pool 60, 244
DataStore pool 50
deleting 62
for update robot 111
in volume list 54
NetBackup pool 50, 54
overview 8

Volumes
adding (see Adding)
assigned 83
barcode 53
changing (see Changing)
changing configuration (see Changing)
cleaning count

attribute 88
volumes list 55

creation time and date 55
deleting (see Deleting)
description for new volume 71
description, changing 304
first time mounted 55
group (see Volume group)
header device 34
last time mounted 55
list 292
maximum mounts allowed 72
media ID column 53
media ID style 70
moving 75, 246
moving (see Move volumes)
moving actions menu 76
optical disk partner 54
recycling 92
replacing 90
robot, host 53
slot 53
status 54
time assigned 54
volume pool (see Volume pool)

Volumes to move
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for move volume 77

W
Wizard

device configuration 6, 24, 36, 236
volume configuration 6, 74

Write enabled
field 144
tape 146

Writing tape files 166
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